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CHAPTER 1

Introduction

Introduction

Intercom system configuration has never been easier with the advent of Bosch’s AZedit Intercom System software. AZedit is a 
Windows-based, full-featured configuration software, providing online and offline configuration capabilities. It gives you the 
ability to manage multiple intercom systems, assign and reassign users to different ports, as well as dynamically add intercom 
hardware to your system setup without jumper changes. AZedit has the capability to load pre-built configuration files, which 
means configurations saved to a disk can be uploaded to the live application at anytime without the interruption of keypanel 
communications. AZedit’s configuration capabilities allow you to make changes through AZedit directly to the application or 
uploaded from a file created at an earlier time.

NOTE: For the purposes of this user manual, the ADAM frame is seen as a peripheral device, therefore when the system 
is uploading information, information is being retrieved from the ADAM. When information is being 
downloaded, information is being sent to the system from the ADAM.

AZedit Description

AZedit is designed to configure the ADAM, ADAM-M, ADAM-CS, Zeus, Zeus II, Zeus III, and Cronus products. It displays 
all resources available for the connected intercom system. In the case of DBX expanded multi-frame ADAM intercom 
systems, AZedit displays all of the available resources across multiple frames. If trunking is being used, it communicates with 
the trunk master to make trunked resources available to the local system.

Getting Started

The AZedit software comes with a CD used to install the application onto the computer used to control the intercom.

Minimum Requirements for Software Installation

• Pentium Processor

• 64 MB Ram

• Microsoft Internet Explorer 5.01 and higher or NT Service Pack 6.0.

• Microsoft Windows 98, NT, 2000, XP, Vista, Windows 7, Windows Server 2008, and Windows Server 
2008 R2.
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AZedit Installation and Configuration

NOTE: In earlier versions of AZedit, not all of these folders are present.

During installation, AZedit creates nine (9) sub-folders within the application folder. These folders are: 

• The AUTH folder is the default folder where authentication files are stored.

• The DEBUG folder is the default folder where debug reports are stored.

• The FIRMWARE folder is the default folder where the application looks for firmware update files.

• The LOG folder is the default location where the application saves the log files.

• The RES folder is the default location where the application saves restriction files.

• The SETUPS folder is the default location where the application saves setup files.

• The SNMP folder is the default location where the application saves SNMP configuration files. 

• The USB folder is where the USB drivers reside for you to download for USB use. 

• The V3XX (versions) folder is where the application stores the AZedit.exe file, the help files, and setup 
files used with AZedit.

When you remove the application, these sub-folders are not removed. This is so previously saved setup files, etc. are not be 
deleted when AZedit is upgraded.

NOTE: You can download the most current AZedit software at http://www.rtsintercoms.com/azedit.php.

To install AZedit, do the following:

1. Insert the AZedit CD into the CD-ROM drive.
The CD begins Autorun installation of the software. The Welcome Window of the Setup Wizard appears.
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2. Click Next.
The End-User License Agreement window appears.

3. Select the I accept the terms in the License Agreement radio button.

4. Click Next.
The Select Installation Folder window appears.

5. Navigate to the folder you want to install AZedit.

6. Select the Create a version-specific sub-folder for the application executable? check box, if desired.
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7. Click Next.
The Ready to Install window appears.

8. Click Install.
AZedit begins to install on the computer.
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9. When it is finished installing, click Next.
The Completing AZedit Installation window appears.

10. Click Finish.

NOTE: If the AZedit CD does not engage Autorun, do the following:

1.Right-click My Computer.
A popup menu appears.

2.Select Explore.
The My Computer window appears.

3.Double-click the CD drive.
The CD contents appear.

4.Double-click Setup.exe.
The AZedit installation begins.
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Uninstalling AZedit

To uninstall the software, do the following:

1. From the Start menu, select Settings, and then Control Panel.
The Control Panel window appears.

2. From the Control Panel window, select Add or Remove Programs.
The Add or Remove Programs window appears.

3. Using the slider, scroll to and select the AZedit program you want to remove.
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4. Click Remove.
An Add or Remove Programs warning appears

5. Click Yes.
The windows uninstaller runs and AZedit is removed.

Connection to Matrix Intercom System

Using Table 1, determine the type of intercom system you have and the type of connection you are using. Verify the cabling 
from the intercom system to the computer running AZedit is correct.

TABLE 1. Connecting to the Intercom System

ADAM & ADAM 
M

ADAM 
CS CRONUS ZEUS & 

ZEUS II
ZEUS III & 

ZEUS III LE/LE+

Serial RS-485a

a. Dip switch settings on the master controller must be set in order to activate this feature. For pinout information, see the Breakout Panel 
Resource Guide (P/N LIT000061000).

J1 connected to 
computer running 
AZedit

JI connected to computer 
running AZedit

J25 connected to 
computer 
running AZedit

Trunk/To PC Connector 
connected to computer 
running AZedit

Serial RS-232
J1 connected to 
computer running 
AZedit

J900 
connected 
to computer 
running 
AZedit

JI connected to computer 
running AZedit

J25 connected to 
computer 
running AZedit

Trunk/To PC Connector 
connected to computer 
running AZedit

USB N/A N/A

J7 connected to 
computer running 
AZedit. The USB 
drivers are located in 
C:\Telex\AZedit\USB.

For more information, 
see the Cronus user 
manual
(P/N 93507770000).

N/A

USB Connector on front 
panel of unit connected to 
the computer’s USB port. 
The USB drivers are 
located in 
C:\Telex\AZedit\USB.

For more information, see 
the Zeus III user manual 
(P/N 93507843000).

Ethernet/
Network

Ethernet J1 on the 
Master Controller 
back card connected 
to the Ethernet 
connection on the 
computer or to a 
network switch.

NOTE: This 
cabling 
requires a 
crossover 
cable.

N/A

J8 connected to the 
Ethernet connection on 
the computer or a 
network switch.

NOTE: This cabling 
requires a 
crossover 
cable.

N/A

Ethernet Connector 
connected to the computer 
or to a network switch.

NOTE: This cabling 
requires a 
crossover 
cable.
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Intercom Configuration Description

AZedit Intercom Configuration is made up primarily of resources and options related to your intercom system. Resources 
are the number of intercom ports, party lines, etc. available on a system. Options describe such things as the number of talk 
levels for each talk key, or the number of setup pages for each keypanel. These resources and options may be changed to 
accommodate your unique environment.

Some options slightly modify the operation of the intercom system. Some resource and option settings are limited by the 
amount of available hardware. 

For example, the number of ports in a Resource list is limited to the number of AIO (Audio Input Output) cards in the 
intercom system. For other resources and options, the quantity is primarily limited by the amount of available memory in the 
master controller. 

The intercom configuration is actually defined in three (3) places within your intercom system: 1) in the master controller 2) in 
AZedit and 3) in each setup file. We normally recommend you set the intercom configuration in the master controller first, and 
then apply these settings to AZedit afterward. Once you have done this, your setup files are automatically set to the same 
settings as the master controller and AZedit. The following paragraphs contain a more detailed discussion of the three (3) 
resource settings, and how to manage the memory limitations. 

NOTE: The only time a user might not want all three (3) settings to match is when configuring several independent 
intercom systems.

Master Controller Intercom Configuration

The Master Controller configuration is the backbone for your intercom system. Whatever is defined here, is allowed for 
actual intercom operation. It is possible to increase or decrease the quantities of some types of resources and options in the 
master controller to free up memory for larger quantities of other resources.

Advantages of reducing master controller intercom configuration settings

• The intercom system powers up faster with fewer resources.

• Less memory resources are used in the system controller. For example, in larger, multi-frame intercom systems, 
where the number of intercom ports can exceed several hundred, the configuration information for the ports 
requires a large portion of the system memory. In such cases, unused IFBs, ISOs etc. can be removed from the 
resource configuration to make room for resources being used.

• Scroll lists are smaller (when viewing them either in AZedit or from a keypanel).

• AZedit connects to the intercom system faster (fewer items to upload).

• AZedit updates faster (fewer items to query).

• Saving/Loading files is faster (less data to upload, less data to save).

• Setup files require less disk space with fewer resources.

• Checks for duplicate names (alphas) is faster with fewer resources.

• Sending changes to the intercom system is faster with fewer resources.

• You cannot mistakenly configure resources that do not exist (i.e., using ports that do not have AIO Cards).
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Disadvantages of reducing master controller intercom configuration settings

• If you add more hardware later (more AIO Cards, for example), you must readjust your Master Controller and 
AZedit configuration settings. Changing settings in the master controller can take up to 10 minutes. You may 
also have to reconfigure your setup files. This may require 2-3 minutes per file, if you have several files.

AZedit Intercom Configuration Settings

• In AZedit versions before 2.0, AZedit.ini, located in the AZedit folder, defined the quantity for each resource and 
option. These quantities can be changed. 

• In AZedit versions 2.0 and higher, the .ini file is not used. The application defaults are defined through the 
registry editor (Run/Regedit). 

To ensure you are viewing the intercom configuration for the application, do the following:

1. If you have been working in FILE mode, save any changes you have made. 
OR
If you have been working in ONLINE mode, send your changes to the intercom system.

2. Select New from the File menu
OR
Click the New File icon.
A warning message appears.

3. Click OK. 

4. From the Options menu, select Intercom Configuration. 
A warning message appears.

5. Click OK.
The Intercom Configuration window appears.

6. Click the Resources page. 

NOTE: When you first install AZedit, it is set to the default resources for a single frame ADAM intercom system. If 
you are using AZedit with an ADAM CS Intercom System, or with a multi-frame ADAM Intercom System, 
you must change this. Although you can change the AZedit resource settings at this time, we recommend 
you change the master controller configuration settings first, then select those settings as the AZedit default 
settings when prompted to do so.
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Setup File Configuration Settings

Whenever you open a setup file, the intercom configuration settings for that setup file are loaded. You can change the intercom 
configuration to different settings than the AZedit default settings. However, the only time you might want to do this is when 
you are creating setup files for several different intercom systems, each with a different set of resources. Usually, you create 
your setup files using the default application resources. 

To create a new file with the default configuration settings, do the following:

1. From the File menu, select New.
If you are in Online mode, a message indicating “You are about to exit ONLINE mode and edit a default intercom 
setup” appears.

2. Click OK.
AZedit enters FILE mode and opens a default intercom setup file.

Modes of Operation

There are three (3) mode possibilities:

FILE - File mode indicates the computer is not communicating with the intercom system. In this mode the user can 
create new setup files and open/edit existing setup files, without the worry of interrupting users.

File mode is an excellent way to make a lot of changes that can be uploaded to the intercom system as a 
batch change without interruptions. The changes made in File mode can also be saved to a disk for upload at 
a later time. This also ensures a backup of changes made to the system.

ONLINE - Online mode indicates the computer is communicating with the intercom system. Users can make changes to 
the intercom configuration or send setup files to the intercom system.

SERVER - Server mode indicates the computer is online and operating in Server mode. Users can view current 
intercom system configurations, as well as intercom activity.

While in Server mode, no changes can be made. This eliminates any redundancy of effort by more than one 
(1) user.

Connecting to ONLINE Mode from FILE Mode

Once you have finished making changes to the intercom system in File mode and have saved changes, you may want to 
connect to the intercom system from File mode to upload the changes.

IMPORTANT: It is recommended you review your communication settings before continuing 
(Options|Communications).

To connect to ONLINE mode, do the following:

1. From the menu bar, select Online.
The Online drop down menu appears.

2. From the drop down menu, select Connect.
The word ONLINE appears in the lower right-hand corner of the main AZedit window.
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To disconnect from ONLINE mode, do one (1) of the following:

To open a file using the New menu, do the following:

1. From the File menu, select New.
A message indicating “you are about to exit ONLINE mode and edit a default intercom setup” appears.

2. Click OK to accept.
The word FILE appears in the lower right-hand corner of the main AZedit window.

To open a file using the Open menu, do the following:

1. From the File menu, select Open.
A message indicating “You are about to exit ONLINE mode and open a file” appears.

2. Click OK to accept.
The Setup Browse window appears for you to choose the setup you would like to open. Also, the word FILE appears 
in the lower right-hand corner or the main AZedit window.

To open a file from the Save menu, do the following:

1. From the File menu, select Save.
The Save (Online setup) Browse window appears.

2. In the File Name text box, enter the setup file name to be saved (for example, Setup_9302003.adm).

3. Click Enter.
The Confirmation - ONLINE Save As window appears.

4. When the option to stay online or enter file mode appears, select Enter FILE Mode. Otherwise, select ONLINE.

5. Click Continue. Otherwise, click Cancel to cancel the upload and return to the main AZedit window.
The upload of the setup file begins. You see a status bar until it is finished uploading the data. Once the file is 
uploaded, the word FILE appears in the lower right-hand corner of the main AZedit window.

Connecting/Disconnecting — SERVER Mode

Monitoring the status of the intercom system is vital to effective and efficient operation. Server Mode allows the user to view 
real-time intercom activity. Remember, changes to the intercom system can not be made in SERVER Mode.

NOTE: You must be in ONLINE Mode before you can enter SERVER Mode.

To connect using SERVER Mode, do the following:

 > From the Online menu, select Server Mode.
A check mark appears next to Server Mode when it is active, the background in all fields turns purple, and the word 
SERVER appears in the lower right-hand corner of the main AZedit window.

To disconnect from SERVER Mode, do the following:

 > From the Online menu, select Server Mode.
The check mark is removed from Server Mode, the background in all fields returns to white, and the word ONLINE 
appears in the lower right-hand corner of the main AZedit window.
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Trouble Connecting?

If you are having trouble connecting to the intercom system, try the following:

• Verify the power to the intercom is on.

• Verify the intercom cable is properly connected to the PC. 

REFERENCE:Refer to the cable information you received with your intercom system.

• Verify the COM port and Baud rate settings are correct.

To adjust the COM port and Baud rate settings, do the following:

1. From Options menu, select Communications.
The Communications window appears.

2. Verify or select the proper settings.

3. Click OK.
The Communications window closes.

By default, AZedit is set for COM1 and 38,400kbps (38.4K baud). The baud rate set in AZedit must match the baud rate 
setting of the master controllers in the ADAM or ADAM CS frame (Dip Switch #1). The 38,400kbps setting provides the 
fastest possible file uploads and downloads, but you may experience more communication errors operating at this speed than 
at a lower baud rate setting. Cable lengths of 30-50ft. (9-15 meters) have been used successfully with the 38,400kbps setting.

NOTE: If you are experiencing communication problems operating at this speed, check the Master Controller Status 
window. Rapid communication errors on the right side of the window indicates a problem. In such cases, check 
cable construction or cable routing, or use a shorter cable. You may have to try different scenarios before 
operation at 38,400kbps is possible.
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CHAPTER 2

General Usage Tools

Status Bar

The Status Bar runs along the bottom of the AZedit application. It displays information such as mode, assignments, users, and 
transmit/receive status.

1. Hover Help: By browsing over an icon, a brief description of the button or icon appears.

2. Assignment Information: When you hover over or click in a key assignment field, the assignment information is 
displayed in these three (3) fields. This is only available when connected to the intercom.

3. Logging Information: When enabled, this field shows the word LOGGING when logging is active.

4. Alarms: When an Alarm occurs in AZedit, a popup message displays and a highlighted message appear in the status 
bar.

5. User Information: When connected to the intercom, this field shows the number of users also connected.

6. MODE Information: This field shows which mode AZedit is running: FILE, ONLINE, or SERVER. For more 
information on modes, See “Modes of Operation” on page 14.

7. Intercom Information: When connected to the intercom, this field shows the name of the intercom you are 
connected to.

8. Tx/Rx Information: These lights display the transmit and receive status of the intercom system. Green lights mean 
operation is normal. Red lights mean there is a problem.

FIGURE 158. Status Bar - AZedit
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Standard Toolbar

The Standard Toolbars at the top of the AZedit application 
window helps you easily and quickly perform common tasks 
within the application. Each icon represents a different task 
you can perform. You can customize the toolbars to have 
only the icons you use most. In addition, there is a second 
customizable standard toolbar available, if needed.

Both the Standard Toolbar and the Standard Toolbar 2 can 
either be docked to the top of the window or float separately 
from the window. By default, the Standard Toolbars are 
docked to the top of the application. 

New Icon 
The New icon creates a new setup file for AZedit. New 
is also available from the File menu. 

• If you are currently editing a file in FILE mode, 
clicking New clears all settings and opens a new, 
blank setup file (you are prompted for 
confirmation first). 

• If you are in FILE mode, but no changes have 
been made, clicking New immediately starts a 
new setup file without any prompts. 

• If you are in ONLINE mode, clicking New 
causes the computer to disconnect from the 
intercom system and enter FILE mode (A 
confirmation message appears). Then, a new, 
blank setup file is opened.

• If you are operating in SERVER mode, you 
cannot start a new file.

NOTE: Select File|New from the menu bar in 
AZedit to start a new setup file.

Open Icon

The Open icon opens an existing AZedit setup file. 
Open is also available in the File menu.

• If you are currently editing a file in FILE mode, 
clicking Open clears all settings and opens a file 
that you select from disk (you are prompted for 
confirmation first). 

• If you are in FILE mode, but no changes are 
made, clicking Open immediately lets you select 
a file to open from disk without any prompts. 

• If you are in ONLINE mode, clicking Open 
causes the computer to disconnect from the 
intercom system and enter FILE mode (you are 
prompted for confirmation). Then, you can select 
a file to open.

• If you are operating in SERVER mode, you 
cannot open a file.

NOTE: Select File|Open from the menu bar to 
open a setup file.

Merge Icon

The Merge icon combines the contents of a previously 
saved file into the file you are currently editing. 
Typically, merge is used with partial setup files 
previously saved using partial save.

NOTE: Select File|Merge from the menu bar in 
AZedit to merge two (2) setup files.

Save Icon

The Save icon saves the current AZedit setup file. Save 
is available in the File menu and via the Save button.

• If you are currently editing a new file in FILE 
mode, clicking Save lets you select a file name 
and location to save. 

• If you are in FILE mode, and editing a previously 
opened setup file, clicking Save allows you to 
save the file with the same file name or with a 
different name. 

• If you are in ONLINE mode, clicking Save 
causes the computer to upload the current 
intercom system configuration and merge it with 
any changes you have made but not sent to the 
intercom system. This assures that the latest 
settings are saved. 

For example, if one (1) or two (2) keypanel 
operators change key assignments on their 
keypanels while you are editing the Online 
configuration, both your changes and their 
changes are saved.

• If you are operating in SERVER mode, you 
cannot save a file.

NOTE: 

• By default, all setup files 
are saved in a folder called 
Setups, which is located in 
your AZedit program 
folder. This folder is not 
deleted if you use the 
Uninstall utility to remove 
AZedit. We recommend 
that you save your files in 
this folder.

• Select File|Save from the 
menu bar.
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Save As Icon

The Save As icon saves the current AZedit setup file 
under another file name. Use the Save As operation to 
save an existing file you want to change without losing 
the original setup file. Save As is available in the File 
menu and via the Save As button.

• If you are currently editing a new file in FILE 
mode, clicking on Save As lets you select a file 
name and location to save. 

• If you are in FILE mode, and editing a previously 
opened setup file, clicking Save As allows you to 
save the file with a new file name. 

• If you are in ONLINE mode, clicking Save As 
causes the computer to download* the current 
intercom system configuration and merge it with 
any changes you have made but not sent to the 
intercom system. This assures the latest settings 
are saved. 

For example, if one (1) or two (2) keypanel 
operators change key assignments on their 
keypanels while you are editing the Online 
configuration, both your changes and their 
changes are saved.

• If you are operating in SERVER mode, you 
cannot use Save As.

NOTE:

• By default, all setup files 
are saved in a folder called 
Setups, which is located in 
your AZedit program 
folder. This folder is not to 
be deleted if you use the 
Uninstall utility to remove 
AZedit. We recommend 
that you save your files in 
this folder.

• Select File|Save As... from 
the menu bar to access 
Save As.

* To download means to receive data from a remote 
system to a local system; whereas to upload means to 
send data from a local system to a remote system.

Partial Save Icon

The Partial Save icon lets you save parts of the setup 
file you are currently working on. Later, you can send 
the partial configuration to the intercom system using 
the Send File command. On the other hand, you can use 
the Merge command to merge the partial file into 
another setup file you are working on. For example, 
you might use Partial Save to save all of your UPL 
Resources and UPL Statements in their own file. You 
can then merge this file into your other setup files using 
the Merge command.

NOTE: Select File|Partial Save... from the 
menu bar to perform a partial save.

Print Icon

The Print icon opens the Print window. You can print 
the configuration information for the view you are 
currently viewing. 

NOTE: Select File|Print... from the menu bar to 
print a window.

For more information, see “Keypanel Print Options 
Window” on page 338.

Print Preview Icon

The Print Preview icon opens a display window to let 
you see how the printed page looks before you print it.

NOTE: Select File|Print Preview from the 
menu bar to access Print Preview.

Print Setup Icon

The Print Setup command lets you select a printer, the 
orientation of the paper, and any other options available 
on your printer.

NOTE: Select File|Print Setup... from the menu 
bar to access Print Setup.

Communications Icon

The Communications icon displays the 
Communications window. From this window you can 
configure the type of connection your intercom system 
is using: Serial, USB, or Network.

NOTE: Select Options|Communications from 
the menu bar to access the 
communications window.

For more information, see “Communications” on 
page 44.
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Clear Icon

The Clear icon (cancel changes command) cancels the 
operation without making changes.

Unlike Undo, which only lets you work on a stack of 
changes (last change made, is the first change undone), 
cancel changes lets you move from window to window 
and clear the changes made to any item. In addition, 
when you select an item and then select cancel changes, 
the confirmation window asks whether you would like 
to Cancel Changes for all items of the selected type. 

For example, if you are viewing the IFB window and 
click on an IFB, then select Cancel Changes, the 
confirmation window reads, Are you sure you want to 
Cancel Changes for the selected IFB?, and a check box 
that reads Cancel Changes for ALL IFBs.

NOTE:

• Cancel Changes is 
available only in ONLINE 
mode and only when an 
item is selected that has 
been changed since the last 
time changes were saved or 
sent to the intercom 
system. 

• Select Edit|Cancel 
Changes from the menu 
bar to cancel changes that 
have been made.

Abort Icon

The Abort icon erases any changes you have made to 
the ONLINE configuration. You must be in ONLINE 
mode to select this. 

If SERVER or FILE is indicated, Abort Changes is not 
available.

NOTE: Select Online|Abort Changes from the 
menu bar to abort changes that have 
been made.

About Icon

The About icon displays a window that details the 
AZedit version, its build date, and copyright 
information.

NOTE: Select Help|About AZedit from the 
menu bar to access the About window.

Activate (Send All Changes) Icon

The Activate (Send All) icon sends changes made in 
AZedit to the Master Controller and the keypanels. 
Send Changes is only available in ONLINE mode. If 
SERVER or FILE is indicated, Send Changes is not 
available. 

When you make changes, the changed items are 
highlighted in yellow. When you select Send Changes, 
these items are sent to the intercom system.
For more information, see “Send All Window” on 
page 327.

NOTE: Select Online|Send Changes from the 
menu bar to send changes made to the 
master controller.

Alpha Copy Icon

The Alpha Copy icon opens the Copy Alpha window. 
The Copy Alpha window helps you quickly copy and 
paste selected alpha or alias names. 

For example, you could copy all Alpha names and paste 
them to all Alias names.You may want to do this if you 
have just added trunking to a stand alone intercom 
system and must employ using Alias names.

NOTE: Select Alphas|Advanced Copy Utility... 
from the menu bar to open the Copy 
Alphas window.

Refresh Alphas Icon

The Refresh Alphas icon allows you to upload all 
current alphas from the intercom system to AZedit. 
Refresh Alphas is only available in ONLINE mode. 
This allows it to retrieve the most current configuration 
and status information from the intercom system.

NOTE: Select Alphas|Refresh Alphas from the 
menu bar to perform a Refresh Alphas.

Paste Icon

The Paste icon pastes the contents of the Windows 
Clipboard into the current configuration window (if that 
window is of the same type as the one (1) that was 
copied).

The paste command is only used after the copy 
command. (To select certain items you want to paste, or 
simultaneously paste to multiple windows, you can use 
Paste Special instead of Paste.) 

NOTE: Select Edit|Paste from the menu bar to 
paste selected items into the setup 
configuration.
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Preferences Icon

The Preferences icon opens the Preferences window. 
Preferences are optional user settings for AZedit.

For more information, see “Application Preferences 
Window” on page 94.

NOTE: Select Options|Preferences from the 
menu bar to access the Preferences 
window.

Redo Icon

The Redo icon allows you to redo up to 20 consecutive 
changes you previously canceled with the Undo Button. 

The Redo command is cleared every time you save 
your setup file or send your changes to the intercom 
system.

NOTE: Select Edit|Redo from the menu bar to 
perform a redo.

Resources Icon

The Resources icon opens the resource page of the 
Intercom Configuration window. In this window you 
can configure your intercom system manually or use 
the Intercom Sizing Wizard to help configure your 
system. 

For more information, see “Intercom Configuration 
Window” on page 52.

NOTE: Select Options|Intercom 
Configuration from the menu bar to 
access the Resources window.

Intercom Icon

The Intercom icon opens the Select Intercom window. 
From this window, you can change the intercom system 
you are viewing. 

NOTE: Select Authentication|Change 
Intercom to change intercom systems.

Send Icon (Send File)

The Send icon lets you select a file from disk, view its 
contents, and then send it to the intercom system. If the 
file is a complete setup file, all configuration 
information in the intercom system is overwritten. If 
the file was created using the Partial Save command, 
only those items contained in the file are overwritten in 
the intercom system.

Send is only available in ONLINE mode.

NOTE: Select Edit|Send File from the menu bar 
to access send file.

SNMP Icon
The SNMP icon opens the SNMP Configuration 
window. From this window you can configure SNMP 
to work with your intercom system. 
For more information, see “SNMP Configuration 
Window” on page 90.

NOTE: Select Options|SNMP Configuration... 
from the menu bar to open the SNMP 
Configuration window.

Toolbar Icon

The Toolbar icon displays or hides the Standard 
Toolbar.

NOTE: Select View|Standard Toolbar from the 
menu bar to show or hide the toolbar.

Toolbars Drop Down Menu Icon

The Toolbars drop down menu displays a list of the 
different types of toolbars available to show or hide in 
AZedit.

You can show or hide:

• Standard toolbar

• Standard 2 toolbar

• Navigation toolbar

• Navigation 2 toolbar

• Status Bar

• Key Assignment Grid

What’s New Icon

The What's New icon opens the developer's notes that 
describe the features, by version, within the AZedit 
application.

NOTE: Select Help|What’s New from the menu 
bar to access the What’s New document.

Authentication Icon

The Authentication icon opens the authentication 
configuration window. 

For more information, see “Authentication 
Configuration Window” on page 85.

NOTE: Select Authentication|Configuration... 
from the menu bar to access the 
authentication configuration window.

Connected Users Icon

The Connected Users icon opens the Connected Users 
window, which displays a list of all users currently 
logged on to the Intercom.

For more information, see “Connected Users Window” 
on page 310.

NOTE: Select Authentication|Show Connected 
Users from the menu bar to open the 
Connected Users window.



22  General Usage Tools AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Connect Icon

The Connect icon connects the intercom system when 
AZedit is in FILE mode. Before connecting, the 
program checks to see if you have made any changes to 
your current intercom setup file. If there are changes, 
you can cancel the connection and save your file before 
connecting. If there are no changes, the current 
intercom system setup file is immediately uploaded 
from the intercom system master controller, and this 
over-writes any setup file currently open. After you are 
connected, ONLINE is displayed in the lower-right 
corner of the window. In ONLINE mode, you can view 
the intercom system configuration and make changes, 
and you can also check various intercom statistics, such 
as which crosspoints are closed, which keys are active 
on a specific keypanel, the versions of firmware in 
various system devices, etc.

NOTE: Select Online|Connect from the menu 
bar to connect the AZedit to the intercom 
system.

Copy Icon

The Copy icon copies the entire window content you 
are currently viewing.

NOTE: Select Edit|Copy from the menu bar to 
perform a copy.

Create Shortcut Icon
The Create Shortcut button opens the Create Desktop 
Shortcut window. You can create a shortcut on your 
desktop to the intercom system.
For more information, see “Create Desktop Shortcut 
Window” on page 311.

NOTE: Select Authentication|Create Shortcut 
from the menu bar to create a shortcut 
for AZedit on the desktop. 

Cut Icon

The Cut icon cuts selected information and temporarily 
places it on the clipboard until you paste it to a different 
field. 

NOTE: If you cut information and do not paste it 
before cutting more information, the 
original information cut is permanently 
lost.

NOTE: Select Edit|Cut from the menu bar to 
perform a cut.

Duplicate Alphas Icon

The Duplicates Alphas icon checks for duplicate 
alphas in your system after you modify the setup file. 
By default, AZedit prompts to check for duplicate 
alphas whenever you open a file from disk.

In a large-scale intercom system, the possibility exists 
that you may accidentally assign the same name (alpha) 
to two (2) different resources. Two (2) resources of the 
same type can never have the same name (for example, 
two (2) intercom ports cannot have the name DIR1).
For more information, see “Check For Duplicate 
Alphas Window” on page 329.

NOTE: Select Alphas|Check for Duplicate 
Alphas from the menu bar to check for 
duplicate alphas.

Ethernet Configuration Icon

The Ethernet Configuration icon opens the Ethernet 
Setup window. Configure the Ethernet connection for 
the intercom system.

For more information, see “Ethernet Setup” on page 41.

NOTE:

• You must be connected to 
the intercom using a serial 
or USB connection to 
configure Ethernet for the 
intercom system 

• Select Options|Ethernet 
Configuration from the 
menu bar to open the 
Ethernet Configuration 
window.

Font Drop Down Menu Icon

The Font drop down menu displays several different 
text sizes for viewing the setup windows. If you select 
one (1) of the larger text sizes, the completed setup 
information does not fit on your window. In this case, 
scroll bars appear on the window.

Shrink Icon

The Shrink icon gives you the ability to manually 
decrease the size of the font in the application with the 
click of the mouse.

NOTE: Select View|Font Size from the menu 
bar to set the size of text displayed in 
windows.
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Grow Icon

The Grow icon gives you the ability to manually 
increase the size of the font in the application with the 
click of the mouse.

NOTE: Select View|Font Size from the menu 
bar to set the size of text displayed in 
windows.

GPIO-16 Icon
The GPIO-16 icon opens the GPIO-16 Configuration 
window. From this window you can setup various 
configuration options, such as IP Addressing, Ethernet 
settings, and Master Controller settings.
For more information, see “GPIO-16 Configuration 
Window” on page 81.

NOTE: Select Options|GPIO-16 
Configuration from the menu bar to 
open the GPIO-16 window.

Key Assignment Grid Icon

The Key Assignment Grid icon provides easy access 
to key assignments to program keypanels. To use the 
grid, click the assignment type combo box and select 
the assignment type from the list that appears. Based on 
the assignment selected, the alphas appear in the grid 
below. Click the border of the grid’s outer frame and 
drag the mouse to resize the grid. Once the alpha that 
you wish to assign appears, place the mouse pointer 
over the assignment, hold down the left mouse button, 
and drag the assignment to the desired key (either talk 
or listen). 

The assignment types abbreviated are:
PP – Point-to-Point
PL – Party Line
IFB – Interrupt Fold-Back
IFB SL – Interrupt Fold-Back Special List
SL – Special List
GPI Out – GPI output
ISO – Isolate
UPL – Universal Programming Language 
(resource)
SPCL – Special Function (e.g. AL, AF, AC, etc…)

For more information, see “Key Assignment Grid 
Window” on page 337.

NOTE: Select View|Key Assignment Grid 
from the menu bar to open the 
Assignment Grid.

Forward Icon

The Forward icon allows the user to follow the same 
sequence of windows used to go back. Forward is used 
in conjunction with Back.

NOTE: Select View|Go Forward from the menu 
bar to advance to the next window.

NavBar 2 Icon

The NavBar 2 icon allows the user to show or hide the 
Navigation 2 Toolbar.

NOTE: Select View|Navigation Toolbar 2 from 
the menu bar in AZedit to show or hide 
the Navigation Toolbar 2.

NavBar Icon

The Nav Bar icon allows the user to show or hide the 
Navigation Toolbar.

NOTE: Select View|Navigation Toolbar from 
the menu bar in AZedit to show or hide 
the Navigation Toolbar.

Paste Special Icon

The Paste Special icon opens the Paste Special 
window. Paste Special is available from the Edit menu. 
It gives you greater control over pasting than you get 
when using the Paste command. You can paste portions 
of the Windows Clipboard to a window. You can also 
paste to multiple windows.

For more information, see “Paste Special Window” on 
page 313.

NOTE: Select Edit|Paste Special from the menu 
bar to open the Paste Special window.

Back Icon

The Back icon allows you to go back up to 20 
consecutive previously-viewed windows.

NOTE: Select View|Go Back from the menu bar 
to return to the previous window.

Refresh Icon

The Refresh icon restores the current AZedit intercom 
port configuration and status information. Use Refresh 
with any window that provides status information.

For example, if you are viewing a particular Keypanel/
Port window, by selecting Refresh you can see the keys 
currently activated. For each key that is on, a red dot 
appears above the key.

The windows refresh automatically every few seconds. 
However, the time between refreshes can vary, 
depending on intercom activity, and the size of the 
intercom system. Use Refresh to ensure you are 
viewing the most recent information for a particular 
window.

NOTE: Select View|Refresh from the menu bar 
to perform a refresh.
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Search Icon

The Search icon opens the Search For Key Assignment 
window. From this window you can search for all ports 
or resources in an intercom system. Search (and 
Replace) helps you change ports without searching for 
all ports that are affected. Search is sometimes useful 
when you are moving a user from one (1) intercom port 
to another. You have to search for all keypanels with 
keys assigned to that person's old port, and change them 
to the new port. 

For more information, see “Search For Key 
Assignment Window” on page 332.

NOTE: Select Edit|Search for key assignment 
from the menu bar to open the search for 
key assignment window.

User Icon
The User icon opens the Select User window. From this 
window you can switch User profiles and log onto the 
intercom system.
For more information, see “Select User Window” on 
page 308.

NOTE: Select Authentication|Change User 
from the menu bar to open the Select 
User window.

Server Status Icon
The Server Status icon toggles Server Mode on and 
off. This button is only available in ONLINE mode. 
For more information, see “Modes of Operation” on 
page 14.

NOTE: Select Online|Server Mode from the 
menu bar to switch to Server Mode.

Status Bar Icon
The Status Bar icon shows or hides the status bar 
located at the bottom of the AZedit application window.
For more information, see “Status Bar” on page 17.

NOTE: Select View|Status Bar from the menu 
bar to advance to the next window.

Standard Toolbar2 Icon

The Standard Toolbar2 icon shows or hides the 
Standard Toolbar2.

NOTE: Select View|Standard Toolbar2 from 
the menu bar to show or hide the 
Standard Toolbar2.

Undo Icon

The Undo icon can undo up to 20 consecutive 
previously made changes. The Undo command is 
cleared every time you save your setup file or send your 
changes to the intercom system in ONLINE mode. 

NOTE: Select Edit|Undo from the menu bar to 
undo previous modifications.

Error Information Icon

The Error Information icon opens the Error 
Information window, which displays enhanced error 
information on recently occurring errors.

NOTE: Select Help|Error Information from 
the menu bar to open the Error 
Information window.

Load Icon

The Load icon opens the Load File navigation window, 
where you can select the file to load into AZedit.

NOTE: Select Online|Load File from the menu 
bar to open the Load File navigation 
window.

Frame Icon

The Frame icon displays a drop down menu containing 
a list of selectable frames within your intercom system.

NOTE: Select Options|Connect To Frame to 
select the frame you want to connect to.

Help Icon

The Help icon opens the help file allowing you to 
search for information in one (1) of two (2) ways; by 
looking through the Index or by typing in keywords.

NOTE: Select Help|Help Topics from the menu 
bar to open the Help file.

Mapping Icon

The Mapping icon opens the Frame Mapping Table 
window which is used to designate frame priority when 
using a multi-frame system.

Select Options|Frame Mapping Table from the menu 
bar to open the Frame Mapping Table window.

Debug Info Icon

The Debug Info icon opens the Upload Debug 
Information navigation window. This is used to select a 
target location for you to store debug information when 
events occur.

NOTE: Select Options|Upload Debug 
Information from the menu bar to open 
the Upload Debug Information window.
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Navigation Toolbars

The Navigation toolbars at the bottom of the AZedit 
application window help you easily and quickly maneuver 
around the application. Each icon represents a different 
window you can open by simply clicking. Besides being able 
to jump to different windows within AZedit, you can 
customize the navigation toolbars to have only the icons you 
use. For example, you can customize the navigation bar to 
have an icon for the Keypanel/Ports window, RVON and all 
the status windows. In addition, there is a second 
navigational bar available, if needed.

Both the Navigation and Navigation 2 Toolbars can either be 
docked to the bottom of the window or float separate from 

the window. By default, the Navigation Toolbars are docked 
at the bottom of the application window.

Password Icon

The Password icon opens the Change Password 
window. 

NOTE: Select Authentication|Change 
Password from the menu bar to open the 
Change Password window.

What’s This Icon

The What's This icon allows you to quickly access 
context sensitive help by clicking on a field.

TM Communications Icon

The TM Communications icon opens the Trunk 
Master Communications Window. 

NOTE: Select Options|TM Communications 
from the menu bar to open the Change 
Password window.

AGRPs Alpha Icon

The AGRPs Alpha icon opens the Assignment Group 
Alphas window. From this window you can create or 
modify descriptions and alphas for assignment groups 
in your intercom system.

NOTE: You can also get to the Assignment 
Group Alphas window by selecting 
Alphas|Assignment Groups from menu 
bar.

For more information, see “Alpha Windows” on 
page 227.

DIMs Description Icon

The DIMs Description icon opens the Inter-panel Dim 
Descriptions window. From this window you can 
create or modify the description for inter-panel DIMs 
in your intercom system.

NOTE: You can also get to the DIMs 
Description window by selecting 
Alphas|Dim Table from the menu bar.

For more information, see “GPI Input and DIM 
Description Windows” on page 231.

Gains Drop Down Menu Icon

The Gains drop down menu icon displays a list of 
three options: Crosspoint, Party Line, and I/O Gains 
windows. 

From these windows you can modify gain settings for 
crosspoints, party lines, and inputs/outputs in your 
intercom system.

NOTE: You can also get to the Gains drop down 
menu by selecting System|Gains from 
the menu bar.

For more information, see “Crosspoint Gains Window” 
on page 214, “Party Line Gains Window” on page 217, 
or “Input/Output Gains Window” on page 220.

GPIs Icon

The GPIs Icon opens the GPI Input window. From this 
window, you can designate or modify the port, alpha, 
the key number, and the key type for GPIs in your 
intercom system. 

NOTE: You can also get to the GPI Input 
window by selecting System|GPI Input 
from the menu bar.

For more information, see “GPI Input Window” on 
page 158.
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IFBs Alphas Icon

The IFB Alphas icon opens the IFB Alphas window. 
From this window you can modify the description, 
alpha, and alias of IFBs in your intercom system.

NOTE: You can also get to the IFB Alphas 
window by selecting Alphas|IFB from 
the menu bar

For more information, see “Alpha Windows” on 
page 227.

IFB Drop Down Menu Icon

The IFB drop down menu icon opens the IFBs 
window. From this window you can view, create, and 
modify IFBs in the intercom system.

Use the drop down arrow to display a list of view 
options to choose. These include:

• IFB Priority

• PGM Listen Source

• IFB Listen Destination

• IFB Special List 
From these windows you can view the IFB priorities, 
configure the PGM Listen Source, IFB listen 
destinations, or the IFB special lists windows.
For more information, see “IFB Priorities Window” on 
page 144, “Program Listen Source Window” on 
page 152, “IFB Listen Destination Window” on 
page 147, or “IFB Special Lists Window” on page 149.

IFB SL Alphas Icon

The IFB SL Alpha icon opens the IFB Special List 
Alphas window. From this window you can rename 
default alphas, aliases, and descriptions for IFB 
Special Lists in your intercom system.

NOTE: You can also get to the IFB SL Alphas 
window by selecting Alphas|IFB 
Special List from the menu bar

 For more information, see “Alpha Windows” on 
page 227.

I/O Cards Alphas Icon

The I/O Cards Alpha icon opens the IO Card 
Descriptions window. From this window, you can 
modify I/O card descriptions for cards in your 
intercom system.

NOTE: You can also get to the I/O Card Alphas 
window by selecting Alphas|I/O Card 
from the menu bar

For more information, see “I/O Card Description 
Window” on page 233.

I/O Card Versions Icon

The I/O Card Versions icon opens the IO Card 
Versions window. From this window, you can view 
I/O card versions and upgrade I/O card firmware 
versions.

NOTE: You can also get to the I/O Card 
Versions window by selecting 
Status|Software Versions|I/O Cards from 
the menu bar

For more information, see “I/O Card Version 
Information Window” on page 278.

ISO Alphas Icon

The ISO Alpha icon opens the ISO Alphas window. 
From this window you can rename default alphas, 
aliases and descriptions for ISOs in your intercom 
system.

NOTE: You can also get to the ISO Alphas 
window by selecting Alphas|ISO from 
the menu bar.

For more information, see “Alpha Windows” on 
page 227.

Keypanels/Ports Status Icon

The Keypanel/Ports Status icon opens the 
Keypanel/Ports Status window. From this window, you 
can view the status of the Keypanel/Ports and upgrade 
keypanel firmware versions.

NOTE: You can also get to the Keypanel/Ports 
Status window by selecting 
Status|Keypanel/Ports from the menu 
bar.

For more information, see“Port Status Window” on 
page 238.

Keypanel/Ports Icon

The Keypanel/Ports icon opens the Keypanels/Ports 
window. From this window, you can configure 
keypanels in your intercom system.

NOTE: You can also get to the Keypanel/Ports 
window by selecting System|Keypanel 
Assignment from the menu bar.

For more information, see “Ports Window” on 
page 109.

Listen Destination Icon

The Listen Destination icon opens the Listen 
Destination window. From this window you can 
configure listen ports and output ports for IFBs in your 
intercom system.

For more information, see “IFB Listen Destination 
Window” on page 147.
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Master Controller Version Icon

The Master Controller Version icon opens the Master 
Controller Version window. From this window you can 
view Master Controller version information and 
upgrade the master controller firmware.

For more information, see “Master Controller Version 
Information Window” on page 277.

PAPs and LCPs Descriptions Icon

The PAPs and LCPs Description icon opens the PAP 
and LCP Descriptions window. From this window you 
can create or modify the descriptions for PAPs or 
LCP-102s in your intercom system.

For more information, see “PAP/LCP Description 
Window” on page 235.

PAPs and LCPs Status Icon

The PAPs and LCPs Status icon opens the PAP and 
LCP Status window. From this window you can view 
the status for PAPs or LCPs in your intercom system.

NOTE: You can also get to the PAPs and LCP-
102 by selecting Status|PAP and LCP-
102 from the menu bar

For more information, see “PAP & LCP-102 Status 
Window” on page 253.

PL Gains Icon

The PL Gains icon opens the Party Line Gains 
window. From this window you can modify gain 
settings for party lines in your intercom system.

NOTE: You can also get to the PL Gains 
window by selecting 
System|Gains|Party Line Gains from the 
menu bar.

For more information, see “Party Line Gains Window” 
on page 217.

Keypanel/Ports Alphas Icon

The Keypanel/Ports Alpha icon opens the 
Keypanel/Port Alphas window. From this window you 
can create or modify descriptions, output alphas, input 
alphas, and aliases for keypanel/ports in your intercom 
system.

NOTE: You can also get to the Keypanel/Port 
Alphas window by selecting 
Alphas|Keypanels/Ports from the menu 
bar.

For more information, see “Port Alphas Window” on 
page 222.

MADI Status Icon

The MADI Status icon opens the MADI Status 
window. From this window you can view MADI port 
allocations, link status, and MADI card location in the 
frame, etc.

NOTE: You can also get to the MADI Status 
window by selecting Status|MADI 
Cards from the menu bar.

For more information, “MADI Card Status Window” 
on page 70.

MC Status Icon

The MC Status icon opens the Master Controller 
Status window. From this window you can view 
Master Controller status values for the Active and 
Standby master controller.

NOTE: You can also get to the Master 
Controller Status window by selecting 
Status|Master Controller from the menu 
bar.

RVON Connection Status Icon

The RVON Connection Status icon opens the RVON 
Connection Status window. From this window you can 
display Card/Channel, Connection, VOIP, Network, 
Errors, and Pass-Through status information for 
RVON devices in your intercom system. 

NOTE: You can also get to the RVON 
Connection window by selecting 
Status|RVON Connection from the 
menu bar.

For more information, see “RVON Connection Status 
Window” on page 266.

RYs Icon

The RYs icon opens the GPI Outputs window. From 
this window you can determine input and output ports, 
as well as individual scroll enable settings.

NOTE: You can also get to the GPI Output 
window by selecting System|GPI 
Output from the menu bar.

For more information, see “GPI Output Window” on 
page 154.
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SLs Icon

The SLs icon opens the Special Lists window. From 
this window you can create and configure special lists 
in your intercom system.

NOTE: You can also get to the Special Lists 
window by selecting System|Special 
Lists from the menu bar.

For more information, see “Special Lists Window” on 
page 135.

UIO Status Icon

The UIO Status icon opens the UIO Status window. 
From this window you can view the status for UIO-256 
and GPIO-16 units in your intercom system.

NOTE: You can also get to the UIO Status 
window by selecting Status|UIO from 
the menu bar.

For more information, see “UIO-256 Status Window” 
on page 255.

URs Alphas Icon

The URs Alpha icon opens the UPL Resource Alphas 
window. From this window you can create or modify 
the description, alpha, and alias for UPL resources in 
your intercom system.

NOTE: You can also get to the UPL Resources 
window by selecting Alphas|UPL 
Resource from the menu bar.

For more information, see “Alpha Windows” on 
page 227.

Versions Drop Down Menu Icon

The Versions drop down menu icon opens the Select 
Device window. From this window, select the device 
for which you want to view status. Options include 
Master Controllers, Keypanels, I/O Cards, or
GPIO-16s.

Use the drop down menu to display a list of view 
options. These include:

• Master Controllers

• I/O Cards 

• Keypanels

• GPIO-16s

XCP Status Icon

The XCP Status icon opens the Crosspoint Controller 
Status window. From this window, you can view the 
status of crosspoints in your intercom system.

For more information, see “Crosspoint Status 
Window” on page 181.

XCP Icon

The XCP icon opens the Crosspoints Status window. 
From this window you can create and configure 
crosspoints used in your intercom system. 

NOTE: You can also get to the Crosspoint Status 
window by selecting System|Crosspoint 
from the menu bar.

For more information, see “Crosspoint Status 
Window” on page 181.

GPIOs Icon

The GPIOs icon opens the GPIO-16s window. From 
this window you can enable/disable Ethernet, change 
IP Addresses, and view information concerning 
GPIO-16 units in your intercom system.

NOTE: You can also get to the GPIO-16 
window by selecting System|GPIO-16 
from the menu bar.

For more information, see “GPIO-16s Window” on 
page 165.

BX Status Icon

The BX Status icon opens either the DBX Link Status 
window or the TBX Link Status window, depending on 
what is installed. From this window you can view the 
status of DBX bus expansion cards installed and 
upgrade the firmware.

For more information, see “DBX or TBX Link Status 
Window” on page 246.

Trunks Status Icon

The Trunks Status icon opens the Trunk Status 
window. From this window can view the status of 
trunked lines in your intercom system.

NOTE: You can also get to the Trunk Status 
window by selecting Status|Trunks from 
the menu bar.

For more information, see “Trunk Inspection Window” 
on page 262.

AGRPs Icon

The AGRPs icon opens the Assignment Groups 
window. From this window you can create, modify, 
and delete assignment groups in your intercom system.

NOTE: You can also get to the Assignment 
Groups window by selecting 
System|Assignment Groups from the 
menu bar.

For more information, see “Assignment Group 
Window” on page 168.
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DIMs Icon

The DIMs icon opens the Inter-panel Dim Tables 
window. From this window you can add and remove 
ports to and from DIM tables in your intercom system.

NOTE: You can also get to the Inter-panel DIM 
Table window by selecting System|Dim 
Table from the menu bar.

For more information, see “Inter-Panel Dim Table 
Window” on page 192.

GPIs Alpha Icon

The GPIs Alpha icon opens the GPI Input Description 
window. From this window you can change the default 
description of the GPI Input.

NOTE: You can also get to the GPI Input 
Descriptions window by selecting 
Alphas|GPI Input from the menu bar.

For more information, see “GPI Input and DIM 
Description Windows” on page 231.

Icoms Status Icon

The Icoms Status icon opens the Remote Intercoms 
Status window. 

This window displays a two (2)-column status window 
and four (4) operations radio buttons that can be 
performed from this window. The text description of 
options 1 and 3 can change depending on the intercom 
selected in the status list.

NOTE: You can also get to the Remote Intercom 
Status window by selecting 
Status|Remote Intercom from the menu 
bar.

For more information, see “Remote Intercoms Status 
Window” on page 264.

Priorities Icon

The Priorities icon opens the IFB Priorities window. 
From this window, you can configure IFB priorities for 
selected IFB assignments in your intercom system.

For more information, see “IFB Priorities Window” on 
page 144.

IFBs Icon

The IFBs icon opens the IFBs window. From this 
window you can configure scroll enable actions, input 
ports, output ports, DIM level, and listen source ports. 

For more information, see “IFBs Window” on 
page 139.

IFB SL Icon

The IFB SL icon opens the IFB Special Lists window. 
From this window you can create and configure IFB 
special lists for your intercom system. 

For more information, see “IFB Special Lists Window” 
on page 149.

I/O Cards Status Icon

The I/O Cards Status icon opens the IO Card Status 
window. From this window you can view the status of 
the I/O cards in the intercom system and upgrade 
firmware for most of the cards in your intercom 
system.

NOTE: You can also get to the I/O Cards Status 
window by selecting Status|I/O Cards 
from the menu bar.

For more information, see “I/O Card Status Window” 
on page 250.

IO Gains Icon

The IO Gains icon opens the IO Card Gains window. 
From this window you can set or modify gain levels 
for IO cards in your intercom system.

NOTE: You can also get to the I/O Gains 
window by selecting 
System|Gains|Input / Output Gains from 
the menu bar.

For more information, see“Input/Output Gains 
Window” on page 220.

ISOs Icon

The ISOs icon opens the ISOs window. From this 
window you can create and configure ISO assignments 
in your intercom system.

NOTE: You can also get to the ISOs window by 
selecting System|ISO from the menu 
bar.

For more information, see “ISO Window” on 
page 161.

KPs Version Icon

The KPs Version icon opens the Keypanel Versions 
Information window. From this window you can view 
keypanel/port versions and upgrade firmware.

NOTE: You can also get to the Keypanel 
Version Information window by 
selecting Status|Software 
Versions|Keypanels from the menu bar.

For more information, see “Keypanel Version 
Information Window” on page 279.
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LCPs Icon

The LCPs icon opens the LCP-102s window. From 
this window you can configure LCPs in your intercom 
system.

NOTE: You can also get to the LCP-102s 
window by selecting System|LCP-102 
Assignment from the menu bar.

For more information, see “PAP & LCP-102 Status 
Window” on page 253.

Logs Icon

The Logs icon opens the Log Viewer window. From 
this window you can view log files (if enabled) in your 
intercom system. You can view these files by date 
and/or times.

NOTE: You can also get to the Log Viewer 
window by selecting Logging|View Log 
from the menu bar.

For more information, see “Log Viewer Window” on 
page 281.

Standby Status Icon

The Standby Status icon opens the Standby Master 
Controller Status window. From this window you can 
view the standby master controller status and upgrade 
firmware.

NOTE: You can also get to the Standby Master 
Status window by selecting 
Status|Standby Controller from the 
menu bar.

For more information, see “Standby Master Controller 
Status Window” on page 244.

PAP Icon

The PAP icon opens the PAP-32 window. From this 
window you can configure PAP-32s for your intercom 
system.

NOTE: You can also get to the PAP-32 window 
by selecting System|Crosspoint from the 
menu bar.

For more information, see “PAP-32 Window” on 
page 174.

PL Alphas Icon

The PL Alphas icon opens the Party Line Alphas 
window. From this window you can create or modify 
party line descriptions, alphas, and aliases.

NOTE: You can also get to the Party Line 
Alphas window by selecting 
Alphas|Party Line from the menu bar.

For more information, see “Alpha Windows” on 
page 227.

PLs Icon

The PLs icon opens the Party Line window. From this 
window you can configure party lines for your 
intercom system.

NOTE: You can also get to the Party Lines 
window by selecting System|Party Line 
from the menu bar.

For more information, see “Party Lines Window” on 
page 131.

RVON Icon

The RVON icon opens the RVON Configuration 
window. From this window you can configure the 
origination and destination points, device types, codec 
information, and serial pass through information for 
RVON devices in your intercom system.

NOTE: You can also get to the RVON 
Configuration window by selecting 
System|Miscellaneous|RVON 
Configuration from the menu bar.

For more information, see “Port Allocation Table 
Window” on page 72.

 RYs Alpha Icon

The RYs Alpha icon opens the GPI Output Alphas 
window. From this window you can create or modify 
descriptions, alphas, and aliases for GPI Outputs in 
your intercom system.

NOTE: You can also get to the GPI Output 
Alphas window by selecting Alphas|GPI 
Output from the menu bar.

For more information, see “Alpha Windows” on 
page 227.

SL Alphas Icon

The SL Alphas icon opens the Special List Alphas 
window. From this window you can create or modify 
descriptions, alphas, and aliases for special lists in your 
intercom system.

NOTE: You can also get to the Special List 
Alphas window by selecting 
Alphas|Special List from the menu bar.

For more information, see “Alpha Windows” on 
page 227.



AZedit Intercom Software General Usage Tools  31

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

TM Status Icon

The TM Status icon opens the Trunk Master Status 
window. From this window you can view the trunk 
master status for your intercom system.

NOTE: You can also get to the Trunk Master 
Status window by selecting Status|Trunk 
Master from the menu bar.

For more information, see “Trunk Master Status 
Window” on page 260.

UPL Icon

The UPL icon opens the User Programmable Logic 
Statements window. From this window you can create, 
enable, disable, and delete user programmable 
statements for your intercom system.

NOTE: You can also get to the User 
Programable Logic window by selecting 
System|UPL Statements from the menu 
bar.

For more information, see “UPL Statements Window” 
on page 198.

URs Icon

The URs icon opens the User Programmable Logic 
Resources window. From this window you can view 
and scroll enable UPL resources in your intercom 
system.

NOTE: You can also get to the User 
Programmable Logic Resources 
window by selecting System|UPL 
Resources from the menu bar.

For more information, see “UPL Resources Window” 
on page 194.

VOX Icon

The VOX icon opens the VOX Settings window. From 
this window you can configure vox settings for 
specific ports in your intercom system.

NOTE: You can also get to the VOX Settings 
window by selecting System|VOX from 
the menu bar.

For more information, see “VOX Window” on 
page 208.

XPT Gains Icon

The XPT Gains icon opens the Crosspoint Gain 
window. From this window you can set and adjust 
gains for crosspoints defined in your intercom system.

NOTE: You can also get to the Crosspoint Gain 
window by selecting 
System|Gains|Crosspoint Gains from the 
menu bar.

For more information, see “Crosspoint Gains Window” 
on page 214.

ARPs Icon

The ARPs icon opens the ARP-32 Assignment 
window. From this window you can create and modify 
ARP options for units in your intercom system.

NOTE: You can also get to the ARP-32 
Assignment window by selecting 
System|ARP-32 Assignment from the 
menu bar.

For more information, see “ARP-32 Window” on 
page 177.

GPIO-16 Version Icon

The GPIO-16 Version icon opens the GPIO-16 
Version Information window. From this window you 
can view GPIO-16 version information and upgrade 
the 
GPIO-16 firmware.

NOTE: You can also get to the GPIO-16 Version 
Information window by selecting 
Status|Software Versions|GPIO-16 from 
the menu bar.

For more information, see “GPIO-16 Version 
Information Window” on page 280.

Lstn Src Icon

The Lstn Src icon opens the Program Listen Source 
window. From this window you can configure program 
listen source options for IFBs in your intercom system.

NOTE: You can also get to the Program Listen 
Source window by selecting 
System|PGM Listen Source from the 
menu bar.

For more information, see “Program Listen Source 
Window” on page 152.
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Alpha Icon

The Alpha icon opens the Keypanel/Port Alphas 
window (see, “Port Alphas Window” on page 222). 
From this window you can modify keypanel/port 
descriptions, input alphas, output alphas, and aliases. 

Use the drop down arrow to display a list of options to 
choose to view. These include:

• Party Line

• IFB

• IFB Special List

• Special List

• GPI Output

• ISO

• UPL Resource

• Assignment Groups

• Auto Dials

• GPI Input

• DIM Tables

• I/O Cards

• PAP and LCP-102

For more information, see “Alpha Windows” on 
page 227.

TM Links Icon

The TM Links icon opens the Ethernet Links Status: 
Trunk Master window. From this window, you can 
check the status of your trunk master links between 
frames. 

NOTE: You can also get to the Ethernet Links 
Status: Trunk Master window by 
selecting Status|Ethernet Links|Trunk 
Master Links from the menu bar.

Frame Links Icon

The Frame Links icon opens the Frame-to-Frame 
Status window. From this window you can check the 
status of Tribus links within your system.

NOTE: You can also get to the Ethernet Links 
Status: Trunk Master window by 
selecting Status|Ethernet Links|Frame-
To-Frame Links from the menu bar.

Alarms Icon

The Alarms icon opens the Intercom Alarm window. 
From this window, you can view a list of alarms raised 
by different events in the Intercom system.

NOTE: You can also get to the Intercom Alarm 
window by selecting Status|Alarms 
from the menu bar.

MADI Cards Icon

The MADI Cards icon opens the MADI Card 
Window. There are three (3) pages in this window—
MADI Card Configuration, MADI Channel Mapping, 
and MADI Card Status.

NOTE: You can also get to the MADI Card 
window by selecting 
System|Miscellaneous|MADI 
Configuration from the menu bar.

Keypanel Colors Icon

The Keypanel Colors icon opens the Keypanel Colors 
window. From this window, you can color code 
assignment types, function types, group and talk/listen 
indications.

NOTE: You can also get to the Keypanel Colors 
window by selecting 
System|Miscellanous|Keypanel Colors 
from the menu bar.
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Frequently Used Toolbar Operations

Below are many of the most frequently used toolbar operations in AZedit.

Show/Hide the Status Bar

To show/hide the status bar, do the following:

 > From the View menu, select Status Bar
OR

Click the status icon. 
The Status Bar appears (or disappears) at the bottom of the AZedit application window.

Show/Hide the Toolbars

NOTE: These instructions can be applied to either the Standard Toolbar(2) or the Navigation Toolbar(2).

To show the toolbar, do the following:

 > From the View menu, select Navigation/Standard Toolbar or Navigation/Standard Toolbar 2.
A check mark appears next to your selection and the toolbar appears.

To hide the toolbar, do the following:

 > From the View menu, select Navigation/Standard Toolbar or Navigation/Standard Toolbar 2.
The check mark is removed from next to your selection and the toolbar disappears.

NOTE: When the Toolbars are not docked to the application window, you can hide them by clicking the X in the 
upper right corner of the toolbar.

Dock and Undock the Toolbars

Often you may need to create space on the application desktop but do not want to lose the usefulness of the toolbars. AZedit 
gives you the freedom to have docked or floating (undocked) toolbars. The floating toolbars can be moved inside or outside 
the application desktop, giving you more space to work.

You can dock toolbars on the top, bottom, or sides of the application window.

NOTE: These instructions can be applied to either the Standard Toolbar(2) or the Navigation Toolbar(2).
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To undock a toolbar, do the following:

 > On the far left side of a toolbar, click and drag the toolbar away from its docked position.
The toolbar becomes detached from the application desktop.

NOTE: You can also undock the toolbar by double-clicking the upper-right side of the toolbar. The toolbar returns to 
its last floating position.

To dock a toolbar, do the following:

 > On the toolbar, click the blue banner and drag it to the desired docking position on the application desktop.
The toolbar docks itself to the specified position.

NOTE: You can also dock the toolbar by double-clicking the upper-right side of the toolbar.
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Customize a Toolbar

Customize the Standard, Standard2, Navigation, Navigation2 toolbar to arrange your most used icons.

To customize a toolbar, do the following:

1. From the View menu, select Customize Toolbars.
The Customize Toolbars flyout menu appears.

2. From the flyout menu, select Standard, Standard 2, Navigation, or Navigation 2, depending on the toolbar you 
want to customize.
The Customize Toolbar screen appears.

3. From the Available toolbar buttons list, select an icon you want to put on the toolbar.

NOTE: You can move only one (1) icon at a time when customizing a toolbar.

4. Click Add.
The icon moves to the Current toolbar buttons list. 

NOTE: To remove an icon from an existing toolbar, select the icon in the Current toolbar buttons list, and then click 
Remove.

5. Once you are finished moving the desired buttons to the current toolbar list, use the Move Up and Move Down 
buttons to select the toolbar position for your icons.
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6. From the Text Options drop down menu, select Show Text Labels, Selective Text Right, or No Text Labels.

7. From the Icon Options drop down menu, select Small Icons or Large Icons.

8. When you are finished, click Close.
The toolbar automatically reflects the modifications.

Show Text Labels

Selective Text Right

No Text Labels

Large Icons Small Icons
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Frequently Used Column Features

Resize List Columns

Occasionally, the columns in AZedit are too narrow to display all their information at one (1) time. When this happens, you 
can resize any column to any width you like.

To resize a column, do the following:

1. Open a window with a column view.

2. Place your cursor over a column marker, left-click and hold (see below).

3. Drag your cursor to the desired column width.

NOTE: You can automatically resize columns to display all the information by double-clicking the resize spot.

Resize 
Arrow
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Hide and Display List columns

On many screens with column views, you have the ability to hide columns. This is useful because it allows you to hide 
columns you rarely use or do not want other users to see.

To hide columns, do the following:

1. Open the window (with column views) in which you want to hide a column.

2. Right-click the column header, and then select Hide.
The column closes.

NOTE: You can hide only one (1) column at a time.

3. Repeat step 2 for any other columns you want to hide.
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To display hidden columns, do the following:

1. Right-click the column header, and then select Show Column.
The Show Column popup menu displays.

2. From the Show Column menu, select the column you want to show. 
OR
Select All to show all the hidden columns.

Rearrange Columns

AZedit allows for many of its columns throughout the application to be rearranged. This means you can group columns 
together to better suit the information you want to view.

To rearrange columns, do the following:

1. In AZedit, open a window with columns.

2. Click and drag the column header to the position you desire.

3. Repeat step 2 until you have rearranged your columns to your satisfaction.
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CHAPTER 3

System Configuration Windows

Ethernet Setup

The Ethernet Setup window, shown in Figure 159, is used to configure an Ethernet connection between the matrix and 
AZedit.

NOTE: You must be connected to the intercom using a serial or USB connection to configure Ethernet for the intercom 
system.

NAVIGATION: From the menu bar, select Options|Ethernet Setup.

FIGURE 159. Ethernet Setup Window
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Left Controller (Active) Group Box

The Left Controller (Active) group box displays the configuration options for the active master controller. The active master 
controller is the backbone for controlling communication across the intercom system. 

NOTE: When a failover occurs, the standby master controller becomes the active master controller. For example, if the 
Left Controller (Active) fails, the Right Controller (Standby) becomes the active controller. This means the 
Active controller is now in the Right slot (physically) in the intercom system.

IP Address Field

The IP Address field identifies the IP Address of the active master controller.

Network Mask Field

The Network Mask field defines the size (the number of IP Addresses available) of a given network. A network mask 
determines which computers can be accessed locally without using a gateway, and which computers can only be reached 
through a gateway.

Default Gateway Field

The Default Gateway field identifies the default gateway address of the active master controller. A default gateway is a node 
on a computer network that serves as an access point to another network. The gateway address is usually the IP Address of the 
router used to grant other computers access to a network.

MAC Address Field

The MAC Address field identifies the MAC (Media Access Card) address of the active master controller. A MAC Address is 
a unique code (address) assigned to most forms of networking hardware. This address is permanently assigned to the 
hardware.

This field cannot be modified.

Right Controller (Standby) Group Box

The Right Controller (Standby) group box displays the configuration options for the standby master controller. The right 
controller acts as a backup for the active master controller. This means if the active master controller fails, the right controller 
takes over the Active Controller spot.

NOTE: When a failover occurs, the standby master controller becomes the active master controller. For example, if the 
Left Controller (Active) fails, the Right Controller (Standby) becomes the active controller. This means the 
Active controller is now in the Right slot (physically) in the intercom system.

IP Address Field

The IP Address field identifies the IP Address of the standby master controller.

Network Mask Field

The Network Mask field defines the size (the number of IP Addresses available) of a given network. A network mask 
determines which computers can be accessed locally without using a gateway, and which computers can only be reached 
through a gateway.
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Default Gateway Field

The Default Gateway field identifies the default gateway address of the standby master controller. A default gateway is a 
node on a computer network that serves as an access point to another network. The gateway address is usually the IP Address 
of the router used to grant other computers access to a network.

MAC Address Field

The MAC Address field identifies the MAC Address of the standby master controller. A MAC Address is a unique code 
(address) assigned to most forms of networking hardware. The address is permanently assigned to the hardware.

This field is cannot be modified.

Apply Button

The Apply button applies the modifications to the Ethernet settings without closing the window.

Close Button

The Close button closes the window without saving the modifications made.

To configure Ethernet in AZedit, do the following:

1. Verify the PC running AZedit is connected to the intercom system by either a serial connection or a USB connec-
tion.

2. In AZedit, from the Options menu, select Ethernet Setup.
The Ethernet Setup window appears.

In the Left Controller (Active) Group Box

3. In the IP Address field, enter the IP Address of the active master controller.

4. In the Network Mask field, enter the network mask address of the active master controller.
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5. In the Gateway Address field, enter the gateway address of the active master controller.

In the Right Controller (Standby) Group Box

6. In the IP Address field, enter the IP Address of the standby master controller.

7. In the Network Mask field, enter the network mask address of the standby master controller.

8. In the Gateway Address field, enter the gateway address of the standby master controller.

9. Click Apply.
Ethernet is configured in AZedit.

Communications

The Communications window, shown in Figure 160, is used to select and configure the type of connection AZedit uses to 
communicate with the intercom system.

NAVIGATION: Select Options|Communications.

To access the Communications window, do the following:

 > From the Options menu, select Communications.
The Communications window appears.

Connection Radio Buttons

The Connection radio buttons identify the type of connection AZedit uses to communicate with the intercom system. The 
following connection types are available:

Serial - when selected, a serial connection is used to connect AZedit to the intercom system.

USB - when selected, a USB connection is used to connect AZedit to the intercom system.

Network - when selected, an Ethernet connection is used to connect AZedit to the intercom system.

FIGURE 160. Communications Window
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COM Port Drop Down Menu

The COM Port drop down menu identifies the COM port (of the PC running AZedit) to use for a serial connection. 

By default, the following selections are available in the drop down menu:

COM 1

COM 2

COM 3

COM 4

NOTE: By default, COM 1– 4 are listed in the drop down menu, however you can also manually enter the COM port 
number into this field, if desired.

Baud Rate Drop Down Menu

The Baud Rate drop down menu identifies the baud rate the serial connection uses to send and receive audio and data.

Available selections are:

9600bps

19.2kbps

38.4kbps

IP Address Group Box

Main Field

The Main field identifies the IP Address given to the Active Master Controller. There are two IP Addresses AZedit can use to 
contact the intercom system–the Main and Partner. If AZedit gets no response from one (1) of the IP Addresses, then it 
switches to the other IP Address.

Browse Button

The Browse button  opens the Available Intercoms window. From this window you can select the intercom to which you 
want to connect with AZedit. For more information on the Available Intercoms window, see “Available Intercoms” on 
page 46.

Partner Field

The Partner field identifies the IP Address given to the Standby Master Controller. When connected to the network with 
Ethernet an intercom system has two (2) Master Controllers (the Active and Standby). The Standby Master Controller acts as 
the Active Master Controller's backup in failover protection.

Advanced Button

The Advanced button opens the secondary AZedit sessions communications configuration window (see “Secondary AZedit 
Sessions” on page 48). From this window you can configure the COM port and baud rate for additional, serially connected 
AZedit sessions on the J9 and J10 connectors of the intercom system. This is available with ADAM systems only.



46  System Configuration Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

OK Button

The OK button applies the modifications made and closes the window.

Cancel Button

The Cancel button does not apply the modifications and closes the window.

Available Intercoms

The Available Intercoms window, shown in Figure 161, displays a list of available intercom systems AZedit can connect to.

NAVIGATION: Select Options|Communications and press the browse button.

Intercoms Group Box

The Intercoms group box displays a selectable list of intercoms (active and standby) in the system.

NOTE: When you have a Standby Master Controller installed, a black and white intercom icon appears in this window.

Selected Intercom Group Box

The Selected Intercom group box displays information detailing the intercom selected from the Intercoms group box.

FIGURE 161. Available Intercoms Window
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Name Field

The Name field displays the name of the selected intercom. 

This field cannot be modified, unless the intercom is connected to a TM-2000 Trunk Master system via TrunkEdit.

Type Field

The Type field displays the type of master controller used in the selected intercom. 

This field cannot be modified.

Status Field

The Status field displays the status of the master controller used in the selected intercom. 

This field cannot be modified.

IP Address Field

The IP Address field displays the active master controller IP Address of the selected intercom system. 

This field cannot be modified

IP Partner Field

The IP Partner field displays the standby master controller IP Address of the selected intercom system, if used. The standby 
master controller serves as a backup to the active master controller in case of a failure. 

This field cannot be modified

Connections Field

The Connections field displays the number of connections currently available on the intercom system. 

This field cannot be modified

Descriptions Field

The Description field displays the description created for the selected intercom. 

This field cannot be modified

OK Button

The OK button applies the selection made and closes the window.

Cancel Button

The Cancel button does not apply the selection and closes the window.
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Secondary AZedit Sessions

The Secondary AZedit Sessions, shown in Figure 162, is used to configure up to three (3) additional AZedit sessions 
connected to the same intercom system, but run on separate computers. Multiple sessions are not supported for ADAM CS. 

You must configure the advanced communications settings on the computer running the primary AZedit session which is 
connected to J1 of the XCP-ADAM-MC Master Controller Breakout Panel to use this feature. Second and third computers can 
then be connected to J9 and J10 of the Master Controller Breakout Panel.

NOTE: From the menu bar, select Options|Communications and then press Advanced.

Connection Group Box

The Connection group box displays Port J9 and Port J10 which are used to connect multiple AZedit sessions on different 
computers to one (1) intercom system. 

Baud Rate Group Box

Baud Rate Drop Down Menu

The Baud Rate drop down menu indicates the baud rate at which the multiple sessions are connecting to the intercom system.

Available selections are: 9600bps, 19.2kbps, and 38.4kbps.

Protocols Enabled Group Box

AZedit Protocol Check Box

The AZedit Protocol check box indicates AZedit is being used for the multiple session.

Command Line Protocol Check Box

The Command Line Protocol check box indicates that command line protocol is being used for the multiple session.

FIGURE 162. Secondary AZedit Sessions Window
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Trunk Master Communications Window

The Trunk Master Communications window, shown in Figure 163, is used to configure how the intercom connects to the 
Trunk Master. 

Available options are: Serial, Disabled, and Network.

Connection Group Box

The Connection Group Box contains radio buttons that identify the type of connection from the intercom to the trunk master.

 The following connection types are available:

Serial - when selected, a serial connection is used to connect AZedit to the intercom system.

USB - when selected, a USB connection is used to connect AZedit to the intercom system.

Network - when selected, an Ethernet connection is used to connect AZedit to the intercom system.

Port Group Box

Port Drop Down Menu

The Port drop down menu is used to select the port that communication is transmitted over. 

FIGURE 163. Trunk Master Communications Window
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Baud Rate Group Box

Baud Rate Drop Down Menu

The Baud Rate drop down menu indicates the baud rate at which the multiple sessions are connecting to the intercom system.

Available selections are:

9600bps

19.2kbps

38.4kbps

IP Address Group Box

Main Field

The Main field identifies the IP Address given to the Active Trunk Master. There are two (2) IP Addresses AZedit can use to 
contact the Trunk Master – the Main and Partner. If AZedit gets no response from one of the IP Addresses, then it switches to 
the other IP Address.

Browse Button

The Browse button  opens the Available Trunk Masters window. From this window you can select the trunk master to 
which you want to connect with AZedit. For more information, see “Available Trunk Masters Window” on page 51.

Partner Field

The Partner field identifies the IP Address given to the Standby Trunk Master. When connected to the network with Ethernet 
an intercom system has two (2) Trunk Masters (the Active and Standby). The Standby Trunk Master acts as the Active Trunk 
Master's backup in failover protection.

Autonomous Frames Connect As Distinct Intercoms Check Box

The Autonomous Frames Connect As Distinct Intercoms check box is used to specify whether frames operating 
autonomously should attempt to connect by proxy (i.e., in place of frame 1) or as distinct intercoms (i.e., in addition to other 
autonomous frames). 

This feature requires the following firmware:

• MCII-e v2.2.0 or later

• Cronus v1.6.0 or later

• Zeus III v1.1.0 or later

• DBX v1.23.0 w PCII-e v1.23.0

• TM-2000 v8.9.0 (for Ethernet connections)

OK Button

The OK button applies the modifications made and closes the window.

Cancel Button

The Cancel button does not apply the modifications made and closes the window.
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Available Trunk Masters Window

The Available Trunk Masters window, shown in Figure 164, is used to view the Trunk Master systems that are available on 
the IP network.

Trunk Masters Group Box

The Trunk Masters group box displays the available trunk masters available to connect to. The active and standby trunk 
masters are labeled in parentheses.

Selected Trunk Master Group Box

Name Field

The Name field displays the name of the selected trunk master.

Type Field

The Type field displays the type of trunk master selected.

Status Field

The Status field displays the status of the selected trunk master.

Available options for this field are Active and Standby.

FIGURE 164. Available Trunk Masters
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IP Address

The IP Address field displays the IP Address of the selected trunk master.

IP Partner Field

The IP Partner field displays the IP Address of the backup trunk master. 

Connections Field

The Connections field displays the number of connections available to the trunk master.

Description

The Description field displays a unique description of the selected trunk master.

Intercom Configuration Window

The Intercom Configuration window is used to configure AZedit to match the intercom system to which it is connected.

IMPORTANT: This causes a First Birthday on the Intercom System. A first birthday completely erases all data and 
resets the application to the factory defaults.

This window contains two (2) pages: 

Resources - the quantities of intercom ports, party lines, etc. available. 

Options - the quantities for such things as the number of talk levels for each talk key or the number of setup pages for 
each keypanel. Some options slightly modify the operation of the intercom system.

NAVIGATION: Select Options|Intercom Configuration and then press Intercom Sizing Wizard.

Also available, is the Intercom Sizing Wizard. The Intercom Sizing Wizard, when used in online mode, polls the intercom 
system for its available resources and then displays the results in the resource page fields.

NOTE: You can use the Intercom Sizing Wizard in File mode to run test intercom system configurations. This is helpful 
when you are planning to implement a new system or upgrade an existing system. 
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Resources Page

The Resources page, shown in Figure 165, is used to define the resources available in intercom system such as the number of 
frames, the number of ports available, assignment type allocations, and intercom system setup.

NAVIGATION: Select Options|Intercom Configuration and then select Resources.

Frames Field

The Frames field identifies the number of frames in the intercom system. You must use the Intercom Sizing Wizard to make 
changes to this field.

Ports Field

The Ports field identifies the number of ports in the intercom system. When multiple frames are used, this field displays the 
total number of ports available across every connected frame. You must use the Intercom Sizing Wizard to make changes to 
this field.

Intercom Sizing Wizard Button

The Intercom Sizing Wizard button opens the Intercom Sizing Wizard. The Intercom Sizing Wizard guides you through a 
series of questions related to your intercom system to determine the resources available.

FIGURE 165. Intercom Configuration Window - Resources Page
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Assignment Type Resources Group Box

NOTE: Some resources listed in this section do not appear in all intercom systems. The resources seen is dependent upon 
intercom system resource availability.

Party Lines Field

The Party Lines field identifies the number of party lines allowed in your intercom system. This field may be set to any 
amount, within memory limits, or may be reduced to zero (0) if no party lines are used. If party lines are reduced to 0, all party 
line (PL) features become inactive and do not appear in scroll lists.

The range for this field is 0 to 999.

For more information, see “Party Lines Window” on page 131.

IFBs Field

The IFBs field identifies the number of IFB assignments allowed in your intercom system. This field may be set to any 
amount, within memory limits, or may be reduced to zero (0) if no IFBs are used. If IFBs are reduced to 0, all IFB features 
become inactive and do not appear in scroll lists. Also, Program Assign Panels are not able to operate.

The range for this field is 0 to 999.

For more information, see “IFBs Window” on page 139.

IFB Special Lists Field

The IFB Special Lists field identifies the number of IFBSL assignments allowed in your intercom system. This field may be 
set to any amount, within memory limits, or may be reduced to zero (0) if no IFBs are used. If IFBs are reduced to 0, all IFB 
SL features become inactive and do not appear in scroll lists.

The range for this field is 0 to 999.

For more information, see “IFB Special Lists Window” on page 149.

Special Lists Field

The Special Lists field identifies the number of Special List assignments allowed in your intercom system. This field may be 
set to any amount, within memory limits, or may be reduced to zero (0) if no special lists are used. If special lists are reduced 
to 0, all special list (SL) features become inactive and do not appear in scroll lists.

The range for this field is 0 to 999.

For more information, see “Special Lists Window” on page 135.
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GPI Outputs Field

The GPI Outputs field identifies the number of GPI Outputs allowed in your intercom system. All ADAM, ADAM CS, and 
Zeus frames include eight (8) GPI inputs and eight (8) GPI outputs. (In a multi-frame ADAM system, only the GPI inputs and 
outputs of the first frame, called the master frame, are used.) 

Additional GPI inputs and outputs are supplied by optional UIO-256 Universal Input/Output frames. If you do not have any 
UIO-256 frames, you can reduce GPI inputs and outputs to eight (8). If you do not plan on using the GPI at all, you can reduce 
the quantity to zero (0). If GPI inputs or outputs are reduced to zero (0), all GPI features become inactive and do not appear in 
scroll lists.

The value range for this field is 1 to 8 to the local frame. With additional accessories, up to 256 inputs may be possible.

For more information, see “GPI Output Window” on page 154.

ISOs Field

The ISOs field identifies the number of ISOs allowed in your intercom system. This field may be set to any amount, within 
memory limits, or may be reduced to zero (0) if no ISOs are used. If ISOs are reduced to zero (0), all ISO features become 
inactive and do not appear in scroll lists.

The range for this field is 0 to 999.

For more information, see “ISO Window” on page 161.

Assignment Groups Field

The Assignment Groups field identifies the number of AGRP (Assignment Groups) allowed in your intercom system. This 
field may be set to any amount, within memory limits, or may be reduced to zero (0) if no AGRPs are used. If AGRPs are 
reduced to zero (0), all AGRP features become inactive and do not appear in scroll lists.

The range for this field is 0 to 999.

For more information, see “Assignment Group Window” on page 168.

UPL Resources Field

The UPL Resources field identifies the number of UPL Resources allowed in your intercom system. This field may be set to 
any amount, within memory limits, or may be reduced to zero (0) if no UPL resources are used. If UPL Resources is set to zero 
(0), all UPL resource features become inactive and do not appear in scroll lists.

The range for this field is 0 to 999.

For more information, see “UPL Resources Window” on page 194.

UPL Statements Field

The UPL Statements field identifies the number of UPL Statements allowed in your intercom system. This field may be set to 
any amount within memory limits, or may be reduced to zero (0) if no UPL statements are used. If UPL statements are reduced 
to zero (0), UPL features become inactive.

The range for this field is 0 to 2000.

For more information, see “UPL Statements Window” on page 198.
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Auto Dials

The Auto Dials field identifies the number or auto dial entries allowed in your intercom system. 

The range for this field is 0 to 999.

For more information, see “Auto Dials Window” on page 189.

GPI Inputs Field

The GPI Inputs field identifies the number of GPI Inputs allowed in your intercom system. 

The range for this field is 1 to 8 local to the frame. With additional accessories, up to 256 inputs may be possible.

For more information, see “GPI Input Window” on page 158.

Inter-panel Dims Field

The Inter-Panel Dims field identifies the number of inter-panel dims allowed in your intercom system. This field may be set 
to any amount, within memory limits, or may be reduced to zero (0) if no inter-panel dim tables are used. If inter-panel dims 
are reduced to zero (0), references to this feature become inactive.

The range for this field is 0 to 999.

For more information, see “Inter-Panel Dim Table Window” on page 192.

PAP / LCP-102 Field

The PAP/LCP-102 field identifies the number of PAP/LCP-102 devices allowed in your intercom system. 

The maximum number of devices is 15 (PAPs and LCPs combined).

• For more information, see “PAP-32 Window” on page 174.

• For more information, see “Edit PAP/LCP Description Window” on page 236.

Intercom Setup Group Box

The Intercom Setup group box displays the type of intercom system to which AZedit is connected and whether redundant 
audio, test audio, or high density audio is enabled.

Intercom System Field

The Intercom System field indicates the type of intercom system AZedit is connected to. This field also displays whether 
DBX (Dual Bus Expander) or TBX (Tribus Card) is being used. DBX and TBX are used to connect and pass audio between 
two (2) ADAM intercom frames. Redundancy between frames can be achieved through the use of DBX cards.
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Redundant Audio Check Box

The Redundant Audio check box indicates redundant audio is being used. Redundant audio (also known as fail-over 
protection) means it is possible to disable any one (1) DBX coaxial link without losing any audio between frames. 

In order for redundant audio to exist, there must be two (2) coaxial links between every pair of frames. For example, in a three 
(3) frame system two (2) links between frames 1 and 2, two (2) links between frames 2 and 3, and two (2) links between 
frames 1 and 3 (or six [6] links in total) must exist. A non-redundant three (3) frame system needs only one (1) link between 
each pair of frames, (1-2, 2-3, and 1-3, or three links in total). When there are two (2) links between a pair of frames, only one 
(1) link is required to pass audio (although both carry the audio between frames, the audio is only used from one [1] link). So, 
if one (1) link is cut, the other link can immediately be used to provide the same audio.

Test Audio Check Box

The Test Audio check box indicates test audio is enabled and being passed between frames. DBX cards use test audio to 
constantly monitor the audio being passed between frames. If an audio problem persists, the DBX cards try to correct it. 
Without test audio, the links between frames can be operational, but it is possible that no audio is being passed over the links. 

High Density Check Box

The High Density check box indicates the number of ports available for use within a multi-frame system. For example, a 
standard frame has 128 ports available for use; however, when high density is selected, the number of ports available becomes 
256 including the DBX cards. (272 ports without DBX cards). As the number of frames increases, the number of ports 
available on each frame decreases to accommodate the number of DBX cards used to connect the frames.



58  System Configuration Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Options Page

The Options Page, shown in Figure 166, is used to view and/or modify system options, such as talk levels, setup pages per 
port, panels with key labels, etc.

In online or server mode, this window shows you the Options settings in the master controller. 

If you start AZedit in file mode (without opening a setup file) this screen shows you the AZedit Option 
settings.

If you open a setup file in file mode, this screen shows you the Option settings for that setup file.

NOTE: We recommend you have a thorough understanding of the intercom configuration before modifying options on 
this page.

NAVIGATION: Select Options|Intercom Configuration and then select Options.

Talk Levels Field

The Talk Levels field indicates the number of Talk Levels available in the system. By default this field is set to 2; however, 
you can change this number to accommodate your particular intercom system. 

This field value can range from 2 to 4.

FIGURE 166. Intercom Configuration Window - Options Page
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Listen Levels Field

The Listen Levels field indicates the number of Listen Levels available in the system. Currently, one (1) listen level is 
supported.

This field cannot be modified

Panels with Key Labels Field

The Panels with Key Labels field indicates the number keypanels allowed to have key labels in the system. By default, this 
value is set to zero (0).

This field value can range from 0 to 272.

Key Labels Per Panel Field

The Key Labels Per Panel field indicates the number of key labels allowed per key panel in the system. 

This field value can range from 0 to 64.
By default, this value is set to zero (0).

Setup Pages Per Port Field

The Setup Pages Per Port field indicates the number of talk/listen key pairs allowed per port. 

This field value can range from 4 to 15.

Physical Panels Per Port Field

The Physical Panels Per Port field indicates the number of keypanels and expansion panels are allowed in the system. 
Currently, only one (1) keypanel and three (3) expansion panels are supported. 

This field cannot be modified.

Keys Per Setup Page Field

The Keys Per Setup Page field indicates the numbers of keys allowed per setup page. Currently, 16 talk/listen key pairs are 
allowed per setup page. 

This field cannot be modified.

Maximum IFB Priority Field

The Maximum IFB Priority field indicates the highest priority allowed to be assigned to an IFB in the system. IFB priorities 
determine which keypanel gets first access to an IFB in cases where two (2) or more keypanels are trying to access the IFB at 
the same time. By default, the IFB priority for each intercom port can be individually set to any number from 0 through 3. With 
the priority set to 3, the keypanel overrides any other keypanel set to a lower priority. Keypanels that are set to the same 
priority can simultaneously access IFBs.

This field value can range from 1 to 8.

Use Input Alphas Check Box

The Use Input Alphas check box indicates that input alphas are enabled for the system.
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Auto Listen Functions Pick Up All Talk Levels Check Box

The Auto Listen Function Pick Up All Talk Levels check box indicates the keypanel operator can automatically talk and 
listen to all talk levels when the talk key is activated. The listen-level adjustment only adjusts a single listen crosspoint level. 
This feature is only available when auto-listen is assigned to a key and the key also has several assigned talk levels.

NOTE: The listen-level adjustment only adjusts a single listen crosspoint level.

Allow For Remote Trunk Master Check Box

The Allow for Remote Trunk Master check box indicates your intercom system is connected to a remote trunk master via a 
modem. In this case, there may be some data transmission delay, so the time-out period extends to compensate. In addition, the 
normal baud rate for direct connection to the trunk master (38.4 kbaud) changes to 9600 baud for the modem connection. 

NOTE: This overrides the setting of Dip switch 4 on the master controller in an ADAM or ADAM CS frame.

Don’t Generate Tallies For In-Use Trunk Assignments Check Box

The Don't Generate Tallies for In-Use Trunk Assignments check box indicates you do not want to generate tallies for 
in-use trunk assignments.

Don’t Generate Tallies For Off-Hook TIF Assignments Check Box

The Don't Generate Tallies for Off-Hook TIF Assignments check box indicates you do not want to generate tallies for 
off-hook TIF assignments.

Don’t Generate Indefinite PL Tallies Check Box

The Don't Generate Indefinite PL Tallies check box indicates you do not want to generate tallies for indefinite PLs.

Always Stack Callers in Call Waiting Window Check Box

The Always Stack Callers in Call Waiting Window check box indicates callers are stacked in the call waiting window.

Configure Onboard GPI Outputs in FR9528 Mode Check Box

The Configure Onboard GPI Outputs in FR9528 Mode check box indicates you are using a FR9528 Relay Frame. Remove 
the check mark if you are using the GPI connector on your ADAM or ADAM CS frame, instead of FR9528.

Generate Snoop Tallies Check Box

The Generate Snoop Tallies check box indicates you want to generate snoop tallies. Snoop tallies provide an indication to 
keypanel users that somebody is listening to them.

NOTE: The keypanel must be working in HOT MIC (USM) mode to use Snoop Tallies. This is available only on KP-32 
keypanels.

Force Autonomous Mode When No Audio Links Up Check Box

The Force Autonomous Mode When No Audio Links Up check box is used to force the current frame into autonomous 
(independent) mode, if none of its Tribus audio links are active. If selected, the frame refuses to communicate with any other 
frames if none of its Tribus links are up, even if Ethernet communications are fine. And, once one (1) or more of its audio links 
are restored, the frame automatically tries to re-establish messaging links to the other frames in the cluster.
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Intercom Sizing Wizard

In AZedit version 2.08.00 or higher, an Intercom Sizing Wizard is provided to help users setup their intercom systems 
quickly and easily. The primary function of this wizard allows users to configure their intercom systems without worrying 
about incorrect configuration options. The wizard walks you through each step to set up your intercom system, asking a series 
of specific questions, resulting in an easy and efficient setup procedure.

IMPORTANT: This causes a First Birthday on the Intercom System. A first birthday completely erases all data and 
resets the application to the factory defaults.

NOTE: You can use this wizard in online mode or file mode. If you plan on using the Intercom Sizing Wizard in online 
mode, you must remember to select the Allow Intercom Resizing in Online Mode checkbox.

How to Use the Intercom Sizing Wizard

To allow intercom resizing in online mode, do the following:

1. From the Option menu in AZedit, select Preferences.
The Application Preferences window appears.

2. Click the Advanced page.
The Advanced window appears.

3. Select the Allow intercom resizing in ONLINE mode checkbox.

NOTE: You must use the Intercom Sizing Wizard if you are changing the number of frames, the number of ports, or the 
Intercom Setup options in your system.
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To access the Intercom Sizing Wizard, do the following:

1. From the Options menu, select Intercom Configuration.
A warning message reading, “WARNING! You are about to reconfigure the intercom! The existing intercom setup is 
ERASED and intercom system will be reset” appears.

2. Click OK.
The Intercom Configuration screen appears.
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3. Click Intercom Sizing Wizard.
The Intercom Sizing Wizard begins.

NOTE:   

In online mode, the wizard automatically determines your intercom system size, and then walks you 
through to get information that is more specific for configuring your system.

In file mode, you must pick your intercom system, and then the wizard walks you through the different 
options to determine the intercom system setup.
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CHAPTER 4

Other Configuration Windows

MADI Configuration Window

NOTE: If you do not see all the columns, you may need to verify no columns are hidden. For more information, see 
“Show or Hide List columns” on page 399.

FIGURE 167. MADI Card Configuration Page
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MADI Card Configuration Page

Slot Display Column

The Slot display column shows the location of the card in relation to the frame the card resides and its position in the frame. 
For example, 2:017 indicates the card is in frame two (2) and slot 17 in the frame.

Description Display Column

The Description display column shows the unique description of the card. This description can be created or modified in the 
I/O Status Description window.

To create or modify the description, do the following:

1. From the Alpha menu in Azedit, select I/O Card.
The I/O Card Descriptions window appears.

2. Double-click the slot entry where the card resides.
The Edit Alpha/Description window appears.

3. In the Description field, enter a description for the card.

4. Press Done.
The Edit Alpha/Description window closes.

Ports Display Column (1)

The Ports display column shows the ports assigned to the card.

Ports Display Column (2)

The Ports display shows the ports assigned to the card.

Ports Display Column (3)

The Ports display shows the ports assigned to the card, if applicable.

Ports Display Column (4)

The Ports display shows the ports assigned to the card, if applicable.
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Reference Clock Drop Down Column

The Reference Clock drop down column is used to select the type of clock the MADI card uses to synchronize its 
transmissions.

Available options for this field are:

Internal - The MADI card generate its own clock which is used to synchronize transmissions.

MADI Stream - The clock is retrieved from the MADI stream.

NTSC/PAL - The clock is sent from the NTSC (National Television System Committee)/PAL (Phase Altering 
Line) connection.

Word - The clock from a word clock driver is used to synchronize the MADI transmission.

Sample Rate Drop Down Column

The Sample Rate drop down column is used to select the speed the MADI card references for transmission.

IMPORTANT:

When Word Clock is selected as the type of clock, the sample rate must match the word clock driver.

When Internal or NTSC/PAL is selected as the type of clock, the sample rate must match that of the 
device.

Available options for this field are: 44.1KHz and 48KHz.

# of Channels Drop Down Column

The # of Channels drop down column is used to select the number of channels on the MADI card. The MADI card can have 
up to 64 channels assigned to each card.

Available options for this field are: 56 and 64.

Link Mode Drop Down Column

The Link Mode drop down column is used to select the connector you want to use.

Available options for this field are:

Fiber A - The signal is sent over the Fiber A connection.

Fiber B - The signal is sent over the Fiber B connection.

Fiber A+B - The signal is sent over the Fiber A connection, however, if Fiber A fails or is damaged, the Fiber B 
connection takes over sending the MADI stream.

Coax - The signal is sent over the coaxial connection.
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Baud Rate Drop Down Column

The Baud Rate drop down column is used to select the baud rate used to send the MADI stream.

Available options for this field are:

None

9600bps

19.2Kbps

38.4Kbps

Show MADI Cards Only Check Box

The Show MADI Cards Only check box indicates only MADI cards are displayed in the window.

MADI Channel Mapping Window

The MADI Channel Mapping window, shown in Figure 168, is used to map the available MADI channels to available 
intercom ports in the system.

FIGURE 168. MADI Channel Mapping Window
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Card Slot Group Box

Card Slot Drop Down List

The Card Slot drop down list is used to select the card you want to view.

Show MADI Cards Only Check Box

The Show MADI Cards Only check box indicates to only show MADI cards in the Card Slot drop down list.

By default, all cards in the system are shown.

Entry Display Column

The Entry display column displays the number of audio channels you have available to use for the selected MADI card.

Port Display Column

The Port display column shows the port number associated with the entry.

Alpha Display Column

The Alpha display column shows the alpha of the selected port. Alphas can be 4-, 6-, or 8-character names depending on the 
configuration. For more information, see “Preferred Alpha Size Drop Down Menu” on page 97.

MADI Channel Drop Down Column

The MADI Channel drop down column is used to select the MADI channel associated with the intercom port. You can have 
up to 64 channels to choose from.

Available selections for this field are:

— (dash) No Channels are assigned

Channels 1–64

Muted? Check Box Column

The Muted? check box column is used to turn the transmit and receive channel audio off. By default, Muted? is not selected.

Show Unavailable Channels Check Box

The Show Unavailable Channels check box is used to display all channels in the system whether they are available for 
assignment or not.

By default, only available channels are shown.
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MADI Card Status Window

Slot Display Column

The Slot display column shows the slot location of the card in the intercom system.

Description Display Column

The Description display column shows the description assigned to the slot.

Ports Display Column (1)

The Ports display column (1) shows the first eight (8) channels assigned to the slot.

Ports Display Column (2)

The Ports display column (2) shows the second eight (8) channels assigned to the slot.

Ports Display Column (3)

The Ports display column (3) shows the third eight (8) channels assigned to the slot.

FIGURE 169. MADI Card Status Window
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Ports Display Column (4)

The Ports display column (4) shows the fourth eight (8) channels assigned to the slot.

Type Display Column

The Type display column shows the type of card in the slot (i.e., MADI-16, AIO-16, etc).

Active Link Display Column

The Active Link display column shows the status of the active link (Fiber A, Fiber B, or Coax).

Backup Link Display Column

The Backup Link display column shows the status of the backup link, if configured. This column is blank if the card is not 
configured for redundant fiber and the link mode set to Fiber A+B.

NOTE: The backup link can never be Coax.

There are two (2) status messages possibilities: OK and Bad.

Status Display Column

The Status display column shows status of the MADI card in the slot.

There are four (4) status message possibilities:

OK

Wrong Back Card 

FPGA Boot Failure

PLL Unlocked

Pass-Through Display Column

The Pass-Through display column shows the type of pass-through connection being used.

Available selections for this field are: RS-232 and RS-485.

MADI to Serial Display Column

The MADI to Serial display column shows the number of bytes received on the MADI link and transmitted out on the serial 
connection.

Serial to MADI Display Column

The Serial to MADI display column shows the number of bytes received on the Serial connection and transmitted out on the 
MADI link.
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Port Allocation Table Window

The Port Allocation Table is used to support I/O cards with more than 16 ports. It allows you to select which card types 
occupy which intercom slots and which ports are allocated to each card. Ports can be allocated in groups of four (4). Each 
group contains 16 ports. Each MADI card can have no more than 64 ports per card.

NOTE: If you are running a single frame system, the single frame can hold up to 880 ports; if you are running a multi-
frame Tribus system, you are limited to 256 ports per frame.

IMPORTANT: Check power limitations of each frame before building large intercom systems.

Requirements:

The Port Allocation Table requires the following minimum firmware versions:

AZedit V4.0.0

MCII-e V2.3.0

DBX V1.24.0, w/PCII-e V1.24.0

NAVIGATION: Select Options|Port Allocation Table.

FIGURE 170. Port Allocation Table Window
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Slot Column

The Slot column displays the number of the slot where the card resides.

This field is not editable.

Type Column

The Type column is used to select the type of card in the slot. Use the drop down menu to select the type of card in the slot.

Available options are: AIO-8, AIO-16, RVON-8, RVON-16, MADI-16, MADI-32, MADI-48, MADI-64, and AES-3.

Allocated Column

The Allocated column is used to select the number of ports to allocate. Use the drop down menu to select the number of ports 
you want to allocate.

Available options are:

8 - Used to allocate 8 ports in a Base 8 system.

8+8 - Used to allocate 16 ports in a Base 8 system.

16 - Used to allocate 16 ports in a Base 16 system.

24 - Used to allocate 24 ports in a Base 16 system.

32 - Used to allocate 32 ports in a Base 16 system.

40 - Used to allocate 40 ports in a Base 16 system.

48 - Used to allocate 48 ports in a Base 16 system.

56 - Used to allocate 56 ports in a Base 16 system.

64 - Used to allocate 64 ports in a Base 16 system.

FIGURE 171. Type Column Options
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Ports Columns (4)

The Ports column is used to assign ports in either groups of eight (8) or 16 ports, depending on what is selected in the 
Allocated column. 

Up to four (4) groups of 16 ports are allowed. 

TIP: To assist in setup and configuration debug, assign consecutive port numbers for multi-group port columns.

NOTE: The Ports column only becomes active for the number of ports you are allocating. For example, if you have 32 
ports, only the first two (2) Ports columns are enabled.

FIGURE 172. Allocated Menu Options
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Warning Column

The Warning column displays a warning when configured card types do not match detected card types and when not all ports 
are allocated (for a given card, or for the intercom as a whole).

FIGURE 173. Ports Column Options
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Warning Field

The Warning field displays warnings pertaining to the intercom system as a whole.  

Apply Button

The Apply button is used to apply any modifications made to the port allocation table to the intercom system while the 
window remains open.

Test Button

The Test button is used to test the modifications you made to the port allocation table before you apply it to the intercom 
system. A message displays when the test is finished notifying you if the port allocation table is valid or not.

Cancel Button

The Cancel button is used to close the window without implementing any of the modifications made to the port allocation 
window.

FIGURE 174. Warning Field
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RVON Configuration Window

The RVON Configuration window, shown in Figure 175, is used to configure RVON devices in the intercom system. 

All five (5) RVON devices provide VoIP (Voice Over Internet Protocol) communications for the RTS family of intercoms. In 
general, voice over IP means sending voice information in digital form using discrete packets, rather than the traditional 
telephone network. All of the RVON devices deliver an integrated solution for connecting custom keypanels to the Intercom 
Matrix over standard IP networks by supporting 8 or 16 channels (ports) of audio in and out.

The RVON devices supported by AZedit are as follows:

RVON-8 - Provides eight (8) channels in and out of digital audio.

RVON Keypanel - Provides voice over IP (Internet Protocol) communications for the KP-32, KP-812, CLD families of 
keypanels.

RVON-C - Provides voice over IP (Internet Protocol) communications for the Cronus intercom system.

RVON-16 - Provides 16 channels in and out of digital audio.

RVON devices are fully compatible with internationally recognized standards and support the following protocols: G.711, 
G.729AB, and G.723 (5.3k and 6.3k).

NOTE: RVONedit is a Windows-based, GUI (Graphical User Interface) application designed exclusively for Bosch 
Security Systems, Inc. RVON products. The application can be used to display or configure RVON (VoIP) 
options associated with the different devices. RVONedit is to the VoIP products as AZedit is to ADAM, Cronus, 
and Zeus. Please contact your customer service representative for ordering details. 

There are five (5) RVON devices in the RVON family:

RVON-8

RVON-Keypanel

RVON-I/O

RVON-C

RVON-16

NAVIGATION: Select System|Miscellaneous|RVON Configuration.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 
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Settings for RVON Card Group Box

RVON Card Drop Down Menu

The RVON Card drop down menu is used to select the card slot where the RVON card resides.

IP Address Field

The IP Address field indicates the IP Address of the RVON card. 

NOTE: An IP Address is an identifier or numerical name for a computer or device on a network. Data between 
computers is routed over the network using these addresses to identify which computer a message is being sent to 
and which computer a message is being sent from. The format of an IP Address is a 32-bit numeric address 
written as four (4) numbers separated by periods. For example, an IP Address looks like 10.100.1.1.

Network Mask Field

The Network Mask field indicates the network mask address of the RVON card, if applicable.

NOTE: A network mask indicates which computers can be accessed locally without using a gateway, and which 
computers can only be reached through a gateway. The bits in the network mask determine what is a network and 
what is a computer.

FIGURE 175. RVON Configuration Window
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Default Gateway Field

The Default Gateway field indicates the default gateway address used of the RVON card, if applicable. The gateway address 
is the IP Address used when a connection outside your network is commenced.

Settings for Pass-Through Serial Via Ethernet Group Box

Target IP Address

The Target IP Address field displays the IP Address of the device to which you want to connect over Ethernet.

Serial Baud Rate Drop Down Menu

The Serial Baud Rate drop down menu is used to select the baud rate at which the data is transmitted.

Available selections for this field are:

9600kbps
19.2kbps
38.4kbps

Settings for Connected Devices Group Box

RVON Channel Drop Down Menu

The RVON Channel drop down menu is used to select the channel used to communicate to another device across the network.

Device IP Address Field

The Device IP Address field indicates the device IP Address to which you want to connect.

Device Type Drop Down Menu

The Device Type drop down menu is used to select the type of device to which you want to connect.

Device Channel Drop Down Menu

The Device Channel drop down menu is used to select the channel on the device to which the RVON card communicates.
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Codec Type Drop Down Menu

The Codec Type drop down menu is used to select the codec type for this channel. 

Available selections are:

G.711m-law
G.711A (8kbps)
G.729AB
G.723 (5.3kbps)
G.723 (6.3kbps)

NOTE: A codec is an algorithm used to compress audio. There are five (5) codecs supported by Bosch Security Systems, 
Inc.: G.711m law, G.711A law, G.729AB, G.723 (5.3k), and G.723 (6.3k). The type of codec dictates the quality 
of audio you hear and the network bandwidth used. The packet size determines how much audio data is carried 
across the network in each transmitted packet. The codec type and packet size chosen require different amounts 
of bandwidth from the network. 

The Intercom System Administrator and the Network Administrator might want to work together in choosing the 
codec type and packet size suitable for the size of the network.

Packet Size Drop Down Menu

The Packet Size drop down menu is used to select the size of each audio packet. 

Available selections for this field are:

10ms audio/packet
20ms audio/packet
40ms audio/packet
60ms audio/packet

As with the codec type, the packet size you choose for the audio transfer affects the audio you hear and the bandwidth you use 
over the network. Using a larger audio packet size results in less bandwidth use. However, the larger packet size can result in 
higher delays and longer gaps if the packet is lost. On the other hand, smaller packet sizes result in larger bandwidth use, but 
lower delays and smaller gaps if the packet is lost.

NOTE: The Intercom System Administrator and the Network Administrator may want to work together in choosing the 
codec type and packet size suitable for the size of the network.

Enable VAD (Voice Activity Detection) Check Box

The Enable VAD (Voice Activity Detection) check box is used to enable VAD on the channel. VAD saves network bandwidth 
by stopping the flow of audio packets when silence is detected. 

NOTE: VAD is similar to VOX. VOX (Voice Operated Switch) is a switch that operates when sound over a certain 
threshold is detected. The circuitry usually includes a delay or hold time threshold that leaves the circuit activated 
when the sound stops. This keeps the circuit from turning off during short pauses in speech.
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GPIO-16 Configuration Window

The GPIO-16 Configuration window, shown in Figure 176, is used to configure the GPIO-16 device. Some settings include 
the IP Address, Network Mask, and Gateway Address.

NAVIGATION: Select Options|GPIO-16 Configuration.

NOTE: Remember to send any change you make to the intercom system using Online|Send Changes or the Activate 

button. 

Select GPIO-16 Group Box

IP Address Field

The IP Address field indicates the IP Address of the GPIO-16 device.

Lookup Button

The Look-Up button  is used to look up a GPIO-16 IP Address entered manually into the IP Address field. This 
IP Address may be on the other side of the gateway.

FIGURE 176. GPIO-16 Configuration Window
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Browse Button

The Browse button  opens the “Select GPIO-16 Window” on page 167. From this window, you can select a GPIO-16 
device from a list of all the devices on the local network that can respond to a broadcast. The MAC Address, IP Address, and 
a description of the device are displayed in the window.

NOTE: If this is the first time the GPIO-16 is being used, only the MAC Address of the unit displays.

GPIO-16 Configuration Group Box

MAC Address Field

The MAC Address field displays the MAC Address of the GPIO-16. This field is not configurable.

NOTE: Do not confuse the MAC Address with an IP Address. The MAC Address is a fixed address that identifies a 
physical piece of hardware on a network. An IP Address, on the other hand, is a network identifier for a computer 
or device on a TCP/IP network. Where, typically, MAC Addresses are hard-coded to a device, an IP Address is 
not.

Description Field

The Description field is used to enter a unique description for the GPIO-16 device. This description appears in the GPIOs 
window (System|GPIO-16).

This field can contain up to 48 characters.

New IP Address Field

The New IP Address field is used to enter or change the IP Address for the GPIO-16 device.

Network Mask Field

The Network Mask field is used to enter a network mask, if applicable, for the GPIO-16 device.

NOTE: A network mask is a 32-bit number indicating the range of IP Addresses residing on a single IP/Subnet/Supernet. 
An example of a network mask is 255.255.255.0.

Default Gateway Field

The Default Gateway field is used to enter the default gateway address for the GPIO-16 device.

NOTE: A default gateway is a node on a computer network that serves as an access point to another network.
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Ethernet Settings Drop Down Menu

The Ethernet Settings drop down menu is used to select the Ethernet settings for the GPIO-16 device. 

Available selections for this field are:

10Mbps, Half-Duplex

100Mbps, Half-Duplex

10Mbps, Full-Duplex

100Mbps, Full-Duplex

Auto negotiate

NOTE: The GPIO-16 automatically alternates between 100Mbps half-duplex and 10Mbps half-duplex in an attempt to 
determine link speeds supported.

Current Settings Field

The Current Settings field displays the current Ethernet speed, selected by the auto-negotiate menu item.

Primary MC Field

The Primary MC field indicates the IP Address of the primary master controller.

Current Button

The Current button  is used to select the IP Address of the intercom AZedit is communicating with.

Primary MC Browse Button

The Primary MC Browse button is used to display all intercoms on the local network that can respond to a broadcast.

Backup MC Field

The Backup MC field indicates the IP Address of the backup master controller.

Apply Button

The Apply button sends all changes to the intercom. It saves all changes you have made and does not close the active window.

Close Button

The Close button closes the current window without saving any changes.
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Configure Logging Window

The Configure Logging window, shown in Figure 177, is used to configure the connection type of the AZedit sessions where 
log messages are sent when the Log To File (See “Logging Page” on page 98.) option is selected. The Configure Logging 
window is only accessible when connected to AZedit using the J1 serial connection or using the target AZedit session.

IMPORTANT: If you are using an ADAM system, you must be running a MCII-e version 1.5.1 or later.

NAVIGATION: Select Logging|Configure Logging.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 

NOTE: When a Cronus is connected and running, a USB radio button is seen. You may select the USB radio button to 
send log messages to another AZedit session connected via a USB connection.

J1 Radio Button

The J1 radio button indicates log messages are sent to another AZedit session connected serially over the J1 port. 

NOTE: The only AZedit sessions allowed to configure the log destination are the AZedit session currently configured as 
that target destination for log messages or the main serial connection connected to J1 of the ADAM MC breakout 
panel. Restrictions can be set up for the AZedit destination session to restrict access to the Configure Logging 
window.

J9 Radio Button

The J9 radio button indicates log messages are sent to another AZedit session connected serially over the J9 port.

J10 Radio Button

The J10 radio button indicates log messages are sent to another AZedit session connected serially over the J10 port.

FIGURE 177. Configure Logging Window
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Ethernet Radio Button

The Ethernet radio button indicates log messages are sent to another AZedit session connected over Ethernet.

IP Address Field

The IP Address field is used to enter the IP Address of the computer running the AZedit session you want to send log 
messages to over Ethernet.

Authentication Configuration Window

The Authentication Configuration window, shown in Figure 178, is used to configure authentication for your intercom 
system. Authentication is the process of determining whether someone is who he or she declares to be. In private and public 
computer networks (including the Internet), and similarly AZedit, authentication is commonly done through user profiles and 
passwords. Intercoms supporting authentication may require a username and password for each AZedit session.

With the introduction of Ethernet connections, it is easier for users to log onto AZedit from more places within the network 
and beyond. Because of this capability, the security of your Intercom can become compromised. With Authentication, a level 
of security is placed on your intercom that requires the use of profiles and personal passwords.

Authentication is enabled on J9, J10, USB or Ethernet sessions. However, the J1 or serial connection session is always 
unauthenticated.

Authentication is configured through AZedit, where usernames and passwords are specified for each user. You can configure 
users as administrators for the different intercom systems or require a restrictions file to be present. Editing authentications 
requires Administrator status or connection on an authenticated system.

When user profiles are present, users can change their passwords and have passwords remembered for future automated 
logons. With the ability to have multiple AZedit sessions running different intercom sessions and allowing for multiple users 
on each computer, controlling access is made easier through the use of user profiles. User profiles include configuration, 
capabilities, communication settings, preferences and toolbar configurations. Profiles are stored separately for each intercom. 
For example, if you have three (3) intercom systems (Intercom 1, Intercom 2, and Intercom 3), each intercom system has its 
own user profile folder.

NAVIGATION: Select Authentication|Configuration from the menu bar.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 
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Sessions Settings Group Box

Enable Authentication Support Check Box

The Enable Authentication Support check box is used to enable authentication for the current AZedit session.

Require Authentication On Check Boxes

The Require Authentication On check boxes are used to select the types of connections that require authentication to use.

J9 - All J9 serial sessions

J10 - All J10 serial sessions

Ethernet - All Ethernet sessions

NOTE: When connected to a Cronus, a USB option is available.

Intercom Users Group Box

User Column

The User column displays the name of the user added to the authentication file.

FIGURE 178. Authentication Configuration Window
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Password? Column

The Password? column displays whether the user has a password associated with the authentication file for the intercom.

Admin? Column

The Admin? column displays if the user is an administrator for the intercom. If the user is an administrator, Yes appears in the 
column. Otherwise, No is displayed.

Restricted? Column

The Restricted? column indicates a restrictions file should be used by AZedit. If a restrictions file is needed, Yes appears in 
the column. Otherwise, No is displayed. 

Add Button

The Add button opens the Add User window. From this window you can create users to add to the intercom users list. For 
more information, see “Add/Edit User Window” on page 88.

Edit Button

The Edit button opens the Edit User window. From this window you can edit existing user profiles from the intercom users 
list. 

To edit existing user profiles, do the following:

1. Highlight the users profile.

2. Click Edit.

Delete Button

The Delete button deletes the selected user profile from the Intercom Users list.

Load Button

The Load button is used to load the Authentication File to the current intercom system.

Save Button

The Save button is used to save the current authentication file. If this is the first save performed, you must name the file. Files 
are saved to the file path defined in AZedit Preferences on the Authentication page. See “Authentication Page” on page 105.

Apply Button

The Apply button sends all changes to all cards in the intercom. It saves all changes you have made and does not close the 
active window.

Done Button

The Done button closes the current window after an Apply has been made. The Done button is the default button seen on the 
Authentication window.

Cancel Button

The Cancel button closes the current window without saving or applying any modifications. The Cancel button appears only 
after you create or modify an authentication file. Otherwise, the Done button is shown.
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Add/Edit User Window

The Add/Edit User window, shown in Figure 179, is used to create or modify user profiles for use with authentication.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 

User Name Field

The User Name field is used to enter the user name for the profile you create or modify in the authentication file.

This field can contain an unlimited number of characters; anything over 24 characters is truncated in the username column on 
the Authentication Configuration window.

FIGURE 179. Add User and Edit User Windows
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Password Field

The Password field is used to enter or modify a password for the profile you create in the authentication file. Passwords 
display as asterisks (*) when you enter them into the field.

There is no character limit on the password field. However, use the password tips below to create secure and easy to remember 
passwords. 

TIP: To create a secure password that is easy for you to remember, do the following:

Do not use personal information.

Do not use words. Tools are available to help attackers guess your password. With today's computing 
power, it doesn't take long to try every word in the dictionary and find your password, so it is best if you 
do not use words for your password.

Mix different character types. You can make a password much more secure by mixing different types of 
characters. Use some uppercase letters along with lowercase letters, numbers and even special 
characters such as '&' or '%'.

Use a pass-phrase. Rather than trying to remember a password created using various character types 
which is also not a word from the dictionary, you can use a pass-phrase. 

Think a sentence or a line from a song or poem that you like and create a password using the first letter 
from each word.

User is an Administrator Check Box

The User is an Administrator check box is used to indicate the current user profile is an administrator for this intercom 
system. Administrator rights allow the user to make changes to the authentication file.

User Requires Restrictions Check Box

The User Requires Restrictions check box indicates a restrictions file is applied to this user.

A Restrictions File is a set of permissions created for a specific user. For example, you can set restrictions so certain users are 
unable to create new users within the intercom system.

NOTE: Bosch’s Restriction Editor is a 32-bit Windows application designed to run under Windows 2000 and Windows 
XP. It may also run on Windows NT/95/98/ME with Internet Explorer V6.0 or later. Restriction Editor requires a 
copy of AZedit.exe to be available in order to determine the AZedit menu structure for creating restrictions.

Restriction Editor is a tool to create restriction files for use with AZedit Intercom software. Restriction Files 
allow administrators to manage user access to resources and features. AZedit includes support for user 
restrictions by reading and analyzing a text file (the restrictions file) that sends out the set of resources and 
features available to each user.
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SNMP Configuration Window

The SNMP Configuration window, shown in Figure 180, is used to configure SNMP (Simple Network Management 
Protocol) for your Intercom System. Simply put, SNMP allows you to send messages when specified events occur over the 
Intercom System.

NAVIGATION: From the menu bar, select Options|SNMP Configuration.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 

System Information Group Box

The System Information group box is used for documentation purposes. This is so the user knows which device is configured 
and where it is physically located.

Name Field

The Name field identifies the name of the Intercom System in which SNMP is configured.

This field can contain up to 255 characters.

Location Field

The Location field identifies the physical location of the intercom system (for example, 3rd floor, Sacramento).

This field can contain up to 255 characters.

FIGURE 180. SNMP Configuration Window
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Contact Field

The Contact field identifies the name of the person responsible for the specified SNMP device.

This field can contain up to 255 characters.

Community Strings Group Box

The Community Strings group box is used to define the level of security to use when queries are submitted. SNMP 
Community Strings are like passwords for network devices.

Most often, there is one (1) community string used for read-only access to a network device. The default value for this 
community string is often public. Using this community string like a password, the NMS retrieves data from network devices.

Read-Only Field

The Read-Only field displays the password that provides read-only access via SNMP.

This field can contain up to 64 characters.

The default entry is public.

Read-Write Field

The Read-Write field displays the password that provides read-write access via SNMP. If the Read-Write field is empty, 
SNMP is limited to read-only access.

This field can contain up to 64 characters.

Traps Field

The Traps field displays the trap identifier for the SNMP event monitor. The traps community string specifies the community 
string included in all SNMP traps generated by the intercom.

This field can contain up to 64 characters.

The default entry is trap.

NOTE: A SNMP Trap is a notification event issued by a managed device (the intercom system) to the network 
management system when an event or error occurs. When an event or error occurs, the notification includes the 
trap community string.
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Valid Hosts Group Box

Use List of Valid Hosts? Check Box

The Use List of Valid Hosts? check is used to allow queries by the specified SNMP monitoring machines. You can specify the 
IP Address of these machines in the Valid Host list.

If this box is selected, then only devices included in the list of valid hosts are allowed to send SNMP 
requests to the device. If the device (TM-2000, MCII-e, etc.) receives an ANMP request, and the 
sender’s IP Address does not appear in the list of valid hosts, then the request is silently discarded.

If the box is not selected, then the targeted device response to any and all SNMP requests, no matter the 
sender’s IP Address.

Valid Host Entry Field

The Valid Host entry field is used to add up to five (5) IP Addresses of host machines that accept SNMP requests. 

NOTE: You must enter a valid IP Address structure for the Add button to become active.

Valid Host List

The Valid Host list displays the IP Addresses of the machines that are allowed to generate SNMP queries.

Add Button

The Add button adds the specified IP Address structure for the Add button to become active.

NOTE: You must enter a valid IP Address structure for the Add button to become active.

Remove Button

The Remove button removes the selected IP Address from the trap target list. You can only remove one (1) IP Address at a 
time.

Trap Targets Group Box

Trap Target Entry Field

The Trap Target entry field displays the IP Address of the computers where the trap messages are sent. You can have up to 
five (5) devices configured to accept these messages.

NOTE: You must enter a valid IP Address structure for the Add button to become active.

Trap Target List

The Trap Target list displays a list of all the IP Addresses (computers) where you want trap messages sent.

Add Button

The Add button adds the IP Address in the trap target entry field to the trap target list.

NOTE: You must enter a valid IP Address structure for the Add button to become active.
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Remove Button

The Remove button removes the selected IP Address from the trap target list. You can only remove one (1) IP Address at a 
time.

Load Button

The Load button is used to read an SNMP file. Once the file has been read, you can modify the settings and save or apply 
them.

Save Button

The Save button is used to save the current SNMP settings to a disk file. The default directory for SNMP files is defined in 
Preferences on the Advanced page. See “Advanced Page” on page 102.

Apply Button

The Apply button sends all changes to the intercom. It does not close the active window.

Done Button

The Done button closes the current window after an Apply has been made. The Done button is the default button seen on the 
SNMP Configuration screen.

Cancel Button

The Cancel button closes the current window without saving or applying any modifications. The Cancel button appears only 
after you modify the settings or load new settings from a file. Otherwise, the Done button is shown.
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Application Preferences Window

The Application Preferences window, shown in Figure 181, is used to set application preferences for Startup/Shutdown 
operations, Alpha displays, Logging operations, General operations, Advanced operations, Authentication save options, and 
Maintenance operations.

NAVIGATION: Select Options|Preferences.|

Startup/Shutdown Page

The Startup/Shutdown page, shown in Figure 181, is used to configure startup and shutdown options for the AZedit 
application.

Auto Connect at Startup Check Box

The Auto Connect at Startup check box indicates AZedit enters online mode when the application is started.

Auto Enter SERVER Mode Check Box

The Auto Enter SERVER Mode check box indicates AZedit enters SERVER mode when the application is started.

Warn About Changes in Configuration Check Box

The Warn About Changes in Configuration check box indicates a warning message (Figure 182) displays every time the 
Intercom Configuration window is accessed.

FIGURE 181. Application Preferences Window - Startup/Shutdown page
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NAVIGATION: Select Options|Intecom Configuration.

Save Window Position on Exit Check Box

The Save Window Position on Exit check box indicates the current window position is saved upon exit. This setting keeps 
the last window placement when you close AZedit and remembers the setting when you open AZedit again.

Ask For Confirmation Before Exit Check Box

The Ask For Confirmation Before Exit check box indicates the popup message below appears every time AZedit is closed.

Save Advanced Communication Settings Locally Check Box

The Save Advanced Communication Settings Locally check box indicates communication settings are saved locally on the 
intercom system.

FIGURE 182. Configuration Change Warning

FIGURE 183. AZedit Exit Message
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Alphas Page

The Alphas page, shown in Figure 184, is used to configure the way AZedit displays Alphas, from sorting to character length.

Sort Alphas: Drop Down Menu

The Sort Alphas: drop down menu is used to select how alphas appear in a list.

Available selections for this field are:

by alpha- the alphas appear in alphabetical order.

by number-  the alphas appear in numerical order.

Allow Alpha Edit From Any View (CTRL+F12) Check Box

The Allow Alpha Edit From Any View (CTRL+F12) check box indicates changes to alphas on any screen within AZedit are 
allowed. By selecting this configuration option, you are not limited to editing alphas in the Alpha window.

Show All Sizes on Alpha Views Check Box

The Show All Sizes on Alpha Views check box displays all alpha sizes (4-, 6-, and 8-character) in all alpha columns. These 
columns refer to the character length of the alpha.

NOTE: When you enter a 4-character alpha, and View All Sizes on Alpha Views, the 4-character alpha populates the 6-
character and 8-character fields.

FIGURE 184. Application Preferences - Alphas page
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Automatically Check for Duplicate Alphas After Opening a File Check Box

The Automatically Check for Duplicate Alphas After Opening a File check box indicates AZedit automatically searches a 
new file for duplicate alphas in the system. This can help decrease the possibility of having duplicate alphas for different ports.

Prompt Before Auto-Checking When a File is Opened Check Box

The Prompt Before Auto-Checking When a File is Opened check box is used to display the message, Do you want to check 
for duplicate alphas? every time a new setup file is loaded.

Prompt When Duplicate Alpha is Created Check Box

The Prompt When Duplicate Alpha is Created check box is used to display a warning message when a duplicate alpha is 
created on the intercom system.

By default, this check box is selected.

Suppress Default Alphas From Pick Lists Check Box

The Suppress Default Alphas From Pick Lists check box indicates any alpha with a default label is hidden in the application 
display.

Force Alphas to Uppercase

The Force Alphas to Uppercase check box indicates alphas are displayed in all capitalized letters.

By default, the Force Alphas to Uppercase check box is selected.

NOTE: In software version 4.0.0 and later, alphas can be created with upper and lower case letters.

Force Unicode ASCII and Katakana to Full-Width

The Force Unicode ASCII and Katakana to Full-Width check box is used to force Unicode ASCII and Katakana characters 
to display full-width. This means it is easy to read the display information in AZedit.

By default, the Force Unicode ASCII and Katakana to Full-Width check box is selected.

Preferred Alpha Size Drop Down Menu

The Preferred Alpha Size drop down menu displays alpha size options available to create and display in AZedit, including 
drop down lists throughout the application. 

Options include: 4-character, 6-character, and 8-character.
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Logging Page

The Logging Page, shown in Figure 185, is used to configure how logging in AZedit operates. You can also configure where 
Log Files are archived. 

Enable SERVER Mode Logging Check Box

The Enable SERVER Mode Logging check box indicates events that occur in SERVER mode are logged to the Log File. For 
example, an intercom system requests a file from a keypanel. A record of this event is sent to the log file.

Enable Standard Talk/Listen Logging Support Check Box

The Enable Standard Talk/Listen Logging Support check box indicates standard logging is active in online and FILE 
Mode. This is also known as key press logging. 

Set Standard Log Mode and Startup To Check Box

The Set Standard Log Mode and Startup To check box allows the user to select how to log events when AZedit starts. The 
following radio button options are used to configure this feature:

Disable Logging Radio Button

Logging is not active.

Log to File Radio Button

Log events are written to a predetermined file on the computer or network.

Log to Serial Port Radio Button

Log events are sent to a device connected over a serial port.

FIGURE 185. Application Preferences - Logging Page
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Log Files .LOG Field

The Log Files .LOG field indicates where log events are logged on the computer or network. You must have the Log to File 
radio button selected.

Browse Button 

The Browse button opens a navigation window you can use to navigate to a folder to log events on the computer or network.

General Page

The General Page, shown in Figure 186, is used to further configure AZedit to fit your intercom system application. From this 
window you can configure AZedit to automatically create backup files (.bak), confirm file names, prompt an online save 
before going into FILE mode, etc.

Automatically Create .BAK Files Check Box

The Automatically Create .BAK Files check box indicates AZedit automatically creates a backup file every time a Save is 
performed. The backup file is created in the same file as the setup file and retains all settings from the last Save. The backup 
file can be useful when you want to return to the previously saved file settings.

By default, Automatically create .BAK files is selected.

FIGURE 186. Application Preferences - General Page
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Confirm File Name Before Save in FILE Mode Check Box

The Confirm File Name Before Save in FILE Mode check box enables a confirmation message verifying the file name and 
save directory to be shown every time you save a setup file.

By default, Confirm File Name Before Save in FILE Mode is selected.

Prompt to Enter FILE Mode During ONLINE Save Check Box

The Prompt to Enter FILE Mode During ONLINE Save check box indicates a confirmation window appears when a Save 
is performed in online mode. When you save the online configuration to a file on disk, AZedit always uploads the current 
intercom settings before proceeding with the save. These settings are merged with any changes you have made, but have not 
yet been sent to the intercom system. The file you save contains current system settings, plus any changes you have made.

NOTE: A backup copy of your system configuration is not needed for protection against power loss since the system's 
master controller retains the system configuration (even during a power outage). However, the backup copy does 
give you protection against a complete failure of the master controller itself. A backup master controller in the 
ADAM or ADAM CS frame also accomplishes this. In addition, a backup disk copy gives you protection against 
unwanted changes to the intercom system configuration.

When the confirmation window appears, you have two (2) options when saving the setup file:

Stay ONLINE:AZedit stays in online mode when the save is performed. If you choose to stay in online mode, you can 
later send changes you have made to the intercom system, and your 
online configuration then matches what you have saved to disk. 

WARNING: If you stay online, there is a risk of changes being made by another keypanel operator to the setup 
file after you save in online mode.

Enter File mode, editing the file just saved:AZedit enters file mode. If you choose to enter file mode the current 
system settings, plus your changes, are saved to disk; however, the 
changes are not sent to the intercom system. In this case, if you want to 
update the intercom system to match the file you have saved, you must 
enter online mode and send the file you saved to the intercom system.

Show Preview of Changes to be Sent During Send Changes Check Box

FIGURE 187. Online Save Warning Message
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The Show Preview of Changes to be Sent During Send Changes check box indicates the Send All window appears 
displaying a list of changes you made. This allows you to verify the changes before you send them to the intercom system.

By default, Show Preview of Change to be Sent During Send Changes is enabled. 

For more information, see “Send All Window” on page 327.

Warn When Editing Keypanel Setup for IFB Output Port Check Box

The Warn When Editing Keypanel Setup for IFB Output Port check box displays the message “This port is configured as 
an IFB output bus for at least one IFB. There may not be a physical keypanel associated with this port every time changes are 
made to an IFB output port.” This helps to insure no changes are made to existing IFB assignments.

Automatically Latch Disable Keys when IFB is Assigned Check Box

The Automatically Latch Disable Keys when IFB is Assigned check box disables latching for keys with IFB assignments.

Warn When Setting Key States on an Incompatible Keypanel Check Box

The Warn When Setting Key States on an Incompatible Keypanel check box displays the warning message, This command 
may not work as expected due to physical design of this port’s keypanel, when an incompatible keypanel is being modified.

Warn When Changing Color of Remote Assignment Group Member Check Box

The Warn When Changing Color of Remote Assignment Group Member check box indicates a warning message appears 
anytime a change is made to a remote assignment group member profile.

By default, this check box is selected.

Show I/O Gains on Volume Select Dialog Check Box

The Show I/O Gains on Volume Select check box is used to either display or hide the I/O gains option when Alt + F2 or the 
Gains icon is selected on the navigation bar. 

NOTE: This does not remove the option from the Gains Icon down arrow. This only removes the I/O gains option from 
the Select Gain Type window.

Setup Files (.ADM): Field

The Setup Files (.ADM) field indicates where to save setup files on the computer or network.
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Browse Button 

The Browse button opens a navigation window you can use to navigate to a folder to save setup files on the computer or 
network.

Advanced Page

The Advanced Page, shown in Figure 188, is used to set advanced options for the currently connected intercom system. These 
options include: panel poll delay support, TIF support, Trunking support, SERVER mode support, allow intercom resizing in 
online mode, allow crosspoint inspection in FILE mode, allow firmware download and allow key state changes.

Enable Panel Poll Delay Support Check Box

The Enable Panel Poll Delay Support check box enables panel poll support in AZedit. Panel Poll Delay is typically used 
when a keypanel’s data line is connected to the intercom port via a modem link from a remote location. In this situation, there 
may be a slight delay in data transmission from the remote keypanel to the intercom system. This may cause sporadic 
operation or no operation at all. However, by setting a delay time, the intercom system waits a little longer for data 
transmissions from the remote keypanel.

Enable TIF/Phone Support Check Box

The Enable TIF/Phone Support check box enables TIF (Telephone Interface Frame) or phone devices to be used with 
AZedit.

FIGURE 188. Application Preferences - Advanced Page
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Enable Trunking Support Check Box

The Enable Trunking Support check box enables the alias alphas and trunking on the system. Aliases are used only with 
trunked intercom systems. Alias names are used to identify destinations in your intercom system to AZedit administrators and 
keypanel operators in other intercom systems. Aliases are provided because sometimes an alpha being used in your intercom 
system is also being used in some other intercom system. In this case, you can enter an alias that does not conflict with the 
name already in use. Another reason you might want to use an alias is some other name might be more meaningful to keypanel 
operators in another intercom system.

Enable SERVER Mode Support Check Box

The Enable SERVER Mode Support check box allows users to enter server mode.

NOTE: When server mode is on, you can view the online configuration and also observe intercom activity, but you 
cannot make any changes and you cannot manually load or send files.

Enable Alarm Notification Popup Check Box

The Enable Alarm Notification Popup check box indicates a popup message appears when an alarm is triggered within 
AZedit.

Allow Intercom Resizing in ONLINE Mode Check Box

The Allow Intercom Resizing in ONLINE Mode check box allows changes to the intercom system via the Intercom Sizing 
Wizard. If this option is not selected, no configuration changes may be made to the Intercom.

Allow Key State Changes Check Box

The Allow Key State Changes check box allow users to toggle the talk or listen key function on and off in AZedit.

To Toggle Key States on or off, do the following:

1. In AZedit, click the Keypanel/Ports icon.
The Keypanel/Ports window appears.

2. Right-click in a listen or talk field.
A popup menu appears.

3. From the popup menu, select Turn Key On.
A red dot appears above the key assignment to signify the key is active.
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Allow Changes to TM Communications Check Box

The Allow Changes to TM Communications check box allows users to make changes to the Trunk Master Communications 
window. For more information, see “Trunk Master Communications Window” on page 49.

Allow Firmware Download Check Box

The Allow Firmware Download check box allows users to download firmware to connected devices in AZedit. If you do not 
want users to be able to download firmware to connected devices, clear the check box. For more information, see 
“Downloading Firmware Updates” on page 364.

Allow License Download Check Box

The Allow License Download check box allows users to download MADI license files. If you do not want users to be able to 
download licenses, clear the check box. For more information, see “Download License File to a MADI Card” on page 425.

Firmware Files (.HEX, .MOT, .BIB): Field

The Firmware Files (.HEX, .MOT, .BIB): field indicates where the firmware files are stored on the computer or network. By 
default, firmware files are stored in C:\TELEX\AZedit\FIRMWARE.

Browse Button 

The Browse button opens a window to navigate to save firmware files on the computer or network.

SNMP Configuration Files (.AZS): Field

The SNMP Configuration Files (.AZS): field indicates where SNMP configuration files are stored on the computer or 
network. By default, SNMP configuration files are stored in C:\TELEX\AZedit\SNMP.

Browse Button 

The Browse button opens a window to navigate to save SNMP configuration files on the computer or network.

Debug Files (.AZD): Field

The Debug Files (.AZD): field indicates the stored debug files location are on the computer or network. By default, debug 
files are stored in C:\TELEX\AZedit\DEBUG.

Browse Button

The Browse button opens a window to navigate to save debug files on the computer or network.

License Files (.LIC): Field

The License Files (.LIC): field indicates the stored license files location are on the computer or network.

Browse Button 

The Browse button opens a window to navigate to save debug files on the computer or network.
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Authentication Page

The Authentication Page, shown in Figure 189, is used to indicate where to store restriction and authentication files. 

Authentication is the process of determining whether someone is, in fact, who he or she declares to be. In private and public 
computer networks (including the Internet), and similarly AZedit, authentication is commonly done through user profiles and 
passwords. Intercoms supporting authentication may require a username and password for each AZedit session.

Restrictions Editor, a tool to create restriction files for use with AZedit, is a 32-bit Windows application designed to run under 
Windows 2000 and Windows XP. It may also run on Windows NT/95/98/ME with Internet Explorer V6.0 or later.

Restriction files allow administrators to manage user access to resources and features. AZedit includes support for user 
restrictions by reading a text file (the restrictions file) and parsing out the set of resources and features available to each user.

NOTE: Restrictions Editor requires a copy of AZedit.exe is available in order to determine the AZedit menu structure for 
creating restrictions.

Warn When Attempting to Change Communication Settings Check Box

The Warn When Attempting to Change Communication Settings check box displays a warning message when you make 
changes to the Communications window.

FIGURE 189. Application Preferences - Authentication Page



106  Other Configuration Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Restriction Files (.RES): Field

The Restriction Files (.RES): field indicates where restriction configuration files are stored on the computer or network. 

The Restrictions file can be on a network shared drive so one (1) computer can run Restrictions Editor and create .RES files 
for each connected intercom from a central location. In addition, AZedit caches a copy of a .RES file on the local machine. So, 
if the network is down, AZedit is still able to access the most recent copy of the .RES file by using this cached version. If you 
are not using a network share, you do not have to specify the Restriction Files directory, AZedit only looks in the cache 
directory.

NOTE: Restriction files are only used with the Restriction Editor software. For more information, contact Bosch Security 
Systems, Inc. technical support.

Browse Button

The Browse button opens a window you can use to navigate to a folder to save Restriction files on the computer or network.

Restriction Cache Files (.RES): Field

The Restriction Cache Files (.RES): field indicates where to save the restriction files AZedit saves locally to prevent any 
downtime in case of network failure. The Restrictions Cache File saves these files in the Restrictions Cache Directory 
(C:\TELEX\AZEDIT\RES). If you are not using a network share, you do not have to specify the restriction files directory, 
AZedit only looks in the cache directory.

NOTE: Restriction files are only used with the Restriction Editor software. For more information, contact Bosch Security 
Systems, Inc. technical support.

Browse Button 

The Browse button opens a navigation window you can use to navigate to a folder to save Restriction Cache files on the 
computer or network.

Authentication Configuration Files (.AZA) Field

The Authentication Configuration Files (.AZA) field indicates where to store the authentication configuration files. When 
using Authentication, AZedit creates an authentication configuration file (.AZA) that retains the settings you specify for 
AZedit use. 

The AZedit Installation creates a directory under C:\Telex\AZedit\ called AUTH to hold these files. You can change where 
AZedit is to store these files, if desired.

Browse Button 

The Browse button opens a window you can use to navigate to a folder to save authentication files on the computer or 
network.
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Maintenance Page

The Maintenance Page, shown in Figure 190, is used to grant users specific user/device configuration abilities, such as 
adding, deleting and editing user and device profiles.

Allow User to Add Intercoms Check Box

The Allow User to Add Intercoms check box allows users to add intercom systems to the AZedit application.

Allow User to Delete Intercoms Check Box

The Allow User to Delete Intercoms check box allows users to delete intercom systems from the AZedit application.

Allow User to Change the Default Intercom Check Box

The Allow User to Change the Default Intercom check box allows users to change the default intercom system AZedit 
connects with.

Allow User to Add User Profiles Check Box

The Allow User to Add User Profiles check box allows users to create user profiles used in AZedit.

Allow User to Delete User Profiles Check Box

The Allow User to Delete User Profiles check box allows users to delete user profiles from the AZedit application.

Allow User to Change the Default User Check Box

The Allow User to Change the Default User check box allows users to change the default user profile used when logging on 
to AZedit.

Hide This Dialog (Permanently) Check Box

The Hide This Dialog (Permanently) check box to hide the maintenance page.

IMPORTANT: Once you choose this option, there is no way to turn this page back on through AZedit. You must use 
Windows Registry Editor to re-enable the maintenance page

FIGURE 190. Application Preferences - Maintenance Page



108  Other Configuration Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03



Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

CHAPTER 5

Setup Windows

Ports Window

The Keypanels/Ports window, shown in Figure 191, is used mainly to set up keypanels in the intercom system. However it 
can be used to do the following:

Keypanel Setup - You use this window to connect a keypanel to a particular intercom port, and then 
set up that keypanel. Keypanel setup includes assigning the keys and options.

Non-keypanel Usage of a Port - Even if you are not using a keypanel at a port, there may still be a few items you 
want to configure.

View Keypanel Activity - You can view keypanel activity, such as key activations, during operation in 
online or server mode.

GPI Input Assignment - You can use GPI inputs to simulate keypanel keys even when no keypanel is 
connected at an intercom port. First, you use GPI Input setup to define which key 
to activate at a specific port. Then, use keypanel setup to select that port and 
assign the key.

NAVIGATION: Select System|Keypanel Assignment.

IMPORTANT: Remember to send any change you make to the intercom system using Online|Send Changes or the 

Activate button. 
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Port Field

The Port field indicates the port number for the keypanel setup currently being viewed. Typing a different port number in this 
box shows the setup information for the specified port.

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which in turn, automatically populates the Port field.

Alpha Drop Down Menu

The Alpha drop down menu indicates the port alpha for the port setup currently being viewed.

NOTE: Once the port alpha has been entered, the Port field populates with the corresponding name.

FIGURE 191. Keypanel/Ports Window
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Scroll Enable Group Box

Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they are not able to assign it using keypad numeric entry 
(KP9X series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to 
any other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear this check box, remote AZedit users do not have access to these scroll lists

NOTE: The AZedit check box is only selectable if trunking has been activated.

LCP-102 Check Box

The LCP-102 check box indicates the intercom port is displayed in the IFB input scroll list of an LCP-102 operating in PAP 
mode. When enabled, the port can be selected as the program source for an IFB input.

NOTE: The LCP-102 check box only appears in the Keypanels/Ports main screen.

Keypanel/Port Settings Group Box

Page Drop Down Menu

The Page drop down menu is used to select which page of keypanel assignments you want to view. By default, there are 
four (4) pages available to view.
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Edit Button

The Edit button opens the Keypanel/Port Configuration window. From this window you can configure an intercom port for 
use with a keypanel. Some setup options include selection modes of keypanels, default views, setup page options, priorities, 

panel poll delays, IFB listen destinations, and VOX (Voice Operated Switch)1. For more information, see “Keypanel/Port 
Configuration Window” on page 117.

Gain Button

The Gain button  opens the Gain Setup window. From this window you can set the listen gains for point-to-point and 
party line assignment types and input/output gains. For more information, see “Gain Setup Window” on page 126.

Port Status Group Box

The Port Status group box displays various status icons indicating processes running in the intercom system. The following 
items are displayed in the Port Status group (upper-right corner of the Keypanels / Ports screen). Most of these icons activate 
based on keypanel features detected by the intercom system master controller.

Listen Keys Group Box

D (Latch Disable) Check Box

The D (Latch Disable) check box indicates the keypanel key cannot be latched on by the user. Clear the check box to activate 
latching capabilities for that key.

NOTE: You can also enable and disable the Latch Disable check box by pressing Ctrl+D.

R (Key Restrict) Check Box

The R (Key Restrict) check box indicates the keypanel key is restricted and cannot be modified by the user. Use this option to 
prevent a keypanel operator from changing a key assignment

NOTE: You can also enable and disable the Key Restrict check box by pressing Ctrl+R.

1. VOX or voice operated switch is a switch that activates when sound over a certain threshold, in dB, is detected. It is usually used to turn 
on a transmitter or recorder when someone speaks. It is sometimes used instead of a push-to-talk button on transmitters or to save stor-
age space on recording devices. The circuitry usually includes a delay or hold time threshold that leaves the circuit activated when the 
sound stops. This keeps the circuit from turning off during short pauses in speech.

Heartbeat Icon - Indicates a data device (keypanel, TIF, or Camera Delegate Panel) is connected 
to the intercom port.

Warning Icon - Indicates the intercom port is defined as an IFB output (in the IFB Setup screen).

 Headset Icon - Indicates the connected keypanel has a headset selected.

LEDs Icon - Indicates the on/off state of any local GPI inputs and outputs. These indicators 
function only when a keypanel with a local GPI port is connected. Bright Green/ Bright Red=On 
(Asserted), Green/ Red=Off (Inhibited) in 16 slices to show RVON GPI activity.

Question Mark Icon - Indicates that the keypanel type you have selected (with the Edit button) 
does not match what is reported by the intercom system.
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Listen Field

The Listen field (shown in Figure 192) displays the key assignments assigned to the keypanel listen keys. You can modify the 
listen assignment by right-clicking in the listen field you want to change and select Change Assignment. For more 
information on changing the key assignment, see “Select Key Assignment Window” on page 129. 

Available selections for this field are:

Ports

Party Lines

IFBs

IFB Special Lists

Special Lists

GPI Outputs

ISOs

UPL Resources

Special Functions

The type of keypanel being configured determines the number of keys displayed in the application window.

NOTE: By default listen assignment alphas are 4 characters in length. However, with the proper hardware, you can set 
the alpha length to 6 and 8 characters. 

To change the alpha character length, do the following:

1. Select Options|Preferences from the menu bar. 

2. Select the Alphas page. 

3. From the Preferred Alpha Size drop down menu, select the alpha size desired.

CWW Field

The CWW (Call Waiting Window) field (shown in Figure 192) is used to receive and respond to callers in the intercom system 
who do not have key assignments. Typically, the CWW is the 16th key on the keypanel and has the special function Auto-
Follow assigned to it. No key assignments can be made to this field. The CWW window can also be used to view scroll lists 
and call people from the scroll list.

FIGURE 192. Listen, Talk and Talk Level 2 Assignments
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Show Volume Button

The Show Volume button displays the current listen levels for the keypanel being viewed. The listen levels only display on 
keys that have assignments configured.

Keypanel Color Button

The Keypanel Color button  is used to display the color assignments in the keypanel. See Figure 194. For more 
information, see “The Log View field is used to see the different logs written. Double-click any log to view the contents.” on 
page 283. 

Talk Keys Group Box

D (Latch Disable) Check Box

The D (Latch Disable) check box indicates the keypanel key cannot be latched on by the user. Clear the check box to activate 
latching capabilities for that key.

NOTE: You can also enable and disable the Latch Disable check box by pressing Ctrl+D.

FIGURE 193. Show Volume Example

FIGURE 194. Key Color Example
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R (Key Restrict) Check Box

The R (Key Restrict) check box indicates the keypanel key is restricted and cannot be modified by the user. Use this option to 
prevent a keypanel operator from changing a key assignment

NOTE: You can also enable and disable the Key Restrict check box by pressing Ctrl+R.

Talk Field

The Talk field (as shown in Figure 192 on page 113) displays the key assignments assigned to the keypanel talk keys. You can 
modify the talk assignment by right-clicking in the listen field you want to change and selecting Change Assignment. For more 
information on changing the key assignment, see “Select Key Assignment Window” on page 129. 

Available selections for this field are:

Ports

Party Lines

IFBs

IFB Special Lists

Special Lists

GPI Outputs

ISOs

UPL Resources

Special Function

Depending on the type of keypanel being configured, determines the number of keys displayed in the application window.

NOTE: By default talk assignment alphas are 4 characters in length. However, you can set the alpha length to 6 and 8 
characters.

To change the alpha character length, do the following:

1. Select Options|Preferences from the menu bar. 

2. Select the Alphas page.

3. From the Preferred Alpha Size drop down menu, select the alpha size desired.



116  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Level 2 Talk Field

The Level 2 Talk field, shown in Figure 192 on page 113, displays the key assignments for the keypanel level 2 talk keys.You 
can assign a level 2 talk key to activate along with a normal talk key assignment (talk level 1). Talk Level 2 is typically used 
with inter-panel dim tables, or to activate a relay or GPI Output. You can modify the special function by right-clicking in the 
listen field you want to change and selecting Change Assignment. For more information on changing the key assignment, see 
“Select Key Assignment Window” on page 129.

NOTE: The following causes a first birthday on your intercom. Be sure to save your Setup file.
You can only assign talk level 2 after you have assigned talk level 1. You can also activate additional talk levels. 
In the Options menu, select Intercom Configuration, then select the Options Page. You can set Talk levels to 2, 3, 
or 4. To have more than 2 talk levels requires the following firmware:

ADAM Master Controller firmware version V9.6.1 or greater.

ADAM Audio Input/Output card firmware version V9.5.1 or greater.

Assignments types available for level 2 talk are:

Ports

Party Lines

IFBs

IFB Special Lists

Special Lists

GPI Outputs

ISOs

UPL Resources

Special Function - for more information, see “Select Key Assignment Window” on page 129.

NOTE: By default, level 2 talk assignment alphas are 4 characters in length. However, you can set the alpha length to six 
(6) and eight (8) characters.

To change the alpha character length, do the following:

1. Select Options|Preferences from the menu bar. 

2. Select the Alphas page. 

3. From the Preferred Alpha Size drop down menu, select the alpha size desired. 



AZedit Intercom Software Setup Windows  117

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Keypanel/Port Configuration Window

The Keypanel/Port Configuration Window is used to configure a selected port. There are three (3) pages divided into logical 
option groups: Setup, Advanced, and VOX.

Setup Page

The Setup Page, shown in Figure 195, is used to configure an intercom port for use with a keypanel. Each keypanel can have 
up to four (4) setup pages of key assignments, and each setup page can assign up to 16 pairs of talk/listen keys. Typically,
one (1) setup page is used for the main keypanel, and one (1) setup page is used for each expansion panel connected to the 
main keypanel (if there are any). 

NOTE: Some keypanels may have more or less than 16 keys. Therefore, there may be cases where all 16 keys on a setup 
page are not used. There may also be cases, such as with the KP-32 keypanel, where the keypanel itself uses not 
only all of the keys on one setup page, but also all of the keys on another setup page.

Panel Group Box

The Panel group box displays the four types of setup pages allowed per port in AZedit. Currently, only four (4) setup pages are 
supported - one (1) main panel and three (3) expansion panels.

Type Drop Down Menu

The Type drop down menu identifies the type of keypanel or expansion panel being used.

FIGURE 195. Keypanel/Port Configuration Setup Window



118  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Setup Page Drop Down Menu

The Setup Page drop down menu identifies the setup page to display for the specified keypanel or expansion panel. 

Available selections for this field are: Setup Page 1, Setup Page 2, Setup Page 3, and Setup Page 4.

If the keypanel and expansion panels have been automatically selected (AZedit in online mode and Reported by Intercom 
radio button selected), the Setup Pages are also assigned automatically to match the keypanel/expansion panel configuration.

If you have manually selected the keypanel and expansion panel types, then you must use the Setup Page radio buttons to 
assign a setup page to each keypanel and expansion panel. If you are not using expansion panels, assign a page to the Main 
keypanel, and select No Setup Page for all expansion panels.

NOTE: KP-12: There are two (2) types of expansion panels for the KP-12: the EKP-12, with 12 keys, and the EKP-20, 
with 20 keys. One (1) or more of each type can be connected to the KP-12 in any order, and there may not be an 
absolute relationship between setup pages and expansion panels. In this case, assign enough setup pages to 
expansion panels to take care of the total number of expansion panel keys available. 

EXAMPLE: Suppose there is only an EKP12 expansion panel connected to the KP-12. In this case, assign 
Expansion Panel 1 to any available setup page. This takes care of all 12 keys on the expansion panel, 
with four (4) keys left over. 

EXAMPLE: An EKP20 and an EKP-12 is connected to the KP-12. This means there are a total of 32 expansion 
panel keys available. In this case, assign Expansion Panel 1 to any available setup page to take care of 
the first 16 expansion keys. Then, assign Expansion Panel 2 to another setup page to take care of 
expansion keys 17-32.

Default View Group Box

By Panel Type Radio Button

The By Panel Type radio button indicates the Keypanel/Ports window displays the correct quantity of Talk and Listen keys 
based on the Type settings. For example, a setup page assigned to the KP-12 displays only 12 Talk and Listen keys. Typically, 
view by Panel Type is the preferred viewing mode. 

NOTE: For KP-32 Users: In view by Panel Type mode, all 32 keys on the KP-32 displays on one (1) screen. In this 
mode, it is not possible to display the talk, listen, and talk level 2 assignments at the same time. Therefore, a 
selection arrow appears in the upper-right corner of the key group. Click the arrow to select which type of keys 
you want to assign.
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To toggle between views, do the following:

 Press Ctrl+Tab on the computer keyboard.
OR
Press Shift+Ctrl+Tab to change the view mode for all intercom ports.

FIGURE 196. Talk Toggle
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By Setup Page Radio Button

The By Setup Page radio button indicates the Keypanel/Ports screen displays all 16 talk and listen key assignments available 
on a setup page, regardless of whether the keypanel or expansion panel has that number of keys.

NOTE: For KP-32 Users: In view by Setup Page mode, only 16 keys on the KP-32 displays in one (1) window. 
However, you can assign talk, listen, and talk level 2 all in the same screen as for any other keypanel.

To assign the first 16 keys, do the following:

Select the setup page currently assigned to the main keypanel.

To assign the remaining 16 keys, do the following:

Select the setup page currently assigned to expansion panel Exp1.

To toggle between views, do the following:

 Press Ctrl+Tab on the computer keyboard.
OR
Press Shift+Ctrl+Tab to change the view mode for all intercom ports.

Show Type Group Box

Set by User Radio Button

The Set by User radio button enables manual selection of keypanel and expansion panel model names in the Type selection 
boxes. You must select Set by User if you want to setup keypanels in file mode. You must also select this option if your 
intercom system master controller cannot correctly determine (in online mode with the Reported by Intercom radio button 
selected) the type of keypanel connected to the intercom port.

Most of the keypanel types in the Type list box are self-explanatory, being various models of keypanels. A few selections, such 
as the TIF interface and the CDP-950 may not be thought of as keypanels, though they are specialized types of keypanels. 

If you are using one (1) or more GPI inputs to activate key assignments at a particular intercom port, we recommend you set 
Show Type to Set by User, and then set the Type list box for the Main Panel to Virtual. This helps to remind you, GPI inputs 
are being used to control key assignments for this port. For more information on this subject, see System GPI Description.
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Reported by Intercom Radio Button

The Reported by Intercom radio button enables the master controller to display the type of keypanel you select to view. You 
must be in online mode for this option to work properly.

Setup Page Options Group Box

Setup Restrict Check Box

The Setup Restrict check box indicates the keypanel operator cannot change the setup page they are viewing. By default, 
keypanel operators can change the setup page usage from their keypanels. If you do not want the keypanel operator to do this, 
select the Setup Restrict check box.

Advanced Page

The Advanced Page, as shown in Figure 197, is used to further configure options for the selected port, such as priority levels, 
panel poll delay time, listen destinations, etc.

FIGURE 197. Keypanel/Port Configuration - Advanced Page
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Priorities Group Box

IFB Priority Field

The IFB Priority field indicates the default IFB priority level for the selected port. This means any IFB assigned to this 
keypanel is assigned this priority automatically. You can change individual priority levels using the IFB Priority window. For 
more information, see “IFB Priorities Window” on page 144. 

By default, this field is set to three (3).
The range for this field is 0 to 8.

Trunk IFB Priority Field

The Trunk IFB Priority field indicates the default trunk IFB priority level for the selected port. This means any trunked IFB 
assigned to this keypanel is assigned this priority automatically. You can change individual priority levels using the IFB 
Priority window. For more information, see “IFB Priorities Window” on page 144. 

This field value can range from 0 to 8.

Trunk Priority Field

The Trunk Priority field indicates the default trunk priority level for the selected port. This means any trunk assigned to this 
keypanel is assigned this priority automatically. You can change individual priority levels using the IFB Priority window. For 
more information, see “IFB Priorities Window” on page 144. 

The range for this field is 0 to 8.

Panel Poll Delay (ms) Field

The Panel Poll Delay (ms) field indicates the amount of time, in ms, data transmissions from remote keypanel to the intercom 
system is delayed. Panel poll delay is used when a keypanel’s data line is connected to the intercom system using a modem 
link from a remote location. A slight delay in data transmission from the remote keypanel to the intercom system, may be seen 
and may cause sporadic or no operation. By setting the delay time, the intercom system waits longer for data transmissions 
from the remote keypanel.

The range for this field is 0 to 500ms.

IMPORTANT: Connect only one (1) remote keypanel per AIO card, and assign only one (1) panel poll delay per AIO 
card. In addition, since excessive poll delay can impair system performance, use the minimum delay 
required to assure proper operation of the remote keypanel. However, allow for the possibility of 
fluctuations in the delay time.
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VOX Page

The VOX page, shown in Figure 198, is used to configure VOX on the selected port. VOX is the threshold level of audio at 
which a channel becomes active. When a threshold is set, a microphone does not activate until the preset audio level is 
attained. This prevents a channel from staying on when no one is around in a high activity area.

VOX is supported in Cronus Intercom system and in intercoms with AIO-16 cards. Through AZedit, you can control enabling 
and disabling VOX, as well as setting the threshold level and the hold time.

VOX support requires the following minimum firmware versions:

Master Controller V9.25.0, or Master Controller II-e V1.1.0

DBX V1.15.0 with Peripheral Controller V10.15.0, or Peripheral Controller II-e V1.15.03

RVON-16 V2.1.1 or later

AIO-16 V1.1.0 or later

Cronus V1.1.0 or later

Enable VOX Check Box

The Enable VOX check box is used to activate VOX on the specified port.

NOTE: Cronus and the AIO-16 cards are the only devices with VOX support.

VOX Threshold Box

The VOX Threshold box displays the level, in dB, at which VOX activates on the keypanel. Use the arrows to change the 
VOX level.

The range for this field is 0.0dB to -126.0dB.

FIGURE 198. Keypanel/Port Configuration - VOX Page
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Hold Time Box

The Hold Time box displays the amount of time, in seconds, the port stays open when no activity is present. Use the arrows to 
change the Hold Time amount.

The range for this field is 0.2 seconds to 12.5 seconds.

Enabled Via UPL Statement Check Box

The Enabled Via UPL Statement check box enables VOX to be activated on a port through the use of a UPL statement.
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2-Wire Settings Page (Zeus III only)

The 2-Wire Settings window, shown in Figure 199, is used to override the Dip switch settings you set on the Zeus III unit 
using AZedit.

NOTE: CH-A or CH-B must be selected on the Zeus III for the 2-Wire Settings page to appear.

NAVIGATION: From the Keypanel/Ports window, select the Edit button.

2-Wire Settings Group Box

Use the 2-Wire Settings options to use either the currently set Dip switches, as set in the Zeus III or to override the Dip switch 
settings for the selected channel. You can set CH-A and CH-B independent from each other, if desired.

Use Dip Switch Settings Radio Button

The Use Dip Switch Settings radio button indicates the currently set Dip switch settings should be used. The current settings 
are displayed below the radio button.

FIGURE 199. 2-Wire Settings Page
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Manually Configure Settings Radio Button

The Manually Override Settings radio button allows the user to select override options to the currently set Dip switch 
options. Once the Manually Override Settings radio button is selected, the override options check boxes become active below 
the radio button.

Available options for this field are:

Half Duplex Check Box - Half-duplex operation is enabled.

Disable Noise Suppression Check Box - Noise suppression is disabled.

Gain Setup Window

The Gain Setup window, shown in Figure 200, is used to set point-to-point, party line, and I/O listen gains or to reset gain 
levels to application defaults. Gain adjustments take effect when you send your changes to the intercom system. Gain settings 
are saved in your setup file, if you save it to disk.

IMPORTANT: Do not make an adjustment here, when it would be better to adjust an Analog Input gain.

For example, suppose there is an external audio source connected at port 1, and keypanels at ports 2 
through 5 have keys assigned to listen to the external audio source. Now, suppose all of the keypanel 
operators are always turning their volume controls down when listening to port 1, and then turning them 
up again to listen to everything else. You could adjust the point-to-point listen level from port 1 to each 
of the keypanel ports. However, the real problem is the external audio coming into port 1 at a higher 
level than the normal system level. To correct this, reduce the analog input gain for port 1 instead of 
adjusting point-to-point gains for ports 2 through 5. 

NAVIGATION:  On the Kepanel/Ports window, click the gain setup icon . 

FIGURE 200. Gain Setup Window
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Point-to-Point Listen Gains Group Box

The Point-to-Point Listen Gains group box is used to adjust the level at which the currently selected intercom port hears a 
specified intercom port.

Input Port Field

The Input Port field indicates the intercom port number where the audio source is connected. You can manually enter the port 
number to which you want to adjust the listen gain level.

NOTE: You can also use the Input Port Alpha drop down menu to select the port number to which you want to change the 
listen gain level.

Input Port Alpha Drop Down Menu

The Input Port Alpha drop down menu displays a list of input ports to select from when you want to change the listen gain 
level. Once you have selected a port from this list, the Input Port field automatically populates with the input port number.

Gain Drop Down Menu

The Gain drop down menu displays a list of gain levels, in dB, from which you can select the specified input port listen gain.

The range for this field is 6.0dB to -72.2dB or Mute.

Party Line Listen Gains Group Box

The Party Line Listen Gains group box is used to adjust the level at which the currently selected intercom port hears a 
specified party line.

Party Line Field

The Party Line field indicates the port number of the party line where the audio source is connected. You can manually enter 
the port number of the party line you want to adjust the listen gain level.

NOTE: You can also use the Party Line Alpha drop down menu to select the party line port alpha to which you want to 
change the listen gain level.

Party Line Alpha Drop Down Menu

The Party Line Alpha drop down menu displays a list of party line alphas from which you can choose to change the listen 
gain level. Once you have selected an alpha from this list, the Party Line field automatically populates with the party line port 
number.

Gain Drop Down Menu

The Gain drop down menu displays a list of gain levels, in dB, from which you can set the specified party line port listen gain.

The range for this field is 6.0dB to -72.2dB or Mute.
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I/O Gains Group Box

The I/O Gains group box is used to view input gain and output gain.

Input Gain Field

The Input Gain field displays the amount of gain, in dB, the input level to the intercom port has been increased or decreased. 

The range for this field is +20dB to –20dB.

NOTE: Gain adjustments take effect when you send your changes to the intercom system. Gain settings are saved in your 
setup file if you save it to disk.

Output Gain Field

The Output Gain field displays the amount of gain, in dB, the output level to the intercom port has been increased or 
decreased. 

The range for this field is +20dB to –20dB.

NOTE: Gain adjustments take effect when you send your changes to the intercom system. Gain settings are saved in your 
setup file if you save it to disk.

Port Gain Reset Button

The Port Gain Reset button opens the gain reset window. You can choose to reset Point-to-Point listen gains and/or Party 
Line listen gains to the application defaults (0dB).

OK Button

The OK button applies the changes made and closes the Gain Setup window.

Cancel Button

The Cancel button disregards the changes made and closes the Gain Setup window.

FIGURE 201. Gain Reset Window
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Select Key Assignment Window

The Select Key Assignment window, shown in Figure 202, is used to change key assignments and special functions for listen 
and talk keys on the Keypanel/Ports window.

Select Intercom System Drop Down Menu

The Select Intercom System drop down menu indicates the intercom for which you want to see key assignments. Once you 
have selected the intercom system to view, the assignment types appear in the Type List window.

NOTE: You must have Enable Trunking Support (Options|Preferences|Advanced) selected to view other intercom 
systems in AZedit.

FIGURE 202. Select Key Assignments for Listen and Talk Keys
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Type List Window

The Type List window displays a list of assignment types from which to choose. Once an assignment type is chosen, a list of 
port numbers and their alphas appear in the #/Alpha window.

The assignment types available are as follows:

Ports

Party Lines

IFBs

IFB Special Lists

Special Lists

GPI Outputs

ISOs

UPL Resources

Special Functions

Special Functions

There are separate special functions for talk and listen keys

Special Functions For Talk Keys

All-Call (AC) - When a talk key is assigned as an All-Call talk key, activating the key also activates the talk paths 
for all talk keys to the left of it (up to, but not including another All-Call key). All Call is 
typically used for IFBs, allowing one user to talk to a group of users.

DIM - DIM (for talk level 2 assignments only, when talk level 1 is a point-to-point key assignment) This 
assignment is used with inter-panel dim tables.

Special Functions For Listen Keys

Auto-Follow (AF) - This special function causes a listen key assignment to always be the same as the talk key paired 
with it. Auto-follow is a convenient assignment because you only have to assign a listen key 
once. Then, whenever you change the talk key assignment, the listen key automatically follows 
to the new assignment.

Many users find it convenient to assign auto-follow to all listen keys. That way, they rarely 
have to bother with listen key assignments, because as they change talk key assignments, the 
listen key assignments automatically change as well. 

When you assign auto-follow to a listen key, you still have to manually activate the listen key 
to hear certain types of destinations. For example, if you activate a talk key to talk to a party 
line, you have to activate a listen key if you want to listen to the party line. The same is also 
true for belt packs connected to intercom ports. This is because party lines and belt packs 
cannot themselves activate talk crosspoints in the intercom system (the talk button on most 
belt packs is simply a microphone on/off switch). In cases where you need to activate both a 
talk and a listen key to communicate with a destination, try using auto-listen.

Auto-Listen (AL) - This special function causes a listen key assignment to always be the same as the talk key that is 
paired with it. Auto-Listen is similar to Auto-Follow except listen automatically activates 
whenever the talk key is activated. Auto-listen is an effective listen key assignment for use with 
party lines or other non-keypanel devices such as belt packs. This is because these devices do not 
have the talk-back capability that keypanels have. If you find that you are always activating the 
listen key when you want to talk to a particular destination, you might want to assign auto-listen to 
that listen key. Auto-listen is generally required when listening to party lines or belt packs from a 
keypanel that does not have listen keys.
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Auto-Mute (AM) - This special function causes a listen key assignment to always be the same as the talk key it is 
paired with. Auto-Mute is similar to Auto-Follow except listening is automatically muted when 
the talk key is activated. Auto-mute is useful for talking to devices that echo your voice back to 
you. If you need to activate the listen key when conversing with a destination, but you hear an 
echo whenever you activate the talk key, consider assigning auto mute to the listen key.

Auto-Reciprocal (AR)- This special function causes a listen key's assignment to be the same as the talk key it is paired 
with. Auto-Reciprocal is similar to Auto-Follow except listening is forced continuously on, even 
when the talk key is off. Auto-reciprocal is useful, for example, when you wish to monitor a party 
line continuously from a keypanel without actually making the keypanel a listener on the party 
line.

Auto-Table (AT) - This special function causes a listen key's assignment to be the same as the Listen Source for 
whatever IFB is currently assigned to the talk key. (You define the Listen Source during IFB 
setup.) Auto Table is convenient in a broadcast environment when a director needs 2-way 
communication with the IFB talent, and the IFB keys are being reassigned frequently during the 
course of a program to talk to new talent locations. Several IFBs can be set up in advance, and 
their Listen Sources can be defined. Then, when the IFB key is reassigned on the director 
keypanel, the Listen Source for each new IFB automatically becomes the listen key assignment 
for the IFB key.

NOTE: Use this assignment with a listen key only when the corresponding talk key has been 
assigned to an IFB.

Party Lines Window

The Party Lines window, as shown in Figure 203, is used to create a port where any number of people can talk and/or listen to 
a group. A party line (also known as a conference line) is typically used when several users of non-keypanel devices (such as 
belt packs or camera intercoms) are engaged in a specific common activity and need to talk and/or listen to each other all the 
time. For example, a TV station has two (2) control rooms and three (3) studios. Because the producers in the control rooms 
want to talk to the everyone in the individual studios (but not all the studios), a dedicated port is setup to act as a party line for 
each studio. The producer can press one (1) key (assigned to the designated party line) on the keypanel and talk to everyone 
assigned to that party line 

IMPORTANT: Do not confuse party lines and special lists.

A party line is typically used when several users of non-keypanel devices (such as belt packs or camera 
intercoms) are engaged in a specific common activity and they need to talk and/or listen to each other 
all the time. Keypanels are almost never members of party lines (although they can be). However, a 
keypanel key can be assigned to occasionally talk or listen to a party line, if desired.

A special list is used when a keypanel operator needs to occasionally talk or listen to a group of 
intercom ports that are otherwise unrelated. 

NAVIGATION: Select System|Party Lines.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 
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PL Field

The PL field indicates the party line port number for which you are configuring.

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which in turn automatically populates the Port field.

Alpha Drop Down Menu

The Alpha drop down menu indicates the party line port alpha for the port setup currently being viewed.

NOTE: Once the port alpha has been entered, the Port field populates with the corresponding name.

Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

FIGURE 203. Party Lines Window
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Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not be able to assign it to a key. Also, they are not able to assign it using keypad numeric 
entry (KP9X series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy 
it to any other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system are able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users do not have access to these scroll lists

NOTE: The AZedit check box is only selectable if trunking has been activated.

Party Line Tallies Group Box

Party Line Tallies are used when two (2) or more keypanels have keys assigned to talk to the same party line. 

NOTE: These are not keypanels that are members of the party line, but keypanels that can talk to the party line with an 
intercom key. 

For example, two (2) different keypanels have the same party line assigned to a talk key. If one (1) of the keypanels activates 
the party line talk key, the tally indication is supplied at the other keypanel. Typically, the tally indication is a flashing 
alphanumeric display (KP9X series keypanels) or a continuously lit red LED indicator (most other keypanels). The tally 
indication tells the keypanel operator that activating the party line key breaks in on a conversation already in progress.

Available selections for this field are: Local Party Line Tallies and Trunk Party Line Tallies. 

Local Check Box

The Local check box is used to enable local party line tallies on the local intercom system.

Trunk Check Box

The Trunk check box is used to enable party line tallies on a remote intercom system.

Port Column

The Port column displays a list of ports on the Intercom System.
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Alpha Column

The Alpha column displays a list of alphas for the ports on the intercom system.

P-T Column

The P-T column indicates the port is a Party Line Talker. If there is a green YES, the port is a party line talker. If a red NO 
displays, the port is not a party line talker.

P-L Column

The P-L column indicates the port is a Party Line Listener. If there is a green YES, the port is a party line listener. If a red NO 
displays, the port is not a party line listener.

Key? Column

The Key? column provides a valid indication in online or server mode only. This column indicates when an intercom port is 
talking or listening to the party line using intercom keys. It refreshes (updates with current information) frequently during 
normal operation. 

To force a refresh, do the following:

From the View menu, select Refresh.
OR
Press Ctrl+Space Bar. 

Available display options are:

§Talk - The port has a talk key pressed to talk to the party line.

§Listen - The port has a listen key pressed to listen to the party line.

§Both - The port has both a talk and listen key pressed for 2-way communication with the party line.

PL Talker Button

The PL Talker button designates the selected port as a permanent talker on the currently viewed party line assignment. This 
means this port is always able to talk. The permanent talker assignment is usually only used with non-intelligent devices (i.e. 
devices that cannot instruct the intercom system on how to route the audio). This option is usually not used with keypanels.

NOTE: You can assign both PL Talker and PL Listener on party line assignments.

PL Listener Button

The PL Listener button designates the selected port as a permanent listener on the currently viewed party line assignment. 
This means the port is always able to listen. The permanent listener assignment is usually only used with non-intelligent 
devices (i.e. devices that cannot instruct the intercom system on how to route the audio). This option is usually not used with 
keypanels.

NOTE: You are able to assign both PL Talker and PL Listener on the currently viewed party line assignment.

NOT PL Talker Button

The NOT PL Talker button removes the PL Talk assignment from the selected port.

NOT PL Listener Button

The NOT PL Listener button removes the PL Listen assignment from the selected port.
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Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.

Special Lists Window

The Special List window, shown in Figure 204, is used to configure special lists in AZedit. A special list is a group of 
intercom ports keypanel operators can talk or listen to by activating a single key. Special lists are typically used for paging, All 
Call, Group Call, etc. Using AZedit, you can define the members of the special list. Once a special list has been set up, you 
typically assign it to a keypanel key using Keypanel setup. The keypanel operator can then activate the special list key to talk 
or listen to all members of the special list.

IMPORTANT: Do not confuse special lists and party lines. 

A special list is used when a keypanel operator needs to occasionally talk or listen to a group of 
intercom ports that are otherwise unrelated. 

A party line is typically used when several users of non-keypanel devices (such as belt packs or camera 
intercoms) are engaged in a specific common activity and they need to talk and/or listen to each other 
all the time. Keypanels are almost never members of party lines (although they can be). However, a 
keypanel key can be assigned to occasionally talk or listen to a party line, if desired.

NAVIGATION: Select System|Special List.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 
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SL Field

The SL field indicates the port number for which you are configuring a special list.

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

Alpha Drop Down Menu

The Alpha drop down menu indicates the special list port alpha currently being viewed.

NOTE: Once the special list alpha has been selected, the SL field populates with the corresponding port number.

FIGURE 204. Special Lists Window
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Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they are not able to assign it using keypad numeric entry 
(KP9X series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to 
any other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users does not have access to these scroll lists.

NOTE: The AZedit check box is only selectable if trunking has been activated.

Relay Field

The Relay field contains the number assigned to a selected relay. Relays are switches that open and close. Relays are optional 
in special lists. If a relay is selected, then the relay closes when the special list currently being viewed is activated from a 
keypanel.

Alpha Drop Down Menu

The Alpha drop down menu contains the alpha assigned to the Special List currently being viewed.

NOTE: Once the relay alpha has been selected, the relay field populates with the corresponding relay number.

Port Column

The Port column displays a list of all the ports in the intercom system.
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Alpha Column

The Alpha column displays the name assigned to the port.

NOTE: You can change these names to ones that are more meaningful to keypanel operators. Click on the row where you 
want to change the name, and then press Ctrl+F12.

SL Member? Column

The SL Member? column displays whether the port is part of an special list. If the selected port belongs to a special list, a 
green Yes appears, otherwise, a red No appears in this column.

Add to SL Button

The Add to SL Button adds selected ports to a special list. When a port is added to a special list, a green Yes appears in the SL 
Member? column.

Remove from SL Button

The Remove from SL Button removes selected ports from a special list. When a port is added to a special list, a green Yes 
appears in the SL Member? column.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.
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IFBs Window

The IFB window, shown in Figure 205, displays configuration information for the IFB assignments created in your intercom 
system. IFB, also known as interrupted fold-back, interrupted feedback, or switched talk back, is a method for a keypanel 
operator to interrupt an audio source someone is listening to, and then talk to that listener. When the keypanel operator is 
finished talking and turns off the IFB key, the original audio source “folds back”, or reconnects, to the listener. IFB could be 
used, for example, to interrupt background music on a PA system while someone is paging. Mostly, though, it is used in 
broadcasting to cue talent, such as news anchors, field reporters, etc.

NOTE: Use the Edit IFB window to create or modify IFB assignments. For more information, see “Edit IFB Window” on 
page 141.

To access the Edit IFB window, do the following:

Double-click an IFB assignment. 
The Edit IFB window appears.

NAVIGATION: Select System|IFB, from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

IFB Column

The IFB column displays the IFB number. This number is not configurable. However, you can control how many IFBs are 
available for use by changing the intercom configuration settings. See, “Intercom Configuration Window” on page 52.

Alpha Column 

The Alpha column displays the name assigned to the IFB. Default names are IF01, IF02, etc. You can change these names to 
ones that are more meaningful to keypanel operators. See, “Alpha Windows” on page 227.

DIM Column

The DIM column displays the dim level, in dB, for program audio. 

The range for this field is -72.2dB to 1.0dB and MUTE. MUTE indicates there is no dimming value and the program audio 
mutes during IFB operation.

FIGURE 205. IFBs Window
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LC Column

The LC column displays the scroll enable settings: LC indicates Local, TK indicates Trunk, and AE indicates AZedit. For 
each type of scrolling, the letters appear green if that type of scrolling is enabled, and brown (or red when selected) if that type 
of scrolling is disabled.

TK Column

The TK column displays the scroll enable settings: LC indicates Local, TK indicates Trunk, and AE indicates AZedit. For 
each type of scrolling, the letters appear green if that type of scrolling is enabled, and brown (or red when selected) if that type 
of scrolling is disabled.

AE Column

The AE column displays the scroll enable settings: LC indicates Local, TK indicates Trunk, and AE indicates AZedit. For 
each type of scrolling, the letters appear green if that type of scrolling is enabled, and brown (or red when selected) if that type 
of scrolling is disabled.

Input Column

The Input column displays the input port number for the selected IFB. This is the source that is interrupted when the IFB is 

used. This is typically the mix minus1 for the IFB

Alpha Column

The Alpha column displays the input port alpha for the selected IFB.

Output Column

The Output column displays the output port for the selected IFB.

Alpha Column

The Alpha column displays the output port alpha for the selected IFB.

Listen Column

The Listen column displays the listen audio source to which the destination is listening. This is uninterrupted audio.

Alpha Column

The Alpha column displays the listen source port alpha for the selected listen source.

Gain Column

The Gain column displays the analog output gain for the intercom port designated as the IFB Output. If the IFB listening 
device connected to the output port does not have a volume control, you can adjust the analog output gain to suit the listener's 
preference. Adjust the analog output gain through either AZedit (System|Gains|Input/Output Gains) or from an LCP-102 
operating in PAP mode.

1. Mix Minus is the final mix of the audio minus what the listener has requested to be removed from the mix.
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Edit IFB Window

The Edit IFB window, shown in Figure 206, is used to configure IFB assignments in your intercom system.

NOTE: Remember to send any changes you make to the intercom system using Online|Send Changes or the Activate 

button. 

IFB

The IFB group box displays the IFB Number and Alpha. You can modify the Alpha using the IFB Alpha screen (Alphas|IFB). 
See, “Alpha Windows” on page 227.

Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

FIGURE 206. Edit IFB Window
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Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they cannot assign it using keypad numeric entry (KP9X 
series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to any 
other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users do not have access to these scroll lists.

NOTE: The AZedit check box is only selectable if trunking has been activated.

Input Group Box

Port Number Field

The Port Number field indicates the Program Input port. Program Input is audio coming into the Matrix. Program input is 
sometimes referred to as Mix Minus (-).

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the IFB port alpha currently being viewed.

NOTE: Once the IFB alpha has been selected, the Port field populates with the corresponding IFB port number.
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Output Group Box

Port Number Field

The Port Number field indicates the IFB output port. The IFB Output is the audio heard by the talent. For example, the 
Program Input plus the Talent’s mic (so they can hear themselves talk) is routed and heard as the IFB output.

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the IFB output port alpha currently being viewed.

NOTE: Once the IFB output port alpha has been selected, the Port field populates with the corresponding port number.

Dim Level Drop Down Menu

The Dim Level drop down menu allows you to choose to diminish the speaker or headphone audio level by a specific amount. 

The range for this field is –1.0dB to –72.2dB and MUTE.

NOTE: By default, the audio source mutes while the keypanel operator is talking. If you want the signal to diminish by a 
certain amount during IFB, select a different amount in the DIM Level drop down list.

Output Gain Field

The Output Gain field displays the analog output gain (in dB) for the intercom port designated as the IFB output. If the IFB 
listening device connected to the output port does not have volume control, you can adjust the output gain to suit the listener’s 
preferences on the Analog Input/Output Gains screen or from and LCP-102 operating in PAP mode.

This field cannot be modified. 

Change the output gain for the port using the Analog Gain Input/Output Window (Systems|Gain|Input/Output). For more 
information, see “Input/Output Gains Window” on page 220.

Listen Source Group Box

The Listen Source is audio usually mixed into the program input. 

For example, anchors desk mic audio (listen source audio) mixed into the newscast (program input). Or, the talent’s pre-fade 
mic is used as the listen source so the talent can always be heard by the keypanel operator.

Port Number Field

The Port Number field indicates the Listen Source port.

NOTE: Once the port number has been entered, the alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.



144  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the listen source port alpha currently being viewed.

NOTE: Once the IFB output port alpha has been selected, the Port field populates with the corresponding port number. 
For more information, see AT on page 131.

IFB Priorities Window

The IFB Priorities window, shown in Figure 207, is used to configure the IFB Port priority. This allows you to put higher 
priority on specific IFB assignments over other IFB assignments.

NAVIGATION: Select System|IFB Priority from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

FIGURE 207. IFB Priorities Window
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Set Priority of Selected Ports Group Box

The Set Priority of Selected Ports group box allows the user to determine which keypanel gets first access to an IFB in cases 
where two (2) or more keypanels are trying to access the IFB at the same time. By default, the IFB priority for each intercom 
port can be individually set from 0 through 3. With the priority set to 3, the keypanel overrides any other keypanel set to a 
lower priority. Keypanels that are set to the same priority can simultaneously access IFBs.

NOTE: You can add more IFB priority levels (up to 8) in the intercom configuration settings (Options|Intercom 
Configuration|Options Page). For more information, see “Intercom Configuration Window” on page 52.

Port

The Port column displays a list of IFB ports on the intercom system.

Alpha

The Alpha column displays a list of alphas (if applicable) for the IFB ports on the intercom system.

Priority

The Priority column displays the priority level for the selected IFB port.

FIGURE 208.  IFB Priority Levels
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Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button is used to clear any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.
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IFB Listen Destination Window

The IFB Listen Destination window, shown in Figure 209, is used to configure the listen destinations for an IFB. 

NAVIGATION: Select System|IFB Listen Destination from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Port Field

The Port field contains the port number of the origin to which you want the listener port to connect.

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

FIGURE 209. IFB Listen Source Window
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Alpha Drop Down Menu

The Alpha drop down menu indicates the IFB listen origination port alpha.

NOTE: Once the alpha has been entered, the Port field populates with the corresponding name.

Set Listen Output Button

The Set Listen Output button assigns the selected destination listen port to the selected port in the Listener column.

Listener column

The Listener column displays the listen destination port.

Alpha column

The Alpha column displays the listen destination alpha.

Output column

The Output column displays the listen origin port.

Alpha column

The Alpha column displays the listen origin alpha.

Reset Button

The Reset button is used to return selected IFB listen destinations to their original configuration. Use the Select All, Invert 
Selections and De-Select All button to select the IFB listen destinations with which you want to work.

To select several individual ports, do the following:

1. Press Ctrl on the keyboard.

2. With the mouse, click the different ports you want to select.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.
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IFB Special Lists Window

The IFB Special Lists window, shown in Figure 210, is used to create and maintain IFB Special Lists. An IFB Special List is 
similar to a Special List, except the members are IFBs instead of ports. 

NOTE: Requires the following minimum firmware versions:

Master Controller v9.22.0

DVX v1.13.0 with Peripheral Controller v10.13.0

TM-2000 v8.5.1 (for remote access to IFB SLs)

NAVIGATION: Select System|IFB Special Lists from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

FIGURE 210. IFB Special Lists Window
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IFB SL Field

The IFB SL field indicates the IFB special list number. By default, you can have 32 IFB SLs. However, the number of IFB 
SLs is a configurable option on the Resources page of the Intercom Configuration window, found on page 52. You can 
designate the number of IFB SLs from 0-999.

NOTE: Once the IFB SL number has been entered, the Alpha drop down menu populates with the corresponding name. 
You can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

Alpha Drop Down Menu

The Alpha drop down menu displays a list of IFB special list port alphas from which to select.

NOTE: Once the alpha has been entered, the IFB SL field populates with the corresponding number.

Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they cannot assign it using keypad numeric entry (KP9X 
series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to any 
other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users do not have access to these scroll lists.

The AZedit check box is only selectable if trunking has been activated.

NOTE: Once the port alpha has been selected, the SL field populates with the corresponding name.
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IFB Column

The IFB column displays a list of IFBs that can be added to the IFB special list. This number is not configurable. However, 
you can control how many IFBs are available for use by changing the intercom configuration settings, see “Intercom 
Configuration Window” on page 52.

Alpha Column

The Alpha column displays the name assigned to the IFB. Default names are IF01, IF02, etc. You can change these names 
using the IFB SL Alphas screen. For more information, see “Alpha Windows” on page 227.

IFB SL Member? Column

The IFB SL Member? column displays whether the IFB is part of an IFB SL. If the selected port belongs to a special list, a 
green Yes appears, otherwise, a red No appears in this column.

Add to IFB SL Button

The Add to IFB SL button adds selected IFBs to an IFB special list.

Remove from IFB SL Button

The Remove from IFB SL button removes selected IFBs from the IFB special list.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.



152  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Program Listen Source Window

The Program (PGM) Listen Source window, shown in Figure 211, is used to direct the IFB PGM Listen Source audio when 
the IFB Program Input changes. The Program Listen Source Window is only used when IFB PGM Input changes are made 
using a UPL (User Programmable Logic) Statement, PAP-32 (Program Assign Panel), or an LCP-102 (Level Control Panel).

NAVIGATION: Select System|PGM Listen Source from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Port Field

The Port field contains the port number for the PGM Listen Source (for example, news anchor’s desk microphone). Once the 
port is entered, the Alpha drop down list populates with the ports associated alpha.

FIGURE 211. Program Listen Source Window
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Alpha Drop Down Menu

The Alpha drop down menu displays a list of program listen source port alphas from which the user can select. Once the port 
alpha is chosen, the port field automatically populates with the corresponding port number.

Use the Port Alphas window to change the name of the port alpha. 

To access the Port Alphas window, do the following:

From the Alphas menu, select Port.
The Port Alphas window appears.
OR

Click the Alphas icon in the navigation toolbar. 
The Port Alphas window appears.

Set Listen Source Button

The Set Listen Source button sets the IFB PGM listen source for the selected Program Input (Input column).

Input Column

The Input Column displays a list of IFB program input ports in the intercom system.

Alpha Column

The Alpha column displays the IFB program port alpha for the corresponding program input port.

Listen Column

The Listen column displays the port number of the program listen source you assign to the selected program input port.

Alpha Column

The Alpha column displays the port alpha of the program listen source you assign to the selected program input port.

None Button

The None button clears the listen source assignment information when the program input assignment changes. When assigned, 
a dash (-) appears in the listen and alpha columns.

No Change Button

The No Change button indicates the listen source assignment information does not change when the program input 
assignment changes. When assigned, No Change appears in the listen column.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.
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Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.

GPI Output Window

The GPI Output window, shown in Figure 212, is used to display the configuration information for GPI Outputs. 

NAVIGATION: Select System|GPI Output from the menu bar.

NOTE: Use the Edit GPI Output window to create or modify a GPI Output. For more information, see “Edit GPI Output 
Window” on page 156.

To access the Edit GPI Output window, do the following:

Double-click the GPI Output for which you want to edit. 
The Edit GPI Output window appears. 

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

RY Column

The RY column displays the GPI Output number. This number is not configurable. However, you can control how many GPI 
Outputs are available for use by changing the intercom configuration (see “GPI Outputs Field” on page 55).

Alpha Column

The Alpha column displays the name assigned to the GPI Output. Changes can be made to the Alpha using the GPI Output 
Alphas window (Alphas|GPI Output).

FIGURE 212. GPI Outputs Window
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LC Column

The LC column displays the local scroll enable settings. A red LC indicates local scroll enable is not active. A green LC 
indicates local scroll enable is active.

TK Column

The TK column displays the trunk scroll enable settings. A red TK indicates trunk scroll enable is not active. A green TK 
indicates trunk scroll enable is active.

AE Column

The AE column displays the AZedit scroll enable settings. A red AE indicates AZedit scroll enable is not active. A green AE 
indicates AZedit scroll enable is active.

Input Column

The Input column displays the GPI input port number configured for the GPI Input

Alpha Column

The Alpha column displays the GPI input port alpha configured for the GPI Input

Output Column

The Output column displays the GPI output port number configured for the GPI Output.

Alpha Column

The Alpha column displays the GPI output port alpha configured for the GPI Output.

Status Column

The Status column displays status information in online or server mode. If the GPI Output is activated, On appears; otherwise, 
Off appears. The information in this column updates periodically. 

To force an update, do the following:

From the View menu, select Refresh.
OR
Press Ctrl+Space on the keyboard.
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Edit GPI Output Window

The Edit GPI Output window, shown in Figure 213, is used to configure GPI outputs you want to use in your intercom 
system.

GPI Output Group Box

The GPI Output group box displays the GPI Output Number and Alpha. You can modify the Alpha using the GPI Output 
Alpha screen (Alphas|GPI Output).

Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys.

AZedit allows you to manage scroll lists within your intercom system by the following:

Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they cannot assign it using keypad numeric entry (KP9X 
series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to any 
other key.

FIGURE 213. Edit GPI Output Window
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Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users do not have access to these scroll lists.

NOTE: The AZedit check box is only selectable if trunking has been activated.

Input Group Box

Port Number Field

The Port Number field indicates the GPI Input port. 

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the GPI Input port alpha currently being viewed.

NOTE: Once the alpha has been selected, the Port field populates with the corresponding port number.

Output Group Box

Port Number Field

The Port Number field indicates the GPI Output port.

NOTE: Once the port number has been entered, the Alpha drop down menu populates with the corresponding name. You 
can also populate the Alpha drop down menu first, which, in turn, automatically populates the Port field.

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the GPI Output port alpha currently being viewed.

NOTE: Once the alpha has been selected, the Port field populates with the corresponding port number.
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GPI Input Window

The GPI Input window, shown in Figure 214, is used to display the configuration information for the intercom system GPI 
Inputs. GPI Inputs can be used to activate key assignments, as inputs to UPL statements and for many other applications. 

NAVIGATION: Select System|GPI Input from the menu bar.

NOTE: Use the Edit GPI Input window to create or modify a GPI Output. For more information, see “Edit GPI Input 
Window” on page 159.

To access the Edit GPI Input window, do the following:

Double-click the GPI Input for which you want to edit. 
The Edit GPI Input window appears. 

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

GPI Input Column

The GPI Input column displays the GPI Input number. This number cannot be modified. However, you can control the 
number of GPI Inputs available for use by changing the intercom configuration (Options|Configuration). The basic system 
hardware has eight (8) GPI Inputs. If you do not have additional UIO-256 or GPIO-16 frames attached, you can limit your GPI 
Inputs to eight (8).

Keypanel Column

The Keypanel column displays the keypanel number assigned to activate by the GPI Input.

Keypanel Alpha Column

The Keypanel Alpha column displays the keypanel alpha of the keypanel activated by the GPI Input.

Key Column

The Key column displays the key assigned to be activated by the GPI Input.

FIGURE 214. GPI Inputs Window
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Key Type Column

The Key Type column displays the type of key activated by the GPI Input - either Talk or Listen. This column is blank when 
No Key is selected as the key type.

NOTE: You can temporarily deactivate a GPI input by checking the No Key box. This is the same as entering 0 for the 
key number. The No Key assignment is included so that you can reactivate the GPI input again later without 
having to redefine all of the parameters.

Status Column

The Status column displays status information in online or SERVER mode. If the GPI Input is active, On appears. Otherwise, 
Off appears. The information in this column updates periodically. 

To force an update, do the following: 

From the View menu, select Refresh.

Edit GPI Input Window

The Edit GPI Input window, shown in Figure 215, is used to configure the GPI Input to select the intercom port and the 
intercom key activated whenever the selected GPI input is activated. There does not have to be an actual keypanel installed at 
the selected intercom port. Each GPI input itself acts like a key. Alternatively, you can connect a keypanel to the intercom port 
and set up one (1) or more GPI inputs as well. This would allow you to activate key assignments not only by pressing the 
keypanel keys, but also by activating the GPI inputs.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

FIGURE 215. Edit GPI Input Window
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GPI Input Group Box

The GPI Input group box displays the number assigned to the GPI Input. This number cannot be modified. However, you can 
control the number of GPI Inputs available for use by changing the intercom configuration (Options|Configuration).

NOTE: Without a UIO-256, there are only eight (8) GPI Inputs with the basic system.

Keypanel Group Box

Port Number Field

The Port Number field indicates the port number of the keypanel activated by the GPI Input. When you populate this field, 
the corresponding Port Alpha appears in the drop down menu.

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the port alpha of the keypanel activated by the GPI Input. When you select a Port 
Alpha from the list, the corresponding Port Number appears in the port number field.

Key Number Group Box

Number Field

The Number field indicates the actual keypanel key number activated by the GPI Input. Numbering of keys begins at the 
bottom left, ending at the top right.

NOTE: Keypanel numbering differs between keypanel types.

FIGURE 216. Keypanel Numbering
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Key Type Group Box

The Key Type radio buttons are used to select the type of key activated by the GPI Input. 

Selections available are:

Talk Radio Button - Sets the GPI port as a Talk key.

Listen Radio Button - Sets the GPI port as a Listen key.

No Key Radio Button - Temporarily deactivates a GPI input. This is the same as entering 0 for the key number. 
The No Key assignment is included so you can reactivate the GPI input again later without 
having to redefine all of the parameters.

ISO Window

The ISO (Isolate) window, shown in Figure 217, displays configuration settings for ISOs in the intercom system. An ISO is a 
type of key assignment used by a keypanel operator to separate an intercom port completely from the rest of the intercom 
system. ISOs are used when a user wants to have a private conversation with a particular intercom port. There is also an 
option, called ISO Self, that cuts the keypanel operator’s keypanel off from the rest of the intercom system. When the ISO key 
is released, normal intercom operation is automatically restored. 

ISO is often used in a broadcasting environment, and may be referred to as Camera ISO. In this application, camera operators 
are often assigned to a party line. ISO provides a means for a keypanel operator to isolate a particular camera from the party 
line to direct the camera operator without outside interference. 

Once all configurations have been sent to the intercom system, the keypanel operator is able to isolate the specified ISO output 
by pressing the ISO key.

NAVIGATION: Select System|ISO from the menu bar.

NOTE: Use the Edit ISO window to create or modify an ISO. For more information, see “Edit ISO Window” on 
page 163.

To access the Edit ISO window, do the following:

Double-click the ISO for which you want to edit. 
The Edit ISO window appears. 

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button.
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ISO Column

The ISO column displays the default ISO number (001, 002, etc.). This number cannot be modified. 

Alpha Column

The Alpha column displays the name assigned to each ISO. You can change the default alphas (IS01, IS02, etc.) to more 
meaningful names using the Alpha ISO window (Alphas|ISO). 

NOTE: The Alpha Size selected from the “Preferred Alpha Size Drop Down Menu” on page 97, determines the length of 
Alpha allowed. Selections are 4-, 6- and 8-character lengths.

ISO Self? Column

The ISO Self? column displays whether the keypanel’s active talk key assignment is suspended while the ISO key is pressed.

LC Column

The LC column displays the local scroll enable settings. A red LC indicates local scroll enable is not active. A green LC 
indicates local scroll enable is active.

TK Column

The TK column displays the trunk scroll enable settings. A red TK indicates trunk scroll enable is not active. A green TK 
indicates trunk scroll enable is active.

AE Column

The AE column displays the AZedit scroll enable settings. A red AE indicates AZedit scroll enable is not active. A green AE 
indicates AZedit scroll enable is active.

FIGURE 217. ISO Window
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Output Port Column

The Output Port column displays the port number of the port to isolate when the ISO key is pressed.

Output Port Alpha Column

The Output Port Alpha column displays the port alpha of the port to isolate when the ISO key is pressed.

Edit ISO Window

The Edit ISO window, shown in Figure 218, is used to configure ISO assignments in the intercom system.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

ISO Group Box

The ISO group box displays the ISO Number and Alpha. You can modify the Alpha using the ISO Alpha screen 
(Alphas|ISO).

Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

FIGURE 218. Edit ISO Window
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Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also they cannot assign it using keypad numeric entry (KP9X 
series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to any 
other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users cannot have access to these scroll lists.

NOTE: The AZedit check box is only selectable if trunking has been activated.

Options Group Box

ISO Self? Check Box

The ISO Self? check box indicates the keypanel operator’s talk key is suspended while the ISO key is active. By selecting this 
option, the keypanel operator, when the ISO key is selected, cannot be interrupted by another caller.

Output Group Box

Port Number Field

The Port Number field indicates the port number of the port to isolate when the ISO key is pressed. Once the port number 
field is populated, the corresponding port alpha appears in the port alpha drop down menu.

Port Alpha Drop Down Menu

The Port Alpha drop down menu indicates the port alpha of the port to isolate when the ISO key is pressed. Once the port 
alpha is selected from the drop down menu, the corresponding port number appears in the port number field.
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GPIO-16s Window

The GPIO-16s window, shown in Figure 219, displays the setup options selected for each GPIO-16 frame configured in the 
intercom system. 

NAVIGATION: Select System|GPIO-16 from the menu bar.

NOTE: Use the Edit GPIO-16 window to create or modify a GPIO-16. For more information, see “Edit GPIO-16 
Window” on page 166.

To access the Edit GPIO-16 window, do the following:

Double-click the GPIO-16 for which you want to edit. 
The Edit GPIO-16 window appears. 

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

GPIO-16 Column

The GPIO-16 column displays the GPIO-16 relay group number. By default, AZedit is configured for six (6) groups (each 
group consisting of 16 relays). 

This field can contain up to 16 groups (with a maximum of 256 relays).

Ethernet? Column

The Ethernet? column displays whether or not Ethernet is enabled on the GPIO-16 device.

IP Address Column

The IP Address column displays the IP Address assigned to the GPIO-16 device.

FIGURE 219. GPIO-16 System Window
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Description Column

The Description column displays a brief description of the GPIO-16 device. This description is created in the GPIO-16 
Configuration screen (Options|GPIO-16 Configuration). For more information, see “GPIO-16 Configuration Window” on 
page 81.

Edit GPIO-16 Window

The Edit GPIO-16 window, shown in Figure 220, is used to modify existing GPIO-16 device settings, such as IP Address, 
and Ethernet connectivity. For complete configuration options, see “GPIO-16 Configuration Window” on page 81.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

GPIO-16 Group Box

The GPIO-16 group box displays the GPIO-16 relay group number. 

This number cannot be modified.

Configuration Group Box

Ethernet Connection Check Box

The Ethernet Connection check box enables Ethernet on the GPIO-16 device.

IP Address Field

The IP Address field indicates the IP Address for the selected GPIO-16 device.

FIGURE 220. Edit GPIO-16 Window
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Browse Button

The GPIO-16 Browse button opens the Select GPIO-16 window. From this window, you can select a GPIO-16 device from a 
list of all the devices on the local network that can respond to a broadcast. For more information, see “Select GPIO-16 
Window” on page 167.

NOTE: If this is the first time the GPIO-16 is being used, only the MAC Address of the unit appears.

Select GPIO-16 Window

The Select GPIO-16 window, shown in Figure 221, is used to select a GPIO-16 device from a list of all the devices on the 
local network that can respond to a broadcast. The MAC Address, IP Address, and a description of the device are displayed in 
the window.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

MAC Address Column

The MAC Address column displays the MAC Address of the GPIO-16.

NOTE: If this is the first time the GPIO-16 is being used, only the MAC Address of the unit appears.

IP Address Column

The IP Address column displays the IP Address of the GPIO-16 device. 

NOTE: If this is the first time you are connecting the GPIO-16, this column may be blank.

Description Column 

The Description column displays a unique description of the GPIO-16. This description is configured in the GPIO-16 
Configuration screen (Options|GPIO-16 Configuration…).

FIGURE 221. Select GPIO-16 Window
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Assignment Group Window

The Assignment Group window, shown in Figure 222, is used to configure Assignment Groups to be used in your intercom 
system. Assignment Groups are lists of random key assignments (both local and remote) of any key type, which is available in 
a single scroll list, to any keypanel. Assignment Groups logically group different types of key assignments into one (1) single 
scroll list. 

For example, you can combine all ports, party lines, and IFBs associated to a studio into one (1) assignment group that can 
then be called up by a keypanel. 

An Assignment Group has an alpha and description, as well as scroll restriction flags. They are not available to remote 
intercoms, however assignment groups can have remote keys assigned to them. In addition, assignment groups can contain 
key assignments that are scroll restricted.

NOTE: At the keypanel, press PGM/SEL in an idle state that brings up a list of Assignment Groups sorted by alpha. 
Press PGM/SEL again to select a specific group. 

Requires the following minimum firmware versions:

Master Controller v9.22.0

DBX v1.13.0 with Peripheral Controller v10.13.0

KP-32 v2.0.1

KP-96 v8.9

NAVIGATION: From the menu bar, select System|Assignment Groups.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 
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Group Field

The Group field indicates the assignment group number. By default, there are 32 assignment group positions available. Using 
the Intercom Configuration window (Options|Intercom Configuration), you can set the number of assignment groups to 
allow.

When the Group field is entered, the alpha drop down menu automatically populates with the corresponding alpha name.

The range for this field is 1 to 999.

Alpha Drop Down Menu

The Alpha drop down menu indicates the alpha name attached to the group number. When the Alpha name is selected from 
the drop down list, the group field automatically populates with the corresponding group number.

FIGURE 222. Assignment Group Window
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Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they are not able to assign it using keypad numeric entry 
(KP9X series keypanels). And, if the destination name appears in any display on their keypanel, they cannot copy it to any 
other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system are able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

NOTE:

If you clear the check box, remote AZedit users do not have access to these scroll lists.

The AZedit check box is only selectable if trunking has been activated.

Once the port alpha has been selected, the SL field populates with the corresponding name.

Alpha Column

The Alpha column displays Alpha of the assignment type in the assignment group. 

Intercom Column

The Intercom column displays the intercom name where the key assignment resides. Because AZedit supports trunking 
systems, multiple intercom systems may be connected and share port assignments.

Type Column 

The Type column displays the type of assignment for that port.

Number Column 

The Number column displays the port number where the assignment resides.



AZedit Intercom Software Setup Windows  171

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Member? Column 

The Member? column displays whether a key assignment is part of an Assignment Group. A Y appears in the column 
indicating it is part of the group.

Add To Group Button

The Add To Group button opens the Select Key Assignment window. From this window you can select different key 
assignments to add to the assignment group. For more information, see “Select Key Assignment Window” on page 129.

Remove From Group Button

The Remove From Group button removes selected key assignments from the currently viewed Assignment group.

To select all the key assignments in an assignment group, do the following: 

1. Select the top assignment. 

2. Press and hold Ctrl+Shift.

3. Select the bottom assignment.
All the assignments are highlighted.

To select specific key assignments from the assignment group, do the following:

1. Press Ctrl.

2. Click the assignments you want.

LCP-102 Window

The LCP-102 window, shown in Figure 223, is used to configure LCP-102 panels in the intercom system. The LCP-102 
combines the features of an Analog I/O Gain Adjustment Panel, a Camera Delegate Panel, and a Program Assign Panel in a 
single frame. 

It is easy to switch between its three panel modes and make rapid configuration changes using the menu selector on the front 
panel. In each mode, you can make up to 64 assignments and then adjust the levels for those assignments.

For example, in TRIMS mode, you can assign and adjust the analog input and output gains for up to 64 intercom ports. In PAP 
mode, you can select the program input source and set its level for each of 64 IFBs. In CDP mode, you can assign up to 64 
intercom ports to any combination of party lines and then adjust the listen level for each participant on that party line. The 
LCP-102 connects to the auxiliary data port of any ADAM or ADAM CS Intercom System, and it also has a loop connector 
for connection to another auxiliary device, such as another LCP-102, or a UIO-256 Universal Input/Output frame. Since a 
single LCP-102 provides trim adjustments for 64 ports, only one (1) unit is required to configure an ADAM CS Intercom 
System completely. For larger ADAM Intercom Systems, up to 15 additional LCP-102 frames can be connected via the loop 
connectors.

NOTE: In AZedit adjusting analog I/O gains is the same as adjusting analog I/O trims at an LCP-102. In addition, in the 
LCP-102 setup screen the Analog I/O Gains mode is the same as TRIMS mode at an LCP-102.

NAVIGATION: Select System|LCP-102 Assignment from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 
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LCP-102 Group Box

LCP-102 Frame ID/Polling ID Drop Down Menu

The LCP-102 Frame ID/Polling ID drop down menu is used to select the LCP-102 Frame ID and Polling ID you want to 
display. 

In a multiple frame system, the different frames are designated as follows:

1: 012: 01

1: 022: 02

1: 032: 03

Where the 1 designates the Frame, and the 02 designates the polling ID.

LCP Description Drop Down Menu

The LCP Description drop down menu is used to select the Frame ID and Polling ID description from the drop down menu. 
Once you select the description, the FrameID/PollingID populates with the corresponding information.

FIGURE 223. LCP-102 Window
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Mode Group Box

LCP-102 Mode Drop Down Menu

The LCP-102 Mode drop down list is used to select the LCP-102 operating mode. 

There are three (3) display modes for the LCP-102. Available options for this field are: 

I/O Gains mode - you can assign and adjust the analog input and output gains for up to 64 intercom ports. 

PAP mode - you can select the program input source and set its level for each of 64 IFBs.

CDP mode - you can assign up to 64 intercom ports to any combination of party lines and then adjust the listen level for 
each participant on that party line.

Enabled Check Box

The Enabled check box indicates an operator at the LCP-102 can access the currently selected mode and change settings. If 
you clear the check box, you can only access this mode and change settings using AZedit.

Setup Page 1 through Page 4 Group Box

LCP Key Assignment Field

The LCP Key Assignment field identifies the assignment for the key. You can manually add the assignment or you can right 
click and select Change Assignment, which displays the Select Key Assignment window. For more information, see “Select 
Key Assignment Window” on page 129.

NOTE: Active appears next to the page number that is currently the active page on the LCP-102.

Change Setup Button

The Change Setup button opens the Select Active Setup Page window. 

Select Active Setup Page

From this window, select the setup page radio button you want to set as the active Setup Page.

Available selections are: Page1, Page 2, Page 3, and Page 4.

FIGURE 224. Select Active Setup Page Window
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PAP-32 Window

The PAP-32 window, shown in Figure 225, is used to configure the PAP-32 in the intercom system. A PAP is an optional rack-
mount component that lets a user select program input ports for IFBs without having to run AZedit. Changes made at the 
Program Assign Panel also appear in the IFB main screen in the configuration program.

NAVIGATION: Select System|PAP-32 Assignment from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

PAP-32 Drop Down Menu

The PAP-32 drop down menu is used to select the PAP-32 numbered resource (up to 15) you want to configure. Once you 
select the PAP-32 number, the PAP-32 Description automatically displays the corresponding description.

FIGURE 225. PAP-32 Setup Window
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PAP-32 Description Drop Down Menu

The PAP-32 Description drop down menu is used to select the PAP-32 resource you want to configure. Once you select the 
PAP-32 description, the PAP-32 number automatically displays the corresponding number.

Panel Drop Down Menu

The Panel drop down menu is used to select which PAP panel you are currently configuring. By default, you have a main 
panel and three (3) expansion panels. 

Program Inputs Group Box

Page Drop Down Menu

The Page drop down menu is used to select which PAP page you want to work with. 

Up to eight (8) pages are available.

To select the PAP page, do the following

Use the drop down button to make your selection.
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(R) Restrict Check Box

The (R) Restrict check box is used to prevent a keypanel operator from changing a key assignment. (Alternatively, press 
Ctrl+R on the computer keyboard while selecting the key assignment.)

Program Input Assignment Fields

The Program Input Assignment fields display the port for the source of audio. You can manually add the assignment or you 
can right click and select Change Assignment, which displays the Select Key Assignment window. For more information, see 
“Select Key Assignment Window” on page 129.

Page Lock Check Box

The Page Lock check box is used to lock the current page configuration so assignments are not configurable from the front 
panel of the PAP.

IFBs Group Box

Page Drop Down Menu

The Page drop down menu is used to select which IFB page you want to work with. 

Up to eight (8) pages are available.

To select the IFB page, do the following

Use the drop down button to make your selection.
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(R) Restrict Check Box

The (R) Restrict check box is used to prevent a keypanel operator from changing a key assignment. (Alternatively, press 
Ctrl+R on the computer keyboard while selecting the key assignment.)

IFB Assignment Fields

The IFB Assignment fields display the port for the destination of audio. You can manually add the assignment or you can 
right-click and select Change Assignment, which displays the Select Key Assignment window. For more information, see 
“Select Key Assignment Window” on page 129.

Page Lock Check Box

The Page Lock check box is used to lock the current page configuration so assignments are not configurable from the front 
panel of the PAP.

ARP-32 Window

The ARP-32 (Audio Routing Panel) window, shown in Figure 226, is used to configure the ARP-32 device within the 
intercom system. The ARP-32 provides the user with the ability to assign one of up to 16 crosspoints and/or up to 16 different 
crosspoints. Through the use of up to three (3) expansion panels, allowing for a total of 64 input keys and 63 output keys, in 
addition to the scroll key.

The sum total of ARPs and LCP-102s cannot exceed 15 in a system. The ARP-32 works with ADAM intercom matrix system 
with a MCII-e only. The ARP-32’s key assignments and setup page assignments are stored by the ADAM MCII-e controller, 
and downloaded to the panel when it powers up. Changes made at the ARP-32 are automatically saved by the MCII-e. 
Changes can also be made using AZedit. ARP firmware version 0.0.1 and later allows configuration of crosspoint connections.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 
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ARP-32 Drop Down Menu

The ARP-32 drop down menu is used to select the ARP-32 numbered resource (up to 15) you want to configure. Once you 
select the ARP-32 number, the ARP-32 Description automatically displays the corresponding description.

ARP-32 Description Drop Down Menu

The ARP-32 Description drop down menu is used to select the ARP-32 resource you want to configure. Once you select the 
ARP-32 description, the ARP-32 resource automatically displays the corresponding number.

Panel Drop Down Menu

The Panel drop down menu is used to select which ARP panel you are currently configuring. By default, you have a main 
panel and three (3) expansion panels. 

FIGURE 226. ARP-32 Setup Window
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Inputs Group Box

Page Drop Down Menu

The Page drop down menu is used to select which Input page you want to work with. 

Up to eight (8) pages are available.

To select the ARP page, do the following

Use the drop down button to make your selection.

(R) Restrict Check Box

The (R) Restrict check box is used to prevent a keypanel operator from changing a key assignment. (Alternatively, press 
Ctrl+R on the computer keyboard while selecting the key assignment.)

Input Assignment Fields

The Input Assignment fields display the port for the source of audio. You can manually add the assignment or you can 
right-click and select Change Assignment, which displays the Select Key Assignment window. For more information, see 
“Select Key Assignment Window” on page 129.

Page Lock Check Box

The Page Lock check box is used to lock the current page configuration so assignments are not configurable from the front 
panel of the ARP.

Outputs Group Box

Page Drop Down Menu

The Page drop down menu is used to select the Output page with which you want to work. 

Up to eight (8) pages are available.
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To select the ARP page, do the following

Use the drop down button to make your selection.

(R) Restrict Check Box

The (R) Restrict check box is used to prevent a keypanel operator from changing a key assignment. (Alternatively, press 
Ctrl+R on the computer keyboard while selecting the key assignment.)

Output Assignment Fields

The Output Assignment fields display the port for the destination of audio. You can manually add the assignment or you can 
right-click and select Change Assignment, which displays the Select Key Assignment window. For more information, see 
“Select Key Assignment Window” on page 129.

Page Lock Check Box

The Page Lock check box is used to lock the current page configuration so assignments are not configurable from the front 
panel of the PAP.
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Crosspoint Status Window

The Crosspoint Status window, shown in Figure 227, is used to configure and inspect crosspoint connections in the intercom 
system. A crosspoint is the point where two (2) ports intersect, in turn being able to talk and listen to each other. The crosspoint 
is basically the connecting point between the talker and the listener. There are separate talk and listen crosspoints between 
every intercom port and every other intercom port in the intercom system.In terms of crosspoints, talking from one (1) port to 
a second port is the same thing as the second port listening to the first port. However, this does not mean that any intercom port 
can arbitrarily listen to another intercom port. 

Methods of Crosspoint Activation

Keypanel Key Assignments - Crosspoints turn on and off as keypanel operators press keys to talk and listen to each other.

Forced Crosspoint - The talk and listen ports on a specific intercom can always be forced to talk/listen to another intercom 
port.

Party Lines - When an intercom port is assigned to talk and/or listen to a party line, the talk and/or listen crosspoints are 
permanently closed between that intercom port and all other intercom ports that are members of the party line. Removing a 
member from a party line releases the crosspoints. Members are assigned to party lines using party line setup.

Trunking Port - Trunk ports are shown as talk and listen in the Crosspoint Status window.

NAVIGATION: Select System|Crosspoint from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 
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Port Field

The Port field displays the port number for the port currently being viewed. 

NOTE: You can manually enter the port number in this field. Once the port is entered, the corresponding alpha appears in 
the Alpha field.

Alpha Drop Down Menu

The Alpha drop down menu displays the port alpha for the port currently being viewed.

NOTE: Once you select an alpha from the list, the corresponding port number appears in the port field.

FIGURE 227. Crosspoint Status Window
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Is Talking To... Group Box

The Is Talking To.... columns are used to select a port or multiple ports to which the currently selected port is talking to.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Port Column

The Port column displays the available port numbers.

Alpha Column

The Alpha column displays the alphas of the available ports.

Closed Column

The Closed column displays whether the crosspoint between two (2) ports is closed. If a crosspoint is closed, the port is being 
used. You can force a crosspoint by clicking the Force button.

F/I Column

The F/I column shows if the crosspoint is forced closed or inhibited.

Is Listening To... Group Box

The Is Listening To.... columns are used to select a port or multiple ports to which the currently selected port is listening to.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.
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Port Column

The Port column displays the available port numbers.

Alpha Column

The Alpha column displays the alphas of the available ports.

Closed Column

The Closed column displays whether the crosspoint is closed. If a crosspoint is closed, the port is being used. You can force a 
crosspoint by clicking the Force button.

F/I Column

The F/I column shows if the crosspoint is forced closed or inhibited. If the crosspoint is forced a green F appears in the 
column. If the port is inhibited a red I appears in the column.
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Force Button

The Force button is used to force a crosspoint closure between the port currently showing and the port or ports selected.

Inhibit Button

The Inhibit button is used to prohibit a crosspoint closure between the port currently showing and the port or ports selected.

Release Button

The Release button is used to free the crosspoint closure between the port currently showing and the port or ports selected. 

FIGURE 228. F/I Column



186  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Inspect Button

The Inspect button is used to provide detailed status information on the crosspoint connection between the port currently 
being viewed and the port selected. For more information, see “Crosspoint Inspection Window” on page 186.

Select All Button

The Select All button highlights all of the items from the Is Talking To... or Is Listening To... list.

De-Select All Button

The De-Select All button clears any selected items in the Is Talking To... or Is Listening To... list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

EXAMPLE: If ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button 
is clicked, ports 1 through 5 are deselected and ports 6 through 10 become highlighted.

Crosspoint Inspection Window

When the crosspoint is open

Input Gain and Output Gain are displayed for the affected intercom ports. 

EXAMPLE: Suppose you are inspecting the crosspoint for intercom port 1 listening to intercom port 2. Assume for a 
moment that the crosspoint was closed. In this case, the microphone signal from the person at intercom 
port 2 enters the intercom system at the port 2 input and is affected by the port 2 Analog Input Gain 
setting. The signal is internally routed to the output of intercom port 1. Assuming no other internal gain 
adjustments, the signal is only affected by the port 1 Analog Output Gain setting. AZedit already knows 

FIGURE 229. Crosspoint Inspection Window
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what settings you have entered for input and output gain, so even if the crosspoint is not closed, it 
displays the pertinent gain information as follows:

Port 2 input gain - This is the current Analog Input Gain setting for intercom port 2. A setting of +0.0dB indicates that the port 
2 input signals is entering the intercom system unaffected. Settings of +1.0dB, +2.0dB, etc. indicate that the port 2 input gain 
is being boosted. All other settings being equal, this means that all ports, including port 1 hears intercom port 2 at a higher 
level than normal. Settings of -1.0dB, 
-2.0dB, etc. have the opposite effect.

Port 1 output gain - This is the current setting for the Analog Output Gain from intercom port 1. A setting of +0.0dB indicates 
that the port 1 output signal is exiting the intercom system unaffected. Settings of +1.0dB, +2.0dB, etc. indicate that the port 1 
output gain is being boosted. All other things being equal, this means that port 1 hears all other ports, including port 2, at a 
higher level than normal. Settings of 
-1.0dB, -2.0dB, etc. have the opposite effect.
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When the crosspoint is closed

The Input and Output Gain is displayed as described above. All other pertinent gain information for the entire audio path is 
displayed as follows:

Current Gain -This is the combined effect of any or all of the following settings which might currently be activated, and which 
can all modify the gain of a crosspoint:

Crosspoint Gain 

Party Line Gain 

Inter-panel Dim Table participation 

IFB Dim Level (specified during IFB setup) 

Dim Crosspoint Volume (a UPL Statement Output Action specified during UPL statement 
setup) 

A setting of +0.0dB indicates no effect. Settings of +1.0dB, +2.0dB, etc. indicate a boost in level. Settings of -1.0dB, -2.0dB, 
etc. indicate a cut in level. Generally, you rarely see more than one of the above settings affecting a crosspoint at the same 
time. However, there are occasions where this might happen. In this case, the settings are added together. When this happens, 
keep in mind that the numbers you are looking at are standard audio reference levels and not absolute numbers. When you add 
two (2) audio signals together that are at the same audio level, you actually double the level. In terms of audio reference levels, 
each doubling of level represents a change of +6.0dB. 

For more information on decibels, see http://www.gcaudio.com/resources/howtos/loudness.html.

EXAMPLE: A keypanel operator at intercom port 1 presses a listen key to listen to a person at intercom port 2. Port 
2 is also a member of party line 1, and the keypanel operator at port 1 is also listening to party line 1 via 
another listen key. This is an unlikely scenario, but if it does happen, the point-to-point listen gain for 
port 1 listening to port 2 is added together with the party line listen gain setting for port 1 listening to 
party line 1. If both of these settings happen to be +0.0dB, the result is a current gain of +6.0dB. The 
keypanel operator at port 1 perceives a slight boost in level from the person at intercom port 2 with 
respect to the other members of the party line.

Overall path gain: This number indicates the combined effect of the Crosspoint Gain, Input Gain, and 
Output Gain settings. A setting of +0.0dB indicates no effect: intercom port 2 hears intercom port 1 at 
the standard level. Settings of +1.0dB, +2.0dB, etc. indicate that the combined effect of all the 
adjustments cause port 2 to hear port 1 at a higher level than normal. Settings of -1.0dB, -2.0dB, etc. 
have the opposite effect.

Crosspoint Inspection in FILE mode

The primary purpose of the DEMO feature is to demonstrate to prospective users how the crosspoint inspection feature 
operates when no intercom connection is currently available. If Allow Crosspoint Inspection in file Mode is activated (Options 
menus|Preferences|Advanced), you can view a demo of crosspoint inspection. In file mode, AZedit has no way of knowing the 
actual status of a crosspoint. However, it can demonstrate the theoretical effect of a closed crosspoint by generating a random 
key press simulation and then looking up all of the relevant gain settings. It then displays this demo information in a manner 
similar to what was previously described above for a closed crosspoint. 
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Auto Dials Window

The Auto Dials window, is used to enter and store up to 999 phone numbers in AZedit. This is also referred to as centralized 
auto dials. Auto dials are telephone numbers frequently dialed and are maintained using AZedit. Customizing auto dial 
numbers in AZedit is as easy as entering the telephone number and selecting whether or not it is scroll enabled.

Centralized auto dials can be used two (2) different ways, with TIF assignments or with keypad sequences. You can also 
configure locally stored auto dial numbers at the keypanel. 

The following firmware versions must be loaded to utilize centralized auto dials in your intercom system.

NAVIGATION: Select System|Auto Dials from the menu bar.

NOTE: Use the Edit Auto Dials window to create or modify an auto dial number. For more information, see “Edit Auto 
Dial Window” on page 190.

To access the Edit Auto Dial window, do the following:

Double-click the Auto Dial for which you want to edit. 
The Edit Auto Dial window appears. 

AZedit Intercom Software v3.6.1 or later

MCII-e v2.0.4 or later

PeriphII-e (Ethernet) v1.20.0 or later

Periph Controller (Standard) v10.20.0 or later

DBX v1.20.0 or later

Cronus Firmware v1.5 or later

Zeus II Firmware v3.4.0 or later

Zeus III Firmware v1.0.0 or later

KP 32 CLD Firmware v1.0.4 or later

KP 32 Firmware v2.1.1 or later
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Auto Dial Column

The Auto Dial column displays the AZedit Auto Dial identification number (001, 002, 003, etc.).

Alpha Column

The Alpha column displays the auto dial alpha. Use the Auto Dial Alphas screen to change the alpha of the auto dial number, 
if desired. 

For more information, see “Alphas Page” on page 96.

LC Column

The LC column displays the scroll enable settings: LC indicates Local, TK indicates Trunk, and AE indicates AZedit. For 
each type of scrolling, the letters appear green if that type of scrolling is enabled, and brown (or red when selected) if that type 
of scrolling is disabled.

Phone Number Column

The Phone Number column displays the phone number associated with the auto dial number.

Edit Auto Dial Window

The Edit Auto Dial window, shown in Figure 230, is used to create an auto dial entry in AZedit. From this window, you 
configure the phone number and activate the type of scroll enable you desire.

Auto Dial Group Box

The Auto Dial group box displays the Auto Dial number and Alpha currently being modified or created.

FIGURE 230. Edit Auto Dial 
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Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key. If you clear this check box and send the change to the intercom system, 
keypanel operators cannot see the destination name in their scroll lists, and therefore, are not able to assign it to a key. Also, 
they cannot assign it using keypad numeric entry

NOTE: (KP9X series keypanels). And, if the destination name appears in any display on their keypanel, they are not able 
to copy it to any other key.

Trunk Check Box

NOTE: Currently not used.

AZedit Check Box

NOTE: Currently not used

Phone Number Group Box

The Phone Number group box is used to enter the phone number you want to assign to this auto dial position.

NOTE: Entering *99 creates a pause in the dialing. This is used to dial extensions or select preset options.
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Inter-Panel Dim Table Window

The Inter-Panel Dim Table window, shown in Figure 231, is used to configure DIM on specific keypanels in the intercom 
system. An Inter-panel Dim Table is a list of two (2) or more keypanels that are located in close proximity to one(1) another. In 
this situation, if the keypanels are using a speaker/microphone combination, feedback can occur if two (2) keypanels have 
keys activated with the same destination. On the other hand, if one keypanel has a key activated to talk to the destination and 
the other is receiving audio from the destination, by using an inter-panel dim table, the intercom system automatically mutes, 
or dim, one (1) or both keypanel speaker outputs while this situation exists. When you configure a dim table, you can also 
define the amount of speaker dimming.

NAVIGATION: Select System|Dim Table from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

FIGURE 231. Inter-Panel Dim Setup Window
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DIM Field

The DIM field indicates the DIM table number you are configuring. 

Up to 32 tables may be created in AZedit.

Gain Drop Down Menu

The Gain drop down menu is used to select the gain level, in dB, to associate with the DIM number. 

Available selections for this field are: 

-1.0dB, -2.0dB, -3.0dB, -4.0dB, -5.0dB, -6.0dB, -7.0dB, -8.0dB, -9.0dB, -10.0dB, -12.0dB, -15.0dB, -18.0dB, -21.0dB, -24.0dB, 
-30.0dB, -36.0dB, -48.2dB, -62.7dB, -72.2dB, and Mute.

Port Column

The Port column displays available ports to add to the DIM Table. 

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Alpha Column

The Alpha column displays the alphas of the available ports.

DIM Member? Column

The DIM Member? column displays whether the port belongs to a DIM table or not. If the port belongs to DIM table, a green 
Yes appears in the column. If the port does not belong to a table, a red No appears in the column.

Add to DIM Button

The Add to DIM button adds the selected ports to a DIM table.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.
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Remove From DIM Button

The Remove From DIM button removes selected ports from a DIM table.

Select All Button

The Select All button highlights all of the items in the list.

De-Select All Button

The De-select All button clears any selected items in the list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

EXAMPLE: If ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button 
is clicked, ports 1 through 5 are deselected and ports 6 through 10 become highlighted.

UPL Resources Window

The UPL Resources window, shown in Figure 232, is used to view current scroll enable settings for each UPL Resource in the 
intercom system. A UPL resource is a key assignment type used as an input condition for a UPL Statement. Once you have 
named a UPL resource, you assign it to a keypanel key using keypanel setup. Then, you use UPL statement setup to create a 
UPL Statement, which instructs the intercom system to perform a specific action when the UPL Resource key is pressed.

NAVIGATION: Select System|UPL Resources from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

FIGURE 232. UPL Resources Window
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UR Column

The UR column displays the UR (UPL Resource) number. 

This number cannot be modified.

Alpha Column

The Alpha column displays the alpha (or name) of the UR Resource. UPL Resources have default names U001, U002, etc., 
however, these can be changed to a more recognizable name using the UPL Resource Alphas window (Alphas|UPL 
Resource). For more information, see “Alpha Windows” on page 227.

LC Column

The LC column displays the local scroll enable settings. A red LC indicates local scroll enable is not active. A green LC 
indicates local scroll enable is active. 

Use the UPL Resources Edit screen, see “Alpha Windows” on page 227, to enable or disable scroll enable.

TK Column

The TK column displays the trunk scroll enable settings. A red TK indicates trunk scroll enable is not active. A green TK 
indicates trunk scroll enable is active. 

Use the UPL Resources Edit screen, see “Alpha Windows” on page 227, to enable or disable scroll enable.

AE Column

The AE column displays the AZedit scroll enable settings. A red AE indicates AZedit scroll enable is not active. A green AE 
indicates AZedit scroll enable is active. 

Use the UPL Resources Edit screen, “Alpha Windows” on page 227, to enable or disable scroll enable.

Input Column

The Input column displays port number of the input audio

Alpha Column

The Alpha column displays the alpha of the input port, if defined.

Output Column

The Output column displays the port number of output audio.

Alpha Column

The Alpha column displays the alpha of the output port, if defined.

Reciprocal? Column

The Reciprocal? column displays whether or not the crosspoint from the output to the input is closed. 

NOTE: If a UPL resource is activated (by talking or listening to it), the crosspoint from the input to the output is closed 
(if both are defined).
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Edit UPL Resource Window

The Edit UPL Resource window, shown in Figure 233, is used to set the scroll enable settings for the UPL resource. The 
Scroll Enable check boxes control who can view destinations in scroll lists and assign those destinations to keypanel keys. 
When you are using AZedit within your own intercom system, you always have access to the complete scroll lists.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

UPL Resource Group Box

The UPL Resource group box contains the UPL Resource Number and Alpha you are currently modifying. These fields 
cannot be modified; however, you can use the UPL Resource Alphas window to modify the Alpha for the UPL resource. For 
more information, see “Alpha Windows” on page 227.

Scroll Enable Group Box

The Scroll Enable check boxes appear in the setup views for the following destination types: intercom ports, party lines, IFBs, 
Special Lists, GPI Outputs, UPL Resources, and ISOs. The Scroll Enable check boxes control who can view destinations in 
scroll lists and assign those destinations to keypanel keys. 

AZedit allows you to manage scroll lists within your intercom system by the following:

FIGURE 233. Edit UPL Resource Window
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Local Check Box

The Local check box indicates any keypanel operator in your intercom system with a programmable keypanel can find the 
destination name in a scroll list and assign it to a key.

If you clear this check box and send the change to the intercom system, keypanel operators cannot see the destination name in 
their scroll lists, and therefore, are not able to assign it to a key. Also, they cannot assign it using keypad numeric entry (KP9X 
series keypanels). And, if the destination name appears in any display on their keypanel, they are not able to copy it to any 
other key.

Trunk Check Box

The Trunk check box indicates any keypanel operator in a remote intercom system with a programmable keypanel can view 
the destination in a scroll list and assign it to a key on their keypanel. 

If you clear this check box and send the change to the intercom system, remote keypanel operators are not able to view the 
destination or assign it to a key by any means.

NOTE: The trunk check box is only selectable if trunking has been activated.

AZedit Check Box

The AZedit check box indicates an AZedit user in a remote intercom system is able to view the destination in a scroll list and 
assign it to keypanel keys in the remote intercom system. 

If you clear the check box, remote AZedit users do not have access to these scroll lists.

The AZedit check box is only selectable if trunking has been activated.

Input Group Box

Port Number Field

The Port Number field is used to indicate the port number to assign as the input source. 

Port Alpha Drop Down Menu

The Port Alpha drop down menu is used to select the alpha of the input port you want to use. If the port number has already 
been entered, this field automatically fills with the appropriate alpha.

Output Group Box

Port Number Field

The Port Number field is used to indicate the port number to assign as the output source.

Port Alpha Drop Down Menu

The Port Alpha drop down menu is used to select the alpha of the output port you want to use. If the port number has already 
been entered, this field automatically fills with the appropriate alpha.
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Options Group Box

Reciprocal? Check Box

The Reciprocal? check box indicates whether or not the crosspoint from the output to the input is closed. If selected, the 
crosspoint from the output to the input is closed.

NOTE: If a UPL resource is activated (by talking or listening to it), the crosspoint from the input to the output is closed 
(if both are defined).

UPL Statements Window

The UPL Statements window, shown in Figure 234, displays information concerning the UPL statements configured for your 
intercom system. UPL is a powerful feature which lets you quickly and easily program the intercom system to perform output 
actions you specify based on input conditions you specify. 

EXAMPLE: You can program the intercom system to load a new setup file at a specified time or load whenever 
someone presses a particular keypanel key. On the other hand, you can program talk and listen paths to 
turn on or off at specified times. Using UPL Statement Setup, you can build the custom operations 
quickly and easily to get the most out of your intercom system.

NAVIGATION: Select System|UPL Statements from the menu bar.

Use the Edit UPL Statement window to create your customized UPL statements. For more information, see “Edit UPL 
Statement Window” on page 201.

To access the Edit UPL Statement window, do the following:

Double click the UPL Statement you wish to create/modify. 
The Edit UPL Statement window appears.
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IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

UPL Statement Column

The UPL Statement column displays the number assigned to the UPL Statement. 

This number cannot be modified.

Enabled Column

The Enabled column indicates whether the UPL Statement is active or not. A green Yes appears when enabled, a red No 
indicates disabled.

Input A Column

The Input A column displays the first type of input being used, such as GPI, keypanel, etc. 

Operation Column

The Operation column displays the operator used in the UPL Statements, such as AND, OR, XOR, etc.

FIGURE 234. UPL Statement Window
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Input B Column

The Input B column displays the second type of input being used (if applicable), such as GPI, keypanel, etc.

Available selections are:

UPL Statement

GPI Input

GPI Input (Local)

GPI Output

GPI Output (Local)

Talk Key

Listen Key

UPL Resource

Crosspoint

Input Talking 

Output Listening

Headset Transfer

Target Date

Target Time

IFB Interrupted

Target Value

VOX Audio

Any Talk Key

Output Column

The Output column displays the type of output resulting from input A and input B, such as key closures, crosspoint forces or 
inhibits, etc.

State Column

The State column displays the current state of the UPL statement. If the statement is active, a red False appears. If has not 
been sent to the intercom, - (a dash) appears. If the statement is currently active, a green True appears.

Description Column

The Description column displays a brief, unique of the UPL statement. This makes it easier to differentiate between other 
UPL Statements.
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Edit UPL Statement Window

The Edit UPL Statement window, shown in Figure 235, is used to create and modify UPL statements used in your intercom 
system.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

UPL Statement Group Box

Comment Field

The Comment field is used to enter a description or comment about the current UPL statement. 

This field can contain up to 32 characters.

Enabled Check Box

The Enabled check box indicates the UPL statement is enabled and ready to use. Clear the check box to disable the UPL 
statement, but not delete it. You can use disabled UPL statements in the future, if desired.

FIGURE 235. Edit UPL Statement Window
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Input A Group Box

Type and Variable Drop Down Menus

The Type and Variable drop down menu is used to select an input condition that causes the intercom system to perform an 
output action. Each UPL statement can have either one (1) or two (2) input conditions. Depending on what is selected from the 
Type drop down menu, dictates what variable is needed. Use Table 2 to determine the type and variables you want to use.

Available selections are:

TABLE 2. Input A Types and Variables

Input Condition Input Description Variables Needed

UPL Statement If a specified UPL statement is true... UPL Statement # and Description

GPI Input If a system GPI Input is activated.... GPI Input # and Alpha

GPI Input 
(Local)

If a Local GPI Input is activated... Port # and Alpha

GPI Input # and Alpha

GPI Output If a system GPI Output is activated... GPI Output # and Alpha

GPI Output 
(Local)

If a Local GPI Output is activated... Port # and Alpha

GPI Output # and Alpha

Talk Key If a specified Talk Key on a keypanel is on... Port # and Alpha

Key #

Listen Key If a specified Listen Key on a keypanel is on... Port # and Alpha

Key #

UPL Resource If a UPL Resource key is activated... UPL Resource # and Description

Crosspoint If a specified Crosspoint is activated... Input # and Alpha

Output # and Alpha

Input Talking If a specified port is talking to anyone... Input # and Alpha

Output Listening If a specified port is listening to anyone... Output # and Alpha

Headset Transfer If the Headset Transfer switch on a keypanel is 
activated...

Port # and Alpha

Current Date If the Current Date is... Year, Month, and Day (YY/MM/DD).

NOTE: You must use the Operator drop down 
menu when using the Date and/or Time 
input.

Current Time If the Current Time is... Hour, Minute, Second (00:00:00) 

All times are entered in the 24-hour or military 
time format. For example, 1:00 pm is 13:00:00.

NOTE: You must use the Operator drop down 
menu when using the Date and/or Time 
input.

IFB Interrupted If the specified IFB is interrupted... IFB # and Alpha
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Invert Input A Check Box

The Invert Input A check box is used to reverse the input condition. 

For example, if the input condition is “Talk Key”, which by itself means, when a specified talk key is on, run the assigned 
output. However, by selecting the Invert Input A check box, the meaning changes to; when a specified talk key is off, run the 
assigned output. 

The invert check box is often used in one UPL statement to cancel an action caused by some other UPL statement.

Operation Group Box

Operation Drop Down Menu

The Operation drop down menu is used to select the type of operator to use when joining Input A and Input B or when using 
the Current Date, Current Time, or the Counter input for Input A. In all other cases, the Operation drop down menu is not used. 

NOTE: Operators, also known as logical operators, are used to construct more complex searches in a database. They help 
make a search more accurate. There are 3 logical operators: AND, OR and NOT.

Operators for Two Input Conditions

Counter If the Counter is...

Counters count increments of time. Each counter 
is equal to 100ms of time. AZedit allows for up 
to 256 counters to be used.

The counter input selection is used to write UPL 
statements to occur in a timed event. For 
example, when a key is pushed, wait 10 seconds 
before running the UPL statement to turn a light 
on.

Counter # 

NOTE: You must use the Operator drop down 
menu when using the Counter input.

VOX Audio If the VOX Audio is... Input # and Alpha

Any Talk Key If Any Talk Key is on a keypanel is on.... Port # and Alpha

Operator Description

AND If input A and input B are both true....then run the specified output.

OR If input A or input B (or both) are true....then run the specified output.

XOR If input A or input B (but not both) are true....then run the specified output.

TABLE 2. Input A Types and Variables

Input Condition Input Description Variables Needed
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Operators for Current Date and Current Time

EXAMPLE: Operators for current time have a 5-second window. For example, if you create a test for a specific time
(i.e., = 12:00:00), the given time is matched for a 5-second window. It returns a TRUE result for the 
time 12:00:00 through 12:00:05. A test for inequality returns TRUE for all but this 5-second window.

Input B Group Box

Type and Variable Drop Down Menus

The Type and Variable drop down menu is used to select an input condition that causes the intercom system to perform an 
output action. Each UPL statement can have either one (1) or two (2) input conditions. Depending on what is selected from the 
Type drop down menu, dictates what variable is needed. Use Table 3 on page 204 to determine the type and variables you want 
to use.

Available selections are:

Operator Description

= If the current date or time equals...

! = When the current date or time does not equal...

< When the current date or time is earlier than...

> = When the current date or time is equal to or later than...

> When the current date or time is later than...

< = When the current date or time is equal to or earlier than...

TABLE 3. Input B Types and Variables

Input Condition Input Description Variables Needed

UPL Statement If a specified UPL statement is true... UPL Statement # and Description

GPI Input If a system GPI Input is activated.... GPI Input # and Alpha

GPI Input (Local) If a Local GPI Input is activated... Port # and Alpha
GPI Input # and Alpha

GPI Output If a system GPI Output is activated... GPI Output # and Alpha

GPI Output (Local) If a Local GPI Output is activated... Port # and Alpha
GPI Output # and Alpha

Talk Key If a specified Talk Key on a keypanel is on... Port # and Alpha
Key #

Listen Key If a specified Listen Key on a keypanel is on... Port # and Alpha
Key #

UPL Resource If a UPL Resource key is activated... UPL Resource # and Description

Crosspoint If a specified Crosspoint is activated... Input # and Alpha
Output # and Alpha

Input Talking If a specified port is talking to anyone... Input # and Alpha

Output Listening If a specified port is listening to anyone... Output # and Alpha

Headset Transfer If the Headset Transfer switch on a keypanel is 
activated...

Port # and Alpha

Target Date If the Target Date is... Year, Month, and Day (YY/MM/DD).

NOTE: Target Date is used in conjunction with 
Current Date.
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Invert Input B Check Box

The Invert Input B check box is used to reverse the input condition. 

For example, if the input condition is Talk Key, which by itself means, when a specified talk key is on, run the assigned output. 
However, by selecting the Invert Input A check box, the meaning changes to; when a specified talk key is off, run the assigned 
output.

The invert check box is often used in one (1) UPL statement to cancel an action caused by some other UPL statement.

Output Action Group Box

Type and Variable Drop Down Menus

The Type and Variable drop down menu is used to select an output result that occurs when an input definition is met. 
Depending on what is selected from the Type drop down menu, dictates what variable is needed. Use Table 4 on page 205 to 
determine the type and variables you want to use.

Available selections are:

Target Time Target Time is used in conjunction with Current 
Time.

Hour, Minute, Second (00:00:00) 
All times are entered in the 24-hour or military 
time format. For example, 1:00 pm is 13:00:00.

NOTE: Target Time is used in conjunction with 
Current Time.

IFB Interrupted If the specified IFB is interrupted... IFB # and Alpha

Target Value Target Value is used in conjunction with the 
Counter input.

NOTE: Automatically switches input A to 
Counter.

The target value is an increment of time, in ms, to 
trigger an event. 1 counter equals 100ms.
The counter input selection is used to write UPL 
statements to occur in a timed event. For example, 
when a key is pushed, wait 10 seconds before 
running the UPL statement to turn a light on. 

VOX Audio If VOX Audio is... Input # and Alpha

Any Talk Key If Any Talk Key is on a keypanel is on.... Port # and Alpha

TABLE 4. Output Values

Output Output Description Variables Needed

Close Crosspoint Close the crosspoint from the specified 
input to the specified output

Input Number, Alpha, Output Number, Alpha

Inhibit Crosspoint Open the crosspoint from the specified 
input to the specified output.

Input Number, Alpha, Output Number, Alpha

Assert GPI Output Activate the specified System GPI 
Output

GPI Output Number and Alpha

Inhibit GPI Output Deactivate the specified System GPI 
Output

GPI Output Number and Alpha

Assert GPI Output (Local) Activate the specified Local GPI Output Port Number and Alpha, GPI Output Number 
and Alpha

TABLE 3. Input B Types and Variables

Input Condition Input Description Variables Needed
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Inhibit GPI Output (Local) Deactivate the specified Local GPI 
Output

Port Number and Alpha, GPI Output Number 
and Alpha

Force Talk Key Closure Force the specified talk key on Port Number, Alpha and Key Number

Force Talk Key Open Force the specified talk key off Port Number, Alpha and Key Number

Dim Crosspoint Volume Cause the specified output to hear the 
specified input at a reduced volume 
level.

Input Number, Alpha, Output Number, Alpha 
and DIM amount (-1.0dB to -72.2dB, and 
Mute)

Load File Cause a file to be loaded from disk and 
sent to the intercom system. 

NOTE: AZedit must be in SERVER 
mode.

The Load File pulls files from the directory you 
have configured on the General page in the 
Preferences window. For more information, see 
“General Page” on page 99.

Force Listen Key Closure Force the specified listen key on Port Number, Alpha, and Key Number

Force Listen Key Open Force the specified listen key off Port Number, Alphas, and Key Number

Clear Counter Clear the Counter Clears the counter input from the UPL 
statement. If you select 0 all counters are 
cleared

Inhibit Output Open the output port. Output Port Number, and Alpha

Inform Command Line 
Protocol

THIS FIELD IS NOT CONFIGURABLE FROM AZEDIT. This option is used by 
command line protocol only. When a query is sent from the command line protocol to 
AZedit, a UPL statement is written with Inform Command Line Protocol as the output. 
This can be used to monitor the query sent from the command line protocol.
For more information, contact customer service.

Set Headset Transfer State Set the Headset to the specified state. Port Number, Alpha, Headset State
Available selections for this field are:

Turn Headset transfer off

Turn Headset transfer on

Force Headset transfer off

Force Headset transfer on

Release Headset transfer

NOTE: The difference between Turn and 
Force is when force is used the user 
cannot change the headset transfer 
once the transfer is complete.

TABLE 4. Output Values

Output Output Description Variables Needed
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Set Talk Key LED State Set the Talk Key LED State Port Number, Alpha, Key, and LED State
Available selections for this field are:

Local Control

Solid Red

Solid Green

Solid Amber

Slow Red Flash

Slow Green Flash

Fast Red Flash

Fast Green Flash

Slow Red Blink

Slow Green Blink

Set Listen Key LED State Set the Listen Key LED State Port Number, Alpha, Key, and LED State
Available selections for this field are:

Local Control

Solid Red

Solid Green

Solid Amber

Slow Red Flash

Slow Green Flash

Fast Red Flash

Fast Green Flash

Slow Red Blink

Slow Green Blink

Set IFB Program Input Set the Program Input Port for an IFB 
assignment.

IFB Number, Alpha, Input Port Number, and 
Alpha 

NOTE: If you set the Input Port Number to 0, 
you are assigning no input port.

Start Paging System Macro Send a signal over a serial connection to 
a paging system to start a macro.

NOTE: The macro is stored in the 
paging system. AZedit sends 
an event to trigger the macro 
on the Paging System.

Macro Number

Stop Paging System Macro Send a signal over a serial connection to 
a paging system to end the macro.

NOTE: The macro is stored in the 
paging system. AZedit sends 
an event to trigger the macro 
on the Paging System

Macro Number

TABLE 4. Output Values

Output Output Description Variables Needed
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NOTE: In most cases, when the input conditions for the UPL statement are true, the output action occurs. Then when the 
input condition ceases to be true, the output action terminates. The exceptions are Load File, Force Keys (talk 
and listen), and Force Headset Transfer. When a UPL statement loads a file, there is no way to unload the file 
when the UPL statement is no longer true. When a talk or listen key is forced on, or a headset is force on, with a 
UPL statement, you must use a second UPL statement to force the keys or headset off.

Description Field

The Description field displays a plain-text description of the UPL statement you build. You can use this description to verify 
the UPL statement is constructed to run as anticipated.

VOX Window

The VOX window, shown in Figure 236, is used to configure VOX on ports in your intercom system. VOX is an audio 
threshold level you set at the point a channel becomes active. When the threshold is set, a microphone does not activate until 
the preset audio level is attained. This prevents a channel from staying on when no one is around in a high activity area. VOX 
is supported in Cronus Intercom systems and in intercoms with AIO-16 cards. 

NOTE: VOX support requires the following minimum firmware versions:

Master Controller V9.25.0, or Master Controller II-e V1.1.0

DBX V1.15.0 with Peripheral Controller V10.15.0, or Peripheral Controller II-e V1.15.03

AIO-16 V1.1.0 or later

Cronus V1.1.0 or later

NAVIGATION: Select System|VOX from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 
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Threshold Group Box

Adjust Box

The Adjust box is used to fine tune the VOX threshold level, in dB, for the port after using the Set To slider. Use the 
adjustment arrows to increase or decrease the VOX threshold level in .5dB increments. 

The range for this field is –126dB to 0.0dB. 

NOTE: The threshold change is only seen in the Threshold column to the right.

FIGURE 236. VOX Window
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Set To Button and Slider

The Set To button and Slider is used to quickly get to the approximate threshold level, in dB, you want to set for the port. 
Once you have used the slider, click the Set To button to set the level for the port. Use the Adjust arrows to fine tune the 
threshold level.

To use the threshold slider, do the following:

1. Click and hold the slider.

2. Drag the slider left to decrease the threshold amount or right to increase the threshold amounts.

Hold Time Group Box

Adjust Box

The Adjust box is used to fine tune the hold time, in seconds, for the port after using the Set To slider. Use the adjustment 
arrows to increase or decrease the VOX threshold level in .1 second increments. 

The range for this field is .02 seconds to 12.5 seconds. 

NOTE: The time change is only seen in the Hold Time column to the right.

Set To Button and Slider

The Set To button and Slider is used to quickly get to the approximate hold time you want to set for the port. Once you have 
used the slider, click the Set To button to set the time for the port. Use the Adjust arrows to fine tune the hold time.

To use the hold time slider, do the following:

1. Click and hold the slider.

2. Drag the slider left to decrease the hold time amount or right to increase the hold time amount.
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Options Group Box

Show Enabled Only Check Box

The Show Enabled Only check box is used to show vox enabled ports only. This feature is used to quickly view ports with 
vox enabled. If this check box is not selected, all available ports are shown.

Real-Time Changes Check Box

The Real-Time Changes check box is used to make changes to the vox threshold in real time. When selected and in online 
mode, vox changes are automatically sent to the intercom system as you make the adjustments.

Port Column

The Port column displays all available ports in the intercom.

Alpha Column

The Alpha column displays the alphas for all the available ports in the intercom.

Supported? Column

The Supported? column displays whether vox is supported on the intercom port. If vox is supported on the port, a green Yes 
appears in the column. If vox is not supported on the port, a red No appears in the column.

NOTE: VOX support requires the following minimum firmware versions:

Master Controller V9.25.0, or Master Controller II-e V1.1.0

DBX V1.15.0 with Peripheral Controller V10.15.0, or Peripheral Controller II-e V1.15.03

AIO-16 V1.1.0 or later

Cronus V1.1.0 or later

Enabled? Column

The Enabled? column displays whether vox is enabled on the specified port. If vox is enabled on the port, a green Yes appears 
in the column. If vox is not supported on the port, a red No appears in the column.

To enable vox on the port, do the following:

1. Highlight the port or ports you want to enable.

2. Click Enable VOX.

NOTE: You can also enable vox from the Keypanel/Port Configuration Window. For more information, see “VOX Page” 
on page 123.

Threshold Column

The Threshold column displays the audio level, in dB, at which vox activates on the port.

Hold Time Column

The Hold Time column displays the time, in seconds, the port waits for the presence of audio before turning off.
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Audio? Column

The Audio? column indicates if audio is present on the port. If audio is present, a green Yes displays in the column. If there is 
no audio on the port, a red No appears in the column.

Enable VOX Button

The Enable VOX button is used to enable vox on the selected port or ports. You can also use the VOX page in the 
Keypanel/Port Configuration window to enable or disable vox on a port. For more information, see “VOX Page” on page 123.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Disable VOX Button

The Disable VOX button is used to disable vox on the selected port or ports. You can also use the VOX page in the
 Keypanel/Port Configuration window to enable or disable vox on a port. For more information, see “VOX Page” on page 123.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Reset Threshold Button

The Reset Threshold button is used to return the threshold levels of the selected port or ports to the default level. 

The default for this field is -30.0dB.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.
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To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Reset Hold Time Button

The Reset Hold Time button is used to return the hold time for the selected port or ports to the default time.

The default for this field is 0.5 seconds.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. For example, if ports 1 through 5 are highlighted, 
while ports 6 through 10 are not, when the Invert Selection button is clicked, ports 1 through 5 are deselected and ports 6 
through 10 become highlighted.
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Crosspoint Gains Window

The Crosspoint Gains window, shown in Figure 237, is used to configure individual gain levels for crosspoints within the 
intercom system.

NAVIGATION: Select System|Gains|Crosspoint from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Port Field

The Port field indicates the current port number you are viewing. Once this field is populated, the Alpha drop down menu 
displays the corresponding alpha for the port.

FIGURE 237. Crosspoint Gain Window
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Alpha Drop Down Menu

The Alpha drop down menu is used to select the alpha of the port you want to view. Once you have selected the alpha, the 
corresponding port number appears in the Port field.

Gain Controls Group Box

Gain Drop Down Menu

The Gain drop down menu is used to select the gain level, in dB, the current port hears the selected (highlighted) port (Listens 
To... columns). Once you have set the gain level, click Set Gain.

The range for this field is +6.0dB to -72.2dB, and Mute.

NOTE: Use the Fine Tune Arrow buttons to increase or decrease the gain incrementally.

Set Gain Button

The Set Gain button is used to set the gain of the selected port to the level selected from the Gain drop down menu. 

CAUTION: Do not use the Set Gain button when using the up and down arrows, because the changes you make with the 
arrows are not reflected in the Gain drop down menu. 

Gain Increase/Decrease Arrows

The Gain Increase/Decrease arrows are used to fine tune the gain level, in increments, of the selected ports. The gain changes 
are only seen in the Gain column in the Listens To... group box.

Options Group Box

Show Non-Unity Only Check Box

The Show Non-Unity Only check box is used to show only those ports with non-unity gain levels. The default level of +0.0dB 
is also called the unity gain level. Normally, the list in the center of the screen shows the gains for all intercom ports. If you 
select the Show Non-Unity Only check box, only those intercom ports that are not set at the default level are shown.

Port Column

The Port column displays all the ports in the intercom system.

Alpha Column

The Alpha column displays the corresponding alpha to its port.

Gain Column

The Gain column displays the gain level for each port.
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Reset Gain Button

The Reset Gain button is used to reset the gain to the unity level for the selected port or ports. 

The unity level is 0.0dB. 

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.
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Party Line Gains Window

The Party Line Gains window, shown in Figure 238, is used to set the gain level, in dB, for ports listening to party lines.

NAVIGATION: From the menu bar, select System|Gains|Party Line.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Port Field

The Port field indicates the current port number you are viewing. Once this field is populated, the Alpha drop down menu 
displays the corresponding alpha for the port.

Alpha Drop Down Menu

The Alpha drop down menu is used to select the alpha of the port you want to view. Once you have selected the alpha, the 
corresponding port number appears in the Port field.

FIGURE 238. Party Line Gains Window
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Gain Controls Group Box

Gain Drop Down Menu

The Gain drop down menu is used to select the gain level, in dB, the current port hears the selected (highlighted) party line 
(Listens To... columns). Once you have set the gain level, click Set Gain.

Gain level selections range from: +6.0dB to -72.2dB, and Mute.

NOTE: Use the Fine Tune Arrow buttons to increase or decrease the gain incrementally.

Set Gain Button

The Set Gain button is used to set the gain of the selected party line to the level selected from the Gain drop down menu. 

IMPORTANT: Do not use the Set Gain button when using the up and down arrows, because the changes you make with 
the arrows are not reflected in the Gain drop down menu. 

Gain Increase/Decrease Arrows

The Gain Increase/Decrease arrows are used to fine tune the gain level in increments of the selected PLs. The gain changes 
are only seen in the Gain column in the Listens To... group box.

Options Group Box

Show Non-Unity Only Check Box

The Show Non-Unity Only check box is used to show only those party lines with non-unity gain levels. The default level of 
+0.0dB is also called the unity gain level. Normally, the list in the center of the screen shows the gains for all party lines. If 
you select the Show Non-Unity Only check box, only those party lines that are not set at the default level are shown.

PL Column

The PL column displays all the party lines in the intercom system.

Alpha Column

The Alpha column displays the corresponding alpha to the party line.

Gain Column

The Gain column displays the gain level for each party line.
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Reset Gain Button

The Reset Gain button is used to reset the gain to the unity level for the selected party line. 

The unity level is 0.0dB. 

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.
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Input/Output Gains Window

The Input/Output Gains window, shown in “Input/Output Gains Window” on page 220, is used to configure the input and 
output gains for selected ports in your intercom system.

NOTE: Do not make an adjustment here when it would be better to adjust a crosspoint gain (see “Crosspoint Gains 
Window” on page 214). Usually you adjust an analog input or output gain when you need to interface an 
intercom port to an external device that operates at a different audio level than the intercom system. In this case, 
the adjustment corrects the level between that port an all other ports. You should use crosspoint gain when you 
want to adjust the level between two (2) specific intercom ports.

NAVIGATION: Select System|Gains|Input/Output from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. Gain Controls

FIGURE 239. Input/Output Gains Window
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Gain Drop Down Menu

The Gain drop down menu is used to select the gain level, in dB, for the highlighted port (Listens To... columns). Once you 
have set the gain level, click either Set Input Gain or Set Output Gain.

The range for this field is +20.0dB to -20.0dB.

NOTE: Use the Gain Increase/Decrease arrows to increase or decrease the gain incrementally.

Set Input Gain Button

The Set Input Gain button is used to set the input gain (the level at which others hear you) of the selected port to the level 
selected from the Gain drop down menu. 

IMPORTANT: Do not use the Set Gain buttons when using the up and down arrows, because the changes you make 
with the arrows are not reflected in the Gain drop down menu. 

Gain Increase/Decrease Arrows

The Gain Increase/Decrease arrows are used to fine tune the input port gain level in increments. The gain changes are only 
seen in the Input Gain column.

Set Output Gain Button

The Set Output Gain button is used to set the output gain (the level at which you hear others) of the selected port to the level 
selected from the Gain drop down menu. 

IMPORTANT: Do not use the Set Gain buttons when using the up and down arrows, because the changes you make 
with the arrows are not reflected in the Gain drop down menu. 

Gain Increase/Decrease Arrows

The Gain Increase/Decrease arrows are used to fine tune the output port gain level in increments. The gain changes are only 
seen in the Output Gain column.

Options Group Box

Show Non-Unity Only Check Box

The Show Non-Unity Only check box is used to show only those party lines with non-unity gain levels. The default level of 
+0.0dB is also called the unity gain level. Normally, the list in the center of the screen shows the gains for all party lines. If you 
select the Show Non-Unity Only check box, only those party lines that are not set at the default level are shown.

Real-Time Changes Check Box

The Real-Time Changes check box is used to make changes to the Input and Output Gain levels in real time. When selected 
and in online mode, these changes are automatically sent to the intercom system as you make the adjustments.

Port Column

The Port column displays a list of available ports to select.
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Alpha Column

The Alpha column displays the corresponding alphas to the ports.

Input Gain Column

The Input Gain column displays the input gain level for each port.

Output Gain Column

The Output Gain column displays the output gain level for each port.

Reset Input Gain Button

The Reset Input Gain button is used to reset the Input Gain level to unity (0.0dB).

Reset Output Gain Button

The Reset Output Gain button is used to reset the output gain level to 0.0dB (Unity).

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. 

For example, if ports 1 through 5 are highlighted, while ports 6 through 10 are not, when the Invert Selection button is clicked, 
ports 1 through 5 are deselected and ports 6 through 10 become highlighted.

Port Alphas Window

The Port Alpha window, shown in Figure 240, displays the ports and their corresponding input alphas, output alphas, aliases, 
and descriptions. Alphas are descriptive names assigned to ports to make them more recognizable to keypanel users than the 
default alphas.

In earlier versions, pre-version 2.06.00, a port had one (1) alpha to represent both the input audio and the output audio of the 
port. For keypanels where both the input and output audio refer to the same device, there is no problem. However, in other 
applications where the input and output paths of a port are used for different purposes, such as IFB program inputs or listen 
sources on the input side and IFB output on the output side, one (1) port alphas do not work. In AZedit version 2.06.00, 
separate input alphas and output alphas were introduced. By default, input alphas mirror the output alpha unless you 
specifically change the input alpha. 

Use Input Alphas check box in the Intercom Configuration Window to enable input alphas. For more information, see “Use 
Input Alphas Check Box” on page 59.

IMPORTANT: When you select the Use Input Alphas from the Intercom Configuration window, the intercom system 
reconfigures itself and performs a First Birthday and remembers the system size.
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When entering key assignments with input alphas enabled, you must enter the input alphas in the listen key assignments and 
output alphas in the talk key assignments.

To use the input alpha feature, you must have the following requirements:

MC V9.17.0
or

DBX V1.9.0 with PC PV.10.9.0
or

Zeus V3.2.0

Aliases are used only when your intercom system is trunked. Aliases are used by AZedit administrators to identify remote 
destinations from local destinations that may share the same alpha in different intercom systems.

NOTE: Output alphas and input alphas only appear on the Port Alpha screen if enabled. All other Alpha screens show 
only alphas and aliases. To display output alphas, input alphas and aliases, you must set two (2) preferences and a 
configuration option. Aliases only appear in a trunk-enabled system. Aliases are names for ports seen by remote 
intercoms.

NAVIGATION: Select Alphas|Port from the menu bar.

Use the Edit Alpha/Description window to create or modify the Port Alphas, Aliases, and Descriptions. 

Double click the Port you wish to create/modify to access the Edit Alpha/Description window. The Edit Alpha/Description 
window appears. For more information, see “Edit Port Alpha/Description Window” on page 225.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

NOTE: If you load an existing 4-character alpha configuration file into the intercom system, and then set the alpha size to 
either six (6) or eight (8), the larger alpha sizes display the default alpha (for example, N005), until they are 
edited.

Port Column

The Port column displays a list of port numbers for the intercom system. 

FIGURE 240. Port Alpha Window



224  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

This number cannot be modified.

Output Alpha (4) Column

The Output Alpha (4) column displays the 4-character output alpha of the port.

NOTE: When you enter a 4-character output alpha, and are viewing all sizes on Alpha views, the 4-character output 
alpha populates the 6-character field and the 8-character field.

Output Alpha (6) Column

The Output Alpha (6) column displays the 6-character output alpha of the port.

Output Alpha (8) Column

The Output Alpha (8) column displays the 8-character output alpha of the port.

Input Alpha (4) Column

The Input Alpha (4) column displays the 4-character input alpha or the port.

NOTE: When you enter a 4-character input alpha, and are viewing all sizes on Alpha views, the 4-character input alpha 
populates the 6-character field and the 8-character field.

Input Alpha (6) Column

The Input Alpha (6) column displays the 6-character input alpha of the port

Input Alpha (8) Column

The Input Alpha (8) column displays the 8-character input alpha of the port.

Alias (4) Column

The Alias (4) column displays the 4-character alias of the port.

NOTE: When you enter a 4-character alias, and are viewing all sizes on Alpha views, the 4-character alias populates the 
6-character field and the 8-character field.

Alias (6) Column

The Alias (6) column displays the 6-character alias of the port. 

Alias (8) Column

The Alias (8) column displays the 8-character alias of the port.

Description Column

The Description column displays a more descriptive definition of the port.



AZedit Intercom Software Setup Windows  225

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Edit Port Alpha/Description Window

The Edit Port Alpha/Description window, shown in Figure 241, is used to create or modify input alphas, output alphas, 
aliases and descriptions for selected ports.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Resource Field

The Resource field displays the selected resource.

Description Field

The Description field is used to enter a short, user-recognized definition of the resource. 

This field can contain up to a 24-characters.

NOTE: Output alphas and input alphas only appear if they are enabled. If they are not enabled, the screen shows only 
alphas and aliases.

Output Alpha (4) Field

The Alpha (4) or Output Alpha (4) field is used to change the default alphas (N001, N002, etc.) to a more meaningful name 
for your users (for example, CAM1, CAM2, etc.). 

This field can contain up to 4 characters. 

FIGURE 241. Edit Port Alpha / Description Window
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Output Alpha (6) Field

The Alpha (6) or Output Alpha (6) field is used to change the default alphas (N001, N002, etc.) to a more meaningful name 
for your users (for example, CAM1, CAM2, etc.). 

This field can contain up to 6 characters.

Output Alpha (8) Field

The Alpha (8) or Output (8) field is used to change the default alphas (N001, N002, etc) to a more meaningful name for your 
users (for example, CAM1, CAM2, etc.). 

This field can contain up to 8 characters.

Input Alpha (4) Field

The Input Alpha (4) field is used to change the default alphas (N001, N002, etc) to a more meaningful name for your users 
(for example, CAM1, CAM2, etc.). 

This field can contain up to 4 characters.

Input Alpha (6) Field

The Input Alpha (6) field is used to change the default alphas (N001, N002, etc) to a more meaningful name for your users 
(for example, CAM1, CAM2, etc.). 

This field can contain up to 6 characters.

Input Alpha (8) Field

The Input Alpha (8) field is used to change the default alphas (N001, N002, etc) to a more meaningful name for your users 
(for example, CAM1, CAM2, etc.). 

This field can contain up to 8 characters.

Alias (4) Field

The Alias (4) field is used to enter an alias. Alias names are used to identify destinations in a trunked intercom system to 
AZedit administrators and keypanel operators in other intercom systems.

This field can contain up to 4 characters.

Alias (6)Field

The Alias (6) field is used to enter an alias. Alias names are used to identify destinations in a trunked intercom system to 
AZedit administrators and keypanel operators in other intercom systems.

This field can contain up to 6 characters.

Alias (8) Field

The Alias (8) field is used to enter an alias. Alias names are used to identify destinations in a trunked intercom system to 
AZedit administrators and keypanel operators in other intercom systems.

This field can contain up to 8 characters.
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Alpha Windows

The Alpha windows, shown in Figure 242, display the ports and their corresponding alphas, aliases, and descriptions. Alphas 
are descriptive names assigned to ports to make them more recognizable to keypanel users than the default alphas. Aliases are 
descriptive names given to alphas that are named the same but reside in different intercom systems. Administrators use aliases 
to identify remote destinations from local destinations that may share the same alpha in different intercom systems. Aliases are 
only used when your intercom system is trunked.

The following windows all have the same columns (with the exception of the assignment group window which are not 
available to remote intercoms and do not have the alias column). For more information, see “Assignment Group Window” on 
page 168.

Party Lines

IFBs

IFB SLs

Special Lists

GPI Output

ISOs

UPL Resources

Assignment Groups (does not have Alias columns)

Auto Dials

The Edit Alpha /Description window is used to create or modify the port alphas, aliases, and descriptions. For more 
information on the Edit Alpha/Description window, see “Edit Alpha/Description Window” on page 229.

To access the Edit Alpha/Description window, do the following:

Double-click the Resource you wish to create/modify. 
The Edit Alpha/Description window appears.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 



228  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

NOTE: If you load an existing 4-character alpha configuration file into the Intercom system, and then set the alpha size 
to either six (6) or eight (8), the larger alpha sizes displays the default alpha (for example, N005), until they are 
edited.

Resource Column

NOTE: Resource refers to the different resource types (Port, PL, IFB, IFB SL, SL, RY, ISO, UR, AGRP, and AD) for 
each window.

The Resource column displays a list of resource numbers for the intercom system. This number cannot be modified.

Alpha (4) Column

The Alpha (4) column displays the 4-character alpha of the port.

NOTE: When you enter a 4-character alpha, and are viewing all sizes on alpha views, the 4-character output alpha 
populates the 6-character field and the 8-character field.

Alpha (6) Column

The Alpha (6) column displays the 6-character alpha of the resource.

Alpha (8) Column

The Alpha (8) column displays the 8-character alpha of the resource.

Alias (4) Column

The Alias (4) column displays the 4-character alias of the resource.

FIGURE 242. Alpha Windows in AZedit
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NOTE: When you enter a 4-character alias, and are viewing all sizes on Alpha views, the 4-character alias populates the 
6-character field and the 8-character field.

Alias (6) Column

The Alias (6) column displays the 6-character alias of the resource. 

Alias (8) Column

The Alias (8) column displays the 8-character alias of the resource.

Description Column

The Description column displays a more descriptive definition of the resource.

Edit Alpha/Description Window

The Edit Alpha/Description window, shown in Figure 243, is used to create or modify the alpha, alias, and/or description of 
Party Lines, IFBs, IFB Special Lists, Special Lists, GPI Outputs, ISOs, UPL Resources, and Assignment Groups.

Assignment groups are not available to remote intercoms and do not have the alias column. For more information, see 
“Assignment Group Window” on page 168.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Resource Field

The Resource field displays the selected resource. 

This field cannot be modified.

FIGURE 243. Edit Alpha/Description Window
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Description Field

The Description field is used to enter a short, user-recognized definition of the resource. 

This field can contain up to 24-characters.

Alpha (4) Field

The Alpha (4) field is used to change the default alphas (N001, N002, etc.) to a more meaningful name for your users (for 
example, CAM1, CAM2, etc.). 

This field can contain up to 4 characters long. 

Alpha (6) Field

The Alpha (6) field is used to change the default alphas (N001, N002, etc.) to a more meaningful name for your users (for 
example, CAM1, CAM2, etc.). 

This field can contain up to 6 characters.

Alpha (8) Field

The Alpha (8) field is used to change the default alphas (N001, N002, etc) to a more meaningful name for your users (for 
example, CAM1, CAM2, etc.). 

This field can contain up to 8 characters.

Alias (4) Field

The Alias (4) field is used to enter a 4-character alias. Alias names are used to identify destinations in a trunked intercom 
system to AZedit administrators and keypanel operators in other intercom systems.

Alias (6)Field

The Alias (6) field is used to enter a 6-character alias. Alias names are used to identify destinations in a trunked intercom 
system to AZedit administrators and keypanel operators in other intercom systems.

Alias (8) Field

The Alias (8) field is used to enter a 8-character alias. Alias names are used to identify destinations in a trunked intercom 
system to AZedit administrators and keypanel operators in other intercom systems.
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GPI Input and DIM Description Windows

The GPI Input and DIM Description windows, shown in Figure 244, displays the GPI Input resources and the DIM 
resources descriptions.

NAVIGATION: Select Alphas|GPI Input or Dim Table from the menu bar.

The Edit Alpha/Description window is used to create or modify the Descriptions for GPI Inputs and DIMs. For more 
information, see “Edit GPI Input and Dim Descriptions Window” on page 232.

To access the Edit Alpha/Description window, do the following:

Double-click the resource you wish to create/modify. 
The Edit Alpha/Description window appears.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Resource Column

NOTE: Resource refers to the different resource types (PL, IFB, IFB SL, SL, RY, ISO, UR, and AGRP) for each window.

The Resource column displays a list of resource numbers for the intercom system. This number cannot be modified.

Description Column

The Description column displays a more descriptive definition of the resource.

FIGURE 244. GPI Input Descriptions and DIM Descriptions
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Edit GPI Input and Dim Descriptions Window

The Edit GPI Input and Dim Descriptions window, shown in Figure 245, is used to create or modify the GPI Input and DIM 
table resource descriptions.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Resource Field

The Resource field displays the selected resource. 

This field cannot be modified

Description Field

The Description field is used to enter a short, user-recognized definition of the resource. 

This field can contain up to 24-character limit.

FIGURE 245. Edit GPI Input and Dim Descriptions Window
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I/O Card Description Window

The I/O Card Description window, shown in Figure 246, displays the I/O card slot position and description.

NAVIGATION: Select Alphas|I/O Cards from the menu bar.

Edit Alpha/Description Window

The Edit Alpha/Description window is used to create or modify the I/O card description. For more information, see
“Edit I/O Card Description Window” on page 234.

To access the Edit Alpha/Description window, do the following:

Double-click the resource you wish to create/modify. 
The Edit Alpha/Description window appears. 

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Slot Column

The Slot column displays the slot position of the I/O Card (slots 1-17). 

FIGURE 246. I/O Card Descriptions Window
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This field cannot be modified.

Description Column

The Description column displays the description of the I/O Card. If a description has not been assigned, the column is blank.

Edit I/O Card Description Window

The Edit I/O Card Description window, shown in Figure 247, is used to create or modify the I/O Card description.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Resource Field

The Resource field displays the selected I/O Card. 

This field cannot be modified

Description Field

The Description field is used to enter a short, user-recognized definition of the I/O Card. 

This field can contain up to 24-characters.

FIGURE 247. Edit I/O Card Description Window



AZedit Intercom Software Setup Windows  235

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

PAP/LCP Description Window

The PAP/LCP Description window, shown in Figure 248, displays the PAP/LCP device number and description.

NAVIGATION: Select Alphas|PAP and LCP-102 from the menu bar.

Edit Alpha/Description Window

The Edit Alpha/Description window is used to create or modify the resource description. For more information, see
“Edit I/O Card Description Window” on page 234.

To access the Edit Alpha/Description window, do the following:

Double-click the resource you wish to create/modify. 
The Edit Alpha/Description window appears. 

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

PAP/LCP Column

The PAP/LCP column displays PAP/LCP device (up to 15 devices). 

This number cannot be modified.

FIGURE 248. PAP and LCP Descriptions Window
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Description Column

The Description column displays the description of the PAP or LCP device. If a description has not been assigned, the column 
is blank.

Edit PAP/LCP Description Window

The Edit PAP/LCP Description window, shown in Figure 249, is used to create or modify the I/O Card description.

IMPORTANT: Remember to send any change you make to the intercom system using Online|Send Changes or the 

Activate button. 

Resource Field

The Resource field displays the selected PAP or LCP. 

This field cannot be modified

Description Field

The Description field is used to enter a short, user-recognized definition of the PAP or LCP. 

This field can contain up to 24-characters.

FIGURE 249. Edit PAP/LCP Description Window
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Status Windows

Status Windows are used to monitor different devices in the intercom system. AZedit displays status for the following 
windows:

Port

Master Controller

Standby Controller

DBX Status Links

I/O Cards

MADI Cards

PAP & LCP-102s 

UIO-256

Ethernet Links

Trunk Master

Trunk Ports

Remote Intercoms

RVON Connection Status

Alarms
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Port Status Window

The Port Status window, shown in Figure 250, is used to view connection status and data communication errors between the 
master controller and data devices that are connected to intercom ports. Data devices include keypanels, camera delegate 
panels, and TIF telephone interfaces. You can also use this screen to upgrade the firmware in certain types of keypanels 
connected to intercom ports.

NAVIGATION: Select Status|Port from the menu bar.

Port Column

The Port column displays a list of the ports in the intercom system.

Alpha Column

The Alpha column displays a list alphas relative to the port it describes in the intercom system.

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) of the ports.

FIGURE 250. Port Status Window
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Status Column

The Status column displays the description of the errors for the device connected to the port.

Bad Cut - Indicates that there was a connection with a data device, but communication has stopped.

OK KP 1-7 - This indicates the device connected to the port is a normally functioning keypanel. The numbers 1-7 
indicates the keypanel Dip switch settings for switches SW1-1 through SW1-3 on the keypanel rear 
panel as summarized in the table below. Refer to the keypanel’s user manual for information on Dip 
switch settings. In the case of a keypanel that does not have Dip switches on its rear panel, “KP 7" 
appears to indicate the keypanel is a normally functioning keypanel.

Number Switch Settings

SW1-1 SW1-2 SW1-3

0 Open Open Open

1 Open Closed Open

2 Closed Closed Open

3 Closed Closed Open

4 Open Open Closed

5 Open Closed Closed

6 Closed Closed Closed

7 Closed Closed Closed

OK? - Indicates the date device connected to the port is a keypanel with an unknown or earlier version of 
software.

OK TIF - Indicates the data device connected to the port is a TIF Telephone Interface. 

Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the port. 

BER To Column

The BER (Burst Error Rate) To column displays the number of errors sent to the port in the last 10 minutes.

Errors From Column

The Errors To column displays the number of errors the Master Controller logs as being sent from the port.

BER From Column

The BER (Burst Error Rate) To column displays the number of errors sent from the port in the last 10 minutes. 

NOTE: While a few errors may not be cause for alarm, constant errors may pose an issue with the keypanel’s 
responsiveness.The stability of the physical connection to the intercom should be checked for problems.
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Description Column

The Description column displays a short, user-recognized, definition of the resource.

Show Enhanced Status Check Box

The Show Enhanced Status check box is used to show more status information. When selected, the BER To, Errors To, BER 
From and Errors From columns are replaced with Poll Delay, Requests, Power Ups, and KP Type (see Figure 251).

NOTE: The trunk port status can be cleared from the window in the event trunking is disconnected from a system 
without first releasing the ports from trunking. This is a right-click menu option when the enhances status 
window is active.  

Poll Delay Column

The Poll Delay column reports the current poll delay setting. The poll delay is set in the Keypanel/Port Configuration window, 
see “Keypanel/Port Configuration Window” on page 117. 

Requests Column

The Requests column provides a running count of talk/listen key closures.

Power Ups Column

The Power Ups column provides a running count of how many times the connected device has been turned on.

KP Type Column

The KP Type column reports the type of keypanel that is connected. If the port has been reserved for trunking, Trunk Port 
appears.

Clear Button

The Clear button opens the Clear Port Status window (see “Clear Port Status Window” on page 241). 

FIGURE 251. Show Enhanced Status Columns
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Clear Port Status Window

The Clear Port Status window, shown in Figure 252, is used to define parameters to clear from a port or from selected ports.

NOTE: Clear port status is commonly used to troubleshoot connections. When a connection is stabilized, it is 
recommended to clear the connection errors. This gives you a better of the rate at which errors are occurring.

Select Scope of Operation Group Box

All Ports Radio Button

The All Ports radio button indicates all ports in the intercom are selected for the Clear Port Status operation.

Only Selected Ports Radio Button

The Only Selected Ports radio button indicates only selected (highlighted ports) are selected for the Clear Port Status 
operation.

Select Items to Clear Group Box

Error Counters Check Box

The Error Counters check box is used to configure error counters to be cleared with the Clear Port Status operation.

Message Counters Check Box

The Message Counters is used to configure message counters to be cleared with the Clear Port Status operation.

“Bad Cut” Status Check Box

The “Bad Cut” Status check box is used to configure “Bad Cut” Status to be cleared with the Clear Port Status operation.

FIGURE 252. Clear Port Status Window
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Key Closures for Disconnected Panels Check Box

The Key Closures for Disconnected Panels check box is used to configure disconnected panel key closures to be cleared 
with the Clear Port Status operation.

Master Controller Status Window

The Master Controller Status window, shown in Figure 253, is used to view connection status and data communication 
errors between the master controller and the configuration PC. You can also use this to upgrade the master controller firmware. 
For more information, see “Master Controller Description” on page 39.

NAVIGATION: Select Status|Master Controller from the menu bar.

FIGURE 253. Master Controller Status Window
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MC Column

The MC column identifies the frame number for each active master controller. In a Zeus or ADAM CS intercom system, this 
number is always 001. This is also the case for a single-frame ADAM system, or for a multi-frame ADAM system that uses 
DBX (Dual Bus Expansion) cards. 

In a multi-frame ADAM system that uses SBX (Single Bus Expansion) cards, the numbers indicate the following:

001 - Active master controller in master frame

002 - Active master controller in first slave frame

003 - Active master controller in second slave frame

004 - Active master controller in third slave frame

005 - Active master controller in fourth slave frame

Slot Column

The Slot column indicates which master controller slot is the active slot and which slot is currently the standby master 
controller. This is not applicable for a Zeus Intercom System. 

NOTE: In a multi-frame ADAM intercom system (with SBX cards), Slot indication is only provided for the active master 
controller in the master frame (frame 001).

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) for the master controller.

Status Column

The Status column displays the status of the master controller. OK indicates the master controller is functioning correctly. 
Anything else indicates a problem with the card.

Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the master controller. 

BER To Column

The BER To column displays the number of errors that have been sent to the master controller in the last 10 minutes.

Errors From Column

The Error From column displays the number of errors the Master Controller logs as being sent from the master controller.

BER From Column

The BER From column displays the number of errors sent from the master controller in the last 10 minutes.

Clear Errors Button

The Clear Errors button is used to clear the error counters.
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Standby Master Controller Status Window

The Standby Master Controller Status window, shown in Figure 254, is used to view connection status and data 
communication errors between the standby master controller and the configuration PC. You can also use this to upgrade the 
standby master controller firmware.

NAVIGATION: Select Status|Standby Controller from the menu bar.

Standby MC Column

The Standby MC column identifies the frame number for each standby master controller. In a Zeus or ADAM CS intercom 
system, this number is always 001. This is also the case for a single-frame ADAM system, or for a multi-frame ADAM system 
using DBX (Dual Bus Expansion) cards. 

In a multi-frame ADAM system that uses SBX (Single Bus Expansion) cards, the numbers indicate the following:

001 - Standby master controller in master frame

002 - Standby master controller in first slave frame

003 - Standby master controller in second slave frame

004 - Standby master controller in third slave frame

005 - Standby master controller in fourth slave frame

FIGURE 254. Standby Master Controller Status Window
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Slot Column

The Slot column is not applicable for a Zeus Intercom System. For an ADAM or ADAM CS Intercom System, this column 
indicates which master controller slot is the active slot and which slot is currently the standby master controller. 

NOTE: In a multi-frame ADAM intercom system (with SBX cards), Slot indication is only provided for the active master 
controller in the master frame (frame 001).

n/a – indicates there is not a standby master controller card inserted in any slot.

Right or Left – indicates which of the two (2) available master controller card slots the standby controller 
is currently using.

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) for the standby master controller.

Status Column

The Status column displays the status of the standby master controller.

“--    --” - Two (2) consecutive dashes indicate that there has never been any data communication between the standby 
controller and the master controller during the current edit session. This could be because the device is not 
connected.

Bad Cut - This indicates that there was a connection to the standby controller, but it is now not connected or there may 
be a power failure or other problem somewhere in the system.

OK Cur - This indicates the standby controller is connected and operating, and is updated with the current intercom 
system configuration.

OK Old - This indicates the standby controller is connected and operating, but is not updated with the current intercom 
system configuration.

Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the standby controller.

BER To Column

The BER To column displays the number of errors sent to the standby controller in the last 10 minutes.

Errors From Column

The Error From column displays the number of errors the master controller logs as being sent from the standby controller.

BER From Column

The BER From column displays the number of errors sent from the standby controller in the last 10 minutes.

Clear Errors Button

The Clear Errors button is used to clear the error counters.
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DBX or TBX Link Status Window

The DBX Link Status window, shown in Figure 255, is used to view the status of the DBX or TBX (Tribus) links between 
frames. 

NAVIGATION: Select Status|DBX Links from the menu bar.

DBX Column

The DBX column displays DBX/TBX cards listed by frame and slot number. For example, 1:009 indicates frame 1, card slot 
number 9.

Comm Column

The Comm column displays the communications status of the DBX/TBX cards.

Status Column

The Status column displays the status of data communication over the DBX/TBX cards. Statuses include:

“--    --” - Two consecutive dashes indicate that there has never been any data communication over the DBX/TBX 
cards. This could be because the device is not connected.

OK Active - This indicates the card is talking and is the active card in the frame.

OK Standby - This indicates the card is talking and is the standby card in the frame.

OK - Indicates the card is talking, but it is neither active nor standby.

FIGURE 255. DBX Link Status Window
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(A) Link Up/Dn Column

The (A) Link Up/Dn column displays the status of the links on DBX/TBX port A. Any of the following indications may 
appear

“--    --” - the link is down

OK # - the link is up (for # hops)

OK All - the link is up (for ALL hops)

NOTE: The hops count indicates how many consecutive links are up. 

EXAMPLE: If card 1:009 reports Link A status of OK 3 hops, that means it could send a message out its Link A and 
that message could travel up to three (3) hops before coming to a down link. (A hop means the jump 
from one DBX/TBX card to another, and to continue a hop, the receiving DBX/TBX card turns around 
and transmits the message out its other port).

OK ALL means that all links are up (every card’s link status should read OK ALL).

(A) # Hops Column

The (A) # Hops column indications are:

“--    --” - the link is down

OK # - the link is up (for # hops)

All - the link is up (for ALL hops)

NOTE: The hops count indicates how many consecutive links are up.

EXAMPLE: If card 1:009 reports Link A status of “OK 3 hops”, that means it could send a message out its Link A 
and that message could travel up to three (3) hops before coming to a down link. (A “hop” means the 
jump from one (1) DBX/TBX card to another, and to continue a hop, the receiving DBX/TBX card 
turns around and transmits the message out its other port).

OK ALL means that all links are up (every card’s link status should read OK ALL).

(B) Link Up/Dn Column

The (B) Link Up/Dn column displays the status of the links on DBX/TBX port B. Any of the following indications may 
appear:

“--    --” - the link is down

OK # - the link is up (for # hops)

OK All - the link is up (for all hops)

NOTE: The hops count indicates how many consecutive links are up.

EXAMPLE: If card 1:009 reports Link A status of “OK 3 hops”, that means it could send a message out its Link A 
and that message could travel up to three (3) hops before coming to a down link. (A “hop” means the 
jump from one DBX/TBX card to another, and to continue a hop, the receiving DBX/TBX card turns 
around and transmits the message out its other port).

OK ALL means that all links are up (every card’s link status should read OK ALL).
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(B) # Hops Column

The (A) # Hops column indications are:

“--    --” - the link is down

OK # - the link is up (for # hops)

All - the link is up (for all hops)

NOTE: The hops count indicates how many consecutive links are active. 

EXAMPLE: If card 1:009 reports Link A status of “OK 3 hops”, that means it could send a message out its Link A 
and that message could travel up to three (3) hops before coming to a down link. (A “hop” means the 
jump from one DBX/TBX card to another, and to continue a hop, the receiving DBX/TBX card turns 
around and transmits the message out its other port).

ALL means that all links are up (in this case every card’s link status should read OK ALL).

Audio A Column

The Audio A column indicates whether Port A links are being used to pass audio from one frame to another (and shows which 
timeslots/ports are being driven). Any of the following indications can be given:

“--    --” - the link is not used for audio.

###-### - this link is used for the timeslots indicated.

EXAMPLE 1

There is one DBX/TBX card per frame (in slot 9). Both DBX/TBX cards are “active” in their frame, and all links are up. The 
following information displays for a 2-frame system without redundant DBX/TBX cards. 

Link A is not used for audio in either direction. Link B, in frame 1, is being used to drive timeslots 129-252 from frame 2, and 
Link B in frame 2, and is being used to drive timeslots 1-124 from frame 1.

NOTE: In systems where there is only one (1) DBX/TBX card per frame (2 frame, and 3 frame systems without 
redundant controllers), and if test audio is enabled, then only 124 timeslots can be forwarded between frames. A 
DBX/TBX link can forward 128 timeslots, but test audio requires four (4) timeslots per link. In the 256x256 (2 
frame), and 384x384 (3 frame) system which have only one (1) DBX/TBX card per frame, all timeslots per link 
are needed for audio, but if test audio is enabled, the last timeslots in each frame are not available.

This means that the last four (4) ports in each frame can listen to, but not talk to, ports in other frames. Similarly, ports in other 
frames can talk to, but not listen to, the last four (4) ports in each frame. Within any frame, any port can talk or listen to any 
other port in that frame; the timeslots are only lost going between frames.

Test Audio is artificially generated audio by the DBX/TBX so that it can produce, publish, forward, receive, and test. It is used 
by the DBX/TBX to ensure that the links are passing valid audio between frames. If the DBX/TBX detects that the link is up, 
but that the audio is corrupt, the DBX/TBX tears down the link and builds it up again.

DBX Status Link A Link B Audio A Audio B

1:009 OK Active OK All OK All - 129-252

2:009 OK Active OK All OK All - 001-124
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EXAMPLE 2

In example 2, the link connecting Port B of 1:9 to Port B 2:9 has been broken. The audio automatically switched over to the A 
links, and the hop count for the A links shows 1 instead of ALL. 

NOTE: Even though this intercom is called a 2-frame, non-redundant, system, it actually has redundant audio because 
both links go between frame 1 and 2. The intercom does not have redundant control because there is only one 
DBX/TBX card per frame, and if any card fails, connectivity is lost.

It is possible for the audio from frame 1 to frame 2 to be carried on one link, while audio in the other direction is carried on 
another link.

Audio B Column

The Audio B column indicates whether Port B links are being used to pass audio from one (1) frame to another (and shows 
which timeslots/ports are being driven). Any of the following indications can be given:

“--    --” -the link is not being used for audio.

###-### - this link is being used for the timeslots indicated.

EXAMPLE 1

The following information would be displayed for a 2-frame system without redundant DBX cards. There is one DBX card per 
frame (in slot 9). Both DBX cards are “active” in their frame, and ALL links are up.

Link A is not being used for audio in either direction. Link B, in frame 1, is being used to drive timeslots 129-252 from frame 
2, and Link B in frame 2, and is being used to drive timeslots 1-124 from frame 1.

NOTE: In systems where there is only one (1) DBX/TBX card per frame (2 frame, and 3 frame systems without 
redundant controllers), and if test audio is enabled, then only 124 timeslots can be forwarded between frames. A 
DBX/TBX link can forward 128 timeslots, but test audio requires four (4) timeslots per link. In the 256x256 (2 
frame), and 384x384 (3 frame) system which have only one (1) DBX/TBX card per frame, all timeslots per link 
are needed for audio, but if test audio is enabled, the last timeslots in each frame are not available.

This means that the last four (4) ports in each frame can listen to, but not talk to, ports in other frames. Similarly, ports in other 
frames can talk to, but not listen to, the last four (4) ports in each frame. Within any frame, any port can talk or listen to any 
other port in that frame, the timeslots are only lost going between frames.

Test Audio is artificially generated audio by the DBX/TBX that it can produce, publish, forward, receive, and test. It is used by 
the DBX/TBX to ensure that the links are passing valid audio between frames. If the DBX/TBX detects that the link is up, but 
that the audio is corrupt, the DBX/TBX tears down the link and builds it up again.

DBX/TBX Status Link A Link B Audio A Audio B

1:009 OK Active OK 1 - - 129-252

2:009 OK Active OK 1 - - 001-124

DBX/TBX Status Link A Link B Audio A Audio B

1:009 OK Active OK All OK All - 129-252

2:009 OK Active OK All OK All - 001-124
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EXAMPLE 2

In example 2, the link connecting Port B of 1:9 to Port B 2:9 has been broken. The audio automatically switched over to the A 
links, and the hop count for the A links shows 1 instead of all. 

NOTE: Even though this intercom is called a 2-frame, non-redundant, system, it actually has redundant audio because 
both links go between frame 1 and 2. The intercom does not have redundant control because there is only one (1) 
DBX/TBX card per frame, and if any card fails, connectivity is lost.

It is possible for the audio from frame 1 to frame 2 to be carried on one link, while audio in the other direction is carried on 
another link

I/O Card Status Window

The I/O Card Status window, shown in Figure 256, is used to view connection status and data communication errors between 
Audio Input/Output Cards and the active Master Controller Card. You can also use this to upgrade the firmware in Audio 
Input/Output Cards and DBX Cards.

NAVIGATION: Select Status|I/O Cards from the menu bar.

Slot Column

The Slot column displays the card in relation to which frame and its position in the frame. 

For example, 1:011, indicates the card is in Frame 1 and in Slot 11.

DBX/TBX Status Link A Link B Audio A Audio B

1:009 OK Active OK 1 - - 129-252 -

2:009 OK Active OK 1 - - 001-124 -

FIGURE 256. I/O Card Status Window
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Port Column

The Port column displays a list of the ports designated to that slot. This column shows AIO-8 card ports and the first half of 
the sixteen ports on an AIO-16.

Port Column

The Port column displays a list of the ports designated to that slot. This column shows the second half of the sixteen ports on 
an AIO-16.

Card Type Column

The Card Type column displays the type of card that is in the slot.

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) of the ports.

(blank) - no card present

OK - the card is communicating with the master controller.

BAD - the card is not communicating with the master controller.

Status Column 

The Status column displays the communication status between the I/O card and the Master Controller.

CUR - The information from the master controller is current and up-to-date.

OLD - The information from the master controller is not current and out-of-date.

CUT - The information is bad and communication terminated.

Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the I/O card. 

BER To Column

The BER To column displays the number of errors sent to the card in the last 10 minutes.

Errors From Column

The Error From column displays the number of errors the Master Controller logs as being sent from the I/O card.

BER From Column

The BER From column displays the number of errors sent from the card in the last 10 minutes.

Description Column

The Description column displays a short, user-recognizable, definition of the resource.

Clear Errors Button

The Clear Errors button is used to clear the error counters.
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MADI Card Status Window

The MADI Card Status window, shown in Figure 257, is used to display configuration options for MADI 16 Plus cards 
installed in your intercom system.

For more information, see “MADI Card Status Window” on page 70.

FIGURE 257. MADI Card Status Window
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PAP & LCP-102 Status Window

The PAP & LCP-102 Status window, shown in Figure 258, is used to view the status information for the PAP or LCP-102 
devices. You can also download firmware updates to the devices from this window.

NAVIGATION: Select Status|PAP and LCP-102 from the menu bar.

PAP/LCP Column

The PAP/LCP column displays a list of all the PAP/LCP-102s in the intercom system.

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) between the intercom system and the 
PAP/LCP-102 connections.

Status Column

The Status column displays the communication status between the PAP or LCP-102 and the Master Controller.

“--    --” - Two (2) consecutive dashes indicate there has never been any data communication between the PAP or 
LCP-102 and the master controller during the current edit session. This could be because the PAP or 
LCP-102 is not connected.

Bad Cut - This indicates there was a connection to the PAP or LCP-102, but it is now not connected, or there may be a 
power failure or other problem somewhere in the system.

OK PAP - This indicates the Program Assist Panel or LCP-102 is connected and operating. 

FIGURE 258. PAP and LCP Status Window
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Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the PAP or LCP-102.

BER To Column

The BER To column displays the number of errors sent to the PAP or LCP-102 in the last 10 minutes.

Errors From Column

The Error From column displays the number of errors the Master Controller logs as being sent from the PAP or LCP-102.

BER From Column

The BER From column displays the number of errors sent from the PAP or LCP-102. in the last 10 minutes.

Description Column

The Description column displays description of the PAP or LCP device.

Clear Errors Button

The Clear Errors button is used to clear the error counters.
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UIO-256 Status Window

The UIO-256 Status window, shown in Figure 259, is used to view status information for the UIO-256 and GPIO-16. You can 
also download firmware updates from this window.

NAVIGATION: Select Status|UIO-256 from the menu bar.

UIO Column

The UIO column displays a list of all the UIO-256 units in the intercom system.

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) of the UIO-256 units in the intercom system.

Status Column

The Status column displays the status of the UIO-256 device.

“--    --” - Two (2) consecutive dashes indicate that there has never been any data communication between the 
UIO-256 and the master controller during the current edit session. This could be because the device is not 
connected.

Bad Cut - This indicates there was a connection to the UIO-256, but it is now not connected, or there may be a power 
failure or other problem somewhere in the system.

OK Cur - This indicates the UIO-256 is connected and operating, and is updated with the current intercom system 
configuration.

OK Old - This indicates the UIO-256 is connected and operating, but is not updated with the current intercom system 
configuration. 

Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the UIO.

FIGURE 259. UIO Status Window
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BER To Column

The BER To column displays the number of errors sent to the UIO in the last 10 minutes.

Errors From Column

The Error From column displays the number of errors the Master Controller logs as being sent from the UIO card.

BER From Column

The BER From column displays the number of errors sent from the UIO in the last 10 minutes.

Clear Errors Button

The Clear Errors button is used to clear the error counters.

Ethernet Links Status: Trunk Master Window

TM/Link Column

The TM/Link column displays the Trunk Master number and the link number. For example, the first link in the second trunk 
master would be represented as 2:1.

Link Up/Dn Column

The Link Up/Dn column displays whether the link is up (active) or down (inactive)

Status Column

The Status column displays the status of the Ethernet link. 

Available selections for this field are:

OK - the link is up

Active - the link is active

Standby - the link is standby

– (hyphen) - the link is down

FIGURE 260. Ethernet Link Status Window
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IP Address Column

The IP Address column displays the IP Address of the trunk master.

Link Ups Column

The Link Ups column displays how many time a connection was established. Normally this value is very low (i.e. 1 or 2); 
however, if there are network problems, a higher number may display.

Round Trip (ms) Column

The Round Trip (ms) column displays approximately how long, in milliseconds, it takes for a message from the intercom to 
be acknowledged by the trunk master.

Round Trip is an average value. It should never be any higher than a predetermined maximum (currently 5 seconds). If this 
value goes higher, the link fails. Alternatively, this value can never be lower than 0 seconds.

The range for this field is 0 – 5.

Packets To Column

The Packets To column display the number of packets (i.e., messages) sent to the trunk master from the intercom.

Retransmits Column

The Retransmits column displays approximately how many messages (i.e., packets) needed to be retransmitted because no 
acknowledgement for those packets is received from the trunk master. This can happen if a message was dropped by the 
network, or if the round trip is high enough the intercom reset the message before it received the acknowledgement from the 
trunk master.

Packets From Column

The Packets From column displays the number of packets (i.e., messages sent from the trunk master to the intercom).

Duplicates Column

The Duplicates column displays approximately how many messages (i.e., packets) needed to be retransmitted because no 
acknowledgement for those packets is received from the intercom.
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Ethernet Link Status: Frame-to-Frame Window

Frame/Link Column

The Frame/Link column displays the Frame number and the frame link number. For example, the first frame and the second 
link would be displayed as 1:2. 

Link Up/Dn Column

The Link Up/Dn column displays whether the fiber link is up (active) or down (inactive).

Slot Column

The Slot column displays the physical position of the Tribus card in the frame.

Status Column

The Status column displays the status of the Ethernet link. 

Available options for this field are:

OK - the link is up

Active - the link is active

Standby - the link is standby

– (hyphen) - the link is down

IP Address Column

The IP Address column displays the IP Address of the Tribus card.

Fault? Column

The Fault? column displays a message if two (2) frames are connected to form a multi-frame intercom, but their 
configurations do not match. When two (2) frame configurations do not match it prevents the frames from communicating 
with each other. If the frames continue to operate as autonomous even though the link between them is up, the reason displays 
in this column.

FIGURE 261. Ethernet Link Status: Frame-to-Frame window
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NOTE: An <N> or similar symbol with the message text denotes a numeric value inserted by the software at runtime.

Link Ups Column

The Link Ups column displays how many times a connection was established.

Round Trip (ms) Column

The Round Trip (ms) column displays approximately how long, in milliseconds, it take s for a message from the intercom to 
be acknowledged by the trunk master.

NOTE: Round Trip is an average value. It should never be any higher than a predetermined maximum (currently 5 
seconds) If this value goes higher, the link would go down. Alternatively, this value can never be lower than 0.

The range for this field is 0 – 5.

Packets To Column

The Packets To column displays the number of packets (i.e., messages) sent to the Tribus card from another Tribus card.

Retransmits Column

The Retransmits column displays approximately how many messages (i.e., packets) needed to be retransmitted because no 
acknowledgement for those packets is received from the Tribus card. 

Packets From Column

The Packets From column displays the number of packets (i.e., messages) sent from the Tribus card.

Duplicates Column

The Duplicates column displays approximately how many messages (i.e., packets) needed to be retransmitted because no 
acknowledgement for those packets was received by the Tribus card.

Frame ID Mismatch: The other 
card thinks this is Frame <N> -

Indicates this frame (the one AZedit is connected) and the other frame disagree as 
to the number of this frame, with <N> being the number that the other frame 
expects this frame to be.

Frame ID Mismatch: The other 
card is <N1>, not <N2> - Indicates with <N1> what this frame expects the other frame to be numbered, and 

<N2> what the other frame is reporting as its number.

Frame ID Mismatch: The other 
card is also frame <N> - Indicates both this frame and the other frame have the same number <N>.

The other frame has a different 
configuration than this frame - Indicates the frame configuration between frames is not identical.

Link is Inactive (unknown cause) - 
Indicates the link is inactive with no known cause.

No State Information Received - 
Indicates no status information is available.
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Trunk Master Status Window

The Trunk Master Status window, shown in Figure 262, is used to view status information for Trunk Master devices in your 
intercom system. You can also download firmware updates from this window.

NAVIGATION: Select Status|Trunk Master from the menu bar.

TM Column

The TM column displays a list of all trunk master connections.

Comm Column

The Comm column displays a list of communication statuses (OK, BAD, or -) of the trunk master connections.

FIGURE 262. Trunk Master Status Window
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Status Column

The Status column displays the data transfer status between the trunk master and the master controller.

“--    --” - Two (2) consecutive dashes indicate that there has never been any data communication between the trunk 
master and the local master controller.

Bad Cut - Indicates that there was a connection to the trunk master, but it is now not connected, or there may be a 
power failure or other problem somewhere in the system.

OK Cur - This indicates the trunk master is connected and operating and is updated with the current intercom system 
configuration.

OK Old - This indicates the trunk master is connected and operating but is not updated with the current intercom 
system configuration. 

Errors To Column

The Errors To column displays the number of errors the Master Controller logs as being sent to the Trunk Master.

BER To Column

The BER To column displays the number of errors sent to the trunk master in the last 10 minutes. 

Errors From Column

The Error From column displays the number of errors the Master Controller logs as being sent from the trunk master. 

BER From Column

The BER From column displays the number of errors sent from the trunk master in the last 10 minutes.

Clear Errors Button

The Clear Errors button is used to clear the error counters.
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Trunk Inspection Window

The Trunk Inspection window, shown in Figure 263, is used to view trunk ports for specified intercom ports. From this 
screen you can select the origination port and view trunked ports.

NAVIGATION: Select Status|Trunk Ports from the menu bar.

Port Column

The Port column displays port number of the port trunking is configured.

Alpha Column

The Alpha column displays port alpha of the port trunking is configured.

FIGURE 263. Trunk Inspection Window
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Trunk [number] Group Box

The Trunk [number] group box displays the number assigned to a trunk (for example, Trunk #1). You can define as many 
trunks as your system allows. 

From Fields

The From fields indicate the name of the intercom system and the port at the origin of the trunk.

To Fields

The To fields indicate the name of the intercom system and the port at the destination of the trunk.

Origination Assignments Group Box

The Origination Assignments group box displays the origination trunk ports (number and alpha) and whether talk and/or 
listen is assigned to them. If talk and/or listen is assigned, a red circle appears under the T/L. 

Destination Assignments Group Box

The Destination Assignments group box displays the destination trunk ports (number and alpha) and whether talk and/or 
listen is assigned to them. If talk and/or listen is assigned a red circle appears under the T/L.
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Remote Intercoms Status Window

The Remote Intercoms Status window, shown in Figure 264, is used to view the status of remote ports and perform minimal 
maintenance tasks. 

NAVIGATION: Select Status|Remote Intercoms from the menu bar.

IMPORTANT: Remember to send any changes you make to the intercom system using Online|Send Changes or the 

Activate button. 

Name Column

The Name column displays a selectable list of remote intercom names.

Status Column

The Status column displays the communication status of the remote intercom. Available statuses are OK or -.

FIGURE 264. Remote Intercom Status Window
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Select an Operation... Group Box

There are four (4) operations that can be performed, as indicated by the four radio button options on the right side of the 
screen. Depending on which intercom is highlighted in the list, the text description of options 1 and 3 changes.

Available selections for this field are:

Clear all key assignments in this intercom that refer to resources in all intercoms that are not 
communicating.

Clear all key assignments in all intercoms that refer to resources in all intercoms that are not 
communicating.

Clear all key assignments in this intercom that refer to resources in the selected intercom, where the 
resources are scroll restricted.

Clear all key assignments in this intercom that refer to resources in all intercoms, where the resources 
are scroll restricted.

The first two (2) options refer to the case where an intercom that used to be in service has been removed from service 
(disconnected from the Trunk Master). These options allow you to remove all key assignments for a disconnected 
intercom (or intercoms) from all keypanels in your intercom.

The last two (2) options refer to the case where remote resources that had been available to this intercom, and had been 
programmed onto keys, are now scroll restricted and are not available to this intercom. These options allow you to remove 
restricted resource key assignments from all keypanels in your intercom.

Clear Button

The Clear button is used to confirm the clear action. When the Clear button is clicked, the Clear Key Assignment window 
appears (see Figure 265). From this window, you can confirm the clearing of key assignments or canceling the operation.

To clear the key assignments, do the following:

Click Proceed to confirm, otherwise click Cancel.

FIGURE 265. Clear Key Assignments Window
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NOTE: When you click Proceed, you can watch the progress bar as it completes the Clear operation. Once complete, 
the following message appears under Operation Status.

RVON Connection Status Window

The RVON Connection Status window, shown in Figure 266, is used to view Card/Channel, Connection, VOIP, Network, 

Errors, and Pass-Through connection status information.

NOTE: When viewing the RVON Connection Status screens, make sure both AZedit and the RVON device are on the 
same Ethernet network. The reason this is important is because the statistics are updated once per second. At this 
rate of dynamic update, a serial port could not pass the data effectively.

NAVIGATION: Select Status|RVON Connection from the menu bar.

Card/Channel Page

FIGURE 266. RVON Connection Status - Card / Channel Page
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Select Local Card and Channel Group Box

RVON Card Drop Down Menu

The RVON Card drop down menu is used to select the card for which you want to view the status. 

IP Address Field

The IP Address field displays the IP Address of the selected device.

Local Channel Drop Down Menu

The Local Channel drop down menu is used to select one (1) of 8 or 16 (depending on the RVON device) channels supported 
by the RVON device.

Remote Connection Information Group Box

Device Type Field

The Device Type field displays the type of device the RVON card is connected to on the other end of the channel (for example, 
RVON Keypanel/VKP).

IP Address Field

The IP Address field displays the IP Address of the device connected at the other end of the channel.

Remote Channel Field

The Remote Channel field displays the channel at the other end of the connection the RVON device is using.
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Connection Page

Connection Information Group Box

Attempts / Drops Field

The Attempts / Drops field displays the number of times a call attempt is made and dropped.

NOTE: The number of attempts should always be one (1) greater than the number of drops.

Current Call State Field

The Current Call State field displays the state of the connection. 

Available selections for this field are: Connected or Idle.

Origination/Termination Field

The Origination / Termination field displays which end of the connection originated or terminated the call.

Local - RVON Device

Remote - Device at other end of the connection

Release Reason Field

The Release Reason field displays the reason the connection was terminated, for example, congestion, network error, local 
release, or remote release.

FIGURE 267. RVON Connection Status - Connection Page
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Connection Duration Field

The Connection Duration field displays the duration of the connection. This is shown as hh/mm/ss.

Compression Algorithm, Audio Packet Size, and Voice Activity Detect (VAD) Fields

The Compression Algorithm, Audio Packet Size, and Voice Activity Detect (VAD) fields display the type of configuration 
the connection is using. This can be different than the original configuration if both ends of the channel are not configured the 
same. If the configuration is different, these fields are displayed in red.

VOIP Page

VOIP Playout Statistics Group Box

Playout Buffer Size Field

The Playout Buffer Size field displays how much audio, in ms, can be received from the network before packets are lost. This 
is four (4) times bigger than configured packet size.

Nominal Playout Delay Field

The Nominal Playout Delay field displays how much audio, in ms, is collected before playout begins. Playout begins at half 
the playout buffer size, which is two (2) times the configured packet size.

Average Playout Delay Field

The Average Playout Delay field displays the actual average audio, in ms, collected before the packets are played out. This is 
measured over the length of the connection.

FIGURE 268. RVON Connection Status - VOIP Page
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Voice Playout Buffer Underrun Field

The Voice Playout Buffer Underrun field displays the number of times packets were not played because the playout buffer 
was empty.

NOTE: If VAD is enabled, there are playout buffer runs because there are no packets being received during silence.

Voice Playout Buffer Overrun Field

The Voice Playout Buffer Overrun field displays the number of packets that were discarded because the playout buffer was 
full.

Missing Sequence Packet Field

The Missing Sequence Packet field displays how many audio packets were missed in the sequence.

Replaced Packets Field

The Replaced Packets field displays how many audio packets were replayed.

Average Frame Jitter Field

The Average Frame Jitter field displays the measure of consistency, in ms, of packet arrival times. Lower jitter is better.

Network Page

FIGURE 269. RVON Connection Status - Network Page
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Network Statistics Group Box

Voice Playout Packets (Tx/Rx) Field

The Voice Playout Packets (Tx/Rx) field displays the number of voice packets transmitted and received from the other side of 
the connection.

DTMF Relay Packets (Tx/Rx) Field

The DTMF Relay Packets (Tx/Rx) field displays the number of DTMF (Dual Tone Multiple Frequency) relay packets 
transmitted and received. DTMF relay packets are a bandwidth and quality saving feature within the RVON devices.

Silence Detection Packets (Tx/Rx) Field

The Silence Detection Packets (Tx/Rx) field displays the number of times a silence detection packet has been sent or 
received. VAD must be enabled.

Silence Suppressed Packets (Tx) Field

The Silence Suppressed Packets (Tx) field displays the number of packets never sent because the packets contained silence.

Packet Interarrival Time (Min/Max) Field

The Packet Interarrivel Time (Min/Max) field (also referred to as latency) displays the minimum and maximum time 
elapsed between packets being sent.

Recent Bandwidth Use (Tx/Rx) Field

The Recent Bandwidth Use (Tx/RX) field displays the amount of bandwidth used, in Kbytes per second, over the length of 
the call. This is calculated by the number of voice packets transmitted and received over the last 10 seconds.

Average Bandwidth Use (Tx/Rx) Field

The Average Bandwidth Use (Tx/Rx) field displays the amount of bandwidth used, in Kbytes per second, over the length of 
the call. This is calculated by the number of voice packets transmitted and received and the length of the connection.
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Errors Page

Error Counts Group Box

Invalid Headers Field

The Invalid Headers field displays the number of IP packets that could not be parsed.

Invalid MAC Address Field

The Invalid MAC Address field displays the number of invalid MAC Addresses that tried to connect to the RVON device.

Invalid SSRC Field

The Invalid SSRC field displays the number of packets with an invalid SSRC. The SSRC is an ID used to verify the validity 
of data packets being received.

Invalid Payload Field

The Invalid Payload field displays how many incorrectly formatted packets were received.

DSP to Micro Overrun Field

The DSP to Micro Overrun field displays the number of packets lost because the micro was too busy to receive.

Invalid Destination Field

The Invalid Destination field displays the number of invalid destinations received.

FIGURE 270. RVON Connection Status - Errors Page
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Lost Packets field

The Lost Packets field displays the number packets that were lost.

Pass-Through Page

Serial to Ethernet Group Box

The Serial to Ethernet information displays the serial data received on the serial connection and transferred to the Ethernet 
address of the card to which the serial data is sent.

Bytes Transferred Field

The Bytes Transferred field displays the number of bytes transferred from the serial connection to Ethernet.

Bytes Lost Field

The Bytes Lost field displays the number of bytes that could not be transferred.

Errors Field

The Errors field displays the number of errors that occurred during transfer.

Tx IP Address Field

The Tx IP Address field displays the IP Address of the card the serial data is sent to.

FIGURE 271. RVON Connection Status - Pass-Through Page
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Baud Rate Field

The Baud Rate field displays the baud rate of the serial connection.

Ethernet to Serial Group Box

The Ethernet to Serial information displays the serial data received on the Ethernet connection and transferred to the serial 
connection.

Bytes Transferred Field

The Bytes Transferred field displays the number of bytes transferred to the serial port.

Bytes Lost Field

The Bytes Lost field displays the number of bytes that could not be transferred.

Errors Field

The Errors field displays the number of errors that occurred during transfer.

Rx IP Address Field

The Rx IP Address field displays the IP Address from which data was last received via Ethernet (this address should match 
the Tx IP Address).

Unexpected Bytes Field

The Unexpected Bytes field displays the number of unexpected bytes of data. Unexpected bytes is data from an IP Address 
that is not the Tx IP Address. The bytes of data are considered unexpected bytes and are not transferred.
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Intercom Alarms Window

The Intercom Alarms window, shown in Figure 273, displays notifications of events that occur in the intercom system. When 
an alarm occurs an Alarm Notification message (Figure 272) appears. From this message, you can navigate directly to the 
Intercom Alarms window by clicking Yes; or select the Don’t ask again check box to hide this message in the future. 

TIP: To redisplay the Alarm Notification Message, do the following:

1.From the Options menu, select Preferences.
The Application Preferences window appears.

2.Click the Advanced Tab.
The Advanced page appears.

3.Select the Enable the Alarm notification popup check box.
The Alarm Notification message is enabled.

FIGURE 272. Alarm Notification Message

FIGURE 273. Intercom Alarms Window
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Frame Column

The Frame column displays the frame where the alarm occurred.

Alarm Time Column

The Alarm Time column displays the time (in military format) the alarm occurred.

Resolved Time Column

The Resolved Time column displays the time (in military format) the alarm is resolved.

Description Column

The Description column displays a description of the alarm that occurred. 

The following alarm descriptions are available:

NOTE: %1 and %2 are placeholders for parameters that get inserted when the alarm description is generated.

Lost contact with Standby controller

Lost contact with I/O card %1

Lost contact with Keypanel %2 (port %1)

No audio links to frame %1

Only 1 audio link to frame %1

Only 1 Tri-Bus has audio links to frame %1

No Ethernet link to frame %1

Frame mapping tables do not agree: slot %1, link %2

System sizes differ: frame %1, controller %2

Frame IDs do not agree: slot %1, link %2

Lost contact with Trunk Master

Ethernet link down

Only 254 timeslots can be forwarded between frames

Lost TDM (backplane) clock

Load File requested by UPL

Audio link failed: Tri-Bus in slot %1, link %2

Port allocation mismatch: I/O card %1
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Software Versions Windows

The Software Versions windows are used to view the versions of software currently running on your intercom system. There 
are four software versions windows in AZedit: Master Controller Version, I/O Card Version, Keypanel Version, and GPIO-16 
Version.

NOTE: You can download software updates for a specific device from these windows. For more information, see 
“Downloading Firmware Updates” on page 364.

Master Controller Version Information Window

The Master Controller Version Information window, shown in Figure 274, is used to view the firmware version of the 
active master controller. You can also update the master controller firmware from this screen.

NAVIGATION: Select Status|Software Versions|Master Controllers from the menu bar.

MC Column

The MC column displays the master controller number. 

Version Column

The Version column displays the type of master controller, firmware version and build date.

NOTE: In the Zeus intercom systems there is only one master controller, and it is always the active master controller. In 
the ADAM and ADAM CS intercom systems there are two master controllers: the active master controller and 
the standby master controller. This screen displays the version information for only the active master controller. 
You can reset the active master controller card to find out the version information for the standby master.

FIGURE 274. Master Controller Version Information Window



278  Setup Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

I/O Card Version Information Window

The I/O Card Version Information window, shown in Figure 275, is used to view version information for the I/O cards in 
your intercom system. You can also download firmware updates to the cards from this window. For more information, see 
“How to Download Firmware to Multiple Cards” on page 390.

NAVIGATION: Select Status|Software Versions|I/O Cards from the menu bar.

Slot Column

The Slot column displays the slot an I/O card is occupying (for example, the AIO-16 card is in slot 2).

Version Column

The Version column displays the firmware version and build date of the I/O card.

FIGURE 275. I/O Card Version Information Window
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Keypanel Version Information Window

The Keypanel Version Information window, shown in Figure 276, is used to view the port and version information for all the 
keypanels on the intercom system. You can also download firmware updates from this window. For more information, see 
“How to Download Firmware to Multiple Cards” on page 390.

NAVIGATION: Select Status|Software Versions|Keypanels from the menu bar.

Port Column

The Port column displays a list of all the ports in the intercom system.

Alpha Column

The Alpha column displays a list of alphas assigned to the ports in the intercom system.

Version Column

The Version column displays the selected keypanel’s firmware version and build date

Show RVON Versions Check Box

The Show RVON Versions check box is used to display the type of RVON card, the version, the firmware release date, and 
the IP Address of the card.

FIGURE 276. Keypanel Version Information Window
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GPIO-16 Version Information Window

The GPIO-16 Version Information window, shown in Figure 277, is used to view GPIO-16 device version information. You 
can also download firmware updates to the GPIO-16 device. For more information, see “Upgrade the GPIO-16 Firmware” on 
page 414.

NAVIGATION: Select Status|Software Versions|GPIO-16 from the menu bar.

UIO Column

The UIO column displays a list of GPIO-16s in the ADAM system.

IP Address Column

The IP Address column displays the IP Address assigned to the GPIO-16 device.

Version Column

The Version column displays the version of the selected GPIO-16 device.

FIGURE 277. GPIO-16 Version Information Window
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Log Viewer Window

The Log Viewer window, shown in Figure 278, is used to record intercom key activations and deactivations. Each time a key 
is pressed or released, a new record is created.

NOTE: In version 3.0 and higher, the setup folders are not version specific; therefore, they appear under 
C:\TELEX\AZedit, whereas in previous versions, they would be housed under each version. As upgrades of 
AZedit are installed, existing log files do not have to be moved to a new location. Use the Logging page 
(Options|Preferences) to change the log file location, if desired.

The Logging menu (in the menu bar at the top of the application window) contains the following items: 

View Log - This runs Log Viewer. Here you can open and view log files. You can monitor intercom activity by 
watching the new records appear in the log. 

Disable Logging - This stops Log Viewer from recording any intercom key activity.

Log to File - Log Viewer automatically creates a log file as soon as key activity begins. It then appends each new 
record to the log file. Log Viewer names the file according to the format year/month/day .log, for 
example: 991201.log would be the log file created for December 01, 1999. 

By default, Log files are stored in the folder C:\TELEX\AZedit\LOG. 

NAVIGATION: Select Logging|View Log from the menu bar.

To specify a folder in a different location, do the following:

1. From the Options menu, select Preferences.
The Preferences notebook opens.

2. Click Logging.
The logging page appears.

3. In the Log Files (.LOG): field, specify the path where you want to save log files (for example, C:\Telex\AZedit\).

4. Click Apply.

5. Click OK.

Log to Serial Port 

Log to Serial Port is only available for ADAM CS and ADAM Intercom Systems. It outputs the log data on a dedicated 
RS232 port of the intercom system. If you have the appropriate communications software to communicate with this port, you 
can use it to capture the logging text to a file or to monitor intercom activity. For the ADAM Intercom System, the dedicated 
logging port is located on J9 of the XCP-ADAM-MC Master Controller Breakout Panel: pin 3 is Rx and pin 8 is Tx. For the 
ADAM CS Intercom Frame, the dedicated logging port is located on J902: pin 3 is Rx and pin 8 is Tx. In either situation, the 
port parameters are 9600-baud, no parity, 8 data bits, 1 stop bit.
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Log Record Format

The format for each log record is as follows:

[yymmdd] [hhmmssff] [nnn-aaaa] [mm-ff-nnn-aaaa] [xx]

Brackets delimit the data fields in each record, and the data in the fields are as follows:

Yy/mm/dd > Date

Hh:mm:ss.ff > Time (ff = frames)

nnn-aaaa > requester's port number and corresponding 4-character alpha

mm-ff-nnn-aaaa > target matrix number, function type, function number, function alpha. (Target matrix number 00 means 
the local matrix.)

xx > one of the 4 pairs TY, TN, LY, or LN, where T=talk, L=Listen, Y=yes (key on), and N=no (key off)

Example: if a keypanel at intercom port 4 with alpha DIR calls local party line 3 with alpha CAM, the following might be 
logged:

[99/12/01] [17:22:04.13] [004-DIR] [00-PL-003-CAM] [TY]

[99/12/01] [17:22:24.08] [004-DIR] [00-PL-003-CAM] [TN]

There are some peculiarities when it comes to trunking. 

EXAMPLE:

Suppose Hap calls Biff (a point-to-point in a different matrix). A line such as the following might be logged: 

[99/12/01] [17:23:09.00] [017-HAP] [07-PP-103-BIFF] [TY]

One (1) or two (2) lines that connect Hap to a trunk might then follow this. The following line might be added: 

[99/12/01] [17:23:09.00] [041-TK19] [00-PP-017-HAP] [LY] 

This reflects that port 41 (trunk 19) effectively turned on a listen key assigned to Hap so that the trunk could hear Hap, i.e. so 
that Hap's audio is fed to the trunk. 

Log File Type Drop Down Menu

The Log File Type drop down menu indicates the choice between Log Files and SERVER Mode Log Files. 

Log Files are logs generated in online and File mode.

FIGURE 278. Log Viewer Window



AZedit Intercom Software Setup Windows  283

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Server Mode Logs are generated while in Server Mode.

Location Browse Button

The Location Browse button allows users to navigate to where the log files are written (either in the Telex file on the PC's 
hard drive or a network share drive).

Date Drop Down Calendar

The Date drop down calendar specifies a date in which to look for log files.

Log View Field

The Log View field is used to see the different logs written. Double-click any log to view the contents.
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CHAPTER 6

Miscellaneous Windows

Keypanels Color Window

The Keypanel Color window is used to change the color assigned to represent a functions type, key assignment, assignment 
group, and talk/listen indications. You can modify both local intercoms and remote intercom assignments, giving you the 
flexibility to distinguish different systems through the use of color patterns.

The Keypanel Color window is only available when the following requirements are met:

• when using a CLD family keypanel (KP 32 CLD, DKP 16 CLD, KP 12 CLD, and EKP 32 CLD) 
firmware version 1.1.1 or later is installed on the KP 32 CLD or v1.0.1 on the KP 12 CLD

• running AZedit version 3.7.0 or later

• running MCII-e version 2.1.0 or later

NOTE: Key colors are associated with assignment types, not to the physical keys they are assigned to.
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NAVIGATION: Select Miscellaneous|Keypanel Colors from the menu bar.

FIGURE 279. Keypanel Colors Window
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Function Types Page

The Function Type page, shown in Figure 279, is used to change the default colors assigned to the various keypanel function 
types.

Select Intercom Drop Down Menu

The Select Intercom drop down menu is used to select the intercom system (local or remote) in which you want to change the 
color of the key function types.

Standard Colors Group Box

The Standard Colors group box displays 18 selectable colors you can use for function type color identification.

To apply a standard color to a key assignment, do the following:

1. From the Select Intercom drop down menu, select the intercom system you want to change the key function types 
for.

2. From the Color column in the right pane, select the function color box you want to change the color for.

3. From the Standard Colors group box, select the standard color you want apply to the function.
The color appears in the Current Color group box.

4. Click Apply.
The Function Color box in the right pane changes to the selected color.

Recent Colors Group Box

The Recent Colors group box displays the most recent colors you have used. The 18 most recent used colors are displayed.

Current Color Group Box

The Current Color group box displays the currently selected color, whether from the color palette, standard colors, or recent 
colors. Also, using the Hue, Sat, Lum or Red, Green, Blue spin boxes, you can adjust the selected color to create a more unique 
color for the function type.

Apply Button

The Apply button is used to apply the color selection.
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Default Button

The Default button is used to clear the color selection and return to the default color.

Function Type Column

The Function Type column displays the different functions types you can make key color changes for.

Available selections for this field are: Null, Special Functions, Ports, Party Lines, IFBs, Special Lists, GPI Outputs, ISOs, 
UPL Resources, and IFB Special Lists.

Color Column

The Color column displays the current color assigned to the function type.

NOTE: You must select the current color box next to the function type you want to change the color for. When selected, 
a thick black line appears around the box.

Show Default Colors Check Box

The Show Default Colors check box indicates the default colors assigned to the function types are shown. If not selected, the 
color column in the right pane displays white boxes.

FIGURE 280. Function Type and Color Columns
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Key Assignment Page

The Key Assignment page, shown in Figure 281, is used to override the default colors assigned to the various assignment 
types. This means you can assign different colors to the individual functions type resources. For example, you can change the 
color seen for the party line assignment 003.

FIGURE 281. Key Assignments Page
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Select Function Type Drop Down Menu

The Select Function Type drop down menu is used to select the function type you want to display the function number 
resources for.

Available selections for this field are: Ports, Party Lines, IFBs, Special Lists, GPI Outputs, ISOs, UPL Resources, and IFB 
Special Lists.

Standard Colors Group Box

The Standard Colors group box displays 18 selectable colors you can use for function type color identification.

To apply a standard color to a key assignment, do the following:

1. From the Select Function Type drop down menu, select the function type you want to change.
The function types appear in a column to the right.

2. From the Color column in the right pane, select the function number color box you want to change the color for.

3. From the Standard Colors group box, select the standard color you want apply to the function type resource.
The color appears in the Current Color group box.

4. Click Apply.
The Function Number Color box in the right pane changes to the selected color.

Recent Colors Group Box

The Recent Colors group box displays the most recent colors you have used. The 18 most recent used colors are displayed.

Current Color Group Box

The Current Color group box displays the currently selected color, whether from the color palette, standard colors, or recent 
colors. Also, using the Hue, Sat, Lum, Red, Green, and/or Blue spin boxes, you can adjust the selected color to create a more 
unique color for the function type.

Apply Button

The Apply button is used to apply the color selection.

Clear Button

The Clear button is used to clear the color selection and return to the default color.

Function Type Column

The Function Type column displays the function numbers (resources available) you can modify the color of the assigned key 
for.

NOTE: Key colors are associated with assignment types, not to the keys they are assigned to.
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Color Column

The Color column displays the current color assigned to the function type.

NOTE: You must select the current color box next to the function type you want to change the color for. When selected, 
a thick black line appears around the box.

Show Default Colors Check Box

The Show Default Colors check box indicates the default colors assigned to the function type resources are shown. If not 
selected, the color column in the right pane displays white boxes.

Assignments Groups Page

The Assignments Groups page, shown in Figure 282, is used to change colors of the different assignment groups.

FIGURE 282. Assignments Group Page
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Select Assignment Group Drop Down Menu

The Select Assignment Group drop down menu is used to select the assignment group you want to modify the key colors for.

Standard Colors Group Box

The Standard Colors group box displays 18 selectable colors you can use for function type color identification.

To apply a standard color to a key assignment, do the following:

1. From the Select Intercom drop down menu, select the assignment group you want to change the key colors for.

2. From the Color column in the right pane, select the assignment group color box you want to change the color for.

3. From the Standard Colors group box, select the standard color you want apply to the assignment group.
The color appears in the Current Color group box.

4. Click Apply.
The Assignment Group Color box in the right pane changes to the selected color.

Recent Colors Group Box

The Recent Colors group box displays the 18 most recent colors you have used.

Current Color Group Box

The Current Color group box displays the currently selected color, whether from the color palette, standard colors, or recent 
colors. Also, using the Hue, Sat, Lum, Red, Green, and/or Blue spin boxes, you can adjust the selected color to create a unique 
color for the function type.

Apply Button

The Apply button is used to apply the color selection.

Clear Button

The Clear button is used to clear the color selection and return to the default color.

Assignment Group Member Column

The Assignment Group Member column displays the members of the assignment group you select from the Assignment 
Group drop down menu.

Color Column

The Color column displays the current color assigned to the assignment group.

NOTE: You must select the current color box next to the assignment group you want to change the color for. When 
selected, a thick black line appears around the box.

Show Default Colors Check Box

The Show Default Colors check box indicates the default colors assigned to the function types are shown. If not selected, the 
color column in the right pane displays white boxes.
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Miscellaneous Colors Page

The Miscellaneous Colors page, shown in Figure 283, is used to change the colors of the talk and listen indicators seen on the 
KP CLD family of keypanels when talk and/or listen is activated.

FIGURE 283. Miscellaneous Colors Page
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Standard Colors Group Box

The Standard Colors group box displays 18 selectable colors you can use for function type color identification.

To apply a standard color to a key assignment, do the following:

1. From the Color column in the right pane, select the Talk Indicator Color box.
OR
From the Color column in the right pane, select the Listen Indicator Color box.

2. From the Color column in the right pane, select the function color box you want to change the color for.

3. From the Standard Colors group box, select the standard color you want apply to the function.
The color appears in the Current Color group box.

4. Click Apply.
The Item Color box in the right pane changes to the selected color.

Recent Colors Group Box

The Recent Colors group box displays the 18 most recent colors you have used.

Current Color Group Box

The Current Color group box displays the currently selected color, whether from the color palette, standard colors, or recent 
colors. Also, using the Hue, Sat, Lum, Red, Green, and/or Blue spin boxes, you can adjust the selected color to create a unique 
color for the function type.

Apply Button

The Apply button is used to apply the color selection.

Clear Button

The Clear button is used to clear the color selection and return to the default color.

Item Column

The Item column displays the items you can modify the key color.

Color Column

The Color column is used to select the item you want to modify the color for.

NOTE: You must select the current color box next to the item you want to change the color for. When selected, a thick 
black line appears around the box.

Show Default Colors Check Box

The Show Default Colors check box indicates the default colors assigned to the talk and listen indicators are shown. If not 
selected, the color column in the right pane displays white boxes.
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Keypanel Screen Saver Window

The Keypanel Screen Saver window, shown in Figure 284, is used to set the display for the screen saver, seen in the display 
window on the keypanel.

NOTE: Screen saver mode can only be used with the KP-32 family of keypanels and is activated at the keypanel. 
Keypanels must have firmware version 2.06 or higher to use this feature.

NAVIGATION: Select System|Miscellaneous|Keypanel Screen Saver from the menu bar.

Screen Saver Line 1 Field

The Screen Saver Line 1 field displays the first line of the screen saver message seen on the keypanel display. When the 
screen saver option is enabled, it automatically displays when the keypanel has not been in use. There are two (2) lines for you 
to type your screen saver message. 

This field can contain up to 40 characters.

Screen Saver Line 2 Field

The Screen Saver Line 2 field displays the second line of the screen saver message seen on the keypanel display. When the 
screen saver option is enabled, it automatically displays when the keypanel has not been in use.

This field can contain up to 40 characters.

OK Button

The OK button is used to accept the screen saver message and close the window.

Cancel Button

The Cancel button is used to close the screen saver window without saving the screen saver message.

FIGURE 284. Keypanel Screen Saver Window
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Procedure

To create/change the screen saver display, do the following:

1. From the System menu in AZedit, select Miscellaneous.
A popup menu appears.

2. From the Miscellaneous popup menu, select Keypanel Screen Saver.
The Keypanel Screen Saver window appears.

3. In the Screen Saver Line 1 field, enter a message (up to 40 characters).

4. In the Screen Saver Line 2 field, enter a message (up to 40 characters), if desired.

NOTE: The KP-32 family of keypanels has a screen saver delay feature that can only be configured at the keypanel.

To set the screen saver delay time, do the following:

1. On the KP-32 keypanel (or KP-632/KP-832), press Menu.
Display appears in the keypanel display.

2. Using , scroll to Service.

3. Press PGM.
Aux Inputs appears in the keypanel display.

4. Using , scroll to Scr Saver.

5. Press PGM.
Delay appears in the keypanel display.

NOTE: There are three (3) options to choose from this list: Delay, DSP Off, and Activate. When DSP Off is selected, 
the keypanel display turns off (press any key to reactivate the display). When Activate is selected, the screen 
saver is immediately enabled (press any key to reactivate the display).

6. Press PGM.
30 min appears in the keypanel display.

7. Using , scroll through the time increments of inactivity on the keypanel before the screen saver is activated.

30 min, 1 hr, 2 hr, 4 hr, 6 hr, 8 hr, 10 hr, 12 hr
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Keypanel Passwords Window

The Keypanel Passwords window, shown in Figure 285, is used to set a password for access to either the entire keypanel 
(Menu Access) or to just the service menu.

NAVIGATION: Select System|Miscellaneous|Keypanel Menu Passwords from the menu bar.

NOTE: The password is applied globally across the intercom system.

Menu Access Password Field

The Menu Access Password field indicates the password needed to access the entire keypanel menu. Asterisks (*) are used 
for security purposes when entering the password.

This field can contain up to 32 characters long.

Service Menu Password Field

The Service Menu Password field indicates the password needed to access the service menu on the keypanel. All other menus 
are accessible. Asterisks (*) are used for security purposes when entering the password.

This field can contain up to 32 numbers.

OK Button

The OK button is used to accept the password entries and close the window. You must Send (Online|Send Changes) your 
changes to the intercom, when completed.

Cancel Button

The Cancel button is used to close the window without accepting the password entries.

FIGURE 285. Keypanel Passwords Window
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To configure password protect on the keypanel menu or keypanel service menu, do the following:

1. From the System menu in AZedit, select Miscellaneous.
A popup menu appears.

2. From the Miscellaneous popup menu, select Keypanel Menu Password.
The Keypanel Passwords window appears.

3. In either the Menu Access or Service Menu Password field, enter a password.

4. Click OK.
The password is in temporary memory.

5. Click the Activate icon  to send the changes to the intercom.

Frame Mapping Table Window

The Frame Mapping Table window, shown in Figure 286, is used to link Tribus frames together. Determine the frame 
position (1 through 8) and enter the primary and secondary MCII-e Master Controller IP Addresses.

NAVIGATION: Select Options|Frame Mapping Table from the menu bar.

Frame Column

The Frame column displays the frame’s positional rank within the intercom system.

FIGURE 286. Frame Mapping Table Window



AZedit Intercom Software Miscellaneous Windows  299

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

IP Address 1 Column

The IP Address 1 column indicates the IP Address of the active MCII-e Master Controller.

To set the IP Address, do the following

1. Click the Address to make the field active.
The Browse button appears.

2. Click the Browse button to open the Select Frame window.

NOTE: For more information, see “Select Frame Window” on page 301.

MAC Address 1 Column

The MAC Address 1 column indicates the MAC Address of the active MCII-e Master Controller in the frame.

IP Address 2 Column

The IP Address 2 column indicates the standby MCII-e Master Controller IP Address

To set the IP Address 2, do the following

1. Click the Address to make the field active.
The Browse button appears.

2. Click the Browse button to open the Select Frame window.

For more information, see “Select Frame Window” on page 301.

MAC Address 2 Column

The MAC Address 2 column indicates the MAC Address of the standby MCII-e Master Controller in the frame.

Base 16 Column Check Box

The Base 16 check box is used to enable the Base 16 port numbering system. For more information, see “Channel Allocation 
Scheme” on page 427.
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Move Up Button

The Move Up button allows you to set the frame position on the system up in the Frame hierarchy. Frame 1 is the master 
frame and holds the most complete frame mapping table. If frame 1 fails, then frame 2 becomes the master frame.

Move Down Button

The Move Down button allows you to set the frame position of the system down in the Frame hierarchy. Frame 1 is the master 
frame and holds the most complete frame mapping table. If frame 1 fails, then frame 2 becomes the master frame.

Accept Frame Mapping Table from Other Frames Check Box

The Accept Frame Mapping Table from Other Frames check box is used to allow other frames to send their frame mapping 
information to the selected frame.

NOTE: Each frame in a valid system must be defined in a table map to be able to communicate with the other frames in 
the system.

Apply Button

The Apply button is used to accept the modifications you make and send them to the Intercom System. Once the modifications 
have been applied, AZedit displays the message below and then reboots itself.

NOTE: You must press the Test button before the Apply button becomes active.

Test Button

The Test button is used to test the frame mapping configuration you create. Once you have tested your frame map 
configuration, press the Apply button to implement the modifications you make. The message below appears if the frame map 
is deemed valid.

Done Button

The Done button is used to close the Frame Mapping window.

FIGURE 287. Apply Button Message

FIGURE 288. Frame Mapping Table Valid Message
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Select Frame Window

The Select Frame window, shown in Figure 289, is used to select a Frame (IP Address and MAC Address) to include in the 
Frame Mapping table for your Tribus System.

IP Address 1 Column

The IP Address 1 column displays the IP Address of the active master controller in the ADAM frame.

MAC Address 1 Column

The MAC Address 1 column displays the MAC Address of the active master controller in the ADAM frame.

IP Address 2 Column

The IP Address 2 column displays the IP Address of the standby master controller, if available, in the ADAM frame.

MAC Address 2 Column

The MAC Address 2 column displays the MAC Address of the standby Master Controller, if available, in the ADAM frame.

OK Button

The OK button is used to accept the selections made and close the window.

Cancel Button

The Cancel button is used to reject the selections made and close the window.

FIGURE 289. Select Frame Window
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Upload Debug Information

The Debug Information menu item, shown in Figure 290, allows you to send a debug file to Bosch to help troubleshoot the 
reason for a crash in AZedit. In the event of a processor crash, the processor saves diagnostic information about the cause of 
the problem to its flash memory. The menu item stays grayed out until a debug file is created during this event.

To create a debug file, do the following:

NOTE: Once the processor has crashed, the Upload Debug Information menu item becomes active.

1. From the Options menu, select Upload Debug Information.
The Upload Debug Information window appears.

FIGURE 290. Upload Debug Information
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NOTE: By default, the debug folder (C:\Telex\AZedit\Debug) is where the AZedit debug file you create is stored.

2. In the File name field, enter a name for the debug file you create. For example, you could use the date as the file 
name–20100605.azd.

3. Click Save.
The Uploading Status message appears.

NOTE: Select the Delete debug information from intercom check box, if you want to delete the debug information 
from the system once the .azd file is created. Otherwise, the information is kept in the intercom system. 
Remember, you can only save the most current debug information. This means that if your processor fails 
twice you can only capture the second failure’s diagnostic information.

To find the file you just created, do the following:

1. Right-click on My Computer, and from the popup menu, select Explore.
The My Computer window appears with a navigation pane down the left hand side of the window.
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2. Navigate to C:\Telex\AZedit\Debug.
OR
Navigate to the folder you store your AZedit debug file.

NOTE: Once you have created the AZedit Debut file, contact Bosch System Engineering for further instructions
(http://www.rtsintercoms.com/contact.php).
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Select Intercom Window

The Select Intercom window, shown in Figure 291, is used to select the intercom system you want to run. 

NAVIGATION: Select Authentication|Change Intercom... from the menu bar.

Intercom Column

The Intercom column displays a selectable list of intercom systems to which a user may log on.

Add Button

The Add button opens the Add Intercom window. For more information, see “Add Intercom Window” on page 306.

Delete Button

The Delete button deletes the highlighted intercom from the Intercom column.

Default Button

The Default button indicates the default intercom system. The default intercom is designated by a check mark icon.

OK Button

The OK button applies the selections made and closes the window.

Cancel Button

The Cancel button discards the selections made and closes the window.

FIGURE 291. Select Intercom Window
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Add Intercom Window

The Add Intercom window, shown in Figure 292, is used to configure an intercom system to be selectable from the Select 
Intercom window.

Intercom Group Box

Name Field

The Name field identifies the name of an intercom. Use this field to enter the name you want to call the intercom. You can also 
use the browse button to pick the intercom from a list.

Browse Button

The Browse button opens the Available Intercoms window from which the user may select an intercom to add to the available 
list. For more information, see “Available Intercoms” on page 46.

NOTE: You must be connected to the Matrix to be able to use the browse button.

IP Address Group Box

Main Field

The Main field identifies the main IP Address for the intercom. The Main IP Address is the IP Address given to the Active 
Master Controller. If you do not know the IP Address, you can browse to find the machine you want to configure.

When connected to the network with Ethernet, an intercom system has two Master Controllers (the Active and Standby). The 
Standby Master Controller acts as the Active Master Controller's backup in failover protection.

NOTE: There are two (2) IP Addresses AZedit can use to contact the intercom system – Main and Partner. If AZedit gets 
no response from one (1) of the IP Addresses, then it switches to the other IP Address.

FIGURE 292. Add Intercom Window
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Browse Button

The Browse button is used to search for the Intercom listed in the Name field, and then fill in the IP Address in the Main field. 
This is an alternate way to search for the IP Address, rather than using the Name field browse button to search on the Available 
Intercom screen.

Partner Field

The Partner field identifies the partner IP Address. The Partner IP Address is the IP Address given to the Standby Master 
Controller.

When connected to the network with Ethernet, an intercom system has two Master Controllers (the Active and Standby). The 
Standby acts as the Active Master Controller's backup.

NOTE: There are two (2) IP Addresses that AZedit can use to contact the intercom system – Main and Partner. If AZedit 
gets no response from one (1) of the IP Addresses, then it switches to the other IP Address.

OK Button

The OK button saves the information entered and closes the window.

Cancel Button

The Cancel button discards the information entered and closes the window.
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Select User Window

The Select User window, shown in Figure 293, is used to select the user profile you want to log on to the intercom system 
with.

NOTE: In the default configuration, the default user is the only user necessary.

NAVIGATION: Select Authentication|Change User... from the menu bar.

User Column

The User column displays a list of current users. You can select a user by highlighting the name and clicking OK. 

Add Button

The Add button opens the Add Users window, see “Add User Window” on page 309, where user profiles may be added to the 
user column.

Delete Button

The Delete button deletes the highlighted user profile from the User column.

Default Button

The Default button indicates the default user profile for the intercom system. The default user profile is designated by a check 
mark icon.

OK Button

The OK button applies the selection and closes the window.

Cancel Button

The Cancel button discards the selection and closes the window.

FIGURE 293. Select User Window
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Add User Window

The Add User window, shown in Figure 294, is used to add users to the selectable list on the Select User window.

User Group Box

Name Field

The Name field is used to enter the name of the user you want to add to the intercom system. 

This field can contain up to 24 characters.

Copy Settings From Group Box

Intercom Drop Down Menu

The Intercom drop down menu is used to select an existing intercom setting you want copy and apply to the new user profile.

User Drop Down Menu

The User drop down menu is used to select an existing user profile you want to copy and apply to the new user profile.

OK Button

The OK button applies the entered information and closes the window.

Cancel Button

The Cancel button discards the entered information and closes the window.

FIGURE 294. Add User Window
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Connected Users Window

The Connected Users window, shown in Figure 295, is used to view all users currently logged on to the current intercom 
system.

NOTE: In the status bar at the bottom of the page, you can also see the number of users logged into the intercom system.

NAVIGATION: Select Authentication|Show Connected Users... from the menu bar.

User Column

The User column displays the name of the user names of current users logged onto AZedit.

Connection Column

The Connection column displays the IP Address of the current connection of the computer you are connecting to.

OK Button

The OK button closes the Connected Users window.

FIGURE 295. Connected Users Window



AZedit Intercom Software Miscellaneous Windows  311

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Create Desktop Shortcut Window

The Create Desktop Shortcut window, shown in Figure 296, is used to create a shortcut icon on your computer desktop. Use 
the Create Shortcut screen to create a shortcut to the AZedit session. This is useful when you have multiple AZedit sessions 
configured on one terminal.

NAVIGATION: Select Authentication|Create Shortcut... from the menu bar.

NOTE: None of these settings change how AZedit logs in to the system. These settings are strictly for the naming of the 
Shortcut you are creating.

Intercom Check Box

The Intercom check box indicates the Intercom name displays in the shortcut name on the desktop.

Intercom Field

The Intercom field is used to enter the name of the intercom. By default, the name of the current intercom appears in the 
Intercom field. You can change this name to display any name you want to appear, however, if the name you enter is not a 
valid intercom name it does not connect without prompting you to select a configured intercom.

User Name Check Box

The User Name check box indicates that the user name should display in the shortcut name. 

User Name Field

The User Name field displays the user name you see in the shortcut, if applicable. By default, Default appears in the User 
Name field. You can change this name to display any name you want to appear.

Shortcut Name Field

The Shortcut Name field displays what is seen when the shortcut is created. By default, the intercom name and user name are 
shown. You can change this to anything you want to display regardless of selections made for displaying the Intercom and 
User Name check boxes.

Description Field

The Description field displays a description of the shortcut that is created. By default, the description displays the intercom 
and the user that are connected. You can change this to display a more meaningful description.

FIGURE 296. Create Desktop Shortcut Window



312  Miscellaneous Windows AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

OK Button

The OK button accepts the modifications, closes the window, and creates a shortcut on the desktop.

Cancel Button

The Cancel button discards the modifications and closes the window without creating a shortcut on the desktop.

Cronus Passwords Window

The Cronus Passwords window, shown in Figure 297, is used to set a password for access to the Cronus front panel menu.

NAVIGATION: Select System|Miscellaneous|Cronus Password from the menu bar.

Front Panel Configuration Field

The Front Panel Configuration field identifies the Cronus front panel password. 

This field can contain up to 20 alphanumeric characters. 

OK Button

The OK button is used to accept the password and close the window. You must Send (Online|Send Changes) your changes to 
the intercom, when completed.

Cancel Button

The Cancel button is used to cancel the password and close the window.

FIGURE 297. Cronus Passwords Window
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CHAPTER 7

AZedit Utilities

AZedit has many features to help save time in daily maintenance and upkeep of your intercom system. The following is a list 
of these utilities:

Paste Special

Partial Save

Send Changes

Refresh Alphas

Duplicate Alphas

Search for Key Assignment

Key Assignment Grid

Keypanel Print Options

Paste Special Window

The Paste Special window, shown in Figure 298, allows you to copy all settings from a single port and then selectively past 
those settings to any number of ports. It is a separate menu item because its behavior is more advanced than the conventional 
Paste menu option. When you select copy from the Edit menu, AZedit stores the settings of the port in a portion of the 
computer’s memory called the clipboard. Paste Special allows selective use of this information, rather than pasting all of the 
information from the clipboard. This feature is an efficient way of targeting a specific port (even a specific key on a port) or an 
entire system or applying a specific setting to many ports.

The Paste Special menu is grayed out until you have copied port information.

CAUTION: While this feature is quick and efficient, it should be noted that once the Paste Special is performed, it cannot be 
undone.
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To copy the settings of a port, do the following:

1. From the Keypanel/Port window, select the port you want to copy.

2. From the menu bar, select Edit|Copy.
The port settings for the selected port are copied.

3. From the Edit menu, select Paste Special.
The Paste Special window appears.

4. Select the features you want to paste to the new port.

5. From the Keys group box, select the keys you want to paste the information to.

6. From the Destination group box, select the ports you want to paste the selected information to.

7. Click Paste.
The selected information is pasted to the selected keys and/or ports.

NAVIGATION: Select Edit|Paste Special from the menu bar.

FIGURE 298. Paste Special Window
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Advanced Group Box

IFB Priority Check Box

The IFB Priority check box is used to instruct AZedit to use the IFB Priority setting from the port that was copied to the 
key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, IFB priorities are included in the Paste 
operation.

Trunk IFB Priority Check Box

The Trunk IFB Priority check box is used to instruct AZedit to use the Trunk IFB Priority setting from the port that was 
copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, trunk IFB priorities are 
included in the Paste operation.

Trunk Priority Check Box

The Trunk Priority check box is used to instruct AZedit to use the Trunk Priority setting from the port that was copied to the 
key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, trunk priorities are included in the Paste 
operation.

IFB Listen Dest Check Box

The IFB Listen Dest check box is used to instruct AZedit to use the IFB Listen Dest setting from the port that was copied to 
the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, IFB listen destinations are included 
in the Paste operation. 

Scroll Enables Group Box

Local Check Box

The Local check box is used to instruct AZedit to use the Local setting from the port that was copied to the key(s) of the 
port(s) selected in the Keys and Destination group boxes. When selected, Local scroll enable settings are included in the Paste 
operation.

Trunk Check Box

The Trunk check box is used to instruct AZedit to use the Trunk setting from the port that was copied to the key(s) of the 
port(s) selected in the Keys and Destination group boxes. When selected, Trunk scroll enable settings are included in the Paste 
operation.

AZedit Check Box

The AZedit check box is used to instruct AZedit to use the AZedit setting from the port that was copied to the key(s) of the 
port(s) selected in the Keys and Destination group boxes. When selected, AZedit scroll enable settings are included in the 
Paste operation.

LCP-102 Check Box

The LCP-102 check box is used to instruct AZedit to use the LCP-102 setting from the port that was copied to the key(s) of 
the port(s) selected in the Keys and Destination group boxes. When selected, LCP-102 scroll enable settings are included in 
the Paste operation.
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Individual Key Settings Group Box

The Individual Key Settings group box identifies many of the individual key settings you can configure on keypanels. These 
settings can be included in a Paste operation.

Talk Key Latch Disables Check Box

The Talk Key Latch Disables check box is used to instruct AZedit to use the Talk Key Latch Disables setting from the port 
that was copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, talk key latch 
disables are included in the Paste operation.

Listen Key Latch Disables Check Box

The Listen Key Latch Disables check box is used to instruct AZedit to use the Listen Key Latch Disables setting from the 
port that was copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, listen key 
latch disables are included in the Paste operation

Talk Key Restrictions Check Box

The Talk Key Restrictions check box is used to instruct AZedit to use the Talk Key Restrictions setting from the port that was 
copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, talk key restrictions are 
included in the Paste operation.

Listen Key Restrictions Check Box

The Listen Key Restrictions check box is used to instruct AZedit to use the Listen Key Restrictions setting from the port that 
was copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, listen key restrictions 
are included in the Paste operation.

Talk Key Assignments Check Box

The Talk Key Assignments check box is used to instruct AZedit to use the Talk Key Assignments setting from the port that 
was copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the talk key 
assignments are included in the Paste operation.

Listen Key Assignments Check Box

The Listen Key Assignments check box is used to instruct AZedit to use the Listen Key Assignments setting from the port 
that was copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the listen key 
assignments are include in the Paste operation.

Key Labels Check Box

The Key Labels check box is used to instruct AZedit to use the Key Labels setting from the port that was copied to the key(s) 
of the port(s) selected in the Keys and Destination group boxes. When selected, key labels are included in the Paste operation.
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Miscellaneous Group Box

Enable Tone Check Box

The Enable Tone check box is used to instruct AZedit to use the Enable Tone setting from the port that was copied to the 
key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, enable tone settings are included in the 
Paste operation.

IMPORTANT: Enabling tone on multiple ports is rarely, if ever, desirable. However this may be used to ensure that 
tone is not enabled on any port.

Keypanel Privacy Check Box

The Keypanel Privacy check box is used to instruct AZedit to use the Keypanel Privacy setting from the port that was copied 
to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, keypanel privacy settings are 
included in the Paste operation.

TIF Dial-out Restrict Check Box

The TIF Dial-out Restrict check box is used to instruct AZedit to use the TIF Dial-out Restrict setting from the port that was 
copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, TIF dial-out restrict 
settings are included in the Paste operation.

Port is TIF Check Box

The Port is TIF check box is used to instruct AZedit to use the Port is TIF setting from the port that was copied to the key(s) 
of the port(s) selected in the Keys and Destination group boxes. When selected, the Port is TIF settings are included in the 
Paste operation.

Key Labels Check Box

The Key Labels check box is used to instruct AZedit to use the Key Labels setting from the port that was copied to the key(s) 
of the port(s) selected in the Keys and Destination group boxes. When selected, the port key label setting is included in the 
Paste operation.

Do Not Interrupt Check Box

The Do Not Interrupt check box is used to instruct AZedit to use the Do Not Interrupt setting from the port that was copied to 
the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the do not interrupt settings are 
included in the Paste operation.

Panel Poll Delay Check Box

The Panel Poll Delay check box is used to instruct AZedit to use the Panel Poll Delay setting from the port that was copied to 
the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the panel poll delay settings are 
included in the Paste operation.

Keypanel Type Info Check Box

The Keypanel Type Info check box is used to instruct AZedit to use the Keypanel Type Info setting from the port that was 
copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the keypanel type 
information is included in the Paste operation.
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VOX Settings Check Box

The VOX Settings check box is used to instruct AZedit to use the VOX Settings setting from the port that was copied to the 
key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the vox settings are included in the 
Paste operation.

2-Wire Settings Check Box

The 2-wire Settings check box is used to instruct AZedit to use the 2-Wire Settings setting from the port that was copied to the 
key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the 2-wire settings are included in the 
Paste operation.

Setup Pages Group Box

Setup Restrict Check Box

The Setup Restrict check box is used to instruct AZedit to use the Setup Restrict setting from the port that was copied to the 
key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the setup restricts information is 
included in the Paste operation.

Setup Page Assignments Check Box

The Setup Page Assignments check box is used to instruct AZedit to use the Setup Page Assignments setting from the port 
that was copied to the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, the setup page 
assignments are included in the Paste operation.

All Setup Pages Check Box

The All Setup Pages check box is used to instruct AZedit to use the All Setup Pages setting from the port that was copied to 
the key(s) of the port(s) selected in the Keys and Destination group boxes. When selected, all setup pages are included in the 
Paste operation. Otherwise, you can select which setup pages to copy and paste. You can also direct where to paste setup pages 
(for example, you can paste setup page 1 into setup page 2 on the new or existing setup).

Copy Setup Pages Group Box

The Copy Setup Pages group box allows the user to rearrange the pages when pasted. In this way the ports being pasted to 
would have a different order of pages than the original port.

IMPORTANT: The All Setup Pages check box must not be selected for the Copy Setup Pages group box to be active.

Page 1 to... Check Box

The Page 1 to... check box is used to select Page 1 to be included in the Paste operation. If selected, you can choose where to 
paste page 1, using the Page drop down menu.
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Page Drop Down Menu

The Page drop down menu is used to select where you want to paste the Page 1 setup information. 

Available selections for this field are:

none

Page 1

Page 2

Page 3

Page 4

Page 2 to... Check Box

The Page 2 to... check box is used to select Page 2 to be included in the Paste operation. If selected, you can choose where to 
paste page 2, using the Page drop down menu.

Page Drop Down Menu

The Page drop down menu is used to select where you want to paste the Page 2 setup information. 

Available selections for this field are:

none

Page 1

Page 2

Page 3

Page 4

Page 3 to... Check Box

The Page 3 to... check box is used to select Page 3 to be included in the Paste operation. If selected, you can choose where to 
paste page 3, using the Page drop down menu.

Page Drop Down Menu

The Page drop down menu is used to select where you want to paste the Page 3 setup information. 

Available selections for this field are:

none

Page 1

Page 2

Page 3

Page 4

Page 4 to... Check Box

The Page 4 to... check box is used to select Page 4 to be included in the Paste operation. If selected, you can choose where to 
paste page 4, using the Page drop down menu.
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Page Drop Down Menu

The Page drop down menu is used to select where you want to paste the Page 4 setup information. 

Available selections for this field are:

none

Page 1

Page 2

Page 3

Page 4

Keys Group Box

The Keys group box is used to select all keys or specific keys to include in the Paste operation. Typically, when using paste 
special, the All Keys option is selected unless user only want the paste to apply to specific keys. In this case, the All Keys 
check box should be cleared.

All Keys Check Box

The All Keys check box indicates all keys are included in the Paste operation. When selected, the keys in the # column are 
highlighted.

Key # Column

The Key # column displays a selectable list of keys to be copied from the port. The All Keys check box must not be selected 
for this feature to be enabled.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Destination Group Box

The Destination group box is used to select the port or ports to paste the specified information.

All Ports Check Box

The All Ports check box indicates that all ports are included in the Paste operation. When selected, the ports in the ports 
columns are highlighted.
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Ports Columns

The Ports columns display the available ports information to which information can be pasted. The All Ports check box must 
not be selected for this feature to be enabled.

You can select more than one (1) port to talk or listen to by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.
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Partial Save Window

The Partial Save window, shown in Figure 299, is used to facilitate quick changes in the intercom system. The benefit of 
using a Partial Save as opposed to loading a full file is that it only loads the changes to the intercom system, that in turn takes 
less time to load to the system. This is particularly used on large systems or for systems with slow data connections. Partial 
Save can be used either in online or file mode.

IMPORTANT: Care should be taken to understand which changes are being made when a partial file is loaded, so that 
unintended changes are avoided. This is particularly important when multiple partial files are being 
loaded simultaneously. 

NOTE: When you first open the Partial Save window, all items that you have changed (but have not yet been saved or 
sent to the intercom system) are already highlighted and can be immediately saved to a file if desired. Press OK 
and immediately save only those items. 

NAVIGATION: Select File|Partial Save from the menu bar.

FIGURE 299. Partial Save Window
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Select Resource Type Drop Down Menu

The Select Resource Type drop down menu is used to select the type of resource you want to include in the Partial Save 
operation. 

Available selections for this field are:

Select Subset to Save Group Box

Available Columns

The Available columns display the available resources to include in the Partial Save operation. The resource number and alpha 
are shown. This list is dependent upon what is selected in the Select Resource Type drop down menu. 

Selected Columns

The Selected columns display the items that are marked for the Partial Save operation. The resource number and alpha are 
shown.

NOTE: If a resource is highlighted in yellow, this signifies a modification made, but not sent to the intercom, before the 
Partial Save window was opened.

Advanced Select Button

The Advanced Select button opens the Advanced Partial Save Selection window. For more information, see “Advanced 
Partial Save Selection Window” on page 326.

Keypanels

Ports

Keypanel Types

PGM Listen Sources

Party Lines

IFBs

IFB Special Lists

Special Lists

Special List Functions

GPI Outputs

ISOs

Assignment Groups

GPI Inputs

Inter-panel Dims

Forces/Inhibits

Input/Output Gains

VOX Settings

Crosspoint Gains

Party Line Gains

LCP-102s

PAP-32s

ARP-32s

GPIO-16s
MADI Cards

UPL Statements

UPL Resources

Alphas

Descriptions

Keypanel Screen Savers

Keypanel Passwords

Key Assignment Colors

Function Type Colors

Miscellaneous Colors
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Add >> Button

The Add >> button is used to add selected resources from the Available list to the Selected list.

You can select more than one (1) port by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

<< Remove Button

The << Remove button is used to remove selected resource from the Selected list and move them back to the Available list.

You can select more than one (1) port by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Select All Button

The Select All button highlights all of the items from the Available or Selected list.

De-Select All Button

The De-select All button clears any selected items from the Available or Selected list.

Invert Selections Button

The Invert Selections button reverses the selections in the current view. For example, if ports 1 through 5 are highlighted, 
while ports 6 through 10 are not, when the Invert Selection button is clicked, ports 1 through 5 are deselected and ports 6 
through 10 become highlighted.

NOTE: You must click in either the Available list or the Selected list to use the Select All, De-Select All or Invert 
Selections buttons.
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To add resources to the save list, do the following

1. In the Select Resource Type list box, select the resource type that you want to add. 
The list of selected resources for that type appears in the Available window. In addition, any resources of that type 
that you have changed are listed in the Selected window.

2. From the Available column, select the resources you want to add.

3. Click Add.
The highlighted resources are moved to the Selected column.

To remove resources from the Save list, do the following 

1. In the Select Resource Type list box, select the resource type that you want to remove. 
The list of available resources for that type appears in the Selected window. 

2. From the Selected column, select the resources you want to remove.

3. Click Remove.
The highlighted resources are moved to the Available column.

4. Repeat steps 1-3 for each resource type that you want to save.

IMPORTANT:The settings for intercom ports are split into two (2) groups: Port settings and Keypanel settings. 

Port settings consist of the port name (Alpha), the Scroll Enable settings, the IFB priority 
setting, and (if trunking is enabled) the Trunk Priority and Trunk IFB Priority settings. 

Keypanel settings consist of key assignments, the Setup Restrict setting (for setup pages), the 
Setup Page assignments, and the Enable Tone, Keypanel Privacy, and TIF Dial-Out Restrict 
settings (accessible via the Edit button). 

When you are using Partial Save to save Keypanel/Port settings, make sure you look at both 
ports and keypanels in the Select Resource Type drop down menu.

5. Click OK when you are ready to save.

A Partial Save window appears. This can be an Online Save1.

NOTE: Use only Windows 3.1 file name conventions:

• no more than 8 characters

• no < , > , : , / , \ , | , ? , or *

• a double period cannot be used

1. An Online save applies the modifications, as well as creates and saves a setup file for later use.
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Advanced Partial Save Selection Window

The Advanced Partial Save Selection window, shown in Figure 300, is used to refine your Save parameters. You can limit 
the types of resources saved by establishing parameters that must be met before selecting the resource. 

Items to Operate On... Group Box

The Items to Operate On... group box is used to select advanced parameters to place on potential save items. Use the 
following radio buttons to select the parameters for Save resources. 

Available selections for this field are:

All items - select all items

Changed - select only items that have been changed

Unchanged - select only items that have not been changed

Restricted - select only items that have been restricted

Unrestricted - select only items that have not been restricted

Archived - select only items that have been archived

Unarchived - select only items that have not been archived

Scope of Operation Group Box

The Scope of Operation group box is used to define where to find resources. Use the following radio buttons to designate 
where to focus the search for Save resources.

All Resources - select all resources, regardless of resource type selected

Current Resource Type Only - select only resources with the specified resource type

FIGURE 300. Advanced Partial Save Selection
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Add Button

The Add button performs the search for resources and adds them to the Selected list in the initial Partial Save window.

Remove

The Remove button performs the search for resources and removes them From the Selected list in the initial Partial Save 
window.

Cancel Button

The Cancel button closes the Advance Partial Save Selection window without performing the advanced search.

Send All Window

The Send All window, shown in Figure 301, lists all of the resources you have modified since the last time changes were sent 
to the intercom system. From this window, items cannot be selected to send. If you select the Details check box, the item 
number and alpha name associated with each item is displayed.

NAVIGATION: Select Online|Send Changes... from the menu bar.

FIGURE 301. Send All Window and Send All Window with Details Selected



328  AZedit Utilities AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Type Column

The Type column displays the type of modification being sent to the intercom system. 

IMPORTANT: The type settings for intercom ports are split into two (2) groups: Port settings and Keypanel settings. 

Port settings consist of the port name (Alpha), the Scroll Enable settings, the IFB priority setting, and 
(if trunking is enabled) the Trunk Priority and Trunk IFB Priority settings. 

Keypanel settings consist of key assignments, the Setup Restrict setting (for setup pages), the Setup 
Page assignments, and the Enable Tone, Keypanel Privacy, and TIF Dial-Out Restrict settings 
(accessible via the Edit button). 

When you are using Partial Save to save Keypanel/Port settings, make sure you look at both ports and 
keypanels in the Select Resource Type drop down menu.

NOTE: Since Port Alphas are associated with the Port settings, you do not see an Alpha name displayed next to a 
Keypanel setting when you check Details.

Items Column

The Items column displays the number of items being sent to the intercom system.

Details Check Box

The Details check box displays the Items Number column and an Alpha column. These columns give more details about the 
changes being sent to the Intercom.

Send Button

The Send button is used to send the changes to the intercom. When clicked, the Send All window closes and a progression bar 
displays the send status.

Cancel Button

The Cancel button closes the Send All window without sending the changes. 

NOTE: The modifications made to AZedit are still active. 
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To clear the changes, do the following:

 > Click the Abort icon.  
OR
Close the AZedit application.

Check For Duplicate Alphas Window

The Check for Duplicate Alphas window, shown in Figure 302, is used to watch the progression of the system check and 
verify there are no duplicate alphas in your intercom system. In a large-scale intercom system, the possibility exists that you 
may accidentally assign the same name (alpha) to two (2) different resources. This should never be allowed for two (2) 
resources of the same type. For example, no two (2) intercom ports should have the same name; no two IFBs should have the 
same name, etc. 

On the other hand, you may decide that you do want to use the same name for two resources of different types. You may decide 
to use the same name for both an intercom port and an IFB. Although you can do it this way, we strongly recommend that you 
do not.

NOTE: In the case where you give an intercom port and an IFB the same name, you may want to turn off Scroll Enable 
for the intercom port so that only keypanel operators can assign the IFB to keypanel keys.

NAVIGATION: Select Alphas|Check for duplicate alphas... from the menu bar.

NOTE: By default, AZedit prompts you and offers to check for duplicate alphas whenever you open a file from disk. You 
can activate or deactivate both the prompt and the check: Options|Preferences|Alphas Page. You find three (3) 
check boxes titled Automatically check for duplicate alphas after opening a file, Prompt before auto-checking 
when file is open and Prompt before checking for duplicate alphas. For more information, see “Alphas Page” on 
page 96. 

FIGURE 302. Checking for Duplicate Alphas... progression window
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NOTE: You can also select Check for duplicate alphas... from the Alphas menu at any time to identify and correct 
duplicate alphas in your setup file or in the online configuration.

If duplicate alphas are found, the Duplicate Alphas window, shown in Figure 303, appears You may see this warning when 
you assign an alpha name that is already being used. You may also see this warning when you select Check for duplicate 
alphas in the alphas menu. 

The abbreviations in the Type column indicate the following communication types:

IFB - Indicates a conflict with an IFB name

ISO - Indicates a conflict with an ISO name

PP - Indicates a conflict with an intercom port name

RY - Indicates a conflict with a GPI Output name

SF - Indicates a conflict with a Special Function name

SL - Indicates a conflict with a Special List name

UR - Indicates a conflict with a UPL Resource
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From this window, you can view the duplicate alpha information, such as the assignment type and the duplicate alphas ports.

To keep both Alphas the same, do the following:

 > Click the Save Alpha button. Otherwise, click Cancel.

NOTE: If you are checking for duplicate alphas, and you want to change a duplicate name, double-click on that name in 
the duplicate alpha list and then make the change

FIGURE 303. Duplicate Alphas Window
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Refresh Screens

The Refresh icon  is also to retrieve the most current configuration and status information from the intercom system. 
Refresh is also available in the View menu and by pressing Ctrl+Space on the computer keyboard.

In online or SERVER modes, selecting Refresh causes AZedit to retrieve the most current configuration and status 
information from the intercom system. You can use Refresh with any screen that provides status information. For example, if 
you are viewing a particular Keypanel/Port screen, you can see which keys are currently activated by selecting Refresh. For 
each key that is on, a red dot appears above that key on your viewing screen. 

NOTE: The screens refresh automatically, usually every few seconds. However, the time between refreshes can vary, 
depending on intercom activity, and the size of the intercom system. To be sure you are viewing the most recent 
information for a particular screen, use Refresh.

Search For Key Assignment Window

The Search for Key Assignment window, shown in Figure 304, is used to find key assignments in the intercom system and 
can be used to replace existing assignments with new assignments. 

NAVIGATION: Select Edit|Search for key assignment... from the menu bar.

FIGURE 304. Search For Key Assignment Search For: Window
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Search For: Group Box

Intercom Drop Down Menu

The Intercom drop down menu is used to select the intercom system you want to search for the key assignment.

NOTE: If trunking is not active, then the Intercom drop down menu does not appear. 

Type Column

The Type column displays a selectable list of assignment types.

Selections include: Ports, Party Lines, IFBs, IFB Special Lists, Special Lists, GPI Outputs, ISOs, UPL Resources, Special 
Functions, and Any Assignments.

# and Alpha Column

The # and Alpha column displays a list of selectable ports and their alphas.

NOTE: Once a port is selected, the port number populates the Port field.

Alpha Field

The Alpha field displays the alpha of the port selected from the # and Alpha columns.

Search Button

The Search button performs the search operation and displays the results on the Search Status: Done window, see “Search 
Status: Window” on page 335.

Cancel Button

The Cancel button cancels the search operation and closes the window.

More >> Button

The More >> button opens the Replace With portion (see Figure 305) of the Search For Key Assignments window.
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<< Less Button

The << Less button closes the Replace With portion of the Search For Key Assignments window.

Replace With: Group Box

Intercom Drop Down Menu

The Intercom drop down menu is used to select the intercom system to which you want to replace the assignment type.

Type Column

The Type column displays a selectable list of assignment types on the Replace With intercom system.

Available selections for this field are: Ports, Party Lines, IFBs, IFB Special Lists, Special Lists, GPI Outputs, ISOs, UPL 
Resources, Special Functions, and Any Assignments.

# and Alpha Column

The # and Alpha column displays a list of selectable ports and their alphas in the Replace With intercom system.

NOTE: Once a port is selected, the port number populates the Port field.

FIGURE 305. Search For Key Assignment - Replace with: Window
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Alpha Field

The Alpha field displays the alpha of the port selected from the # and Alpha columns.

Selective Replace Button

The Selective Replace button replaces only specified key assignments (not all key assignments) within the intercom system. 
When selected the Search Status window, shown in Figure 306, appears.

Search Status: Window

The Search Status window, shown in Figure 306, displays the results from the Search For Key Assignment window 
parameters. You can also jump to assignment type, repeat the search or begin a new search.

Port Alpha Columns

The Port and Alpha columns display the port number and alpha that fits the key assignment search parameters set on the 
Search for Key Assignment window.

When a Replace operation is performed, you can select more than one (1) port by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

FIGURE 306. Search Status Window and the Search Status - Replace Window
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To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Go To Panel Button

The Go To Panel button is used to jump to the selected key assignment.

Replace Button

The Replace button is used to replace the search for key assignment with the replace with key assignment. When selected, the 
following message appears to confirm the replace action.

NOTE: Remember to send your changes to the intercom, using Online|Send Changes or the Activate icon. 

Repeat Search Button

The Repeat Search button is used to repeat the search with the existing search parameters.

New Search Button

The New Search button is used to start a new search. When selected, the Search For Key Assignment window appears. You 
can enter new search parameters.

Done Button

The Done button is used to close the Search Status window.

NOTE: Remember to Send your changes to the intercom, using Online|Send Changes or the Activate icon. 

FIGURE 307. Replace Key Assignments Window
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Key Assignment Grid Window

The Key Assignment Grid window, shown in Figure 308, provides easy access to key assignments for programming 
keypanels. 

NAVIGATION: Select View|Key Assignment Grid from the menu bar.

To use the grid, do the following:

1. Click on the assignment type combo box.

2. Select the assignment type from the list that appears. 
Based on the assignment selected, the alphas appear in the grid below. 

NOTE: Clicking on the border of the grid’s outer frame and dragging the mouse resizes the grid. 

3. Once the alpha appears you want to assign, place the mouse pointer over the assignment, hold down the left mouse 
button, and drag the assignment to the desired key (either talk or listen). 

System Select Drop Down Menu

The System Select drop down menu is used to select the intercom system you want to view key assignment for. This drop 
down menu only appears when the intercom system is trunked.

Key Assignment Drop Down Menu

The Key Assignment drop down menu is used to select the key assignment you want to assign to the key.

Grid Fields

The Grid fields display the available alphas for the selected assignment type in the intercom system. 

FIGURE 308. Key Assignment Grid
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To assign an alpha to a keypanel, do the following:

 > Drag and drop the assignment to the desired keypanel field.

To open the key assignment grid, do the following:

 > From the standard toolbar, click the assignment grid icon. 
The Key Assignment grid opens.

NOTE: You can also select Key Assignment Grid from the View menu or right click anywhere on an open screen 
(except a talk or listen field) in AZedit and select Show Grid.

The assignment types are abbreviated:

Keypanel Print Options Window

The Keypanel Print Options window, shown in Figure 309, is used to print the setup page and key assignment information 
for selected keypanels. You can also print designation strips. Designation strips are commonly used with keypanels that do not 
have alphanumeric displays, but do have a designation strip holder to identify the key assignments. 

Select Keypanels - Select one or more keypanels (or All Keypanels) at the left side of the screen. 

Setup Page Report - Click on this if you want to print all of the talk and listen key assignments for all four (4) setup pages.

Designation Strips - Click this if you want to print designation strips to fit in keypanels designation strip holders.

NAVIGATION: While in the Keypanel/Ports window, select File|Print.

PP – Point-to-Point

PL – Party Line

IFB – Interrupt Fold-Back

IFB SL – Interrupt Fold-Back Special List

SL – Special List

GPI Out – GPI output

ISO – Isolate

UPL – Universal Programming Language (resource)

SPCL – Special Function (e.g. AL, AF, AC, etc…)

FIGURE 309. Keypanel Print Options Window
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Select Keypanels Group Box

All Keypanels Check Box

The All Keypanels check box is used to select all keypanels in the keypanel list. When selected, all keypanels are highlighted.

Keypanels List

The Keypanels list displays the alphas and ports of every keypanel in the intercom system. 

You can select more than one (1) port by performing one (1) of the following:

To select multiple random ports, do the following:

1. Press and hold the Ctrl key. 

2. Click the ports you want to select.

To select a block of ports, do the following:

1. Click the top-most port in the block.

2. Press and hold the Ctrl + Shift.

3. Press the bottom-most port in the block. 
All the ports in between the top and bottom port are selected.

Select Report Type Group Box

Setup Page Report Radio Button

The Setup Page Report radio button is used to print all talk and listen key assignments for all four (4) setup pages on a 
keypanel.

Designation Strips Radio Button

The Designation Strips radio button is used to print designation strips to fit in keypanel designation strip holders. When this 
option is selected, you have the following print options for the designation strips:

Compressed Output

Expanded Output

Use Listen Assignments

Use Key Labels

Compressed Output Check Box / Expanded Output Check Box 

If neither of these boxes is checked, designation strips are printed for each setup page, with space between the setup pages. 

If Compressed Output is selected, all designation strips are printed with no space between them. This saves extra work 
when cutting the strips apart. 

If Expanded Output is selected, the designation strips print, not only with space between the setup pages, but also, with 
space between keys 1-8 and 9-16 of each setup page. These strips require the most work to cut apart



340  AZedit Utilities AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Use Listen Assignments Check Box

The Use Listen Assignments check box indicates only listen key assignments are to be printed.

NOTE: Only the listen key assignments are printed.

Use Key Labels Check Box

The Use Key Labels check box indicates only key labels are to be printed, instead of alphas.

OK Button

The OK button is used to send the selected options to your default printer.

Cancel Button

The Cancel button is used to cancel the print operation and close the Keypanel Print Options window.
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Other Print Windows

When printing from other windows in AZedit, use the Print Preview, as shown in Figure 310, to view what the print out 
displays. Depending on the window you want to print determines the print you see.

FIGURE 310. Print Preview Window
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CHAPTER 8

Operation

Assigning Names (Alphas) for Intercom Resources

By default, intercom resources have generic names like N001, N002 etc. These names are called alphas. When alphas are 
assigned keypanel keys they appear in the alphanumeric displays above the keypanel keys. 

To assign alphas, do the following:

1. Click the Alphas icon on the Navigation toolbar at the bottom of the window.
The Port Alphas window appears.
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2. Double-click the port alpha you want to modify.
The Edit Alpha/Description window appears. 

3. In the Description field, enter a description of the alpha you assign.

4. In the Alpha (4) field, enter a 4-character alpha.

NOTE: To enable longer alphas, select to Options|Preferences|Alphas.

5. In the Alpha (6) field, enter a 6-character alpha.

6. In the Alpha (8) field, enter an 8-character alpha.

7. In the Alias fields, enter the alias you want to use.

8. Click Done.
The Edit Alpha/Description window closes.

TIP: Press the Alt key while pressing the character underlined on the button enables buttons to be selected 
without using the mouse. A black outline around the button denotes that it is selected. When a button is 
selected, and the Enter key is pressed, the action of the selected button is performed.



AZedit Intercom Software Operation  345

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

To change the alpha for a particular intercom port while you are viewing the keypanel setup window, do the following:

 > Press Ctrl+F12. 
The Edit Alpha/Description window appears.

NOTE: This feature is only available if it is enabled in the application preferences. 

To enable the Ctrl+F12, do the following:

1.From the Options menu, select Preferences.
The Preferences window appears.

2.Click the Alphas tab.
The Alphas page appears.

3.Verify Allow alpha edit from any view (CTRL+F12) is selected.

Assigning Descriptions for GPI Inputs

GPI Inputs are used to allow external devices to trigger events in the ADAM system. Through the use of GPI inputs, a user 
may trigger specific talk/listen key to be activated on a specific port/keypanel when an external contact closure is made. 
Additional hardware may be necessary to use this function.

GPI inputs do not have names, since they are never assigned directly to intercom keys. However, you can add brief 
descriptions for GPI inputs to help you keep track of what they are being used for. You can assign a description to a GPI input 
during GPI input setup by using Ctrl+F12 alpha editing.

For more information, see “GPI Input Window” on page 158.
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Assigning Descriptions for Inter-panel Dims

Inter-panel Dim tables are used to block or diminish the audio coming from one (1) keypanel user in other keypanels.Muting a 
keypanel through a Dim table is similar in function to inhibiting a crosspoint. For more information, see “Inter-Panel Dim 
Table Window” on page 192.

Inter-panel Dims do not have names, since they are never assigned directly to intercom keys. However, you can add brief 
descriptions for Inter-panel Dims to help you keep track of what they are being used for. You can assign a description to an 
Inter-panel Dim table during Dim table setup by using Ctrl+F12 alpha editing. 

NAVIGATION: Select Systems|Dim Table from the menu bar.

Keypanel Setup, General Procedure

NOTE: While editing Setup or Advanced settings, you can click Apply at any time to enter your changes. 

To set up a keypanel, do the following:

1. In the Port field, enter the port number. 
OR
From the Alpha drop down menu, select the port name (alpha).

NOTE: If all key assignments are disabled on the selected intercom port, and Trunk Port displays at the top of the 
window, this means the port is reserved for trunking and cannot be used for any other purpose. To reclaim 
the port, you must either run TrunkEdit and remove the trunking allocation or “Release a Trunk Port in 
AZedit” on page 424.

2. Press Enter.
The port is now selected.

3. Click Edit to modify keypanel properties
The Keypanel/Port Configuration window appears.

NOTE: For more information, see “Keypanel/Port Configuration Window” on page 117.
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4. Click the Setup tab to configure basic settings.
The Setup page appears.

NOTE: On a KP-32 panel and similar double row panels, the lower row is considered the main panel and the upper 
row is considered the expansion. In the keypanel configuration window, the main panel is listed at the top 
with the expansion row showing up below. This is confusing when setting up a keypanel, the setup pages on 
the actual keypanel show the exact opposite of the configuration window. 
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5. Click the Advanced tab to configure advanced settings.
The Advanced Page appears.
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6. Click the VOX tab to configure vox settings, if applicable.
The Vox page appears.

NOTE: VOX is not available in every system. VOX features depend upon the type of card being used for that port.
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7. Click the 2-Wire Settings tab to configure 2-wire settings (only available with the Zeus III family of intercom 
systems).
The 2-Wire Settings page appears.
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8. Configure the 2-wire settings for your system.

9. Click OK to save changes.
OR
Click Cancel to exit.
The Keypanel/Port Configuration window closes.
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Moving a User to a New Intercom Port

As you set up your intercom system, you establish many types of relationships between intercom ports and the other types of 
intercom resources. The most obvious relationships are the point-to-point key assignments that let users talk to each other. If 
you move a user from one (1) intercom port to another, you must search the intercom system and find all keys at all other 
intercom ports assigned to talk or listen to the user at the old port. Then, you must to update these keys to the new port where 
the user is connected. If the user was also defined in one (1) or more party lines, special lists, IFBs or ISOs, you must update 
those as well. 

In order to make sure all affected resources are properly updated, the following order is suggested.

Step 1 Check for Party Line participation

Step 2 Check for IFB participation

Step 3 Check for GPI Output participation

Step 4 Check for ISO participation

Step 5 Check for GPI Input participation

Step 6 Check for UPL Statement participation

Step 7 Check for Dim Table participation

Step 8 Check for Forced or Inhibited Crosspoint participation

Step 9 Move User from the old port to the new port

NOTE: In many cases, you may skip the first 8 steps if you are certain the user is not associated with any of these 
resources.

Check for Party Line Participation

To check for party line participation, do the following:

1. From the System menu, select Party Lines.
The Party Lines window appears.

2. Verify the user you are moving does not belong to any of the party lines in the system.

3. If the user is a member of a party line, remove them from the PL Talker and/or PL Listener lists.

4. Select the new port number where the party line is going to be connected.

5. Click the PL Talker and/or PL Listener button.

Check for IFB Participation

To check for IFB participation, do the following:

1. From the Systems menu, select IFB.

2. Scroll through the IFB list to see if the user’s old port is included in any of the input or output columns.

3. If it is tied to an input or output, double-click on IFB.
The Edit IFB window appears.

4. Change the port setting from the user’s old port to the user’s new port.
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Check for GPI Output Participation

To check for GPI Output participation, do the following:

1. From the System menu, select GPI Output.
The GPI Output window appears.

2. Scroll through the list of GPI Outputs to see if the user’s old port is included in any of the input or output columns.

3. If it is tied to a GPI output or input, double-click the GPI Output.
The Edit GPI Output window appears.

4. Change the port setting from the old port to the new port.

Check for ISO Participation

To check for ISO participation, do the following:

1. From the System menu, select ISO.
The ISO window appears.

2. Scroll through the list of ISOs to see if the user’s old port is included in any of the output columns. 

3. If it is tied to an output, double-click the Output.
The Edit ISO window appears.

4. Change the port setting from the old port to the new port.

Check for GPI Input Participation

To check for GPI Input participation, do the following:

1. From the System menu, select GPI Input.
The GPI Input window appears.

2. Scroll through the list of GPI Inputs to see if the user’s old port is included in any of the Keypanel or Keypanel 
Alpha columns.

3. If the port is tied to a GPI input, double-click the GPI Input.
The Edit GPI Input window appears.

4. Change the port setting from the old port to the new port.

Check for UPL Statement Participation

To check for UPL Statement participation, do the following:

1. From the System menu, select UPL Statement.
The User Programmable Language Statement window appears.

2. Scroll through the list of Input A, Input B, and Output to see if the user’s old port is included in any of the input or 
output columns.

3. If it is tied to an input or output, double-click the UPL statement.
The Edit UPL Statement window appears.

4. Change the input or output setting from the old port to the new port.

Check for Dim Table Participation

To check for Dim Table participation, do the following:

1. From the System menu, select Dim Table.
The Dim Table window appears.

2. Scroll through the list of Ports to see if the user’s old port is included in any DIM tables.

3. If it is tied to a Dim table that you want to change, highlight and click Remove from Dim.
The port number is removed from the Dim table.
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Check for Forced or Inhibited Crosspoint Participation

To check for Forced or Inhibited Crosspoint participation, do the following:

1. From the System menu, select Crosspoint.
The Crosspoint window appears.

2. Scroll through the Is Talking To Ports and Is Listening To Ports column to see if the user’s old port is included in 
any of those columns.

3. If it is forced or inhibited, highlight the port and click Release.
The port number is released from the force or inhibit.

Move User From An Old Port To A New Port

Search For a Key Assignment

To search for a key assignment, do the following:

1. Click the Search icon. 

2. In the Search for Key Assignment field, click the type of key assignment radio button you want to search for.

3. From the list at the right, click the name of the user you want to move. 

4. Click Do Search.
A Key Assignment Search Results list appears. This list contains the names of all ports with keys assigned to the 
target user.

5. Click the first name in the list.

6. Click Go To Panel.
The Keypanel/Ports Edit window appears with the chosen port showing. 

7. Click the key with the assignment you are searching for. 

NOTE: Sometimes, there may not appear to be a key assigned to the target user. In this case, select another setup 
page in the Page list box. You may have to check all four (4) setup pages to locate the target user key.

8. With the key selected, click the Gain button and check the Point-to-Point Listen Gain. 
The default Gain setting should be +0.0 dB. If the setting is different, note the setting, and then reset it to +0.0 dB. 

9. Click OK to exit.

NOTE: After the key has been reassigned, you may want to reset the listen gain if the default setting as not used 
previously.

Reset the Gain of a Port

To reset the Gain of a port, do the following:

1. With a keypanel key selected, click the Gain button.
The Gain Setup for Ports window appears.

2. Change the gain to the setting that you noted, previously. 

3. Click OK.

4. Repeat steps 1 and 2 until all intercom ports in the search list have been changed.
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Move User Information to New Port

To move the user’s configuration information, do the following:

NOTE: If there is no configuration information, skip steps 8-12.

1. Click the KP icon.
The Keypanel/Port Window appears.

2. Select the user’s old port name in the Alpha list box.

3. From the edit menu, select Copy.

4. From the Alpha drop down menu, select the user’s new intercom port.

5. From the Edit menu, select Paste.
The user’s information should now appear in the new intercom port.

6. Save your changes.

7. Send your changes to the intercom system.

NOTE: Do not forget to disconnect the user’s intercom cable from the old intercom port, and connect it to the new port.

Ctrl-C

Ctrl-C is often used to copy highlighted or selected data to the clipboard. 

To copy highlighted or selected information, do the following:

1. Press and hold the Ctrl key.

2. Press the C key. 

3. Release both keys.
The information is copied and ready to be pasted.

Ctrl-V

Ctrl-V is used to paste text from the clipboard to the current cursor position.

To paste highlighted or selected information, do the following:

1. Press and hold the Ctrl key.

2. Press the V key. 

3. Release both keys.
The information is pasted in the selected area.



356  Operation AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Ctrl-F

Ctrl-F is used to open the Search for Key Assignment window.

To open the Search for Key Assignment window with Ctrl-F, do the following:

1. Press and hold the Ctrl key.

2. Press the F key. 

3. Release both keys.
The Search for Key Assignment window appears.

IFB Priority Setup

The IFB Priority field indicates the default IFB priority level for the selected port. This means any IFB assigned to this 
keypanel is assigned this priority automatically. You can change individual priority levels using the IFB Priority window.

NOTE: You can use the IFB Priorities setup window to set the IFB priorities for several keypanels at the same time. You 
can also set the IFB priority for an individual keypanel during keypanel setup.

To set the IFB priority, do the following:

1. From the System menu, select IFB Priority.
The IFB Priority window appears.

2. Select one (1) or more ports:

• to select an individual port, click on the port

• to select several consecutive ports, click and drag the mouse down the list; or click the first name, 
then shift-click to select the last name

• to select several random ports, hold down the control key then click on the desired ports

• to select or clear all ports, click on the Select All or De-select All button on the left side of the 
window

• to select all ports that are not currently selected, click the Invert Selections button

3. In the Set the IFB priority for the selected ports group box, select the priority you want to set for the port(s).

4. Repeat steps 1 - 3 for additional ports or groups of ports.

TIP: Remember to save your changes and send them to the intercom system.
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Panel Poll Delay Activation

Panel Poll Delay is typically used when a keypanel’s data line is connected to the intercom port via a modem link from a 
remote location. In this situation, there may be a slight delay in data transmission from the remote keypanel to the intercom 
system. This may cause sporadic operation or no operation at all. However, by setting a delay time, the intercom system waits 
a little longer for data transmissions from the remote keypanel. The delay time can be set anywhere from 0 milliseconds 
(1/1000 of a second) to 500 milliseconds (500/1000’s of a second, or 1/2 second).

To activate the panel poll delay feature, do the following:

1. From the Options menu, select Preferences.

2. Click the Advanced tab.

3. Select Enable Panel Poll Delay Support.

4. Click Apply.

5. Click OK.
Panel poll delay should now be adjustable in the Keypanel / Ports Advanced Information window.

Merging

Merge is used to combine the contents of a previously saved file into the file you are currently editing. 

To merge two (2) files, do the following:

1. From the file menu, select Merge. 

2. Select the setup file you want to resize.

3. Click OK.

• If the setup file that you are merging has a larger set of resources than the new setup file, you see a list 
of the resources in the setup file that you are merging. If you click OK, only that portion of the resources 
that fits in the new setup file is loaded. For example, if the file you are merging has 136 ports, but your 
new setup file has 72, settings for ports 73-136 does not load. 

• If the setup file that you are merging has a smaller set of resources than the new setup file, you see a list 
of the resources in the setup file that you are merging. If you click OK, the entire set of resources in that 
setup file are loaded, and the resulting new setup file has a larger set of resources than the original. For 
example, if the setup file you are merging has 72 ports, but your new setup file has 136, the new setup 
file preserves all of the port settings for ports 1-72, and new blank port settings are added for ports 73-
136.

• If the setup file that you are merging has the same set of resources as the new setup file, you do not see 
any warning about a mismatch of resources. In this case, you did not need to perform any procedure to 
resize the file. You may cancel the entire procedure and use the original setup file in its current 
configuration.

4. Save your new setup file.
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How to Enable Trunking

To enable trunking, do the following:

1. From the Options menu, select Preferences.

2. Click the Advanced tab.

3. Select Enable trunking support.

4. Click Apply.

5. Click OK.
Trunking is enabled in all views. 

NOTE: You do not need to send this change to the intercom system.



AZedit Intercom Software Operation  359

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

Alpha and Alias Settings in the .INI File

NOTE: AZedit Versions 2.0 or higher does not use an .ini file; rather, it references the preferences in the registry editor 
on your computer. You can access these Preferences through the Options menu in AZedit.

The following items correspond to the Alphas settings, which are located on the Options menu, under Preferences. Making 
changes in the AZedit.ini file can only activate some of these settings. This file is located in the AZedit folder of your 
computer. You can make changes in a text editor, such as Notepad. After you open the file in the text editor, scroll down to the 
[alphas] settings. The [alphas] settings are summarized below, with default settings shown. After making changes, save the file 
as a text-only file in the same location and with the same name.[alphas].

EnableMultiSizeSupport=N

N= The Default alpha size list box and the Show all alias sizes on alpha views check box are not selectable, and all 
alphas have the number of characters set under DefaultAlphaSize (below). 

Y= The Default alpha size list box is selectable, giving several alpha character lengths to choose from for the 
default. Also, the Show all alias sizes on alpha views check box is selectable.

ShowAllSizes=N

N= The Show all alias sizes on alpha views check box is cleared

Y= The Show all alias sizes on alpha views check box is checked

AllowAlphaEditFromAllViews=Y

N= Ctrl+F12 cannot be used to change alphas

Y= Ctrl+F12 can be used to change alphas

DefaultAlphaSize=4

Sets the number of characters for alphas (4 is default, with options of 6- and 8-character alphas.)

AlphaSortMode=3

3= Sort alphas by number (ascending) 

1= Sort alphas by alpha (ascending)

AutoCheckDuplicateAlphas=Y

N= No checking for duplicate alphas is performed when opening files

Y= Check for duplicate alphas is performed when opening files

PromptBeforeAutoCheck=Y

N= Duplicate alpha checking proceeds automatically, with no prompting

Y= User must respond to prompt before duplicate alpha checking proceeds.
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Connecting and Disconnecting

Connect from File Mode

IMPORTANT: Verify the communications settings for you intercom. Select Options|Communications from the menu 
bar.

 > From the Online menu, select Connect.
OR

Click the Connect button. 

Disconnect from Online Mode

 > From the File menu, select New.
OR
From the File menu, select Open.
OR
From the File menu, select Save.

Disconnect from Server Mode

If you have activated server mode, then you must turn this feature off when you want to disconnect from the intercom system 
and continue working. First, click on Server Mode in the Online menu to remove the check mark. Then, use any of the three 
(3) methods listed above to disconnect in online mode.

Connect at Startup Option

By default, AZedit tries to connect to an intercom system upon startup. If you do not want to do this, change the startup 
settings as follows:

1. From the Options menu, select Preferences.

2. Select the Startup/Shutdown tab.

3. Clear the Auto-Connect at Startup and Auto Enter SERVER Mode check boxes.

4. Click Apply.

5. Click OK.
The application starts in FILE mode.

Capabilities Conflict Message

After the application connects to the intercom system, you may see the warning message Capabilities Conflict. This may 
happen if you are connecting for the first time, or if you have updated the master controller firmware. Typically, you should 
just select Yes, reconfigure AZedit.
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Trouble Connecting?

1. Verify the intercom system is turned off.

2. Verify the PC to intercom cable is properly connected. 
Refer to the cable information in your Intercom System Installation Manual.

NOTE: Connecting the intercom cable while components are active is not recommended and may cause 
unpredictable results. This includes ability or lack of ability for the computer to communicate with the 
intercom system. You may be required to restart the computer and/or reset the master controller in the 
intercom system.

3. Verify the COM Port and Baud Rate are configured properly.
OR
Verify the USB cable is secure at each end
OR
Verify the network connection and IP are working correctly. 

4. In the Options menu, select Communications to verify the settings match those of the intercom system. 

NOTE: By default, AZedit is set for COM1 and 38,400 kbps (38.4K baud). The baud rate set in AZedit must match 
the baud rate setting of the master controllers in the ADAM or ADAM CS frame (Dip switch #1). The 
38,4000 kbps setting provides the fastest possible file uploads and downloads, but you may experience more 
communication errors operating at this speed than at a lower baud rate setting. Cable lengths of 
30–50 ft. (9–15 meters) have been used successfully with the 38,4000 kpbs setting. However, this may not 
always work under all operating conditions. If you suspect that you are experiencing communication 
problems operating at this speed, check the Master Controller Status window (Status menu). Rapid 
accumulations of communication errors are indicated in the right side of that window. In such cases, check 
cable construction, cable routing, or use a shorter cable. Try to find a remedy that permits operation at 
38,400 kbps.

Scroll Enable Setup using Copy and Paste Special 

You can disable or enable scrolling for all destinations of a particular type (Ports, Party Lines, etc.) using the Copy and Paste 
Special commands. The procedure varies slightly, depending on the destination type.

Scroll Enable Setup for all Intercom Ports

1. Enter File or Online mode.

NOTE: If you want to change all Scroll Enable settings, do the following:

a. Save the online configuration to disk. 

b. Open the configuration file in File mode. 

c. Change the Scroll Enable settings as described below. 

d. Resave the file when finished. 

e. Connect to the intercom system. 

f. Send the file to update the intercom system.

2. Close all open windows.

3. From the System menu, select Keypanel Assignment.
When you access keypanel setup, the setup for an intercom port appears. It does not matter which intercom port is 
selected.
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4. Select the Scroll Enable check boxes.

5. From the Edit menu, select Copy. 
This copies all settings for the intercom port, including the Scroll Enable settings.

6. From the Edit menu, select Paste Special.
The Paste Special window appears.

NOTE: Initially, all items are selected in the Paste Special window. This means that if you click Paste at this time, all 
settings for the current intercom port are pasted. However, you only want to paste the Scroll Enable 
setting(s). 

7. Click Clear All. 

8. Select the Scroll Enable check boxes. 
Note that in this case, you are not activating the Scroll Enable setting(s) you are just selecting items to paste.

9. From the Destination field, select All Ports.

10. Click Paste. 
If you follow this example, the Local check box is unchecked for all intercom ports.

NOTE: If Paste cannot be selected, then you may not have copied any information. 

Scroll Enable Setup for all Party Lines or Special Lists

1. Enter File or Online mode.

NOTE: If you want to change all Scroll Enable settings in the online configuration, save the online configuration to 
disk, then open it in file mode or online mode and change the Scroll Enable settings as described below. 
Resave the file when finished. Then connect to the intercom system and use send file to update the intercom 
system.

2. Close all open windows.

NOTE: The following steps use party line setup as an example. If you want to change special lists, substitute special 
list for party line.

3. From the System menu, select Party Line or Special List.

NOTE: When you access party line setup, the setup for a party line appears. It does not matter which party line is 
selected.

4. Select the Scroll Enable check boxes, as desired.
In this example, all scrolling has been disabled.
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5. From the Edit menu, select Copy.

6. From the Edit menu, select Paste Special. 
The Paste Special window appears.

7. Select the Scroll Enable check boxes, if they are not already selected. 
Note that in this case, you are not activating the Scroll Enable setting(s) you are just selecting items to paste.

8. In the Destination field, select All. 

9. Click Paste. 
It may take a few moments to paste the Scroll Enable settings from the currently selected party line to all other party 
lines. If you follow this example, you should note that the Local check box is now unchecked for all party lines.

NOTE: If Paste cannot be selected, then you may not have copied any information.

Scroll Enable Setup for all IFBs, or all GPI Output, or all ISO’s, or all UPL Resources

The following steps use IFB as an example. If you want to change GPI Output instead, substitute GPI Output for IFB. The 
same applies for ISO setup or UPL Resource setup.

1. Enter file or online mode.

NOTE: If you want to change all Scroll Enable settings in the online configuration, do the following:

a. Save the online configuration to disk. 

b. Open the file in File mode.

c. Change the Scroll Enable settings. 

d. Save the file when finished. 

e. Send file to update the intercom system.

2. Close all open windows.

3. From the System menu, select IFB.
The IFBs window appears.

4. Double-click an IFB resource. 
The Edit IFB window appears.

5. Select the Scroll Enable check boxes, you desire.
In this example, all scrolling has been disabled.

6. Click Done.
The Edit IFB window closes.

7. Verify the same IFB is highlighted in the IFB list.

8. From the Edit menu, select Copy.

9. From the Edit menu, select Paste Special. 
The Paste Special window appears.

10. Select the Scroll Enable check boxes desired.

NOTE: In this case, you are not activating the Scroll Enable setting(s) you are just selecting items to paste.

11. In the Destination field, select All. 
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12. Click Paste. 
It may take a few moments to paste the Scroll Enable settings from the currently selected IFB to every other IFB. 

NOTE:  

• None of the IFB have the Local check box is not selected.

• If Paste cannot be selected, then you may not have copied any information.

Downloading Firmware Updates

Updating a Master Controller Firmware

IMPORTANT: The following procedure causes one (1) or more brief disruptions in intercom communications. Also, 
save your intercom system configuration before proceeding.

Master Controller Update, Part 1: All Intercom Systems

1. Connect to the intercom system.

2. Verify server mode is deactivated.

3. From the Status menu, select Master Controller. 

NOTE: You can also perform this procedure from the Master Controller Version Information window, but the 
procedure is written using the Master Controller Status window, since that window provides slightly more 
feedback during the update process. As an option, you can access both windows and then switch back and 

forth between them using the Go Back and Go Forward buttons.  

4. Select the master controller to update:

• ADAM CS or Single-Frame ADAM: There is only one (1) master controller, and it should already be 
selected. If not, click to select it.

• Multi-frame ADAM Systems with Slave Frame Master Controllers (Non DBX Systems): Select 
only the master controllers for all slave frames. These are numbered 002, 003 etc. Do not select the 
master controller for the master frame (001). 

5. Verify AZedit is the active window. 

6. Right-click the master controller.

7. From the flyout menu, select Firmware Download.
This opens the Firmware Download window.

8. Select the disk drive and folder where the firmware file is located.

9. Select the file you want to download.

NOTE: For an ADAM or ADAM CS intercom system, the firmware file name is combined.hex.

10. Click OK. 
The Download Device Firmware window appears, and the download information displays in the upper-left corner.

11. Click Begin Download. 
You can watch the progression of the download.

NOTE: If there is any disruption in the communications link during the download, you get an error message. In this 
case, repeat the download. When the file has been 100% downloaded, the master controller begins 
processing the update. 



AZedit Intercom Software Operation  365

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

IMPORTANT: Any disruption at this point, such as a loss of power, removing or resetting cards (ADAM, ADAM CS) 
etc. results in master controller failure. If this happens, either return the affected unit for replacement, or 
remove the EEPROM chip(s) from the affected unit and manually reprogram them with an EEPROM 
programming tool. In addition, ADAM and ADAM CS users should not proceed with the update of any 
more cards until problem is identified.

• ADAM CS or Single-Frame ADAM Systems: Allow one (1) or two (2) minutes for the update to 
complete. You may also see a message that the intercom connection has been lost. If this happens, 
wait about 15 to 30 seconds, and then click Retry to restore the connection. You may have to do this 
once or twice. At some point, you see the Slot indication change in the Master Controller Status 
window. For example, if the Slot originally was Right, it changes to Left. This indicates that the 
standby master controller has taken over as the active master controller and is now ready to be 
updated. Proceed to Update, Part 2, ADAM CS and Single-Frame ADAM Systems.

• Multi-Frame ADAM Systems with Slave Frame Master Controllers (Non DBX Systems): 
Allow 1 or 2 minutes for the update to complete. During this time, the Master Controller Status 
window displays OK Old for all slave master controllers. Finally, you may see a message that the 
intercom connection has been lost. If this happens, wait about 15 to 30 seconds, then click Retry to 
restore the connection. You may have to do this once or twice. At some point, the slave master 
controllers indicate OK Cur. This indicates that the standby slave/master controller have taken over 
as the active master controllers and are now ready to be updated.

Master Controller Update, Part 2, ADAM CS and Single-Frame ADAM Systems

1. Select the Master Controller. 

2. Press Ctrl+Shift+D.

3. Select the disk drive and folder where the firmware file is located.

4. Select the file you want to download (combined.hex).

5. Click OK. 

6. Click Begin Download. 
If there is an error during the download, repeat only the Part 2 update. Allow 1 or 2 minutes for the update to 
complete. You eventually see a message that the intercom connection has been lost. If this happens, wait about 15 to 
30 seconds, and then click Retry to restore the connection. You may have to do this once or twice. 

NOTE: After the update, you also see a Capabilities Conflict message. This happens because the new firmware has 
now added new capabilities to both master controllers.

7. Click Yes.

After all messages are cleared, you see the Slot indication change in the Master Controller Status window. For example, if the 
Slot originally was Left, it changes to Right. This indicates that the standby master controller has taken over. Note that this is 
the master controller that you first updated, so both master controllers are now updated.

NOTE: Depending on the differences between the old and new firmware, your intercom system may perform a first 
birthday reset. For an ADAM CS Intercom System, this means that the intercom configuration settings in your 
master controller are reset to the default size for an ADAM CS Intercom System. In a single-frame ADAM 
Intercom System (ADAM-136), this means that the intercom configuration settings in your master controllers are 
reset to the default size for an ADAM-136 Intercom System. If you previously customized your intercom 
configuration settings, you must redefine these in the master controller. 

To check the MC intercom configuration, do the following:

1. Verify you are online.

2. From the Options menu, select Intercom Configuration.
The Intercom Configuration window appears.
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3. Verify the resource allocation is correct for your system size. 
If the resource configuration is not correct for your intercom system size, perform the procedure Changing the master 
controller configuration settings.

Systems with Slave Frame Master Controllers (Non DBX Systems)

1. Select the Master Controller. 

2. Press Ctrl+Shift+D.

3. Select the disk drive and folder where the firmware file is located.

4. Select the firmware file (combined.hex).

5. Click OK. 

6. Click Begin Download.
If there is an error during the download, repeat only the Part 2 update. 

NOTE: Allow one (1) or two (2) minutes for the update to complete. During this time, the Master Controller Status 
window displays OK Old for all slave master controllers. Finally, you may see a message that the intercom 
connection has been lost. If this happens, wait about 15 to 30 seconds, then click Retry to restore the 
connection. You may have to do this once or twice. 

7. Click Yes. 
The slave master controllers should now indicate OK Cur. All slave master controller cards have now been updated. 
Proceed to Update, Part 3, Multi-Frame ADAM Systems.

Master Controller Update, Part 3, Multi-Frame ADAM Systems

NOTE: Applies only for systems with slave frame Master Controllers (Non-DBX Systems)

To update the master controllers in the master frame, do the following:.

1. Select master controller 001.

2. Press Ctrl+Shift+D.

3. Select the disk drive where the firmware file is located.

4. Select the folder where the firmware file is located.

5. Select the firmware file (combined.hex).

6. Click OK. 

7. Click Begin Download. 
If there is an error during the download, repeat only the Part 3 update. 

NOTE: Allow one (1) or two (2) minutes for the update to complete. Finally, you may see a message that the 
intercom connection has been lost. If this happens, wait about 15 to 30 seconds, and then click Retry to 
restore the connection. You may have to do this once or twice. When the connection is restored, you notice 
the Slot has changed (from Right to Left or vice-versa). You are now ready to update the last master 
controller card.

8. Select master controller 001.

9. Press Ctrl+Shift+D.

10. Select the disk drive where the firmware file is located.

11. Select the folder where the firmware file is located. 

12. Select the firmware file (combined.hex).

13. Click OK. 

14. Click Begin Download.
If there is an error during the download, repeat only from step 7. 
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NOTE: Allow one (1) or two (2) minutes for the update to complete. Finally, you may see a message that the 
intercom connection has been lost. If this happens, wait about 15 to 30 seconds, and then click Retry to 
restore the connection. You may have to do this once or twice. When the connection is restored, you notice 
the Slot has again changed (from Right to Left or vice-versa).

15. Click Yes to update the capabilities settings. 
The slave master controllers should now indicate OK Cur. All slave master controller cards have now been updated.

IMPORTANT: Depending on the differences between the old and new firmware, your intercom system may perform a 
first birthday reset. This means your multi-frame intercom system is resized to the default intercom 
configuration for a single-frame (ADAM-136) Intercom System. You must restore the default intercom 
configuration to the proper setting for your intercom system. Alternatively, if you have been using 
custom resource settings, you must redefine these in the master controllers. 

To check the intercom configuration, do the following:

1. Verify you are online.

2. From the Options menu, select Intercom Configuration.
The Intercom Configuration window appears.

3. Verify the resource allocation is correct for your system size. 
If the resource configuration is not correct for your intercom system size, perform the procedure Changing the master 
controller configuration settings.

Updating AIO (Audio Input/Output) Card Firmware

The following procedure causes one (1) or more brief disruptions in intercom communications.

To update the AIO card firmware, do the following:

1. Verify the intercom system is not in server mode.

2. From the Status menu, select I/O Cards. 

3. Select one (1) or more of the I/O cards.

NOTE:  

• These are numbered 001, 002 etc.

• Updating should be performed during non-critical periods of intercom usage. Be aware there is a 20-30 
second period during the download process where the master controller takes each Audio I/O card off 
line and reprogram its firmware. Any disruption at this point (loss of power, card removal, manually 
resetting cards) results in I/O card failure! If this happens, you either have to return the affected cards 
for replacement, or you must remove the EEPROM chips from the affected cards and manually 
reprogram them with an EEPROM programming tool. Since this could potentially result in a major 
disruption, we recommend that you only update a limited number of I/O cards at a time, and.

4. Verify AZedit is the active window. 

5. Press Ctrl+Shift+D. 
The Firmware Download window appears.

6. Select the disk drive and folder where the firmware file is located. 

7. Select the file you want to download.

NOTE: For an ADAM CS Intercom System, the file name is Aio_cs.hex; for ADAM, the file name is 
Aio_std.hex.

8. Click OK. 
The Download Device Firmware window appears, and the download information displays in the upper-left corner.

9. Click Begin Download. 
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NOTE: If there is any disruption in the communications link during the download, you get an error message. In this 
case, repeat the download. When the file has been 100% downloaded, the master controller begins updating 
the I/O cards. During this time, the Status column may display OK Old next to individual I/O cards, or it 
may display nothing. In addition, intercom ports go offline. Any disruption at this point (loss of power, card 
removal, manually resetting cards) result in I/O card failure as previously described. 

When the update is completed, the intercom ports come back online, and one-by-one, the status for I/O cards 
change to OK Cur. The complete update procedure may take 3-5 minutes. You can verify the new firmware 
version in the Audio I/O Card Version Information window.

Updating Keypanel Firmware

General Information

When you update keypanels, the update information is downloaded to the master controller from the configuration computer. 
Then, the update information is simultaneously sent to all of the Audio I/O cards where keypanels are being updated. From 
there, the update information is downloaded to individual keypanels. 

You can update one (1) or several keypanels at the same time. However, when updating multiple keypanels connected to the 
same Audio I/O card, the update time could potentially be much longer. This is because the Audio I/O card must address each 
keypanel separately and then download the update information to that keypanel. As a general rule in this case, expect the total 
update time to be the update time for one (1) keypanel times the number of keypanels on the same Audio I/O card that are 
being updated. For example, if the update time for one keypanel is 10 minutes, the update time for six keypanels of the same 
type on the same Audio I/O card could be as much as 60 minutes. When updating keypanels on separate Audio I/O cards, there 
is no additional time involved since each Audio I/O card processes updates independently. 

Other factors affecting the overall download time include the amount of activity in the intercom system (potentially a major 
factor) and the baud rate for communications between the intercom system and the configuration computer (a relatively minor 
factor). Updates proceed more quickly during periods of little activity, and when the baud rate has been set to the highest 
possible speed.

Updating KP-12, DKP-8, DKP-12, and KP-8T Keypanels (KP-12 Type Keypanels)

CAUTION: Do not remove power or disconnect the keypanel during this procedure. If you do, the flash EEPROM in the 
keypanel must be replaced. Usually, downloads proceed without any type of problem. However, to be on the safe 
side, you may wish to limit downloads to small quantities of keypanels at a time. 

NOTE: As a general rule, it takes at least 10 minutes to update an individual KP-12 keypanel. 

To update a KP-12 keypanel, do the following:

1. From the Status menu, select Software Version|Keypanels.

2. Select the keypanel you want to update. 
The KP-12, DKP-8, DKP-12, and KP-8T keypanels show up as KP-12 version, and any combination of these 
keypanels may be selected for update. In addition, it does not matter if they currently have different versions of 
firmware. However, do not also select keypanels of a different type, like ZEUS or KP-32, along with the KP-12 type.

3. With the keypanels selected, press Shift+Ctrl+D.
This opens the Firmware Download window.

4. Select the folder where the firmware file is located.

5. Select the file you want to download.

6. Click OK. 
The Download Device Firmware window appears.
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7. Click Begin Download. 

NOTE: First, the file loads. Then it downloads to the master controller in the intercom system, and the percentage is 
reported. When the file has been 100% downloaded, the master controller begins sending the information to 
the keypanel. The keypanel displays download in the Incoming Messages window, and all keypanel activity 
is locked out while the flash is being re-written. It takes 4–5 minutes at this point for the keypanel to update. 
If you are viewing the Port Status window, the Status column displays OK until just before the update is 
completed. Then Bad displays for a few moments and OK returns. The update is now completed. If you are 
viewing the Keypanel Version Information window, the new keypanel version appears when the update is 
completed.

8. Repeat the steps 1-7 to update more keypanels.

BKP-4, MKP-4, TKP-4, WKP-4 Keypanel Update (Zeus Type Keypanels)

NOTE: Zeus keypanels can all recover from a failed download procedure. No, chip replacement is needed. Just follow 
the instructions as listed below for this event.

NOTE: As a general rule, it takes at least four (4) minutes to update a Zeus keypanel. To update multiple Zeus keypanels 
on the same Audio I/O card therefore takes about four (4) minutes times the number of keypanels being updated.

1. From the Status menu, select Software Version|Keypanels.

2. Select the keypanel you want to update.
Select only keypanels that are identified as ZEUS version. It does not matter if the keypanels have different versions of 
firmware. 

NOTE:  

• To select several keypanels at random, click on the first keypanel, and then hold down the Ctrl key on 
the computer keyboard while clicking on additional keypanels. 

• To select a range of keypanels, click on the first keypanel, then hold down the Shift key and click on 
the last keypanel in the range.

NOTE: Versions at 1.x.x need to have the boot downloader preconfigured before the download works correctly.

3. With the keypanels now selected, press Shift+Ctrl+D.
This opens the Firmware Download window.

4. Select the folder where the firmware file is located.

5. Select the file you want to download.
For ZEUS keypanels, the firmware file name is zkp.hex.

6. Click OK. 
The Download Device Firmware window appears, and the download information display in the upper-left corner. 
Note that at this time you can check the list of ports that you have selected.

7. Click Begin Download.
The file loads. 
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NOTE:  

• The file downloads to the master controller in the intercom system, and the percentage is reported as the 
download progresses. When the file has been 100% downloaded, the master controller begins sending 
the information to the Audio I/O cards. Since each selected keypanel on a card must be addressed 
separately, the following sequence of events occur: 

• First RQDL displays in the Call waiting window. Then the Headset LED flashes green as the 
first chunk of data is being read from the Audio I/O card. After about one (1) to two (2) 
minutes, OK 1 displays. This indicates that the first of two (2) chunks of data has been 
updated. Again, the Headset flashes green while the second chunk of data is being read. After 
another 1 to 2 minutes, OK 2 briefly displays and the keypanel returns to normal operation. 
The download is complete. Once normal operation is restored, the new keypanel version 
appears in the Keypanel Version Information window.

• If an error occurs at any time during the download, a lower-case e appears in the left segment of the Call 
waiting display. The keypanel automatically requests the failed chunk of data is resent. Allow one (1) to 
two (2) minutes for the keypanel to repeat the previous step in the download process. If another error 
occurs, the first e shifts to the left and another e appears. Again, the keypanel requests the failed chunk 
is resent. This process goes on indefinitely until either the download is successfully completed, or until 
someone downloads different firmware to the intercom system. 

TIP: Repeated download failures could indicate a problem with the intercom cable, or with the data transceiver 
on an Audio I/O card, or a data port problem on a particular keypanel.

KP-32 Keypanel Update

NOTE:  

• The KP-32 can recover from a failed download procedure. No, chip replacement is needed. Just follow 
the instructions as listed below for this event.

• As a general rule, it takes at least 10 minutes to update a KP-32 Type keypanel. To update multiple 
KP-32 type keypanels on the same Audio I/O card therefore takes about 10 minutes, multiplied by the 
number of keypanels being updated.

1. Open the Keypanel Version Information window.

2. Select the keypanel (or keypanels) you want to update. 

NOTE: Select only keypanels that are identified as KP-32 version. It does not matter if the keypanels have different 
versions of firmware.

3. With the keypanels now selected, press Shift+Ctrl+D.
The Firmware Download window appears.

4. Select the folder where the firmware file is located.

5. Select the file you want to download.
For the KP-32, the firmware file name is kp32.hex.

6. Click OK. 
The Download Device Firmware window appears, and the download information displays in the upper-left corner. 

NOTE: At this time, you can check the list of ports you have selected.
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7. Click Begin Download. 
The file loads. Then it downloads to the master controller in the intercom system, and the percentage is reported as 
the download progresses. When the file has been 100% downloaded, the master controller sends the information to 
the Audio I/O cards. Each keypanel displays “Code Download in progress” in the left side of the panel, and the chunk 
number displays. There are 10 chunks of data for the complete download. When the download is complete, the KP-32 
displays asterisks, and then it returns to normal operation. Once normal operation is restored, the new keypanel 
version appears in the Keypanel Version Information window.

NOTE:  

• The file downloads to the master controller in the intercom system, and the percentage is reported as the 
download progresses. When the file has been 100% downloaded, the master controller begins sending 
the information to the Audio I/O cards. Since each selected keypanel on a card must be addressed 
separately, the following sequence of events occur: 

• First RQDL displays in the Call waiting window. Then the Headset LED flashes green as the 
first chunk of data is being read from the Audio I/O card. After about one (1) to two (2) 
minutes, OK 1 displays. This indicates that the first of two (2) chunks of data has been updated. 
Again, the Headset flashes green while the second chunk of data is being read. After another 1 
to 2 minutes, OK 2 briefly displays and the keypanel returns to normal operation. The 
download is complete. Once normal operation is restored, the new keypanel version appears in 
the Keypanel Version Information window.

• If an error occurs at any time during the download, the keypanel automatically requests the failed chunk 
of data be resent. Try 2 appears in the keypanel display. If another error occurs, Try 3 appears, and so 
forth. This process goes on indefinitely until either the download is successfully completed, or until 
someone downloads different firmware to the intercom system. Repeated download failures could 
indicate a problem with the intercom cable, or with the data transceiver on an Audio I/O card, or a data 
port problem on a particular keypanel.

TIP: Repeated download failures could indicate a problem with the intercom cable, or with the data 
transceiver on an Audio I/O card, or a data port problem on a particular keypanel.
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Assigning Auto-Follow to all Listen Keys using Copy and Paste Special

To set all listen keys to auto-follow for all intercom ports, do the following:

1. Close all open windows.

2. Enter File mode.

3. From the Status menu, select Keypanel Assignment.
When you access keypanel setup, the setup for an intercom port appears. It does not matter which intercom port is 
selected.

4. From the Edit menu, select View by Setup Page.
If View by Setup Page is already active, View by Panel Type appears in the menu. 

5. Select a setup page; however do not select the one assigned to the Main keypanel. 
This allows you to set auto-follow for key 16. In this example, Page 2 has been selected. 

6. From the drop down menu, select listen key 1.

7. Assign auto-follow to all of the listen keys.

a. In the Listen Key 1 text box, enter AF.

b. Press the Tab key to move the cursor to listen key 2.

c. In the Listen Key 2 text box, enter AF.

d. Repeat steps 6 and 7for all listen keys.
Auto-follow should now be assigned to all listen keys on setup page 2.
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8. From the Edit menu, select Copy. 
This copies the entire setup for the intercom port.

9. From the Edit menu, select Paste Special. 
This opens the Paste Special window, where you can select the items that you want to paste to the other intercom 
ports.

By default, all items in the Paste Special window is selected. However, you only want to paste the listen key assignments from 
setup page 2 to all other pages on all intercom ports. 

1. Click Clear All. 

2. Check All Setup Pages.

3. Clear the All Setup Pages check box. 

IMPORTANT: This is necessary to activate the Individual Key Settings check boxes.

4. Select the All Ports check box.

5. Select the All Keys check box.

6. Clear all the Individual Key Settings check boxes, except Listen Key Assignments.

7. Under Copy Setup Pages, clear every check box, except Page 2. 

8. From the drop down menu, select Page 1.

9. Click Paste.
It takes a few moments to copy the page 2 listen key settings to page 1 for all intercom ports. Then, the Paste Special 
window closes.

NOTE: If Paste cannot be selected, you may still be in Server mode. Enter File mode and repeat the proceeding steps 
as needed.

10. From the Edit menu, select Paste Special.

11. From the Page 2 drop down menu, select Page 2.

12. Click Paste.

13. Repeat steps 8 through 10 for Pages 3 and 4. 

You can save a setup file where you have only configured the AF settings. When you want to create a new setup file, open your 
AF setup file and use save as to save it under a new name. Then, add your other configuration settings, such as talk key 
assignments, party lines etc.

If you want to add AF assignments to the configuration, save the Online configuration to disk, then open it in File mode and 
add the AF assignments as described above. Resave the file when finished. Then connect to the intercom system and use send 
file to update the intercom system.
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Activating or Deactivating the Advanced Settings Tab in the Options Menu 
Preferences

Use the Advanced tab in the Preference settings (Options|Preferences) to enable or disable the Advanced Settings Tab in the 
Registry Editor.

To enable or disable this feature, do the following:

1. From the Start menu, select Run.
The Run window appears.

2. In the Open field, type regedit.
The registry editor appears.

3. Select Telex|AZeditV3|Intercoms|Default|Users|Default|advanced.

4. In the right window pane, double-click ShowAdvancedFeatures.
The Edit String window appears.

5. In the Value data field, enter Y to activate the Advanced Settings tab.
OR
In the Value data field, enter N to deactivate the Advanced Settings tab.

6. Restart AZedit.

7. From the Options menu, select Preferences. 
The Advanced features tab should be visible if you enabled this feature, and it should be removed if you disabled this 
feature.

Enabling Intercom Configuration Resizing in Online Mode

To enable intercom configuration resizing in Online mode, do the following:

1. Close all open windows.

2. Verify Server mode is not activated.

3. From the Options menu, select Preferences.
The Application Preferences window appears.

4. Click the Advanced tab.

5. Select the Allow intercom resizing in ONLINE mode check box.

6. Click Apply.

7. Click OK.

Ctrl+F12 Alpha Editing

Ctrl+F12 alpha editing allows you to change the name for a particular port, party line etc. while you are viewing its setup 
window.

To activate Ctrl+F12, do the following:

1. From the Options menu, select Preferences.

2. Click the Alphas tab.

3. Select the Allow alpha edit from any view (CTRL+F12) check box.

4. Click Apply.

5. Click OK. 
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Using Ctrl+F12 Alpha Editing

Press Ctrl+F12 on the computer keyboard to name an intercom port, party line, etc. while you are setting it up.

EXAMPLE: You can press Ctrl+F12 to change the alpha for that intercom port if you are viewing the Keypanel / 
Ports setup window for intercom port 12 

EXAMPLE: Change the name for IFB 003 from within IFB setup. First, access IFB setup. Then, in the IFB list, 
select IFB 003. (Just click once to highlight it; do not double-click to open the setup window.) With IFB 
003 highlighted, press Ctrl+F12 to change the alpha name.

EXAMPLE: Change the name for partly line PL 3 from within Party Line setup. First, access Party Line setup. Then, 
select party line 3 (PL03) in the upper-left corner of the window. Now, press Ctrl-F12 to change the 
alpha name.

EXAMPLE: Change the name for special list SL03 from within Special List setup. First, access Special List setup. 
Then, select special list 3 (SL03) in the upper-left corner of the window. Now, press Ctrl-F12 to change 
the alpha name.

Key Restriction Setup using Copy and Paste Special

This procedure shows you how to set all of the restriction check boxes for all intercom ports. This prevents any keypanel 
operator at any intercom port from changing the assignment on any key. 

To restrict copy and paste functionality on keypanels, do the following:

1. Verify AZedit is in File mode.

2. From the System menu, select Keypanel Assignments. 
When you access keypanel setup, the setup for an intercom port appears. It does not matter which intercom port is 
selected.

3. From the View menu, select View by Setup Page.

4. From the page drop down menu, select any setup page, except the one assigned to the Main keypanel. 
This allows you to set the restrict check box for key 16. In this example, Page 2 has been selected. 
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5. Click the listen key 1 field.

6. Press Shift+Ctrl+r (hold down the Shift Key and the Control Key, and then press the r key). 
The R check boxes for all listen keys are selected.

7. Click the talk key 1 field.

8. Press Shift+Ctrl+r to restrict all of the talk keys.

9. From the Edit menu, select Copy.
This copies the entire setup of the intercom port.

10. From the Edit menu, select Paste Special. 
This opens the Paste Special window, where you can select the items that you want to paste to the other intercom 
ports.
By default, all items in the Paste Special window are checked. However, you only want to paste the R settings from 
setup page 2 to all other pages on all intercom ports.

11. Click Clear All. 

12. Select All Setup Pages. 

13. Clear the All Setup Pages check box.
All the Individual Key Settings check boxes become active.

14. Select All Ports.

15. Select All Keys. 

16. Clear all Individual Key Settings check boxes, except Talk Key Restrictions and Listen Key Restrictions.

17. In Copy Setup Pages, clear all Copy Setup Page check boxes, except Page 2. 

18. From the Page 2 drop down menu, select Page 1.

NOTE: If you set up restrictions for some other page instead of page 2, substitute that page for Page 2.

19. Click Paste. 
It may take a few moments to copy the page 2 listen key settings to page 1 for all intercom ports. The Paste Special 
window closes.

NOTE: If Paste cannot be selected, you may still be in Online mode. Enter File mode and repeat the proceeding 
steps as needed.

20. From the Edit menu, select Paste Special.

21. From the Page 2 drop down menu, select Page 2. 

22. Click Paste.
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23. Repeat steps 18 and 19 for the rest of the pages.
All R boxes are checked on all setup pages at all intercom ports.

NOTE:

• You can save a setup file where you have only configured the R settings. When you want to create a 
new setup file, open your R setup file and use save as to save it under a new name. Then, add your other 
configuration settings, such as talk key assignments, party lines etc.

• If you want to add R assignments to the Online configuration, save the Online configuration to disk, 
then open it in File mode and add the R assignments as described above. Resave the file when finished. 
Then connect to the intercom system and use send file to update the intercom system. You can also do 
this in Online mode, without saving it as a separate file.

Restricting Setup Page Reassignment for all Intercom Ports Using Copy and 
Paste Special

This procedure shows you how to restrict the setup page assignments for all intercom ports. This prevents any keypanel 
operator at any intercom port from changing the setup page assignments.

To restrict setup pages for all intercom ports, do the following:

1. From the System menu, select Keypanel Assignments.
The Keypanel Assignments window appears. When you access keypanel setup, the setup for an intercom port 
appears. It does not matter which intercom port is selected.

2. Click Edit.
The Keypanel/Port Configuration window appears.

3. Click the Setup tab.

4. In Setup Page Options, select the Setup Restrict check box.

5. Click OK.

6. From the Edit menu, select Copy. 
This copies the entire setup for intercom port that you are currently viewing.

7. From the Edit menu, select Paste Special. 
This opens the Paste Special window, where you can select the items that you want to paste to the other intercom 
ports.

NOTE: By default, all items in the Paste Special window are selected.

8. Click Clear All.

9. Select the Setup Restrict check box.

10. Select the All Ports check box.
You are now ready to paste the setup page restriction to all other intercom ports. 

11. Click Paste.
The Paste Special window closes, and you should now see that Setup Restrict is checked for all intercom ports.
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Activating Crosspoint Inspection in File Mode

By default, the Inspect button in the Crosspoint Status window only functions in Online or Server mode. You can also activate 
the Inspect button for use in File mode: 

1. From the Options menu, select Preferences.
The Preferences window appears.

2. Select the Advanced tab.

3. Select Allow crosspoint inspection in FILE mode.

4. Click Apply. 

5. Click OK.
The Inspect button in the Crosspoint Status window should now function in File mode.

Port Configuration for Non-Keypanel Usage

The following items can be configured in an intercom port when connecting non-keypanel devices.

Scroll Enable Settings - By default, any keypanel operator can assign keypanel keys to talk or listen to any 
intercom port. You may wish to make some or all intercom ports inaccessible for key 
assignment, including intercom ports where there are no keypanels connected. You use the 
scroll enable feature to do this.

Gain Settings - There may be occasions where you need to adjust the listen gain for a non-keypanel 
device that is listening to a party line or to some specific intercom port. For example, a 
belt pack operator may want to monitor a party line, but at a lower level than the normal 
intercom volume. Alternatively, a belt pack operator may want to listen to background 
music coming from some intercom input port, but at a reduced level. To make gain 
adjustments, click on the Gain button.

NOTE: If all controls are disabled, (grayed out), on the selected intercom port, and Trunk Port displays at the top of the 
window, this means the port is reserved for trunking and cannot be used for any other purpose. To reclaim the 
port, you must run TrunkEdit and remove the trunking allocation. Or, see “Release a Trunk Port in AZedit” on 
page 424.
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Auto Server Mode

If you use UPL statements to load files, AZedit must be running in Server mode. You may wish to set the application so that it 
always starts in Server mode. 

To configure Server mode to automatically start, do the following:

1. From the Options menu, select Preferences.
The Preferences window appears.

2. Select the Startup/Shutdown tab.

3. Select Auto enter SERVER mode. 

NOTE: It does not matter if you select Auto connect at startup.

4. Click Apply.

5. Click OK.

6. Restart AZedit to assure the program connects to the intercom system in Server mode. 
Server should be indicated in the lower-right corner of the window.

NOTE: AZedit may also be put in your Windows startup folder. This would assure the computer reconnects 
to the intercom system in Server mode whenever the computer is restarted. 

Starting the Application in File Mode

Typically, AZedit is set to start in Online or Server mode and it automatically connects to the intercom system at startup. 
However, you may wish to start AZedit in File mode, even though the configuration computer is still connected to the 
intercom system. 

To automatically start AZedit in File mode, do the following:

1. From the Options menu, select Preferences.
The Preferences window appears.

2. Click the Startup/Shutdown tab.

3. Clear Auto connect at startup and Auto enter SERVER mode.

4. Click Apply.

5. Click OK.

6. Restart AZedit.

Entering File Mode from Server Mode

To enter File mode from Server Mode, do the following:

1. From the Online menu, click on Server Mode to remove the check mark. 
This places the application in Online mode.

2. From the File menu select New.
OR
From the File menu, select Open.
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Changing the Number of Talk Levels

Talk levels are defined in the Intercom Configuration settings (Options menu). Before changing intercom configuration 
settings, we recommend you read “Intercom Configuration Window” on page 52.

Enabling or Disabling the Configuration Conflict Message

The configuration conflict message occurs whenever you connect to the intercom system, and the application detects that its 
settings are not the same as the intercom system settings. 

To enable or disable the configuration conflict message, do the following:

3. From the Options menu, select Preferences.
The Preferences window appears.

4. Click the Startup/Shutdown tab.

5. Select the Warn about changes in configuration check box to activate the message.
OR
Clear the check box to disable the message.

6. Click Apply.

7. Click OK.

Procedure to Change Intercom Configuration Settings

IMPORTANT: If you make changes to any of the intercom configuration settings and then click the Apply button, all 
current setup information is erased. This includes all key assignments, party line configurations, etc. In 
addition, if you are operating in Online mode, the intercom system is reset, all communications ceases, 
and you have to reload your setup. For a large intercom system, it may take up to 10 minutes to restore 
the system after changing settings. We recommend making changes when the system is not active or at 
a low-traffic time.

Changing the master controller configuration settings

NOTE: Make sure that AZedit is not operating in Server mode: (Online should display in the lower-right corner of the 
AZedit window.

1. Connect to the intercom system.

2. From the Options menu, select Intercom Configuration.
A warning message appears.
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NOTE: If you are not able to select or change any items in the Intercom Configuration, AZedit is probably not set to 
allow intercom resizing in Online mode. To enable intercom resizing in Online mode, See “Enabling 
Intercom Configuration Resizing in Online Mode” on page 374.

3. Click OK.
The Intercom Configuration window appears.

4. Eject the standby master controller, if applicable.

5. Click the Resources tab to view and change resource settings.
OR
Click the Options tab to view and change option settings.

NOTE: While viewing either tab, you can press the F1 key to get further help. 

6. Once finished modifying the resources and options, click Test.

NOTE:  

• If the test fails, this indicates you have selected more resources than can be stored in system memory. 
Click OK, and then reduce the quantities of one (1) or more resources and test again. If the test is a 
success, click OK to close the test results window, and then click Apply.

• In all cases, there is sufficient memory for all of the intercom ports in your intercom system. Memory 
test failures generally are the result of allocating too many of some other type of resource.

IMPORTANT: Clicking Apply deactivates intercom system operation and erases all setup information, such as key 
assignments, party line configurations, etc.

NOTE: It is best to set the AZedit default to match the settings of the master controller. The only time you might not 
want to do this is if you are running AZedit on several different intercom systems. In this case you can use 
different settings for AZedit and for individual setup files.

7. Click Continue.
The master controller reconfigures itself, and the system momentarily goes offline. A message to retry the intercom 
connection appears.

8. Click Retry. 

NOTE: You may have to do this more than once.

9. Insert the standby master controller back into the frame. 
The master controller writes the new configuration information to the standby master controller.

If you create new setup files at this time, they should also match the intercom configuration. However, you can change the 
configuration settings for AZedit or for setup files independently of the master controller configuration settings. You might 
want to do this if you are using AZedit with several different intercom systems, or if you previously created one (1) or more 
setup files, and you now wish to resize those files to match the master controller configuration. The following procedures 
describe how to resize AZedit or individual setup files.
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Changing the AZedit intercom configuration

You might use this procedure when you are just starting out with AZedit, and you want to start creating setup files before 
connecting to the intercom system. Alternatively, you might use this procedure when you are using AZedit on several different 
intercom systems, but you want to set the resources to the size that accommodates all of the systems.

To change the AZedit intercom configuration, do the following:

NOTE: If you are currently working in File mode, save before proceeding.

1. Verify File mode is active.

2. From the Options menu, click Intercom Configuration. 
A warning message appears.

3. Click OK.
The Intercom Configuration window appears.

4. Select the Resources tab.

5. Configure resources as needed.

6. Click on the Options tab.

7. Modify the options, if necessary.

8. Click Test.

9. If the test fails, this indicates you have selected more resources than can be stored in system memory. Click OK, and 
then reduce the quantities of one (1) or more resources and test again.
OR
If the test is a success, click OK to close the test results window.

10. Click Apply.
A warning message appears.

11. Click OK.
A message appears asking to make changes the default.

12. Click Yes.

If you create new setup files, they are created with the new AZedit default settings. However, you can also configure setup 
files independently of the AZedit settings as described below.

Changing the Configuration Settings in Setup Files

Reconfigure A Previously Created Setup File To Have The Default AZedit Configuration

You may wish to use this procedure to resize a setup file that you created prior to reconfiguring AZedit. You might use this 
procedure, for example, after you have eliminated unused resources from the master controller and have then reconfigured 
AZedit to match the new master controller settings. Alternatively, you may need to resize a setup file after you have added 
more hardware to your intercom system (such as adding more Audio I/O cards, or adding a UIO-256 frame). In this case, you 
should resize the intercom system first as previously described, and accept the new settings as the AZedit defaults. 

To add resources to setup files to match the enlarged intercom system configuration, do the following:

1. From the File menu, select New. 

2. When prompted, select Load Default Configuration.
If you do not see any prompt, the AZedit default configuration is already loaded.

3. From the File menu, select Merge.

4. Select the setup file you want to resize.

5. Click OK.
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NOTE:  

• If the file you are merging has a larger set of resources than the AZedit default configuration, you see a 
list of the resources in the setup file. If you click OK, only that portion of the resources that fits in the 
default configuration is merged. For example, if the file you are merging has 136 ports, but your default 
configuration only has 72, no settings for ports 73-136 merge. 

• If the setup file that you are merging has a smaller set of resources than the default configuration, you 
see a list of the resources in the file. If you click OK, the entire set of resources in the file is loaded, and 
the resulting new file has a larger set of resources than the original. For example, if the file you are 
merging has 72 ports, but your default configuration has 136, the new file preserves all of you port 
settings for ports 1-72, and new empty port configurations from 73-136 are added onto the file.

• If the file that you are merging has the same set of resources as the default resource configuration, you 
do not see any warning about a mis-match of resources. In this case, you did not need to perform any 
procedure to resize the file. You may cancel the entire procedure and use the file in its current 
configuration.

6. Save your new file to disk.

Reconfiguring A Setup File To Have Non-default Settings For Resources 

This procedure is used if you are running the same copy of AZedit to set up several differently sized intercom systems. For 
example, if your AZedit is configured for an ADAM-136 intercom system, but it is also being used to configure an ADAM CS 
intercom system, you may wish to create your ADAM CS setup files with the normal ADAM CS configuration settings. You 
do not have to do this, but it prevents anyone from trying to configure items that do not exist in your ADAM CS intercom 
system. 

To create a non-default setup file, do the following:

1. Save the current setup file.

2. From the File menu, select New.

3. When prompted, select either Load Default Configuration or Use Current Configuration. 
If you know which configuration most closely matches the new settings that you want, select that option; otherwise, it 
does not matter which choice you select.

4. From the Options menu, select Intercom Configuration.
A warning message appears.

5. Click OK.
The Intercom Configuration window appears.

6. Make the necessary modifications.

7. Click Apply. 

IMPORTANT:Do not make the new settings the default settings.

You should now have a new blank setup file that is set to the configuration that you want. You now merge the previously saved 
setup file into the new setup file. For more information, See “Merging” on page 357.

To create a new setup file with non-default resource settings, do the following:

1. From the File menu, select New.

2. From the Options menu, select Intercom Configuration.
A warning message appears.

3. Click OK.
The Intercom Configuration window appears.

4. Configure the resources and options, as desired.

5. Click Apply.
A warning message appears.
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6. Click OK.
The message “Would you like to make this configuration the AZedit default?” appears.

7. Select No.

8. Save the new configuration file.

You can now edit the new setup file, or work on some other setup file. Whenever you open the new file, the configuration 
settings for that file, and not the AZedit default settings, are loaded.

IFB Setup Procedures

Use the following procedure to setup any of these types of IFBs:

• Standard, one-way IFB, where the keypanel operator only needs to talk to the listener.

• 2-way IFB, where the keypanel operator can talk and monitor the talent during IFB operation.

• 2-way IFB, where the keypanel operator can talk and several people can monitor the talent over an 
external speaker or other device during IFB operation.

Setup Procedure for standard one-way and two-way IFB

To name an IFB, do the following:

1. From the Alphas menu, select IFB.
The IFB Alphas window.

2. Double-click an IFB you want to name.
The Edit Alpha/Description window appears.

3. In the Alpha field, enter a name. 

NOTE: For trunked (remote) intercom systems only, enter an Alias name, if desired, that is more meaningful to 
keypanel operators in the remote intercom system. Remote intercom users see only the alias name.

4. In the Description field, enter a brief description, if desired.

5. Click Done.

To configure the IFB that you just named, do the following:

1. From the System menu, select IFB.
The IFBs window appears.

2. Double-click the IFB you just named.
The Edit IFB window appears.

3. In the Input field, enter the Port Number of the intercom port where the normal audio source is connected. 

EXAMPLE:For example, if you are setting up an IFB for paging with interruptible background music, connect the 
background music to an intercom port input then select that intercom port in the Input field. If you 
are setting up an IFB to cue broadcast talent, create a talent mix-minus signal. (This should be the 
broadcast audio minus the talent voice audio. This is usually created at an external audio mixer.) 
Then connect the mix minus signal to an intercom port input and select that intercom port in the 
Input field.
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4. In the Output field, enter the intercom port that normally hears the audio signal selected in step 10. 

NOTE:  

• For paging, select the intercom port where the paging speaker output is connected. For talent cueing, 
select the intercom port where the talent earset or headset is connected.

• By default, the audio source is completely cut off, or muted, while the keypanel operator is talking. If 
you only want the signal to be diminished by a certain amount during IFB operation, select a different 
amount in the Dim Level select box. For example, if you select -6dB, the background music, talent mix-
minus, etc. seems to diminish by about half volume during IFB operation.

• You may not want keypanel operators to have the ability to assign this IFB to keys on their keypanels. 
In this case, make sure the Scroll Enable boxes are not checked.

Listen Source field

The Listen Source field is only used for 2-way IFB operation. It lets the keypanel operator and/or other studio personnel listen 
to the talent during IFB operation.

To set up 2-way IFB operation, do the following:

1. Connect the talent mic signal (the direct mic signal, not the mix-minus signal) to an intercom port input. 

2. Select that port in the Listen Source field.

NOTE: The Tone Override Input field is not used for standard IFB.

3. Click Done.

To set up a keypanel to use the IFB that you just configured, do the following: 

NOTE: Some steps may be omitted for standard, talk-only IFB.

1. From the System menu, select Keypanel Assignment.
The Keypanels/Ports window appears.

2. From the Alpha drop down menu, select the intercom port where the operator keypanel is connected.

3. In any unused talk field, enter the alpha name of the IFB (the alpha name you set up previously).

4. If you previously set up a Listen Source, select a listen key box and enter AT. 

NOTE: AT (Auto Table) is a reserved listen key name for use with IFB talk keys. When you define a listen key as an 
AT key, AZedit automatically searches the table of IFBs and locates the IFB that is assigned to the talk key. 
It then uses the defined Listen Source for that IFB as the listen key assignment. There are two (2) advantages 
to this. First, you never have to remember which intercom port is the listen source after you have set up a 
particular IFB. Second, if you change the talk key assignment to a different IFB later, the listen key 
automatically takes on the Listen Source assignment for the new IFB.

By default, all keypanels are assigned the lowest IFB priority. This means that any keypanel can talk to the IFB listener, and all 
talkers are heard. You can give a keypanel a higher IFB priority if desired. During IFB operation, a keypanel with a higher IFB 
priority overrides any keypanel with a lower priority, and the IFB listener cannot hear the lower priority keypanels. To raise the 
priority number for a keypanel, access the keypanel advanced features as follows: 
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IFB Priority Configuration

To assign a priority to an IFB, do the following

1. On the Keypanel/Ports window, click Edit. 

2. Click the Advanced tab. 

3. In the IFB Priority field, enter a higher number. 

NOTE: By default, only three (3) IFB Priority levels are allowed. If you want more, you can customize the IFB 
priority in Options|Intercom Configuration|Options tab.

4. Click OK.

If you want the talent microphone signal to go to a studio monitor or similar device during IFB operation, you need to define 
that destination.

To define the audio destination, do the following: 

1. On the Keypanel/Ports window, click Edit. 

2. Click the Advanced tab. 

3. In the IFB Listen Destination field, select the intercom port where the studio monitor or other output is connected. 

4. Click OK.

5. Send your changes to the intercom system. 
The new key assignment should appear on the operator’s keypanel, and the normal audio source should be audible at 
the IFB output.

6. Activate the IFB key to verify operation. 
The audio source should diminish or mute and the keypanel mic audio should be audible at the IFB output.

7. If a Listen Source and listen key have been assigned, activate the listen key to check operation. 
The talent mic signal should be audible at the operator keypanel or at the defined Listen Destination if you are using 
an external monitor or similar device.

Using the Keypanel Tone Generator

To use the keypanel tone generator, do the following:

1. From the Online menu, select Connect
OR

Click the Connect icon. 
Online displays in the mode pane at the lower-right corner of the window.

2. From the System menu, select Keypanel Assignments.
OR

Click the Keypanel icon.

3. Select the intercom port where the problem keypanel is connected.

4. Click Edit.

5. Click the Advanced tab.

6. Select the Enable Tone check box to turn the tone generator on. 

7. Click OK.

8. Assign a talk key to talk to the keypanel used to check the path from this keypanel back to itself. For example, if you 
are checking a keypanel at port 1, assign a key at port 1 to talk to port 1. 

9. Send the changes to the intercom system.
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10. At the keypanel being tested, activate the key you just assigned.
You should be able to hear the tone. (Turn up the volume if necessary. Also, make sure headset or speaker is selected 
as appropriate.)

NOTE:  

• If the keypanel address is not set correctly, you cannot see the key assignment that you just sent. In 
addition, the keypanel does not receive the signal to turn on the tone generator. In this case, the problem 
may be an incorrectly set keypanel address. Alternatively, if other keypanels connected to the same 
Audio I/O card are having similar problems, there could be a malfunction in the data transceiver on that 
Audio I/O card.

• If you cannot hear the test tone on a keypanel, assign and activate a key to talk to a second keypanel. If 
you can hear the tone at the second keypanel, this means the talk path from the first keypanel is OK, but 
there may be a problem with the listen path from the first keypanel to the intercom system. 

• If you cannot hear the test tone at the second keypanel, try sending a test tone from the second keypanel 
to the keypanel being tested. (Turn on the tone generator in the second keypanel, then assign and 
activate a talk key to talk to the first keypanel.) If the tone is audible at the first keypanel, then there may 
only be a problem in the talk path from the first panel. If the tone is not audible, there may be a complete 
break or disconnect in the cable.

11. Clear Enable Tone check box when you are finished.

12. Send the change to the intercom system.

NOTE: If you turn on a tone generator from AZedit you must also turn it off from AZedit. If you turn on a tone 
generator from the keypanel, you must turn it off from the keypanel.

Show/Hide the Toolbars

Sometimes it is convenient to hide the toolbar on an application window to open up space on the application desktop. By 
default, AZedit has the navigation toolbars showing, however, you can hide them.

To hide the Navigation/Standard Toolbars, do the following:

 > From the View menu, select Navigation/Standard Toolbar or Navigation/Standard Toolbar2.
The check mark is removed from next to your selection.

To show the Navigation/Standard Toolbar, do the following:

 > From the View menu, select Navigation/Standard Toolbar or Navigation/Standard Toolbar2.
A check mark appears next to your selection.

NOTE: When the Navigation Toolbars are not docked to the edge of the application window, you can hide them by 
clicking the X in the upper right corner of the toolbar.
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Dock and Undock the Toolbars

You might need to create space on the application desktop, but do not want to lose the usefulness of the navigation toolbar. 
AZedit gives you the freedom to have docked or floating (undocked) toolbars. The floating toolbars can be moved inside and 
outside the application desktop giving you more space to work.

To undock a toolbar, do the following:

 > On the far left side of the toolbar, click and move the toolbar away from its docked position.
The Toolbar becomes detached from the Application Desktop.

NOTE: You may also undock the toolbar by double-clicking the far right side of the toolbar. This unlocks the toolbar 
from its last floating position.

To dock a toolbar, do the following:

 > Double-click the blue banner bar on the toolbar.
The toolbar docks itself to the bottom of the application desktop.

NOTE: You may also click the blue banner on the toolbar and drag it to the bottom or top of the application desktop 
to dock it.

Customize a Toolbar

To customize the Standard, Standard 2, Navigation, or Navigation 2 toolbar, use the Customize Toolbar window to arrange 
your most used icons to be easily accessible.

To customize a toolbar, do the following:

1. From the View menu, select Customize Toolbars.
The Customize Toolbars popup menu appears.

2. From the Customize Toolbar menu, select Standard, Standard 2, Navigation, or Navigation 2, depending on which 
toolbar you want to customize.
The Customize Toolbar window appears.

3. Select your individual preferences.

4. Click Close.
The Toolbar dynamically changes and the Customize Toolbar window closes.

Enable VOX

VOX (Voice Activated Switching) is the threshold level of audio at which point a channel becomes active. When the threshold 
is set, a microphone is not activated until the preset audio level is attained. This prevents a channel from staying on in a high 
activity area.

NOTE: VOX is supported only on Cronus systems and AIO-16 cards.

Default gain structures are as follows:

Cronus -20 dB to +20 dB

AIO-16 -126 dB to 0.0 dB
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There are two (2) ways to enable VOX on a port: 

• the VOX tab on the Keypanel/Port Configuration window 

• the VOX Settings window.

To enable VOX from the Keypanel/Ports Configuration window, do the following:

1. From the Alpha drop down menu, select the port you want to enable VOX. 

2. Click Edit.
The Keypanel/Port Configuration window appears.

3. Click the VOX tab.
The VOX window appears.

4. Select Enable VOX.
VOX is enabled on the port.

5. Using the VOX Threshold up and down arrows, set the VOX Threshold.

6. Using the Hold Time up/down arrows, set the Hold Time for the port to stay active before shutting off.
Once VOX is enabled, you see the VOX icon on the Keypanels/Ports window. 

To enable VOX from the VOX Settings window, do the following:

1. From the System menu, select VOX.
The VOX Settings window appears.

2. From the Port column, select the port to enable VOX.

3. Using the up/down arrows, set the threshold that VOX is activated.

4. Using the up/down arrows, set the amount of time the port stays active before shutting off.

5. Click Enable VOX.
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How to Download Firmware to Multiple Cards

To save time in updating individual cards one at a time with the same firmware, AZedit is able to update multiple cards with 
the same firmware simultaneously. However, it is recommended to perform downloads 

NOTE: You can download firmware from either the I/O Card Status window or the I/O Card Version Information 
window. For the purpose of this example, the I/O Card Version Information window is used.

To download firmware to multiple cards, do the following:

1. From the Status menu, select Software Versions|I/O Cards.
The I/O Card Version Information window appears. 

2. Select multiple cards.

NOTE: When downloading the same firmware to multiple cards, you can only download to similar cards.

To select all the key assignments in an assignment group, do the following: 

1. Select the top assignment. 

2. Pressing Ctrl+Shift, select the bottom assignment.
All the assignments are highlighted.

To select specific key assignments from the assignment group, do the following:

1. Press Ctrl.

2. Click the assignments you want.

3. Right-click any of the highlighted cards and select Download Firmware…. 
The Firmware Download window appears.

4. Select the firmware file (usually ends in .hex, .bib, .mot extensions) 
OR
Browse to find the file.
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5. Click OK.
The Download Device Firmware window appears.

6. Click Begin Download.
Depending on the number of cards you are updating, determines the amount of time the download process takes. 
Once the Download is complete, a message saying, “AZedit has successfully completed sending the firmware. 
However, it may still be being delivered to the target device(s)”.

IMPORTANT: Do not power off the Intercom System or remove any cards while the download is in process. 
Doing so results in undesirable effects.

7. Using the Software Version windows, verify the success of the download before removing or re-powering the target 
device(s).” 

8. Click OK.

9. From the Status menu, select Software Version|I/O Cards.

10. Verify the firmware was upgraded on each of the specified cards.
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How to Enable Key Labels

Key Labels allow you to rename ports to more meaningful names, without losing assignment type information of the keypanel 
key.

NOTE: Intercom Configuration options Panels with Key Labels and Key Labels per Panel must be set before using the 
Key Label feature. 

IMPORTANT: Before you set key labels in your Intercom System, be sure to save your existing setup file. 

To set the Key Label configuration, do the following:

1. From the Options menu, select Intercom Configuration.
A warning message appears.

2. Click OK.
The Intercom Configuration window appears.

3. Click the Options tab.

4. In the Panels with Key Labels field, enter the number of keypanels allowed to have key labels (up to 272 keypanels 
per frame) 

NOTE: For each additional frame, the number of keypanels allowed to have key labels assigned decreases due to the 
number of DBX cards in the system and the number of Frames.

5. In the Key Labels per Panel, enter the number of key labels allowed on a keypanel (up to 64 labels per keypanel).

To enable Key Labels, do the following:

1. On the Keypanel/Ports window, click Edit.
The Keypanel/Port Configuration window appears.

2. Click the Advanced tab.

3. Select the Key Label.
Key Labels appear on the Keypanel/Ports window.

To assign a Key Label, do the following:

1. In a Key Label field, enter a meaningful name for a Talk Key.
Repeat this for as many key labels as desired.

2. Send the new setup file to the Intercom.
The Key Labels appears in the appropriate keypanel window.
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How to Enable Snoop Tallies

Snoop Tally, when enabled, provides an indication to keypanel users that somebody is listening to them. For example, snoop 
tallies are displayed on a keypanel 1 if keypanel 2, which is listening to keypanel 1 via a point-to-point or a special, list, but is 
not talking to keypanel 1. Snoop tallies are supported on KP-32 family keypanels.

Snoop Tally requires the minimum firmware versions:

• Master Controller V9.24.0

• DBX V1.15.0 with Peripheral Controller V10.15.0

NOTE: Hot Mic must be activated on the keypanel for snoop tally to work.

To enable Snoop Tallies, do the following:

1. From the Options menu, select Intercom Configuration.
A warning message appears.

2. Click OK.
The Intercom Configuration window appears.

3. Click Options.

4. Select the Generate Snoop Tallies option.

5. Click Apply.
A warning message appears.

6. Click OK.
A message appears.

7. Click Yes to make this configuration the default, otherwise click No.
A message that reads, “Remove the Standby Master Controller from the intercom frame. Note: The Standby Master 
Controller is the card in slot 19 or slot 20 that does NOT have red LED #23 on.”, appears.

8. Click OK.
The Intercom Configuration has been modified.

9. Send the changes to the Intercom.

When snoop tallies have been enabled on a keypanel an amber color light appears on the mic-mute LED on KP-32 family 
keypanels. 
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How to Enable Do Not Interrupt

To enable Do Not Interrupt on a port, do the following:

1. From the System menu, select Keypanel Assignments.
The Keypanel/Ports window appears.

2. From the Alpha drop down menu, select the port you want to enable Do Not Interrupt.

3. Click Edit.
The Keypanel/Port Configuration window appears.

4. Click Advanced.

5. Select the Do Not Interrupt check box.

6. Click Apply.

7. Click OK.

8. Send your changes to the intercom.
Do Not Interrupt is enabled for the selected port.

NOTE: When Do Not Interrupt is active on a port, and one (1) keypanel is talking to another keypanel, no other 
keypanel can interrupt the call (unless the caller is on a trunked system). When the caller tries to reach the 
keypanel with Do Not Interrupt enabled, they see the Alpha blink intermittent with asterisks in the keypanel 
window. However, once the call is released from the first caller, the second caller is connected (if they are 
still waiting).

Connect Cronus to the PC and the Network over Ethernet

NOTE: You must be running version 2.06.07 or later of AZedit and have an Ethernet card installed.

IMPORTANT: Verify the Cronus system is connected to the PC using either a USB (universal) or RS-232 (ADAM 
standard) cable. The USB drivers can be found in the AZedit software directory 
(C:\Telex\AZedit\v.xxx\USB).

Before you can connect Cronus to the network over Ethernet, you must first setup the Ethernet connection over a serial 
connection.

To connect Cronus to the PC with a serial cable, do the following:

1. Open AZedit.

2. From the System menu, select Keypanel Assignments.
The Keypanel/Port window appears.
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3. From the Options menu, select Ethernet Setup.
The Ethernet Setup window appears. 

4. In the IP Address field, enter the IP Address for the Cronus system.

5. In the Network Mask field, enter the Network Mask for the Cronus system.

6. In the Default Gateway field, enter the Default Gateway for Cronus.

NOTE: If you do not know these numbers, your system administrator can give you the IP Address and Network 
Mask to use.

7. Click Apply.

8. Click Close.
The Ethernet Setup window is closed.

9. Connect the Cronus to your network with an Ethernet cable.

10. Connect the PC to your network with an Ethernet cable.

11. From the Options menu, select Communications.
The Communications window appears. 

12. In the Connection area, select the Network radio button

13. In the IP Address field, either enter the Cronus IP Address you wish to connect with
OR
Click the Search button.
The search button scans the network for any Cronus devices. If multiple units are on the network each appears in the 
list; select the Cronus you wish to work with.

14. Click OK. 
The Communications window closes.
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How to Use the Intercom Sizing Wizard

If you plan to use the Intercom Sizing Wizard in Online mode, you must remember to select the Allow Intercom Resizing in 
Online Mode checkbox. 

To select the Allow Intercom Resizing in Online mode, do the following:

1. From the Option menu, select Preferences.
The Application Preferences window appears.

2. Click the Advanced tab.
The Advanced window appears.

3. Select the Allow Intercom Resizing in ONLINE Mode checkbox.

NOTE: You must use the Intercom Sizing Wizard if you are changing the number of frames, the number of ports, or 
the Intercom Setup options in your system.

To access the Intercom Sizing Wizard, do the following:

1. From the Options menu, select Intercom Configuration.
A warning message that reads, “WARNING! You are about to reconfigure the intercom! The existing intercom setup 
is ERASED and intercom system will be reset” appears.

2. Click OK.
The Intercom Configuration window appears. 
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3. Click Intercom Sizing Wizard.
The Intercom Sizing Wizard begins.

NOTE: In Online mode, the wizard automatically determines your intercom system size, and then walks you though 
to get information that is more specific for configuring your system.

In File mode, you have to pick your intercom system, and then the wizard walks you through the different 
options to determine the intercom system setup.
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Set the Cronus Front Panel Control Password

1. From the System menu, select Miscellaneous.
A popup menu appears.

2. From the Miscellaneous menu, select Cronus Password.
The Cronus Passwords window appears.

3. In the Front Panel Configuration field, enter a password for the Cronus (up to 20 alphanumeric characters).

4. Click OK.
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Show or Hide List columns

You have the ability to hide columns on any windows with column views, if desired. It is useful to hide columns you rarely use 
or do not want other users to see the data in certain columns.

To hide columns, do the following:

1. Open a window with column views.

2. Right-click the column header.

3. Select Hide.
The column closes.

4. Repeat step 2 for any other columns that you want to hide.

To show hidden columns, do the following:

1. Right click the column header.

2. Select Show Column.
The Show Column popup menu displays.
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3. From the Show Column menu, select the column you want to show. 
OR
From the Show Column menu, select All to show all the hidden columns. 

Download License File to Cronus

Linking more than one (1) Cronus system together requires you to have linking software installed on the system (normally, 
this is loaded at time of purchase). If you are adding a Cronus system to an existing Cronus matrix, you may need to load a 
license file on your existing system. Each license file is uniquely stamped with the MAC Address of the master controller 
running in the intercom system.

NOTE: The Cronus system must be in Stand Alone state shown on the front panel display. Once the License file is 
loaded, the Download License option in the Options menu disappears.

To download the Cronus license file, do the following:

1. From the Options menu, select Download License.
The Download License submenu appears.

2. Select the license file to download
OR
Use browse to navigate to the file

3. Click Open.
The License file begins to download. Once the file is downloaded, the message “AZedit download successful! The 
license file X:\XXX.lic was downloaded and accepted by the intercom.

4. Click OK.
Frame 1 appears on the front panel after the download completes.
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How to Create a Desktop Shortcut to AZedit

A desktop shortcut, usually represented by an icon, points to a program, folder, document, or Internet location. Clicking a 
shortcut icon takes you directly to the object the shortcut points. Shortcut icons contain a small arrow in their lower left corner. 
Shortcuts are merely pointers—deleting a shortcut does not delete the item the shortcut points to.

With AZedit, you can create a unique shortcut to multiple AZedit sessions or logons for the application.

To create a shortcut to AZedit, do the following:

1. From the Authentication menu, select Create Shortcut.
OR

Click the Shortcut icon. 
The Create Desktop Shortcut window appears.

2. Select the Intercom checkbox.

3. In the Intercom field, enter the intercom name.

NOTE: If desired, you can create an AZedit session logon based on the user. For more information, see 
“Authentication Configuration Window” on page 85.

4. Select the User Name check box, if desired.

5. In the User field, enter a user name to create a shortcut that is user specific.

6. In the Shortcut Name field, enter a recognizable name for your AZedit session.

7. In the Description field, enter a short description of the AZedit session that is meaningful to the user.

8. Click OK.
The shortcut is created on the computer desktop.

How to Set VOX on Several Ports at the Same Time

To set VOX on several ports at the same time, do the following:

1. From the System menu, select VOX.
The VOX Settings window appears.

2. In the Port Columns, select the ports you want to enable VOX on, by using either of the following procedures:

a. While pressing the Ctrl key, select multiple individual ports (can be done randomly).

b. While pressing the Ctrl and Shift key, select a block of ports.

3. Click Enable VOX.

To disable vox on a port, do the following:

1. From the System menu, select VOX.
The VOX Settings window appears.

2. In the Port Columns, select the ports you want to enable VOX on, by using either of the following procedures:

a. While pressing the Ctrl key, select multiple individual ports (can be done randomly).

b. While pressing the Ctrl and Shift key, select a block of ports.

3. Click Disable VOX.
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Add an IFB to an IFB Special List

To add an IFB to an IFB Special List, do the following:

1. From the System menu, select IFB Special Lists.
The IFB Special Lists window appears.

2. In the IFB SL field, enter the IFB SL resource number you want to add an IFB SL.
You can also use the alpha drop down list to select from.

3. In the IFB Columns, select the IFB ports you want to add to the IFB SL.

4. Click Add to IFB SL.

Add Multiple IFBs to an IFB Special List at the Same Time

To add multiple IFBs to an IFB Special List, do the following:

1. From the System menu, select IFB Special Lists.
The IFB Special Lists window appears.

2. In the IFB SL field, enter the IFB SL resource number you want to add an IFB SL.
You can also use the alpha drop down list to select from.

3. In the IFB Columns, choose multiple IFB ports using one (1) of the following methods:

a. While pressing the Ctrl key, select different IFB ports (can be done randomly).

b. While pressing the Ctrl and Shift key, select a block of IFB ports.

4. Click Add to IFB SL.

To remove multiple IFBs from an IFB Special List, do the following:

1. From the System menu, select IFB Special Lists.
The IFB Special Lists window appears.

2. In the IFB SL field, enter the IFB SL resource number you want to add an IFB SL.
You can also use the alpha drop down list to select from.

3. In the IFB Columns, choose multiple IFB ports using one (1) of the following methods:

a. While pressing the Ctrl key, select different IFB ports (can be done randomly).

b. While pressing the Ctrl and Shift key, select a block of IFB ports.

4. Click Remove from IFB SL.
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Create an Administrator Profile

An administrator can add and delete users, change passwords, change admin states, change restrictions file requirements or 
enable/disable authentication on any of the connection types.

To create an administrator profile, do the following:

1. From the Authentication menu, select Configuration….
The Authentication Configuration window appears.

2. Click Add.
The Add User window appears.

3. In the User Name field, enter the user name of the administrator.

4. In the Password field, enter a password (any password works; this is changed later by the administrator).

5. Select the User is an Administrator check box, if they are to be an Administrator.

6. Select the User requires Restrictions check box, if you want restrictions for the user enabled when they sign on.

7. Click OK to add the user as an administrator. 
OR
Click Cancel.

Resize Columns

Occasionally columns in AZedit are too small to display the information. When this happens, you can resize any column to 
any width you like.

To resize a column, do the following:

1. Open a window with a column view.

2. Place your cursor over a column marker.

3. Left-click and hold to reveal the resizing icon.

4. Drag your cursor to the desired column width.
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Order Columns

It is possible to reorder the way columns appear on a window. For example, on the Port Alpha window the columns are in the 
following order: Port, Alpha, Alias, and then Description. However, by simply dragging and dropping a column in the position 
you want, you can reorder the columns to fit your needs.

To reorder columns using drag and drop, do the following:

1. Open a window with a column view.

2. Click and hold the column you want to move to another position.

3. Drag the column to the new position and release.
The column has now been reordered.

How To Set The Delay Time For Screen Saver Mode

A screen saver is an animated image activated on a display when no user activity has been sensed for a specified amount time. 
With the KP-32 family of keypanels (firmware version 2.06 or higher), you have the option to set a window saver for the 
keypanel display.

To set the window saver delay time, do the following:

1. On a KP-32 keypanel (or KP-632 and 832), press Menu.
Display appears on the keypanel display.

2. Using the  button, scroll to Service.

3. Press PGM.
Aux Inputs appears on the keypanel display.

4. Using the  button, scroll to Scr Saver.

5. Press PGM.
Delay appears on the keypanel display. 

NOTE: There are three (3) options to choose from this list: 

Delay - the keypanel display is set to turn off after a certain amount of time the keypanel is inactive: 
30 min, 1 hr, 2 hr, 4 hr, 6 hr, 8 hr, 10 hr, 12 hr

DSP Off - the keypanel display turns off (pressing any key re-activates the display)

Activate - the window saver is immediately enabled (pressing any key re-activates the display)

6. Press PGM.
30 min appears on the keypanel display.

7. Usingselect the amount of time the keypanel is inactive before the display turns off. 
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How To Create/Change The Screen Saver Display

The screen saver display is the scrolling message that appears when inactivity on a keypanel has attained a certain time limit. 

To create or change the screen saver display, do the following:

1. From the System menu, select Miscellaneous|Keypanel Screen Saver.
The Keypanel window Saver window appears.

2. In Screen Saver Line 1 field, enter a message (up to 39 characters). 

3. In Screen Saver Line 2 field, enter a message (up to 39 characters). (Optional)

NOTE: The screen saver delay time can only be set from a KP-32 family keypanel.

Add/Remove a Port to/from a Special List

A Special List is a group of intercom ports that a keypanel operator can talk or listen to by activating a single key. Special lists 
are typically used for paging, all call, group call, etc.

To add a port to a special list, do the following:

1. From the Systems menu, select Special List.

2. From the Special List columns, select the port or ports you want to add to a special list.

3. Click Add to SL.
The selected port(s) turn yellow and a green Yes appears in the SL Member? column.

To remove port(s) from a special list, do the following:

1. From the Systems menu, select Special List.

2. From the Special List columns, select the port or ports you want to add to a special list.

3. Click Remove from SL.
The selected port(s) turn yellow and a red No appears in the SL Member? column.
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How to Create an Assignment Group

An Assignment Group is a list of arbitrary key assignments (both local and remote) of any key type that can be created in 
AZedit, and which is available in a single scroll list to any keypanel. Assignment Groups logically group different types of key 
assignments into one (1) single scroll list.

To create an Assignment Group, do the following:

1. From the Alpha drop down list, select the Assignment Group Alpha you want to create. 

2. Click Add to Group.
The Select Key Assignment window appears.

3. From the Type column, select the type of port (for example, IFBs) you want to add to your assignment group.

4. From the # and Alpha columns, select the port(s) you want to add to the assignment group.

5. Click Add to Group.
The selected ports are added to the assignment group list.

6. From the Scroll Enable radio buttons, select the type of scroll list in which you want assignment group to appear.

NOTE: You can add different types of key assignments to the each assignment group. For example, you can assign 
all the key assignments for a particular studio to one assignment group. This is a convenient way to see only 
the key assignments for a particular studio instead of having to search through all the ports to find a 
particular assignment.

7. Repeat steps 3, 4, and 5 if you want to add more key assignments.
OR
Click Done.

8. Send your changes to the Intercom.

Remove Assignments in Assignment Groups

To remove assignments from assignment groups, do the following:

1. From the Alpha drop down list, select the Assignment Group Alpha you want to modify/remove. 

2. From the Assignment Group columns, select the key assignments you want to remove.

3. Click Remove from Group.
The selected ports are removed from the assignment group list.
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How to Use an Assignment Group at the Keypanel

Assignment Groups are a convenient way of grouping similar key assignments (i.e. all studio A key assignments) in a scroll 
list, which in turn allows the user to access the key assignments by logical groups rather than having to scroll through the 
entire list of assignments. 

Once you have created and sent your assignment group, you can start using the assignment. 

To see the assignment group from the keypanel, do the following:

1. While the keypanel is in an idle state (the CWW window is clear), tap the PGM/SEL key.
The Assignment groups appear in the call-waiting window.

2. Using the  or , scroll to the Assignment Group you want.

3. Once you have found the Assignment Group, tap PGM/SEL.
A list appears in scroll form, allowing you to view the members of the assignment group.

NOTE: You can copy any assignment within the Assignment group to a key on the keypanel by using the copy 
CWW key.

How to re-display the maintenance tab using the Registry Editor

When you choose to hide the maintenance tab in the Applications Preferences window, you must use the Registry Editor to 
activate the tab again so that it can be seen

NOTE: The Registry Editor is an advanced tool that enables you to change settings in your system registry, which 
contains information about your computer and the programs that run on it. You should not edit the registry unless 
it is necessary. Generally, it is best to use AZedit controls to change your program settings. If an error is made in 
the registry, the software may become nonfunctional.

CAUTION: Be sure to make a backup .reg file of the registry before making any changes, so that you can import the working 
version if a mistake is made.

To open the Registry and activate the maintenance tab, do the following:

1. From the start menu, click Run.
The Run window appears.

2. In the Open: field, enter regedit.

3. Click OK.
The Registry Editor opens.

4. Expand HKEY_CURRENT_USER.

5. Expand Software.

6. Expand AZeditV3. (If you are using an earlier version of AZedit [v 2.9 or earlier] you expand AZedit)

7. Expand Intercoms.

8. Expand Default.

9. Expand Users.

10. Expand Default.
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11. Expand maintenance.
The maintenance tab options appear in the display window.

12. Double-click HideMaintencePreferences.
The Edit String window appears.

13. In the Value Data field, type a capital N. 

14. Click OK.
The Maintenance tab is now active.
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How to display output alphas, input alphas, and aliases on alpha windows

To display the Output Alphas, Input Alphas, and Aliases on the Alpha window, do the following:

1. From the Options window, select Preferences.
The Application Preferences window appears.

2. Click the Alpha Tab.
The Alpha window appears.

3. Select the Show all sizes on alpha views.

4. Click Apply.
Now, Alphas with 4-, 6-, and 8-character names appear.

To display Aliases, do the following:

NOTE: An alias is what that port is called on a remote system (over trunking).

1. Click the Advanced tab.
The Advanced window appears.

2. On the Advanced window, select Enable trunking support.

3. Click Enable.
Trunking is now available. Aliases are only used in trunking situations.

To display the Input Alphas, do the following:

1. From the Options menu, select Intercom Configuration.
The message “Warning! Changing these settings may cause a mismatch between AZedit and the intercom. Normally, 
we recommend that you change the settings for the intercoms first in ONLINE mode, and then accept those settings as 
the defaults for AZedit", appears.

2. Click OK.
The Intercom Configuration window opens.

3. Click the Options tab.
The Options page appears.

4. Select User input alphas.

5. Select Apply.
The Aliases are now enabled and displayed on the Alpha windows.
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How to set preferred alpha sizes

To set preferred alpha sizes, do the following:

1. From the Options menu, select Preferences.
The Application Preferences window appears.

2. Click the Alphas tab.
The Alphas window appears.

3. From the Preferred alpha size drop down list, select the preferred alpha size: 4-, 6-, or 8-character.

4. Click Apply.

NOTE: When you choose 6- or 8-character Alphas, you may have up to 6- or 8-character alphas. However, 4-
character alphas still display even when 6- or 8-character alphas are chosen.
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Configure the GPIO-16

When configuring the GPIO-16 device you must do the following:

• Configure the GPIO-16

• Assign the GPIO-16 device to a relay group.

NOTE: If this is the first time you are using the GPIO-16 with AZedit, the IP Address may not display, however the 
MAC (Media Access Control) address does. A MAC address is a hardware address that uniquely identifies each 
node (or device) of a network.

To configure the GPIO-16, do the following:

1. From the Options menu, select GPIO-16 Configuration.
The GPIO-16 Configuration window appears.

2. In the IP Address field, enter the IP Address of the GPIO-16. 
OR

Use the browse button  to open the Select GPIO-16 window.
Once the IP Address field is populated, the rest of the configuration window becomes active.
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NOTE: The browse button  is used to display the IP Addresses of all the GPIO-16 devices on the local network 
that can respond to a broadcast.

The lookup button  is used to look up an IP Address you manually enter into the IP Address field. The 
lookup button is most commonly used when you know the IP Address of a GPIO-16, but is on the other side 
of a gateway and cannot respond to a broadcast. If the GPIO-16 at that address exists and can communicate 
with AZedit, then its configuration is loaded into the GPIO-16 Configuration area (outlined in red below).

3. In the Description field, enter a unique description.

4. In the New IP Address field, enter the new IP Address.

5. In the Network Mask field, enter the network mask.

6. In the Default Gateway field, enter the default gateway address.

7. From the Ethernet Settings drop down menu, select the Ethernet setting you want to use:

• 10Mbps, Half Duplex

• 100Mbps, Half Duplex

• 10Mbps, Full Duplex

• 100Mbps, Full Duplex

• Auto-negotiate – the GPIO-16 automatically alternates between 100Mbps half-duplex and 10Mbps 
half-duplex, in an attempt to determine what link speeds are supported.
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NOTE: The Current Settings display field displays the current Ethernet speed selected by the auto-negotiate menu 
item. This field actively displays only when auto-negotiate is selected.

8. In the Primary MC field, enter the IP Address of the primary master controller of the intercom the GPIO-16 is 
connected.
Once the IP Address for the Primary MC is entered, the Backup MC IP Address field automatically populates with the 
Backup MC IP Address.

NOTE: Use the current intercom button  to select the IP Address of the intercom to which AZedit is 
communicating.

9. Click Apply to apply the changes you have made.
OR
Click Close.

NOTE: From the configuration window, you browse any GPIO-16 device (on the local network that can respond to a 
broadcast). However, in the GPIO-16 system window, you can select or clear the Use Ethernet option, and 
enter a GPIO-16 IP Address. If you use the browse button in this window, you only see the GPIO-16 devices 
used by the current intercom system (for example, only those not already configured to talk to another 
intercom, or those that have a Dip switch set allowing the current intercom to take control of them if they are 
configured for another intercom but are not currently talking to that intercom.

Assign the GPIO-16 device to the relay group in AZedit

Once you have Assigned the IP Address to the GPIO-16 device, you need to assign it to a group of relays.

To assign the GPIO-16 device to a group of relays, do the following:

1. From the System menu, select GPIO-16.
The GPIO-16s window appears.

2. Double-click the relay group you want to assign to a GPIO-16 device.
The Edit GPIO-16 window appears.

3. Select the Ethernet Connection checkbox.

4. In the IP Address field, enter the IP Address of the GPIO-16. Alternatively, use the browse button  to display a 
list of GPIO-16 IP Addresses connected to the intercom.

5. Click Done.
OR
Click Next to configure the next group of relays.

NOTE: In the GPIO-16 system window, you can enable or disable the Use Ethernet options, and enter a GPIO-16 IP 
Address. If you use the browse button in this window, you only see the GPIO-16 devices used by the current 
intercom system (for example, only those not already configured to talk to another intercom, or those that 
have a Dip switch set allowing the current intercom to take control of them if they are configured for another 
intercom but are not currently talk to that intercom). However, from the configuration window, you can 
browse any GPIO-16 device on the local network that can respond to a broadcast.
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Upgrade the GPIO-16 Firmware

NOTE: At least one (1) relay group must be assigned before you can download firmware to the GPIO-16 device.

To upgrade the GPIO-16 firmware, do the following:

1. From the Status menu, select Software Versions.
The Software Versions popup menu appears.

2. From the Software Versions popup menu, select GPIO-16.
The GPIO-16 Version information window appears.

3. Right-click the GPIO-16 device you want to upgrade.
A popup menu appears.

4. From the popup menu, select Download Firmware.
The Download Firmware window appears.

5. Navigate to the firmware file (typically a .hex file) you want to download to the device.
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6. Click Open.
The Download Device Firmware window appears.

7. Click Begin Download.
The firmware download begins. Once the download has finished, a message appears on the window. The download 
may take a few minutes after the message appears to complete the download.

8. Click OK.

9. Verify the version upgrade in the GPIO-16 Version Information window is correct.
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Assign Key Assignments for the ARP-32

To assign key assignments on the ARP-32, do the following:

1. From the System Menu, select ARP-32 Assignments.
The ARP-32s window appears.

2. From the ARP-32 port drop down menu, select the port you want to assign key assignments.
OR
From the ARP-32 alpha drop down menu, select the port.

NOTE: You can only assign point-to-point assignments. There are three (3) ways to assign ports to the ARP-32 (in 
either the input or output assignments).

• Manually enter the port number (N001, N002, etc.) or port alpha

• Right-click and select Change Assignment

• Use the Assignment Grid

Download Firmware to the ARP-32

NOTE: The ARP-32 firmware cannot be downloaded when the panel is operating as an ARP panel.

To download firmware to an ARP-32, do the following:

1. Power off the panel.

2. Disconnect the panel from the intercom.

3. Connect the panel to a spare keypanel port.

4. Change the polling ID to match the keypanel port (if connected to an AIO-16 in individual driver mode, it is 
sufficient to verify the polling ID is in the 1–8 range).

5. Set Dip switch 8 to closed.

6. Power on the panel.
The panel enters boot downloader mode and displays “This panel needs a firmware download!” in the lower left 
window.

7. Open AZedit.

8. From the Status menu, select Software Versions.
The Software Versions popup menu appears.

9. From the popup menu, select Keypanels.
The Keypanel Version Information window appears. In the Version field, NEEDS DOWNLOAD displays for the 
ARP-32.
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10. Right-click the port to which the ARP-32 is connected.
A popup menu appears.

11. From the popup menu, select Download Firmware.
The Firmware Download window appears.

12. Using the browse feature, browse to the file to be downloaded (for example, ARP32.hex).

13. Click Open.
The Download Device Firmware window appears.

14. Click Begin Download.
The download begins. Once the download is complete, a success message appears.

15. Click OK.
The ARP-32 firmware download is complete. This may take a few minutes to occur.

16. Verify the version upgrade in the Keypanel Version Information window is correct.

17. Power off the panel.
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18. Set Dip switch 8 to open.

19. Change the polling ID back to the proper ARP-32 ID.

20. Disconnect the panel from the spare keypanel port.

21. Reconnect the panel to the PAP/LCP/UIO port.

22. Power on the ARP-32.

Assign Keys

To assign keys to a keypanel in AZedit, do the following:

1. Right-click the talk or listen field.
A popup menu appears.

2. From the popup menu, select Select Key Assignment.
The Select Key Assignment window box appears.

NOTE: If you are assigning keys on a KP-32 Keypanel, review the notes regarding differences between 
KP-32 setup and other keypanels.

3. In the Select Key Assignment window box, click the desired type of assignment in the left-most column:

4. Once you select a type of key assignment, select the desired name from the list in the right-most column. 

5. Click OK.
The Select Key Assignment window box closes, and the name that you selected appears in the combo box on the 
Keypanels / Ports window.

NOTE:

• For the setup page that is assigned to the main keypanel, you cannot assign or use key 16, as this is 
used for incoming messages (this is also referred to as the call waiting window, or CWW). For all 
other setup pages, you may assign and use key 16.

• If you are working with keypanels and expansion panels that have more or less than 16 keys, we 
strongly recommend that you set the Default View (Edit button, Setup tab) to View by Panel Type 
and not by Setup Page. However, if you are using view by Setup Page, note you can switch to View 
by Panel Type by pressing Ctrl+Tab.

• You can also assign a key by positioning the cursor in the key assignment text box and then typing 
the name. However, if there are any duplicate alphas in your intercom system, the key may take on 
the wrong assignment. If there is a conflict of alpha names, a drop down list appears asking which 
one you want to place (e.g., the IFB named N001 or the PL named N001)

• After you assign a talk key, you notice that a new key assignment text box activates under the talk 
key (except the KP-32 in View by Panel Type mode). This can be used for a second key assignment 
that activates along with the first key assignment. This is referred to as a level-2 talk key. 

If more than 2 talk levels have been defined in the intercom configuration (or if you are working 
with a KP-32 in View by Panel Type mode), you also see a scroll arrow at the right side of the 
window. Use this scroll arrow to select which talk levels you want to view. 

• In many cases, we recommend one (1) of the Special Function key assignments (particularly the 
auto-follow special function) for your listen keys.
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How to view alarms

To view alarms in AZedit, do the following:

 > From the Status menu, select Alarms.
The Alarms window appears.



420  Operation AZedit Intercom Software 

Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

How to turn off the Alarms notification

To turn off the alarm popup notification, do the following:

1. From the Options menu, select Preferences.
The Preferences window appears.

2. Click the Advanced tab.
The Advanced page appears.

3. Verify the Enable alarm notification popup check box is clear. 

4. Click OK.
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How to save debug information

The Debug Information menu item, shown in Figure 311, allow you to send a flash file to Bosch Security Systems, Inc. to 
help troubleshoot the reason for an intercom issue in AZedit. In the event of a processor crash, the processor saves diagnostic 
information about the cause of the problem to its flash memory. The menu item stays grayed-out until a flash file is created 
when the processor crashes.

NOTE: Every card in every frames stores its own debug information. If frame 3 has a processor crash, you must connect 
AZedit to frame 3 to create an .azd file to send to Bosch Security Systems, Inc. for debugging.

FIGURE 311. Debug Information Menu
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To save the debug information to a file, do the following: 

1. From the Options menu, select Upload Debug Information.
The Upload Debug Information window appears.

NOTE: By default, the Debug folder (C:\Telex\AZedit\Debug) is where the AZedit debug file you create is stored.

2. In the File name field, enter a name for the debug file you create. For example, you could use the date as the file 
name - 12152008.azd.
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3. Click Save.
The Uploading Debug Information Status window appears.

NOTE: Select the Delete debug information from intercom check box if you want to delete the debug information 
from the system once the .azd file is created. Otherwise, the information is kept on the intercom system. 
Remember you can only save the most current debug information. This means if you processor fails twice 
you only capture the second failure’s diagnostic information.

4. Click OK.
The AZedit debug file is made.
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Release a Trunk Port in AZedit

To release a trunk port in AZedit, do the following:

1. From the menu bar, select Status|Port.
The Port Status window appears.

2. Select the Show Enhanced Status check box at the bottom of the window.

3. Right-click the port to be released.
A popup menu appears.

4. Select Remove Trunk Port Status.
The Trunk Status is removed.
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Download License File to a MADI Card

To download the license file, do the following:

1. From the I/O Version window, right-click the MADI card you want to upgrade.
A popup menu appears.

2. From the popup menu, select Download license....

3. Navigate to the license file.

4. Click Open.
The Download License File window appears.

5. Click Begin.
The license file is downloaded. A success message appears once the file is done downloading.

6. From the Status menu, select I/O Card Status.
The I/O Card Status window appears.

7. Verify the download was successful.
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APPENDIX A

Channel Allocation Scheme

Each ADAM Frame slot, 17 in total, is capable of supporting 16 channels of audio. Depending on your frame construction, 
there are two(2) configuration options that are supported—Base 8 (standard density) and Base 16 (high density).

Base 8

The Base 8 channel numbering system splits the 16 channels between a top and bottom group. The bottom group starts with 
channels 1–136, the top group consists of channels 137–272 (see Figure X).

EXAMPLE: If you have an AIO-16 in slot one, channels 1–8 and 137–144 are used by the AIO-16 card. 
Alternatively, if you have AIO-16s in slots 1 and 3, and an AIO-8 in slot 2, the following channel 
mapping applies:

• AIO-16 channels 1–8 and 137–144

• AIO-8 channels 9–16. (Channels 145–161 are not used when an AIO-8 is in the slot.

• AIO-16 channels 17–33 and 162–178
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FIGURE 312. Base 8 Channel Numbering Scheme Example with AIO-8 Cards
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FIGURE 313. Base 8 Channel Numbering Scheme Example with AIO-16 Cards
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Base 16

Unlike Base 8 channel numbering scheme, where the channels are split into an upper and lower set of eight(8), the Base 16 
channel numbering scheme puts all 16 channels in one (1) slot. This means, when you configure your intercom system to 
support Base 16, slot 1 in the ADAM holds channels 1–16, slot 2 holds 17–32, slot 3 holds 33–48, and so on.

FIGURE 314. Base 16 Port Number Scheme Example



Bosch Security Systems, Inc. User Manual  F.01U.239.453 Rev. 03

APPENDIX B

AZedit Keyboard Shortcuts

AZedit Keyboard Shortcuts

Keyboard Shortcuts

Keyboard Shortcut Description Context

CTRL+R Toggle key restriction state Keypanel Assignment

CTRL+SHIFT+R Toggle key restriction state, and set all keys to the right to the same state Keypanel Assignment

CTRL+ALT+R Toggle key restriction state, and set all keys to the left to the same state Keypanel Assignment

CTRL+D Toggle latch disable state Keypanel Assignment

CTRL+SHIFT+ALT+D Toggle latch disable state, and set all keys to the right to the same state. Keypanel Assignment

CTRL+ALT+D Toggle latch disable state, and set all keys to the left to the same state. Keypanel Assignment

CTRL+ENTER Display key assignment selection window Keypanel Assignment

SHIFT+ENTER Display port volume window Keypanel Assignment

PAGE DOWN Display the next setup page/panel Keypanel Screen

PAGE UP Display previous setup page/panel Keypanel Screen

PAGE DOWN Display next LCP-102 mode LCP-102 screen

PAGE UP Display previous LCP-102 mode LCP-102 screen

CTRL+PAGE DOWN Display next keypanel, PL, SL, etc. Most screens

CTRL+PAGE UP Display previous keypanel, PL, SL, etc. Most screens

CTRL+TAB Toggle between setup page and panel oriented views Keypanel screen

CTRL+SHIFT+TAB Toggle between setup page and panel oriented views (for all ports) Keypanel screen

ALT+< Shift keypanel display to the left (when the panel has more than 16 keys) Keypanel screen

ALT+> Shift keypanel display to the right (when the panel has more than 16 keys) Keypanel screen

CTRL+T Toggle KP-32 key assignment viewing between talk and listen keys Keypanel screen (KP32)

CTRL+1 View talk level 1 key assignments Keypanel screen

CTRL+2 View talk level 2 key assignments Keypanel screen

CTRL+3 View talk level 3 key assignments Keypanel screen

CTRL+4 View talk level 4 key assignment Keypanel screen

CTRL+SHIFT+1 View listen level 1 key assignments Keypanel screen

CTRL+UP View previous key level Keypanel screen

CTRL+DOWN View next key level Keypanel screen
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CTRL+HOME Move focus to port number edit box Keypanel screen

CTRL+SPACE Refresh data, re-upload screen data from intercom All screens (ONLINE 
MODE)

CTRL+LEFT Go back to previous view All screens

CTRL+Right Go forward to next view All screens

CTRL+SHIFT+F12 Refresh Alphas, re-upload alphas from intercom All screens (ONLINE 
MODE)

CTRL+N Create a new file All screens

CTRL+O Open a file All screens

CTRL+M Merge a file All screens (FILE 
MODE)

CTRL+S Save current file All screens

CTRL+A Save current file with a new name (Save As) All screens

CTRL+P Perform a partial save All screens

CTRL+G Go online All screens (FILE 
MODE)

CTRL+L Load a file and mark changes for sending All screens (ONLINE 
MODE)

SHIFT+F10 Send changes to the intercom All screens (ONLINE 
MODE)

CTRL+C Copy All screens

CTRL+V Paste All screens

ALT+BACKSPACE Undo last action All screens

ALT+Z Undo last action All screens

CTRL+SHIFT+Z Redo last action All screens

CTRL+F Search for key assignment All screens

CTRL+F12 Edit alpha for current resource (must be enable d in preferences) All screens

CTRL+SHIFT+D Firmware Download Status screens 
(ONLINE MODE)

CTRL+SHIFT+V Firmware Versions Status screens 
(ONLINE MODE)

CTRL+SHIFT+ALT+1 Perform First birthday All screens (ONLINE 
MODE)

CTRL+SHIFT+M View MC/AIO memory All screens (ONLINE 
MODE)

CTRL+SHIFT+C Display AZedit communications statistics All screens
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Notes



Bosch Security Systems, Inc.
12000 Portland Avenue South
Burnsville, MN 55337 U.S.A.

www.boschcommunications.com


	AZedit Software User Manual
	CHAPTER 1 Introduction
	Introduction
	AZedit Description
	Getting Started
	Minimum Requirements for Software Installation

	AZedit Installation and Configuration
	Uninstalling AZedit
	Connection to Matrix Intercom System
	Intercom Configuration Description
	Master Controller Intercom Configuration
	Advantages of reducing master controller intercom configuration settings
	Disadvantages of reducing master controller intercom configuration settings

	AZedit Intercom Configuration Settings
	Setup File Configuration Settings
	Modes of Operation
	Connecting to ONLINE Mode from FILE Mode
	Connecting/Disconnecting — SERVER Mode
	Trouble Connecting?

	CHAPTER 2 General Usage Tools
	Status Bar
	Standard Toolbar
	Navigation Toolbars
	Frequently Used Toolbar Operations
	Show/Hide the Status Bar
	Show/Hide the Toolbars
	Dock and Undock the Toolbars
	Customize a Toolbar

	Frequently Used Column Features
	Resize List Columns
	Hide and Display List columns
	Rearrange Columns


	CHAPTER 3 System Configuration Windows
	Ethernet Setup
	IP Address Field
	Network Mask Field
	Default Gateway Field
	MAC Address Field
	IP Address Field
	Network Mask Field
	Default Gateway Field
	MAC Address Field
	Apply Button
	Close Button

	Communications
	COM Port Drop Down Menu
	Baud Rate Drop Down Menu
	Main Field
	Browse Button
	Partner Field
	Advanced Button
	OK Button
	Cancel Button

	Available Intercoms
	Name Field
	Type Field
	Status Field
	IP Address Field
	IP Partner Field
	Connections Field
	Descriptions Field
	OK Button
	Cancel Button

	Secondary AZedit Sessions
	Baud Rate Drop Down Menu
	AZedit Protocol Check Box
	Command Line Protocol Check Box

	Trunk Master Communications Window
	Port Drop Down Menu
	Baud Rate Drop Down Menu
	Main Field
	Browse Button
	Partner Field
	Autonomous Frames Connect As Distinct Intercoms Check Box
	OK Button
	Cancel Button

	Available Trunk Masters Window
	Name Field
	Type Field
	Status Field
	IP Address
	IP Partner Field
	Connections Field
	Description
	Intercom Configuration Window


	Resources Page
	Frames Field
	Ports Field
	Intercom Sizing Wizard Button
	Party Lines Field
	IFBs Field
	IFB Special Lists Field
	Special Lists Field
	GPI Outputs Field
	ISOs Field
	Assignment Groups Field
	UPL Resources Field
	UPL Statements Field
	Auto Dials
	GPI Inputs Field
	Inter-panel Dims Field
	PAP / LCP-102 Field
	Intercom System Field
	Redundant Audio Check Box
	Test Audio Check Box
	High Density Check Box

	Options Page
	Talk Levels Field
	Listen Levels Field
	Panels with Key Labels Field
	Key Labels Per Panel Field
	Setup Pages Per Port Field
	Physical Panels Per Port Field
	Keys Per Setup Page Field
	Maximum IFB Priority Field
	Use Input Alphas Check Box
	Auto Listen Functions Pick Up All Talk Levels Check Box
	Allow For Remote Trunk Master Check Box
	Don’t Generate Tallies For In-Use Trunk Assignments Check Box
	Don’t Generate Tallies For Off-Hook TIF Assignments Check Box
	Don’t Generate Indefinite PL Tallies Check Box
	Always Stack Callers in Call Waiting Window Check Box
	Configure Onboard GPI Outputs in FR9528 Mode Check Box
	Generate Snoop Tallies Check Box
	Force Autonomous Mode When No Audio Links Up Check Box

	Intercom Sizing Wizard
	How to Use the Intercom Sizing Wizard


	CHAPTER 4 Other Configuration Windows
	MADI Configuration Window
	MADI Card Configuration Page
	MADI Channel Mapping Window
	MADI Card Status Window

	Port Allocation Table Window
	Requirements:
	Slot Column
	Type Column
	Allocated Column
	Ports Columns (4)
	Warning Column
	Warning Field
	Apply Button
	Test Button
	Cancel Button

	RVON Configuration Window
	RVON Card Drop Down Menu
	IP Address Field
	Network Mask Field
	Default Gateway Field
	Target IP Address
	Serial Baud Rate Drop Down Menu

	GPIO-16 Configuration Window
	IP Address Field
	Lookup Button
	Browse Button
	MAC Address Field
	Description Field
	New IP Address Field
	Network Mask Field
	Default Gateway Field
	Ethernet Settings Drop Down Menu
	Current Settings Field
	Primary MC Field
	Current Button
	Primary MC Browse Button
	Backup MC Field
	Apply Button
	Close Button

	Configure Logging Window
	J1 Radio Button
	J9 Radio Button
	J10 Radio Button
	Ethernet Radio Button
	IP Address Field

	Authentication Configuration Window
	Enable Authentication Support Check Box
	Require Authentication On Check Boxes
	User Column
	Password? Column
	Admin? Column
	Restricted? Column
	Add Button
	Edit Button
	Delete Button
	Load Button
	Save Button
	Apply Button
	Done Button
	Cancel Button

	Add/Edit User Window
	User Name Field
	Password Field
	User is an Administrator Check Box
	User Requires Restrictions Check Box

	SNMP Configuration Window
	Name Field
	Location Field
	Contact Field
	Read-Only Field
	Read-Write Field
	Traps Field
	Use List of Valid Hosts? Check Box
	Valid Host Entry Field
	Valid Host List
	Add Button
	Remove Button
	Load Button
	Save Button
	Apply Button
	Done Button
	Cancel Button

	Application Preferences Window
	Startup/Shutdown Page
	Auto Connect at Startup Check Box
	Auto Enter SERVER Mode Check Box
	Warn About Changes in Configuration Check Box
	Save Window Position on Exit Check Box
	Ask For Confirmation Before Exit Check Box
	Save Advanced Communication Settings Locally Check Box

	Alphas Page
	Sort Alphas: Drop Down Menu
	Allow Alpha Edit From Any View (CTRL+F12) Check Box
	Show All Sizes on Alpha Views Check Box
	Automatically Check for Duplicate Alphas After Opening a File Check Box
	Prompt Before Auto-Checking When a File is Opened Check Box
	Prompt When Duplicate Alpha is Created Check Box
	Suppress Default Alphas From Pick Lists Check Box
	Force Alphas to Uppercase
	Force Unicode ASCII and Katakana to Full-Width
	Preferred Alpha Size Drop Down Menu

	Logging Page
	Enable SERVER Mode Logging Check Box
	Enable Standard Talk/Listen Logging Support Check Box
	Set Standard Log Mode and Startup To Check Box
	Log Files .LOG Field
	Browse Button

	General Page
	Automatically Create .BAK Files Check Box
	Confirm File Name Before Save in FILE Mode Check Box
	Prompt to Enter FILE Mode During ONLINE Save Check Box
	Show Preview of Changes to be Sent During Send Changes Check Box
	Warn When Editing Keypanel Setup for IFB Output Port Check Box
	Automatically Latch Disable Keys when IFB is Assigned Check Box
	Warn When Setting Key States on an Incompatible Keypanel Check Box
	Warn When Changing Color of Remote Assignment Group Member Check Box
	Show I/O Gains on Volume Select Dialog Check Box
	Setup Files (.ADM): Field
	Browse Button

	Advanced Page
	Enable Panel Poll Delay Support Check Box
	Enable TIF/Phone Support Check Box
	Enable Trunking Support Check Box
	Enable SERVER Mode Support Check Box
	Enable Alarm Notification Popup Check Box
	Allow Intercom Resizing in ONLINE Mode Check Box
	Allow Key State Changes Check Box
	Allow Changes to TM Communications Check Box
	Allow Firmware Download Check Box
	Allow License Download Check Box
	Firmware Files (.HEX, .MOT, .BIB): Field
	Browse Button
	SNMP Configuration Files (.AZS): Field
	Browse Button
	Debug Files (.AZD): Field
	Browse Button
	License Files (.LIC): Field
	Browse Button

	Authentication Page
	Warn When Attempting to Change Communication Settings Check Box
	Restriction Files (.RES): Field
	Browse Button
	Restriction Cache Files (.RES): Field
	Browse Button
	Authentication Configuration Files (.AZA) Field
	Browse Button

	Maintenance Page
	Allow User to Add Intercoms Check Box
	Allow User to Delete Intercoms Check Box
	Allow User to Change the Default Intercom Check Box
	Allow User to Add User Profiles Check Box
	Allow User to Delete User Profiles Check Box
	Allow User to Change the Default User Check Box
	Hide This Dialog (Permanently) Check Box


	CHAPTER 5 Setup Windows
	Ports Window
	Port Field
	Alpha Drop Down Menu
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	LCP-102 Check Box
	Page Drop Down Menu
	Edit Button
	Gain Button
	D (Latch Disable) Check Box
	R (Key Restrict) Check Box
	Listen Field
	CWW Field
	Show Volume Button
	Keypanel Color Button
	D (Latch Disable) Check Box
	R (Key Restrict) Check Box
	Talk Field
	Level 2 Talk Field

	Keypanel/Port Configuration Window
	Setup Page
	Type Drop Down Menu
	Setup Page Drop Down Menu
	By Panel Type Radio Button
	By Setup Page Radio Button
	Set by User Radio Button
	Reported by Intercom Radio Button
	Setup Restrict Check Box

	Advanced Page
	IFB Priority Field
	Trunk IFB Priority Field
	Trunk Priority Field
	Panel Poll Delay (ms) Field

	VOX Page
	Enable VOX Check Box
	VOX Threshold Box
	Hold Time Box
	Enabled Via UPL Statement Check Box

	2-Wire Settings Page (Zeus III only)
	Use Dip Switch Settings Radio Button
	Manually Configure Settings Radio Button

	Gain Setup Window
	Input Port Field
	Input Port Alpha Drop Down Menu
	Gain Drop Down Menu
	Party Line Field
	Party Line Alpha Drop Down Menu
	Gain Drop Down Menu
	Input Gain Field
	Output Gain Field
	Port Gain Reset Button
	OK Button
	Cancel Button

	Select Key Assignment Window
	Select Intercom System Drop Down Menu
	Type List Window

	Party Lines Window
	PL Field
	Alpha Drop Down Menu
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	Local Check Box
	Trunk Check Box
	Port Column
	Alpha Column
	P-T Column
	P-L Column
	Key? Column
	PL Talker Button
	PL Listener Button
	NOT PL Talker Button
	NOT PL Listener Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Special Lists Window
	SL Field
	Alpha Drop Down Menu
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	Relay Field
	Alpha Drop Down Menu
	Port Column
	Alpha Column
	SL Member? Column
	Add to SL Button
	Remove from SL Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	IFBs Window
	IFB Column
	Alpha Column
	DIM Column
	LC Column
	TK Column
	AE Column
	Input Column
	Alpha Column
	Output Column
	Alpha Column
	Listen Column
	Alpha Column
	Gain Column

	Edit IFB Window
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	Port Number Field
	Port Alpha Drop Down Menu
	Port Number Field
	Port Alpha Drop Down Menu
	Dim Level Drop Down Menu
	Output Gain Field
	Port Number Field
	Port Alpha Drop Down Menu

	IFB Priorities Window
	Port
	Alpha
	Priority
	Select All Button
	De-Select All Button
	Invert Selections Button

	IFB Listen Destination Window
	Port Field
	Alpha Drop Down Menu
	Set Listen Output Button
	Listener column
	Alpha column
	Output column
	Alpha column
	Reset Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	IFB Special Lists Window
	IFB SL Field
	Alpha Drop Down Menu
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	IFB Column
	Alpha Column
	IFB SL Member? Column
	Add to IFB SL Button
	Remove from IFB SL Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Program Listen Source Window
	Port Field
	Alpha Drop Down Menu
	Set Listen Source Button
	Input Column
	Alpha Column
	Listen Column
	Alpha Column
	None Button
	No Change Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	GPI Output Window
	RY Column
	Alpha Column
	LC Column
	TK Column
	AE Column
	Input Column
	Alpha Column
	Output Column
	Alpha Column
	Status Column

	Edit GPI Output Window
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	Port Number Field
	Port Alpha Drop Down Menu
	Port Number Field
	Port Alpha Drop Down Menu

	GPI Input Window
	GPI Input Column
	Keypanel Column
	Keypanel Alpha Column
	Key Column
	Key Type Column
	Status Column

	Edit GPI Input Window
	Port Number Field
	Port Alpha Drop Down Menu
	Number Field

	ISO Window
	ISO Column
	Alpha Column
	ISO Self? Column
	LC Column
	TK Column
	AE Column
	Output Port Column
	Output Port Alpha Column

	Edit ISO Window
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	ISO Self? Check Box
	Port Number Field
	Port Alpha Drop Down Menu

	GPIO-16s Window
	GPIO-16 Column
	Ethernet? Column
	IP Address Column
	Description Column

	Edit GPIO-16 Window
	Ethernet Connection Check Box
	IP Address Field
	Browse Button

	Select GPIO-16 Window
	MAC Address Column
	IP Address Column
	Description Column

	Assignment Group Window
	Group Field
	Alpha Drop Down Menu
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	Alpha Column
	Intercom Column
	Type Column
	Number Column
	Member? Column
	Add To Group Button
	Remove From Group Button

	LCP-102 Window
	LCP-102 Frame ID/Polling ID Drop Down Menu
	LCP Description Drop Down Menu
	LCP-102 Mode Drop Down Menu
	Enabled Check Box
	LCP Key Assignment Field
	Change Setup Button
	Select Active Setup Page

	PAP-32 Window
	PAP-32 Drop Down Menu
	PAP-32 Description Drop Down Menu
	Panel Drop Down Menu
	Page Drop Down Menu
	(R) Restrict Check Box
	Program Input Assignment Fields
	Page Lock Check Box
	Page Drop Down Menu
	(R) Restrict Check Box
	IFB Assignment Fields
	Page Lock Check Box

	ARP-32 Window
	ARP-32 Drop Down Menu
	ARP-32 Description Drop Down Menu
	Panel Drop Down Menu
	Page Drop Down Menu
	(R) Restrict Check Box
	Input Assignment Fields
	Page Lock Check Box
	Page Drop Down Menu
	(R) Restrict Check Box
	Output Assignment Fields
	Page Lock Check Box

	Crosspoint Status Window
	Port Field
	Alpha Drop Down Menu
	Port Column
	Alpha Column
	Closed Column
	F/I Column
	Port Column
	Alpha Column
	Closed Column
	F/I Column
	Force Button
	Inhibit Button
	Release Button
	Inspect Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Crosspoint Inspection Window
	Crosspoint Inspection in FILE mode

	Auto Dials Window
	Auto Dial Column
	Alpha Column
	LC Column
	Phone Number Column

	Edit Auto Dial Window
	Local Check Box
	Trunk Check Box
	AZedit Check Box

	Inter-Panel Dim Table Window
	DIM Field
	Gain Drop Down Menu
	Port Column
	Alpha Column
	DIM Member? Column
	Add to DIM Button
	Remove From DIM Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	UPL Resources Window
	UR Column
	Alpha Column
	LC Column
	TK Column
	AE Column
	Input Column
	Alpha Column
	Output Column
	Alpha Column
	Reciprocal? Column

	Edit UPL Resource Window
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	Port Number Field
	Port Alpha Drop Down Menu
	Port Number Field
	Port Alpha Drop Down Menu
	Reciprocal? Check Box

	UPL Statements Window
	UPL Statement Column
	Enabled Column
	Input A Column
	Operation Column
	Input B Column
	Output Column
	State Column
	Description Column

	Edit UPL Statement Window
	Comment Field
	Enabled Check Box
	Type and Variable Drop Down Menus
	Invert Input A Check Box
	Operation Drop Down Menu
	Type and Variable Drop Down Menus
	Invert Input B Check Box
	Type and Variable Drop Down Menus
	Description Field

	VOX Window
	Adjust Box
	Set To Button and Slider
	Adjust Box
	Set To Button and Slider
	Show Enabled Only Check Box
	Real-Time Changes Check Box
	Port Column
	Alpha Column
	Supported? Column
	Enabled? Column
	Threshold Column
	Hold Time Column
	Audio? Column
	Enable VOX Button
	Disable VOX Button
	Reset Threshold Button
	Reset Hold Time Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Crosspoint Gains Window
	Port Field
	Alpha Drop Down Menu
	Gain Drop Down Menu
	Set Gain Button
	Gain Increase/Decrease Arrows
	Show Non-Unity Only Check Box
	Port Column
	Alpha Column
	Gain Column
	Reset Gain Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Party Line Gains Window
	Port Field
	Alpha Drop Down Menu
	Gain Drop Down Menu
	Set Gain Button
	Gain Increase/Decrease Arrows
	Show Non-Unity Only Check Box
	PL Column
	Alpha Column
	Gain Column
	Reset Gain Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Input/Output Gains Window
	Gain Drop Down Menu
	Set Input Gain Button
	Gain Increase/Decrease Arrows
	Set Output Gain Button
	Gain Increase/Decrease Arrows
	Show Non-Unity Only Check Box
	Real-Time Changes Check Box
	Port Column
	Alpha Column
	Input Gain Column
	Output Gain Column
	Reset Input Gain Button
	Reset Output Gain Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Port Alphas Window
	Port Column
	Output Alpha (4) Column
	Output Alpha (6) Column
	Output Alpha (8) Column
	Input Alpha (4) Column
	Input Alpha (6) Column
	Input Alpha (8) Column
	Alias (4) Column
	Alias (6) Column
	Alias (8) Column
	Description Column

	Edit Port Alpha/Description Window
	Resource Field
	Description Field
	Output Alpha (4) Field
	Output Alpha (6) Field
	Output Alpha (8) Field
	Input Alpha (4) Field
	Input Alpha (6) Field
	Input Alpha (8) Field
	Alias (4) Field
	Alias (6)Field
	Alias (8) Field

	Alpha Windows
	Resource Column
	Alpha (4) Column
	Alpha (6) Column
	Alpha (8) Column
	Alias (4) Column
	Alias (6) Column
	Alias (8) Column
	Description Column

	Edit Alpha/Description Window
	Resource Field
	Description Field
	Alpha (4) Field
	Alpha (6) Field
	Alpha (8) Field
	Alias (4) Field
	Alias (6)Field
	Alias (8) Field

	GPI Input and DIM Description Windows
	Resource Column
	Description Column

	Edit GPI Input and Dim Descriptions Window
	Resource Field
	Description Field

	I/O Card Description Window
	Slot Column
	Description Column

	Edit I/O Card Description Window
	Resource Field
	Description Field

	PAP/LCP Description Window
	PAP/LCP Column
	Description Column

	Edit PAP/LCP Description Window
	Resource Field
	Description Field

	Status Windows
	Port Status Window
	Port Column
	Alpha Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Description Column
	Show Enhanced Status Check Box
	Poll Delay Column
	Requests Column
	Power Ups Column
	KP Type Column
	Clear Button

	Clear Port Status Window
	All Ports Radio Button
	Only Selected Ports Radio Button
	Error Counters Check Box
	Message Counters Check Box
	“Bad Cut” Status Check Box
	Key Closures for Disconnected Panels Check Box

	Master Controller Status Window
	MC Column
	Slot Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Clear Errors Button

	Standby Master Controller Status Window
	Standby MC Column
	Slot Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Clear Errors Button

	DBX or TBX Link Status Window
	DBX Column
	Comm Column
	Status Column
	(A) Link Up/Dn Column
	(A) # Hops Column
	(B) Link Up/Dn Column
	(B) # Hops Column
	Audio A Column
	Audio B Column

	I/O Card Status Window
	Slot Column
	Port Column
	Port Column
	Card Type Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Description Column
	Clear Errors Button

	MADI Card Status Window
	PAP & LCP-102 Status Window
	PAP/LCP Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Description Column
	Clear Errors Button

	UIO-256 Status Window
	UIO Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Clear Errors Button

	Ethernet Links Status: Trunk Master Window
	TM/Link Column
	Link Up/Dn Column
	Status Column
	IP Address Column
	Link Ups Column
	Round Trip (ms) Column
	Packets To Column
	Retransmits Column
	Packets From Column
	Duplicates Column

	Ethernet Link Status: Frame-to-Frame Window
	Frame/Link Column
	Link Up/Dn Column
	Slot Column
	Status Column
	IP Address Column
	Fault? Column
	Link Ups Column
	Round Trip (ms) Column
	Packets To Column
	Retransmits Column
	Packets From Column
	Duplicates Column

	Trunk Master Status Window
	TM Column
	Comm Column
	Status Column
	Errors To Column
	BER To Column
	Errors From Column
	BER From Column
	Clear Errors Button

	Trunk Inspection Window
	Port Column
	Alpha Column
	From Fields
	To Fields

	Remote Intercoms Status Window
	Name Column
	Status Column

	RVON Connection Status Window
	Card/Channel Page
	Connection Page
	VOIP Page
	Network Page
	Errors Page
	Pass-Through Page

	Intercom Alarms Window
	Frame Column
	Alarm Time Column
	Resolved Time Column
	Description Column
	Software Versions Windows


	Master Controller Version Information Window
	MC Column
	Version Column

	I/O Card Version Information Window
	Slot Column
	Version Column

	Keypanel Version Information Window
	Port Column
	Alpha Column
	Version Column
	Show RVON Versions Check Box

	GPIO-16 Version Information Window
	UIO Column
	IP Address Column
	Version Column

	Log Viewer Window
	Log File Type Drop Down Menu
	Location Browse Button
	Date Drop Down Calendar
	Log View Field


	CHAPTER 6 Miscellaneous Windows
	Keypanels Color Window
	Function Types Page
	Key Assignment Page
	Assignments Groups Page
	Miscellaneous Colors Page

	Keypanel Screen Saver Window
	Screen Saver Line 1 Field
	Screen Saver Line 2 Field
	OK Button
	Cancel Button

	Keypanel Passwords Window
	Menu Access Password Field
	Service Menu Password Field
	OK Button
	Cancel Button

	Frame Mapping Table Window
	Frame Column
	IP Address 1 Column
	MAC Address 1 Column
	IP Address 2 Column
	MAC Address 2 Column
	Base 16 Column Check Box
	Move Up Button
	Move Down Button
	Accept Frame Mapping Table from Other Frames Check Box
	Apply Button
	Test Button
	Done Button

	Select Frame Window
	IP Address 1 Column
	MAC Address 1 Column
	IP Address 2 Column
	MAC Address 2 Column
	OK Button
	Cancel Button

	Upload Debug Information
	Select Intercom Window
	Intercom Column
	Add Button
	Delete Button
	Default Button
	OK Button
	Cancel Button

	Add Intercom Window
	Name Field
	Browse Button
	Main Field
	Browse Button
	Partner Field
	OK Button
	Cancel Button

	Select User Window
	User Column
	Add Button
	Delete Button
	Default Button
	OK Button
	Cancel Button

	Add User Window
	Name Field
	Intercom Drop Down Menu
	User Drop Down Menu
	OK Button
	Cancel Button

	Connected Users Window
	User Column
	Connection Column
	OK Button

	Create Desktop Shortcut Window
	Intercom Check Box
	Intercom Field
	User Name Check Box
	User Name Field
	Shortcut Name Field
	Description Field
	OK Button
	Cancel Button

	Cronus Passwords Window
	Front Panel Configuration Field
	OK Button
	Cancel Button


	CHAPTER 7 AZedit Utilities
	Paste Special Window
	IFB Priority Check Box
	Trunk IFB Priority Check Box
	Trunk Priority Check Box
	IFB Listen Dest Check Box
	Local Check Box
	Trunk Check Box
	AZedit Check Box
	LCP-102 Check Box
	Talk Key Latch Disables Check Box
	Listen Key Latch Disables Check Box
	Talk Key Restrictions Check Box
	Listen Key Restrictions Check Box
	Talk Key Assignments Check Box
	Listen Key Assignments Check Box
	Key Labels Check Box
	Enable Tone Check Box
	Keypanel Privacy Check Box
	TIF Dial-out Restrict Check Box
	Port is TIF Check Box
	Key Labels Check Box
	Do Not Interrupt Check Box
	Panel Poll Delay Check Box
	Keypanel Type Info Check Box
	VOX Settings Check Box
	2-Wire Settings Check Box
	Setup Restrict Check Box
	Setup Page Assignments Check Box
	All Setup Pages Check Box
	Page 1 to... Check Box
	Page Drop Down Menu
	Page 2 to... Check Box
	Page Drop Down Menu
	Page 3 to... Check Box
	Page Drop Down Menu
	Page 4 to... Check Box
	Page Drop Down Menu
	All Keys Check Box
	Key # Column
	All Ports Check Box
	Ports Columns

	Partial Save Window
	Select Resource Type Drop Down Menu
	Available Columns
	Selected Columns
	Advanced Select Button
	Add >> Button
	<< Remove Button
	Select All Button
	De-Select All Button
	Invert Selections Button

	Advanced Partial Save Selection Window
	Add Button
	Remove
	Cancel Button

	Send All Window
	Type Column
	Items Column
	Details Check Box
	Send Button
	Cancel Button

	Check For Duplicate Alphas Window
	Refresh Screens
	Search For Key Assignment Window
	Intercom Drop Down Menu
	Type Column
	# and Alpha Column
	Alpha Field
	Search Button
	Cancel Button
	More >> Button
	<< Less Button
	Intercom Drop Down Menu
	Type Column
	# and Alpha Column
	Alpha Field
	Selective Replace Button

	Search Status: Window
	Port Alpha Columns
	Go To Panel Button
	Replace Button
	Repeat Search Button
	New Search Button
	Done Button

	Key Assignment Grid Window
	System Select Drop Down Menu
	Key Assignment Drop Down Menu
	Grid Fields

	Keypanel Print Options Window
	All Keypanels Check Box
	Keypanels List
	Setup Page Report Radio Button
	Designation Strips Radio Button
	Compressed Output Check Box / Expanded Output Check Box
	Use Listen Assignments Check Box
	Use Key Labels Check Box
	OK Button
	Cancel Button

	Other Print Windows

	CHAPTER 8 Operation
	Assigning Names (Alphas) for Intercom Resources
	Assigning Descriptions for GPI Inputs
	Assigning Descriptions for Inter-panel Dims
	Keypanel Setup, General Procedure
	Moving a User to a New Intercom Port
	Check for Party Line Participation
	Check for IFB Participation
	Check for GPI Output Participation
	Check for ISO Participation
	Check for GPI Input Participation
	Check for UPL Statement Participation
	Check for Dim Table Participation
	Check for Forced or Inhibited Crosspoint Participation
	Move User From An Old Port To A New Port

	Ctrl-C
	Ctrl-V
	Ctrl-F
	IFB Priority Setup
	Panel Poll Delay Activation
	Merging
	How to Enable Trunking
	Alpha and Alias Settings in the .INI File
	Connecting and Disconnecting
	Connect from File Mode
	Disconnect from Online Mode
	Disconnect from Server Mode
	Connect at Startup Option
	Trouble Connecting?

	Scroll Enable Setup using Copy and Paste Special
	Scroll Enable Setup for all Intercom Ports
	Scroll Enable Setup for all Party Lines or Special Lists
	Scroll Enable Setup for all IFBs, or all GPI Output, or all ISO’s, or all UPL Resources

	Downloading Firmware Updates
	Updating a Master Controller Firmware
	Updating AIO (Audio Input/Output) Card Firmware
	Updating Keypanel Firmware
	Updating KP-12, DKP-8, DKP-12, and KP-8T Keypanels (KP-12 Type Keypanels)
	BKP-4, MKP-4, TKP-4, WKP-4 Keypanel Update (Zeus Type Keypanels)
	KP-32 Keypanel Update

	Assigning Auto-Follow to all Listen Keys using Copy and Paste Special
	Activating or Deactivating the Advanced Settings Tab in the Options Menu Preferences
	Enabling Intercom Configuration Resizing in Online Mode
	Ctrl+F12 Alpha Editing
	Using Ctrl+F12 Alpha Editing

	Key Restriction Setup using Copy and Paste Special
	Restricting Setup Page Reassignment for all Intercom Ports Using Copy and Paste Special
	Activating Crosspoint Inspection in File Mode
	Port Configuration for Non-Keypanel Usage
	Auto Server Mode
	Starting the Application in File Mode
	Entering File Mode from Server Mode
	Changing the Number of Talk Levels
	Enabling or Disabling the Configuration Conflict Message
	Procedure to Change Intercom Configuration Settings
	Changing the master controller configuration settings
	Changing the AZedit intercom configuration

	Changing the Configuration Settings in Setup Files
	Reconfigure A Previously Created Setup File To Have The Default AZedit Configuration
	Reconfiguring A Setup File To Have Non-default Settings For Resources

	IFB Setup Procedures
	Setup Procedure for standard one-way and two-way IFB

	Using the Keypanel Tone Generator
	Show/Hide the Toolbars
	Dock and Undock the Toolbars
	Customize a Toolbar
	Enable VOX
	How to Download Firmware to Multiple Cards
	How to Enable Key Labels
	How to Enable Snoop Tallies
	How to Enable Do Not Interrupt
	Connect Cronus to the PC and the Network over Ethernet
	How to Use the Intercom Sizing Wizard
	Set the Cronus Front Panel Control Password
	Show or Hide List columns
	Download License File to Cronus
	How to Create a Desktop Shortcut to AZedit
	How to Set VOX on Several Ports at the Same Time
	Add an IFB to an IFB Special List
	Add Multiple IFBs to an IFB Special List at the Same Time
	Create an Administrator Profile
	Resize Columns
	Order Columns
	How To Set The Delay Time For Screen Saver Mode
	How To Create/Change The Screen Saver Display
	Add/Remove a Port to/from a Special List
	How to Create an Assignment Group
	Remove Assignments in Assignment Groups
	How to Use an Assignment Group at the Keypanel
	How to re-display the maintenance tab using the Registry Editor
	How to display output alphas, input alphas, and aliases on alpha windows
	How to set preferred alpha sizes
	Configure the GPIO-16
	Assign the GPIO-16 device to the relay group in AZedit
	Upgrade the GPIO-16 Firmware
	Assign Key Assignments for the ARP-32
	Download Firmware to the ARP-32
	Assign Keys
	How to view alarms
	How to turn off the Alarms notification
	How to save debug information
	Release a Trunk Port in AZedit
	Download License File to a MADI Card

	APPENDIX A Channel Allocation Scheme
	Base 8
	Base 16

	APPENDIX B AZedit Keyboard Shortcuts
	AZedit Keyboard Shortcuts
	Notes


